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SAFETY NOTES

SAFETY NOTES
1. These safety notes are general notes and have to be adjusted to the existing works
regulations.
2. Only trained and qualified technicians are authorized to operate vibration control systems.
3. Also refer to the safety notes in the operating manuals of the devices.
4. Make sure that the device is switched off when you connect it to the power supply.
5. Be sure to observe generally accepted safety rules when you operate this device. For
example, take suitable measures to prevent unintentional operations of the device.
6. In any case of emergency or irregular operation or before switching on/off any power
supply or disconnecting/connecting any cable or rebooting the PC,
1. shut down the shaker power amplifier,
2. use the external shutdown port of the vibration controller to close the output.
7. Ensure that the supply voltage remains within the nominal range of the devices. Refer to
the nominal voltage of the devices (see the operating manuals and the type plates of the
devices).
8. The ON/OFF switch does not disconnect the devices from the mains voltage.
To completely disconnect the supply voltage, remove the power plug from the grounded
outlet (see also the operating manuals of the devices).
9. Make sure that no objects (e. g. necklaces, paper clips etc.) or liquids get inside the
housings of the devices (danger of electrical shock, short circuit).
10. Close the amplifier master gain before switching on/off the measurement device.
11. Make sure that all cables are connected in a way that they are not damaged and that no
one could stumble over them. Refer to the relevant notes in the operating manuals when
connecting the devices.
12. Only qualified technical personnel are authorized to repair the devices. Unauthorized
opening or incorrect repair of the devices may greatly endanger the user (risk of electrical
shock or fire).
13. In spite of all safety measures taken, there still remains a risk endangering persons and
devices.
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WHAT’S NEW IN REV. 2.16?
The m+p VibControl Revision 2.16 provides you with new functions that make your vibration
control system even more powerful. The table below will give you an overview of the new 
features and enhancements and refer you to the relevant pages in the m+p VibControl 
Revision 2.16 user manual.
As a reminder, this new revision of the m+p VibControl software has resulted primarily from
direct dialog with you, the people in the field performing vibration tests every day. Therefore, if
you have any suggestions that could improve our product offering, please contact your local
m+p international representative.

New Feature

Chapter

Page

Automated ICP settling time

3.3.7.2

46

Additional overview with online charts showing up to 16 traces

5.3.6

92

Shock and vibration tests for railway applications IEC 61373 - 
linear PSD slopes

6.1.1.2

102

Scheduled random measurements

6.1.3

118

Transducers list states calibration date

6.1.4.4

124

Sine tests for material testing with specified number of sine cycles

6.2.3

167

Improved compensation of existing pulses in classical shock

6.3.1.2

215

Displacement optimization in classical shock

6.3.1.2

221

Quickly see if the test meets the specifications:
online threshold checking for SRS parameters

6.7.1.2
8.7.1

381
534

Enhanced safety: monitoring vibration control tests

6.7.3.2

398

Everything at a glance: enlarged legend in VibPosttest Multiplot

8.3.4.2

486

Quick comparisons of different test runs - channel-wise color
assignment in VibMultiPlot charts

8.3.5

487
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Getting Started

The m+p VibControl Operating Manual will guide you through the m+p VibControl Vibration
Control and Analysis System. Example "Getting Started" files for all ordered test modes are
enclosed with the system (Path: C:\VcpNT\Data\).
Prior to starting your real vibration testing, please familiarize yourself with the m+p VibControl
functions first by reading through this manual and testing the functions with the Getting Started
files. With the help of this Operating Manual, you will easily learn how to define, run and analyze
a vibration control test in m+p VibControl.
Learn how to install the hardware parts, start and stop the system, and operate the graphical
user interface. Have a look at how to save your data and define the shakers used in your
laboratory. To become familiar with the system, define, run and analyze the Getting Started
tests on a bare wire, i.e. directly connect the output signal to input channel "4". Thus, you can
test m+p VibControl without a shaker or specimen required. Bare-wire testing allows operators
to check the performance of their hardware at any time.
These symbols mean special information:
Attention: Safety feature




Useful tip
Example

Microsoft Windows Support
m+p VibControl supports the following Microsoft operating systems:
Windows 7™ and Windows 10™, while Windows 10™ is the preferred operating system.
m+p VibControl Rev. 2.16 directly supports current 64-bit Windows operating systems and thus
makes full use of the potential offered by modern PCs.

Hardware Support
m+p VibControl Rev. 2.16 generally supports m+p hardware. The software functions described
in this manual refer to a connection with m+p front-ends, such as m+p VibPilotE, m+p VibRunner, m+p VibMobile.
We also support further front-ends. These require special handling concerning their connection
with m+p VibControl. Please contact our support for further information and assistance.
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Installation

The m+p VibControl system consists of two hardware components: the PC and the data
acquisition and signal processing front-end. The clear separation between the m+p VibControl
program running on the PC and the controlling processes on the front-end guarantees an
absolutely safe test operation.
m+p VibControl runs with the operating systems Windows 7™ and 10™. When we talk about
Windows in the following text, we refer to all operating systems mentioned. For installing the
components you need administrator rights. The systems delivered by m+p international are not
provided with an administrator password!

2.1

m+p VibControl License for Desktop PC

The optional m+p VibControl license can be installed on any desktop PC which is equipped
with a network card. There is no need to install a front-end with it.
All functions are available, except the VibRunner module (used for running tests).
Measurement results on the laboratory PC can be easily transmitted to the desktop PC in the
office via network or via a data medium, and can be analyzed and documented there.
Test definitions including the feasibility check of the test can be prepared on this PC, too.

2.1.1

m+p VibControl License is Independent from PC

m+p VibControl software is license-independent from your PC. It can be installed on several
PCs and the dongle enables the software.

Do not remove the dongle during operation!

2.2

PC with Front-End

The m+p VibControl software can be installed on any PC using a Windows operating system.
To ensure optimum system operation, it is recommended to have this PC equipped with:
•

a quad core i5 oder quad core i7 processor,

•

> 8 GB RAM,

•

a second network adapter for the local m+p VibRunner network (if m+p VibRunner
front-ends are used for data acquisition).

For signal acquisition and control, connect one of the following data acquisition and signal processing front-ends:
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Windows 7

Windows 10

m+p VibPilot

x

x

m+p VibPilotE

x

x

m+p VibRunner

x

x

m+p VibMobile

x

x

VXI with IEEE-1394 Firewire
interface

x

VXI with EX2500
LAN interface

x

x

VXI Front-Ends need IO-Library Version 16.3.

The hardware setup and installation procedure is described in the corresponding hardware
manuals.

2.3

Install the m+p VibControl Software

For the software installation, local administrator rights are required! Please
check this before starting the installation procedure!

Before installing the m+p VibControl software it is recommended to disable
your virus scan software! Reactivate it after the installation procedure.

Insert your CD into the CD-ROM drive. Start the Vib_2_16_XX.exe file.
If your Windows operating system does not have a compatible .NET framework, you will be
requested to install the required .NET framework. The current version can be downloaded
directly from the Microsoft Download Center.
Now, choose the destination location for the installation.
The installation directory should be "C:\VcpNT". If you want to use another directory, click the
Browse button and select the desired one.

Do not install the m+p VibControl program files into the "Programs" folder.
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Choose the destination location for the installation

In the following window you choose the components to install. Do you want an update or a full
installation. Do you want to use metric units or SAE units in your tests? Select the appropriate
entry and click the Next button to proceed.
Select the default units used in your laboratory (SAE or metric units). SAE
will use inch and g while metric will use meter and m/s2. Once it is
installed, you can choose from either one. In this window you only choose
the default units.

Choosing the components

The "Update Installation" only replaces the old program files with the files
of the new version. The configuration files of the users will not be replaced.
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Enabling the Software Modules

The "Full Installation" choice will overwrite all existing files!

The Setup is now ready for installation. Verify the selections you have made and start the installation procedure with a click on Install.
Please take into account that the copy process may take some time.

Verifying the Setup settings and starting the installation

We recommend rebooting the system after the installation procedure.

2.3.1

Enabling the Software Modules

Together with your hardware we delivered the m+p VibControl software on CD or USB stick as
well as a dongle. For activating your licenses, connect the dongle with the PC. When you click
the Utils... button in the m+p VibControl program toolbar and open the Configuration option,
you can view the dongle number (Module ID) and your licenses in the Keyword Setup tab.

m+p VibControl toolbar
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KeywordSetup

In the KeywordSetup tab you can choose the desired language in the Language field.
Before you save the language setting with a click on the Save button, please make sure that
all other program parts have been closed.
Close VibConfig by clicking the Cancel button.
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2.3.2

Data Path Selection and Communication
with the Front-End(s)

Change to the Setup tab to select data paths, define the front-end you use and start the
Service.
For some of these actions you need administrator rights.
In the Start mode line you select the front-end in use. If you want to combine several front-ends,
the master-slave configuration can be defined with a click on the

button.

In the Setup tab m+p VibControl proposes directories for the basic path and the throughput
data path which can be modified according to your needs. The basic path is the default directory path from which test run definitions are loaded and onto which result files are stored. To
modify the path, click into the Data line and browse for the desired directory path.
Usually, throughput data is written to the common result file folder.
Use the Throughput line of the tab to define another path for saving your throughput data. This
enables you to choose a fast responding SSD memory for saving your throughput data which
will result in a better performance.
If you want to return to the default path, you only have to delete the entry in the Throughput line.

Data path selection

In the next step you have to start the Service. Successively, click the Install Service button and
the Start Service button.
A message appears stating that the connection to the m+p VibRunner front-end(s) is being
established.
Now, the message “Startup completed“ will appear and the heartbeat service starts counting.
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Choosing the Start mode and start of the Service as administrator

In Administrator mode you can select the front-ends and start and stop the Service.

Choosing the Start mode and start of the Service as user
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Dongle Upgrade to a New Licence (From Rev. 2.15 Onwards)

The Start mode field for selecting the front-ends is inactive for normal users. The Service installation buttons and the Start service and Stop service buttons are also inactive. With a click on
the

button, VibConfig changes to the Administrator mode.

Please make sure that the heartbeat is counting - the heartbeat stops
counting when the service has stopped and the communication with the
front-end has failed.

Whenever the heartbeat of the service stops, successively click the Stop Service button and
the Start Service button. Then, the heartbeat restarts counting.
To close VibConfig, click the Cancel button.

2.4

Dongle Upgrade to a New Licence (From Rev. 2.15 Onwards)

m+p international provides a license file which has to be programmed to your dongle.
•

Be sure to make a backup of your current VcpNT folder before upgrading to a higher version!

•

Insert the dongle into the PC before starting the upgrading procedure.

•

Install m+p VibControl Rev. 2.15 (VcpNT 2.15).
You will not be able to run m+p VibControl Rev. 2.15 before the upgrade
procedure has been completed!
So please carry out the following steps!

•

Now, you can program your dongle:
In the VcpNT\Bin folder you will find the "DinkeyChange" tool which is used for programming the dongle.

•

Run the DinkeyChange.exe.

DinkeyChange start window
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•

Open the File menu in DinkeyChange and choose the Open Update Code file function and
then the update file from the Update E-Mail sent by m+p international.

Open the update code file

•

Then, click the Make changes to dongle,button to complete the update process.

Programming the dongle

•

The following message confirms a successful update and states a confirmation code.

Update message with Confirmation Code

You can verify your update by checking the Confirmation Code from this message against the
one of your license e-mail.

2.5

Getting Started Files

For each of the test modes ordered, you will find a "Getting_Started" file in the directory
"C:\VcpNT\Data\ m+p". This file is an example file that will help you with the test definition in
VibEdit.
"Getting_Started" tests are run in shortcut. Thus you can test the system without shaker and
specimen.
To perform a shortcut test using the m+p VibPilot or the m+p VibRunner front-end, connect the
drive signal (Source1) directly to input channel "4" (see pictures below).
Make sure that the front-end is switched on and the ticker is counting.
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Getting Started test using the m+p VibPilot front-end

Getting Started test using the m+p VibRunner front-end

•

At VXI systems, you insert the SMB-end of the adapter cable that came with the system
into the "OUT" port of the E1432A signal generator and input module.
Connect the other end of the adapter cable to the BNC port "4" of the breakout-box via a
BNC-cable. The BNC-cable closes the control loop between the integrated D/A-converter
(DAC) of the E1432A signal generator and input module, and the input channel "4" of the
module.

Then call a Getting Started test into the VibRunner software module (see chapters 3.3 and 6),
run the selfcheck procedure and start the test.
When the front-end has been connected in shortcut mode, open the m+p VibControl program
part "VibRunner" from the toolbar.
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In VibRunner, the status light of the Idle button shows green. Select the desired test mode from
the selection field, Then choose the Getting Started file, e. g. "Getting Started Sine.tsn".

VibRunner with green Idle button

The test will be loaded into VibRunner and the defined profile is shown in the control channel
window. With a click on the Selfcheck button you start the test. Then, a gentle click can be
heard and at the front-end the status LEDs might light up shortly. If all settings are correct, the
Standby button will light up green after the selfcheck has been finished. Now, the test can be
started with a click on the Run button.
Whenever you are facing problems concerning your m+p VibControl system, the Getting
Started test enables you to check the proper function of your front-end.

2.6

Further m+p international Frontends

m+p VibControl supports all m+p international frontends. We provide frontends suited for a
large variety of applications.
Our mobile solutions are the versatile m+p VibMobile and the very compact, optionally batterydriven m+p VibPilotE .

m+p international frontends m+p VibMobile and m+p VibPilotE

m+p international
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Strain Measurements

2.7

Strain Measurements

m+p VibControl offers full strain support for m+p VibMobile and m+p VibRunner hardware.
Both front-ends can be equipped with the 102.4 kSa/s per channel bridge module which is
suited for dynamic strain measurements, experimental stress analysis and fatigue testing of
mechanical structures. It enables connection of eight strain gauges in full-, half-, or quarterbridge configurations.
For information on how to define a strain measurement see chapter 6.7.4 “Strain Measurements”, page 399.

2.8

System Operation without Administrator Rights

Create a new user (e.g. "Vibco") and call the tool "UserUpdates2". It can be found under:
"C.\VcpNT\Bin\UserUpdates2.exe."
Then log onto the system as user "Vibco".

You can only start and stop the service with local administrator rights!

2.9

External Shutdown

m+p VibControl has a variety of safety features built in to prevent that your test item is overtested. Nevertheless, we encourage the use of a hard-wired switch as an emergency stop.
All m+p international front-ends (m+p VibPilot, m+p VibRunner, m+p VibMobile) have two
digital input ports to connect an emergency switch with normally closed contact. As soon as the
emergency switch opens the contact, the front-end firmware will run down the signal output in a
controlled manner.

m+p VibPilot bridge for external shutdown
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Digital Start and Stop

Use the bridge contacts for connecting the emergency switch.
As soon as you push the emergency button, the external shutdown circuit is opened and the
m+p front-end firmware starts ramping down the signal to ensure a controlled system shutdown.

When a test has been aborted using the emergency switch you won’t be
able to start it again as long as the contact is open.
Reset the switch and you will be able to start further test runs

m+p VibPilotE back - bridge is done between digital input channel 8 and ground connector

2.10

Digital Start and Stop

Use this option for activating an external device/recorder during your measurement run.
Connect this device to digital output channel 7.
As soon as VibRunner is in Run mode, digital output channel 7 is set to "high" and the external
device is activated. When VibRunner is in Standby mode after the measurement the digital
output channel is set to "low" and the device is stopped.

m+p international
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Digital Start and Stop
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3

General Program Structure and Operation

Have a closer look at the m+p VibControl program structure! The main program parts appear
in the toolbar.

Toolbar/Utilities

The m+p VibControl system consists of three main program parts designed for the test run definition, test run control and the evaluation of the measurement results:
VibEdit:
Define your vibration test including the test reference, the shaker
and specimen definition, and the channels definition.
You define, modify or print out your test setup. Charts assist you in checking it.
Then, load the test setup into the VibRunner program part.

VibRunner: Run and control the test.
Chart functions help you to monitor the test run, control functions enable you to
interfere, when problems occur.
Even if a test is running, you can simultaneously analyze results in VibPosttest
and/or define a new test or modify the current test setup in VibEdit.

VibPosttest: Evaluate and post-process your measurement results.
Load the results file into VibPosttest for graphical and mathematical evaluation
of the test results. Then, print out your test report or export test data to Microsoft
Word or Excel.

Further program parts of the m+p VibControl system are:
VibMultiPlot It enables you to evaluate data from several result files,
to compare them and to print the report.

m+p VibUtil is our optional test sequencing program. It can be used to
automate vibration tests by setting up test sequences, so that you can define
various vibration tests which are carried out automatically in sequence.
This program part is described in detail later in this manual
(see chapter 7 “m+p VibUtil (Test Sequencing)”, page 453).

m+p international
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User Definable Toolbar

m+p Utils
provides access to the program configuration. Here you enable
the purchased licenses, make your language settings and start or stop the
m+p VibControl service.
Apart from VibConfig the menu lists freeware we provide to our customers
(e.g. Pulse Editor, RoadLoad Editor, LineModifier, VibSlideRule).
These options are described in detail later in this chapter.
m+p VibControl and its program parts can be used in parallel. They can be accessed via the
toolbar or via the Windows Start menu (Start -> Programs -> m+p VibControl -> VibEdit,
VibRunner, VibPosttest, etc.).

All icons start up independent processes, so you can start up a vibration
test, click on VibEdit and set up another test, then click on VibPosttest and
start some post-test printing.

3.1

User Definable Toolbar

The user definable toolbar provides access to the individual program parts of the m+p
VibControl vibration control software. Right-click on an icon in the toolbar or choose the
Settings menu item from the Utils... list to open the Settings window.
The Settings window allows you to change the toolbar options including the individual icon
parameters, such as the icon size.
The individual lines in the Utility menu can be edited in the same way as the general toolbar
with the exception that there is no bitmap association, but only a text entry.
Finally, the toolbar location can be customized for optimum use.

Toolbar configuration window
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•

Tick the Always on top check box if you want the toolbar to be visible on top of any other
application that may be active.

•

Tick the Show in taskbar check box if you want to add an “m+p Toolbar“ icon to the task
bar at the bottom of your screen.

•

In the Current Position entry fields you can define the position where you want the toolbar
to appear on the screen. Tick the Store position check box if you want to store the toolbar
position you have defined.

m+p VibControl Rev. 2.16
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VibEdit Program Part, Define a Test

•

In the Content frame you define the content of the toolbar, i.e. the applications ( *.exe files)
that shall appear on the toolbar. The window on the left shows which applications are currently included in the toolbar.
Use the Add, Remove and Reload buttons to add or remove applications to/from the
toolbar.
The entry fields in the center of the window allow you:
- to define a label for each application,
- to select an application file in the search window which will be opened
after you clicked the ... button,
- to select an image file in the search window which will be opened after you clicked
the ... button. The selected image file will be used as an icon for this application.
- path: enter a path for your working folder.
Clicking OK you confirm the settings, clicking Cancel you undo your settings.
The window will close and the modified toolbar will appear.

3.2

VibEdit Program Part, Define a Test

To start with your test definition, open VibEdit. For your first test definitions, we recommend
using a Getting Started test and modifying it according to your needs.
When you click the VibEdit button, the "Open" dialog appears where you first select the test
mode required and then the Getting Started test setup file belonging to this test mode.
Now, you modify this test including the test reference, the shaker and specimen definition, the
test schedule and the channels settings and save it with a new name.
The four test definition areas are represented by tabulators:

VibEdit tabulators

•

Reference, Define the test mode profile, the measurement levels, the alarm and abort
limits etc.

•

Specimen: Load the shaker file and define the specimen and the fixture properties.

•

Schedule: Define the selfcheck properties and at which level shall be tested during which
period of the test.

•

Channels: Define the number of channels, the channel types and the function of each
sensor attached.

m+p international
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Open VibEdit and a Test File

VibEdit for sine test setup

3.2.1

Open VibEdit and a Test File

1. Open VibEdit from the toolbar with a click on the VibEdit
button . The Open
dialog is displayed. The default data path is: “C:\VcpNT\Data\m+p“.
2. Select the test mode from the File Type list, e.g. Random.
3. The m+p sub-directory offers one Getting Started file for each test mode. With the Getting
Started files, you can perform bare-wire testing on channel 4. These files can be used as
templates for personal test mode definitions.
4. Open a file of the test mode to be defined with a double click of your mouse button or
select it and use the Open button of the dialog.
5. When you opened the Getting Started file, the VibEdit window appears with the Reference
tab. The four available tabs are arranged one after the other. Click the Shaker tab, the
Schedule tab, and the Channels tab to open the corresponding definition page for the test
mode.
6. If you want to define a new test, modify an existing file of the corresponding test mode e.g. the Getting Started file - and save it under a new name. Now you can modify the test
definition as needed.
7. With a click on Cancel you can abort the test definition process.
Further information on the single test modes can be found in chapter 6 “Define and Run Vibration Tests”, page 99.
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Open VibEdit and a Test File

3.2.1.1

Opening Another Test Mode in VibEdit

To open another test mode, you can either select it via the menu (Open function from the File
menu), or time-efficiently from the toolbar.

“Open“ toolbar in VibEdit

Multiple test mode files can be opened at the same time. The file you opened most recently will
appear in the foreground, all previously opened files are placed in the background. To have an
overview of and/or recall any opened file, select the Window menu. In the second menu block,
you find a list of all files which are currently open. To select one of these files, click it.

3.2.1.2

Typical File Extensions

When saving a file, m+p VibControl automatically assigns a typical file extension made of test
data type plus test mode type, e.g. t + sn = tsn = test setup file (sine).
Test data:

shaker file
=shk
test setup file = t
result file
=r
throughput file= sot

Test mode:

random
sine
sine dwell
classical shock
SRS
mixed mode
transient capture
sine reduction
acoustic
random reduction
RoadLoad

m+p international

= rn
= sn
= sd
= cs
= ss
= sr
= tc
= rs
= ac
= rr
= td
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Saving Test Definitions

Image formats for saving charts:
*.jpg, *.bmp, *.png

This is what the main extensions mean
*.shk
*.trn
*.tsn
*.tsd
*.tcs
*.tss
*.tsr
*.ttc
*.trs
*.rrn
*.rsn
*.rsd
*.rcs
*.rss
*.rsr
*.rtc
*.rrs

3.2.2

shaker
random test setup
sine test setup
sine dwell test setup
classical shock test setup
shock response spectrum (SRS) test setup
mixed mode test setup (i.e. SoR, RoR, SoRoR)
transient capture test setup
sine data reduction test setup
random results
sine results
sine dwell results
classical shock results
shock response spectrum (SRS) results
mixed mode results (i.e. SoR, RoR, SoRoR)
transient capture results
sine data reduction results

Saving Test Definitions

Every new test definition is written by opening an existing test definition file and overwriting the
existing test setup with a new one. There are two ways to save the new test setup:
1. Save the data as a new file and keep the original data that has been overwritten under the
existing file name. This is recommended when a new test setup is to be saved.
2. Save the data as existing file and overwrite any previous data. This is recommended
when a test setup is to be modified and the original one is not needed any more.

Always save your test setup files in sub-directories of "C:\VcpNT\Data".
The Getting Started files can be found in the "m+p" sub-directory.

When a test run in VibRunner has been completed, m+p VibControl creates a result file. The
name of the result file is "test setup name_test run number ", e.g. "SineFCT97_005". In VibPosttest, you will detect from this test run number which test run to analyze.
Whenever you have completed one tab of a new test definition, e.g. the Reference tab, click
to save the settings and thus avoid that data may get lost by - for example - clicking a
wrong button by accident.
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Delete Result Files in VibPosttest

If charts are slow or NOT shown close any extra definition windows.

With a click on Cancel you can abort any test definition process.

3.2.3

Delete Result Files in VibPosttest

Delete result files

To relieve the memory, delete old result files from time to time. Before deleting them, you can
save them on an external storage device.
You will find the result files in the data path "C:\VcpNT\Data\*".
A copy of the deleted data file is saved in the system trash can for recovery in case of erroneous
deletion.

Restore Deleted Files
Deleted files can be recycled from the recycle folder

.

1. Open the recycle folder from the desktop.
2. Mark the file(s) to be restored.
3. To restore a marked file, press the right mouse button and select Restore.

m+p international
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How to Edit Tables

3.2.4
3.2.4.1

How to Edit Tables
Cut/Copy/Paste

Cut/copy/paste menu

When editing tables, complete rows can be easily cut or copied to the clipboard from where
they can be pasted. Additionally, you can make the same entry or selection for multiple rows
at the same time.

Cut
To cut a row and copy it to the clipboard, mark it with a click of your right
mouse button and select Cut from the context menu.
Alternative:

Copy
To copy a row to the clipboard, mark it with a click of your right mouse button
and select Copy from the context menu.
Alternative:

Paste
To paste a cut or copied row from the clipboard, mark the row below the destination row with a click of your right mouse button and select Paste from the
context menu.
Alternative:
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How to Edit Tables

3.2.4.2

Make a Global Entry or Selection

Global parameter setting

You can globally make the same entry or selection for all lines marked at this time.
1. For example, to set the same higher abort limit for multiple lines, click on the No. column
of the first line with your left mouse button.The line will be marked. Then, press and hold
the Shift key and click on the last line to modify. With the Shift key held all lines in between
are selected.
2. Select the field of the limit to set with a click of your left mouse button. Release the Shift
key and type in the new abort limit.
3. Press to globally set this abort limit for all rows selected.
4. If you want to modify several single of the table instead of several lines in a row, use the
Ctrl key instead of the Shift key to mark these lines for the above procedure.

3.2.4.3

Copy and Paste Columns

How to Copy and paste columns

m+p international
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How to Edit Tables

For a fast and easy copy and paste of table data between external applications (i.e. Excel) and
m+p VibControl editor (reference editor) and list tables (channel tables), we offer column copy
and paste functions. Thus, you can copy information between setups of different modes of excitation (i.e. channel location, sensitivity, abort, etc.) which allows for easier, faster and error-free
transfer of vital data.
To copy or paste an entire column, select one or several lines of the table and click with the
right mouse button into the desired column. Click the Copy column option to copy the data.
Then change to another test setup or application and paste the data using the context menu.

3.2.4.4

User-Defined Columns in the Channels Table

You can add user-defined columns to the channels table in VibEdit. Select Edit Custom
Columns... in the Extras menu to activate the function.

User-defined column

ID
m+p VibControl generates a number, which cannot be edited.

Name
Enter a name for the new column.

Visible
Define whether the column shall be visible or not.

Position
Click on the line to open a selection menu where you can choose an entry.
The new column will be inserted to the left of this column.
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VibEdit Tools

The default setting is "-1". The new column will be added as last column of
the table.

Width
Enter the width of the column in pixels.
The definition will be saved as .xml file. In the lower part of the window you will find buttons for
importing or exporting the column definition. It can be saved as default setting, too.

3.2.5
3.2.5.1

VibEdit Tools
Subscreen

"Advanced" button in random test setup

In VibEdit, you need a click of your left mouse button to proceed to further setup steps.
Subscreen buttons are marked with arrows (>>). For example, to define advanced random
parameters, click on the Advanced >> button.

m+p international
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VibEdit Tools

3.2.5.2

Test Information

To check the current test data, read from the GUI’s numerical, graphical and text information.
Parameters

Defined Parameters are constantly checked on feasibility and highlighted in red if not correct.

Numerical shaker load display
Spectra

Defined Spectra are represented in numerical (e.g. tabular) and graphical form.

Numerical and graphical reference pulse display

Feasibility Check
Every parameter is constantly checked for feasibility and highlighted red if it is not correct.
If highlighted, please check your definition!
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Modification of the Print Templates for the Test Mode Specifications

Moving within Tables
•

To activate a field, click it with your left mouse button.

•

To change to the next field, press the Tab key.

•

To move within a field, use the arrow keys.

•

To copy, delete or paste a channel row, mark this row and use the common Cut-CopyPaste functions.

3.2.6

Modification of the Print Templates for the Test Mode
Specifications

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
The default templates installed with m+p VibControl can be found under:
"VcpNT\config\<LANGUAGE>\s_TEST MODE.fmt.default" (z.B. "s_random.fmt.default").
To edit one of the default templates, open the *.fmt file in Word. You can choose to load your
company logo or modify fonts and column positions as required.
Please note that *.fmt files will not be overwritten during software updates. If you wish to revert
to the default template format, simply copy the "TEST MODE.fmt.default" file and remove the
".default" portion of the file name.

3.2.7

Direct Change from VibEdit to VibRunner

Define your test and click on the VibRunner button
in the toolbar. A window will appear
asking you to save the test definition. After the saving procedure the test definition will be
loaded directly into the VibRunner as long as there is no active test run at the moment. Now
start your test.

m+p international
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VibRunner Program Part, Run a Test

3.3

VibRunner Program Part, Run a Test

Open the VibRunner program from the toolbar. Here you start vibration tests, monitor and control them.
Alternative:

Select Windows -> Programs -> m+p VibControl -> VibRunner

Running a random test

To make the operator’s job as time-efficient as possible, VibRunner offers these tools for
frequently used operating actions:

Click

To

Load the parameters of the current test into preferred text editor
(e.g. MS Word or Wordpad) for a quick overview of complete test parameters.
Load the current test into VibEdit.

Load the current test into VibPostTest.

Freeze the online chart display.
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Load a Test

Expand the screen area available for the display of multiple charts.
(Available only if Multi-Monitor option is active.)
Click the Chart button to open one more window.
Open the Chart drop-down list to select the required number of charts
to be displayed.
Open the Chart setup drop-down list to select the range of charts you want to be
displayed in the selected number of charts.
(C-D means Control channel, Error signal, Drive signal:
1-3 means display of the first three channels in three charts (channel 1, 2 and 3)

Save the result file under a name different from that automatically generated.

Result file

Open the Comment window where you are able to view and/or edit comments.

3.3.1

Load a Test

You have opened VibRunner and would like to load a test setup:
Click

or select Open from the File menu.

Load a Test Directly from VibEdit
Define your test in VibEdit and click on the VibRunner button
in the toolbar. A window will
appear asking you to save the test definition. After the saving procedure the test definition will
be loaded directly into the VibRunner and can be started immediately.

VibEdit toolbar with VibRunner button

m+p international
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Online Status and Online Control

Load a Test from a Network Drive
Before you can load a test from a network drive, you need to have network access established
by the system administrator. This network access is established in VibConfig (please refer to
your Installation manual for more information).

Please make sure that you use a valid UNC network path for loading your
test setup (see examples below). m+p VibControl cannot write results to
another file!

To load the test setup, click

or select Open from the File menu.

The "Open" dialog is displayed.
By default, the "C:\VcpNT\Data\m+p" directory is displayed.
Select the network environment icon to the right of the dialog window. Now, follow the path to
open the desired test setup file.
Example for a valid UNC file: \\server\drive\path\...
e.g. \\Mpiserver\v1\User\smith\Getting Started Sine.rsn

Example for an invalid file: Z:\User\smith\Getting Started Sine.rsn

3.3.2

Online Status and Online Control

Action buttons

The upper left part of VibRunner is the online control panel. The current test status is indicated
by the green light. At the beginning, VibRunner is in the "Idle" status. To change the current
test status, click the corresponding action button. The above action buttons are the same for
each test mode.
There are more action buttons which are test mode-specific ones changing the testing schedule. First have a look at the general action buttons. The specific ones will follow when the corresponding test mode will be described.
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Online Status and Online Control

Idle

Idle

As soon as VibRunner is ready, the Idle button shows a green light. Starting from the "Idle"
status, you first start the Selfcheck. By clicking Idle while a test is running you halt the test and
the mode changes to Standby.

Selfcheck
Every test run requires running a selfcheck first. After a successful selfcheck,
VibRunner changes to standby mode.

Run
After a successful selfcheck the test can be started by clicking the Run button.
While a test is running, the Run button signals a green light. As soon as the test
run is completed, VibRunner changes to standby mode.
To definitely abort the test and save the measurements, you click the Abort
button.
To continue a halted test ("Standby"), you click the Run button.

Standby
The VibRunner changes to standby mode, as soon as any of the following
actions has occurred:
• A successful selfcheck is completed.
• The user clicks Standby to temporarily halt the on-going test.
• Either the system or the user aborts the test run.

m+p international
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Online Status and Online Control

• The abort limits are exceeded.
• The end of the test run is reached.
• To continue a test that is in Standby mode, you click the Run button.

Measure
Saving data can be scheduled and/or data can be saved manually online
(operator selected).
In each test mode, you can define scheduled measurements in VibEdit’s
Schedule tab which are then taken during the test run as defined.
A measurement can be taken manually at any time by clicking the Measure button. Every time
a measurement is taken, the Measure button shows green light.
All measured responses of the measurement and control channels as well as the corresponding drive signal, the error and the control spectra will be stored in the result file.

Abort

By clicking the Abort button you halt an on-going test and it will enter standby mode. With the
test being halted, the Standby button signals green light. By clicking the Run button, you continue this test. By clicking Abort again you definitely abort this test. With a test being definitely
aborted, you can restart the test with the selfcheck.
After the regular test end has been reached, the test is in Standby mode. To definitely abort the
test and store the results, click the Abort button. This will switch the test status from Standby
to Idle mode and the test results will be saved.
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3.3.3
3.3.3.1

Options Menu
Beep at the End of the Test

Beep at test end selection

m+p VibControl has the capability to generate a beep at the end of test, independent of the
mode of operation.
The toggle on/off of the beep feature is included in the online chart layout format and can be
stored in the default or any customized layout format for re-use.

3.3.3.2

Print or Store Screenshot at Test End

A screenshot of the entire VibRunner window can be saved and/or printed upon test end.
Choose Store screenshot at test end from the Options menu to save to a predetermined image
format (*.jpg, *.png, *.bmp). This convenient reporting tool helps preserve test information
during a test stop caused by a manual shutoff or when limits of a test are reached.

Print screenshot at test end

m+p international
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Options Menu

3.3.3.3

Comments

To enter individual comments such as specs, specimen characteristics, test run information or
the tester’s name, make use of 10 comment lines available in VibEdit’s Specimen tab, in
VibRunner and in VibPostTest.
To open the Comment window in VibRunner, select Comment in the Options menu.

Opening the Comment window

Alternatively, click the

button in the toolbar.

The Comment window will open.

Comment window

You can detect from the above figure, that either comments 1 to 5 or comments 6 to 10 are
displayed at the same time.
To switch, check Comments 1-5 or Comments 6-10, respectively.
To confirm a new or changed comment, click the Apply button.
To confirm a new or changed comment and close the dialog, click the OK button.
To abort the dialog and not confirm any change not yet confirmed, click the Cancel button.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts.
Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed above the
charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.
If you want the Comment window to be automatically displayed after each selfcheck, select and
activate the Show Comments after Selfcheck option in the Options menu.
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Display of Comments after Selfcheck
If you want the Comment window to be automatically displayed after each selfcheck, select and
activate the Show Comments after Selfcheck option in the Options menu.

Automatic display of comment window after selfcheck

User Comment in Online Test Log
m+p VibControl logs all steps of a test run in an online protocol. Users are able to enter individual comments on certain test run steps or events which will then be stored with the test log.
Right-click the online test log area to open the context menu Add comment / Refresh.

Context menu to add comments

Select Add comment to open a dialog window where you are able to enter your comment(s).

Entry of user comment in online test log

Finally confirm your entry by clicking OK. Your comment will then appear in the online test log.
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Options Menu

3.3.3.4

Auto-Increment of Result Files On/Off

Auto-increment result file

m+p VibControl features the capabilities to let the software auto-increment the result data files
or not. When selecting the Auto-Increment option the software will automatically assign a
numerical extension to the test definition file name and will additionally increment the numerical
extension based on existing data files.
When selecting not to auto-increment the result data files, the software proposes a file name
which can be modified. The system will prompt for overwriting the file every time the proposed
file name already exists.

3.3.3.5

Auto-Save Settings

Auto-save settings option

When the Auto-Save Settings option is enabled the test configuration including the order of the
channels to be displayed, their scaling, alarm and abort limits will be saved automatically whenever you start a selfcheck.
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3.3.3.6

Auto-Load Settings

Auto-load settings option

This function is very time-saving. Once you have defined a chart setup including the order of
the channels to be displayed, their scaling, alarm and abort limits, just store it with your test file.
When you load the test the next time, enable the Auto-Load Settings option and the test file will
come up with the stored chart setup. This function is very useful for test sequences - each test
will be started with exactly the chart configuration you need for monitoring the most important
channels.

3.3.3.7

Test Mode Specific Options

There are further options available, depending on the selected test mode.

Simple RMS Legend
You can choose a simple RMS legend, which displays the RMS value for only one measurement channel and which has a defined place in the chart. The “usual“ RMS legend offers a lot
more functions.

Large RMS Display, Large Actual Amplitude Display
In Random test mode, you can select the Show large RMS legend function. It displays the current RMS value in big letters in front of the chart.
In Sine and Sine Dwell test modes, you can select the Show large actual amplitude display
function. It displays the current amplitude value in big letters in front of the chart. It also shows
no background so that the test run can still be monitored.

Show Cursor as RMS, Show Cursor as Sine-Peak
In Random test mode and in Mixed Mode the cursor value can be displayed as RMS value.
Activate the Show Cursor as RMS option and the RMS value will be averaged from several
measurement values and then be displayed.
But if a sine frequency can be detected in the measurement signal, it is better to select the
Show Cursor as Sine-Peak function. Then the amplitude value will be shown at the cursor position instead of the average value.
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Show Average Count Window
In Random test mode you can enable the Average Count window. It counts the averages
elapsed versus averages remaining. Open the Options menu and select the Average Count
Window function to open the display.

3.3.4

Tools Menu

The Tools menu offers functions to manage your disk space, for using Scope Mode and for creating NEXUS™ files.

3.3.4.1

DiskManager

The DiskManager is a customer specific feature.

3.3.4.2

Scope Mode

To verify that the transducers are functioning correctly before commencing a test, the scope
mode offers a time data display in standby mode, even before you start the selfcheck. It is available for all test modes and can be useful for observing measurement signals to ensure the sensors have reached their steady state, before you start the selfcheck and the test run. Errors due
to incorrect channel inputs can also be detected. Furthermore, scope mode is also available
during the test runs.
To activate scope mode click the Scope Mode button. The button is located at the bottom of
the left window part.
To abort scope mode before starting the selfcheck, click the Abort button.
To start selfcheck while scope mode is active, click the Selfcheck button.
In sine, random, mixed mode and acoustic test modes, scope mode is always active in standby.
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Scope mode active in sine test mode

In shock, roadload and transient capture modes, scope mode can be toggled on/off in standby.
It is disabled when you switch from the run state to standby state.

Scope mode active in shock test mode
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3.3.4.3

Create Nexus File

This option is described in the Appendix, chapter 9.1.3 “Create NEXUS™ File”, page 545.

3.3.5

WANO Channel Mapping

The lower left part is the WANO panel. The WANO panel shows the channel mapping of the
on-going test. During the test, this panel indicates alarm (W), abort (A), notching (N) and overloads (O) information per channel:

Channel

1234

5678

9 10 11 12 13 14 15 16

WANO channel mapping

Each column represents an individual channel. The channel number is read from left to right.
The first WANO column represents channel 1, the last WANO column represents channel 16.
The W indicator lights up if an alarm (warning) limit is exceeded.
The A indicator lights up if an abort limit is exceeded.
The N indicator lights up if a notch limit is reached.
The O indicator lights up if an overloading occurs.
If you want to map all defined channels, just double click the WANO section and a supplementary WANO window opens which defines all channels.

Wano channel mapping for 96 channels
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This WANO window shows two lines for each channel. The indicator of the top line lights up
when the limit is exceeded. The indicator of the bottom line is lit if the limit was exceeded any
time during the whole test run.

Overload Indication
If an input channel overload is detected while in sine sweep mode then the actual amplitude
result can not be determined. To indicate this invalid result the data is set to an infinite value
while in overload. If the overloads are of a short duration this will be seen as a number of single
vertical lines off the upper limit of the vertical display.
Also note that since the WANO display is continually updated then it may not indicate a
momentary overload although the result data will correctly indicate the invalid measurement
result.

3.3.6

Throughput Data Recording

Throughput data recording controls

Remaining

States the throughput time remaining

Elapsed

States the throughput time elapsed

Throughput data acquisition can be started before the test run is started!

Scope Mode: The control system will be armed for measuring.
You can now activate throughput and start the selfcheck later. Then the
throughput data are recorded before any signal leaves the DAC. Thus, the
recorded data will reflect events like the opening of the relay as well as all
selfcheck results.
Start TP:

Opens the Throughput dialog window and starts the throughput data recording
process. The measured data are written to the throughput file.

Stop TP:

Stops the throughput data recording process.
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Throughput Data Window

Throughput data window

Click on the Start TP button to manually start the throughput recording and open the Throughput Data window. Define the Frequency and the throughput Duration. Select whether
throughput shall record all channels or only selected ones and whether the schedule shall be
followed or ignored. The bottom line displays the estimated file size and the free disk space.

Show/Hide Throughput Recording Controls
It is possible to show or hide the Throughput controls of the VibRunner window. If you want a
larger test log part in the VibRunner window, it is recommended to hide the throughput controls.
Enable/disable the throughput controls in the VcpNT.ini file
(directory: VcpNT\Config\Users\<login name>\VcpNT.ini) by setting the
CanHaveThroughput parameter to 1 (enabled) or 0 (disabled).
[common]
CanHaveThroughput=1/0

3.3.7

Selfcheck

Prior to starting a test run, you need to run the selfcheck which outputs a scaled-down level of
your defined test run. For a random test run, the maximum output voltage of the source / DAC
module is 0.1 Vrms and can be reduced in the Selfcheck level field of VibEdit’s Schedule menu.
An entry of -12 dB reduces the selfcheck level to 25 mV. It is also possible to define a selfcheck
attenuation for certain frequency bands.
The selfcheck is necessary to check that all defined channels give a meaningful response and
that the measured system gain of the control and watchdog channels do not deviate from the
defined system gain by a set tolerance.
You can switch on/off the system gain from selfcheck by enabling/disabling the system gain
control in the VcpNT.ini file (directory: VcpNT\Config\Users\<login name>\VcpNT.ini). Set the
ReportGainError parameter to 1 (enabled) or 0 (disabled).

[common]
ReportGainError=1/0
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3.3.7.1

Selfcheck Procedure

•

Examine the system transfer function and check the entire control loop

•

Select the Selfcheck mode

•

Start the Selfcheck

•

Analyze the selfcheck results which provide values for checking the transducer
sensitivities and the channel response (channel function)

•

Printout and save selfcheck results

3.3.7.2

Examining the System Transfer Function and the Control Loop

The selfcheck examines the transfer function of the total system (armature, expansion, and
specimen). The system gain measured during the selfcheck ("Gain act. [EU/V] rms") controls
the output of the first drive. The system gain indicates the voltage necessary to reach the full
test level.
To perform random testing at 30 grms at full test level and with a measured
system gain of 10g/V, the drive must be 3 V rms.
10 g/V * 1/x = 0.1 V/g * 30 grms = 3 V rms

The selfcheck level is used to determine the measured system gain (“Gain act. [EU/V] rms“)
and to compare it to the system gain defined in VibEdit’s Channels tab ("Gain [EU/V] rms"). If
the selfcheck level is within tolerance, the selfcheck log states “OK“.
If the selfcheck level is out of the selfcheck limit defined, the selfcheck log states “Gain Error“.
The selfcheck log will be displayed automatically only if the selfcheck level limit is exceeded or
if there is an error in the control loop.
The transfer functions obtained during selfcheck are used to pre-calculate the drive signal
expected in a real test run. Due to different levels and frequency resolutions (sine test), these
values should however always be considered as estimations. Now, the pre-calculated drive
signal, plus the measured spectra (time signals in shock mode), are stored in the result file.
These values can also be displayed in on-line display of the VibRunner program. The expected
response will be displayed for all channels involved in the control process by means of the
frequency spectra so that possible peaks can already be detected prior to running the test. This
allows the user to define additional notches if necessary and to check for possible channel
overloads.
Prior to starting the selfcheck, have a quick verification of the test parameters and the channel
assignment. To open a list of test parameters in Word and verify e.g. the channel assignment,
click

.

Print out the test parameters, if needed.
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Automated ICP Settling Time
The automated ICP settling time picks the perfectly settled state of a transducer to start the selfcheck run. Your m+p VibControl system measures the incoming ICP transducer signal and
starts the selfcheck as soon as it is sufficiently stable.

3.3.7.3

Selfcheck Modes

Fixed Level Mode
Standard selfcheck is done using a fixed output level. This level is defined in the Selfcheck level
(100 mV) field, You can manually define an attenuation shape using the >> button.

Selfcheck mode - fixed level settings

Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line.

Selfcheck attenuation defined
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Limiter Mode:
The Limiter mode automatically reduces the output level at critical points of the spectrum,
which are mostly distinct resonances with low damping. As the position and the intensity of
these resonances are often not known previously, they are determined by the selfcheck at
reduced level with simultaneous measurement of the transfer functions. The excitation level is
gradually increased and, while considering the recently calculated transfer function, it will automatically be limited at critical points. This also reduces the structural response, similar to the
notching feature in a controlled test run. The aim is finishing the selfcheck with a good signalto-noise ratio and determining all required parameters while the specimen experiences only
low to middle load. This process requires more time than a normal selfcheck does.
In Limiter mode you define the selfcheck range using the Min. selfcheck level (100 mV) field
and the Max. selfcheck level (100 mV) field. The Limiter mode limits the response to a reasonable value. Any spectral lines which are too close to the reference spectrum or the notch limits
are automatically reduced to a safe value.

Selfcheck mode - Limiter mode settings

In the screenshots below you can see the effect of the above settings. The same selfcheck run
with Limiter mode settings and with Fixed level selfcheck settings.

VibPosttest charts - Limiter mode settings versus Fixed level settings
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3.3.7.4

Start the Selfcheck

After a test has been loaded, VibRunner is in Idle mode.
Switch on the power amplifier.
To start the selfcheck, click the Selfcheck button. An hourglass is now displayed on the screen
while m+p VibControl is arming the measurement front-end.
After a few seconds the Selfcheck button signals green light. Now, the selfcheck procedure is
running.
As soon as the selfcheck has been completed, VibRunner changes to Standby mode.
During the selfcheck of random tests, the coherence is displayed both as a plot (in VibPostTest)
and in the selfcheck log (see 6.1.8.5 “Coherence Measurement”, page 140).

Random Getting Started in selfcheck

Test Name and Test Run Name
During test definition, you have saved the test under a special test name. For every test run,
m+p VibControl creates a separate result file and - at test end - automatically saves this file
with the test run number added to the test name defined.

Note that the maximum length of a file name (including full path) is 80 characters. An error message will indicate if this exceeded in which case enter
a shorter file and/or folder name.
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See the "Result File" line:

At test end, you can save the result file under a different test run name, too.

3.3.7.5

Analyze the Selfcheck Results

The selfcheck log displays the system gain defined in the Channels tab of VibEdit and the measured gain, the sensitivity of the transducer, the measured background noise and the measured voltage. The Remarks column gives additional information on the results of the
selfcheck.

Check for each channel:
Gain rms defined
Gain rms current
Sensitivity
Noise rms
Meas. rms
Remark

the system gain defined,
the system gain measured,
the transducer sensitivity,
the background noise measured,
the voltage measured.
states the selfcheck result for this channel.

Selfcheck results stating errors

The above screenshot is stating some errors:
The Coherence of 0.521 is too low. The test run will not start with a coherence below 0.8.
The signal-to-noise ratio is "1". This leads to the "Open channel" message in the Remarks
column. The measured voltage should be greater than the background noise by a factor of at
least 10.
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If an "Open Channel" remark appears in the selfcheck log, please check whether
- the transducer fell off the specimen,
- the cable is defective or parted,
- the BNC cables are correctly connected to the breakout box/front-end,
- the charge amplifier is switched on.

If a "Gain Error" remark appears in the selfcheck log, this means that
- the defined system gain is outside the tolerance of the measured system
gain.
- Please check your test definition:
You can either modify the system gain defined in the VibEdit Channels tab,
so that it is similar to the measured system gain.
Or you can modify the Selfcheck gain level limit in dB.in the VibEdit
Schedule tab.
A gain error does not prevent the test start!
You can start any test even if the selfcheck states a gain error.

.If the coherence is below 0.8, m+p VibControl will not start the test run
- Check the above points as a bad coherence is a result of the faulty conditions described above

Coherence is a safety feature: A bad coherence locks the test start!

If the magnitude of the background noise is similar to that of the measured voltage,
there is an error in the control loop.
Please check in any case why this error occurred. Here are some of the possible reasons:
- selfcheck level too low
- cable defective
- charge amplifier switched off or incorrectly set.
The measured voltage should be greater than the background noise by a
factor of at least 10.
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Reload test into VibEdit

To load this test setup into VibEdit, click

.

VibRunner remains open but the VibEdit window is placed in the foreground. VibEdit allows to
define a new test setup or modify an existing one.

If VibEdit was already opened or minimized on the task bar, take care that
the proper test definition is loaded.

Check which parameter has caused the error message, change it as appropriate and save the
test setup.

Selfcheck Restart
Reload this test setup into the VibRunner.
Restart the selfcheck procedure as described.
If m+p VibControl recognizes in selfcheck that the system gain is out of tolerance or that there
is an error in the control loop, it will display a selfcheck log automatically.
If a gain error reappears in selfcheck you should consider whether or not you
really should run the test.
If the test conditions remain unchanged, the system gain will only change slightly.
If the m+p VibControl spots a considerably changed system gain in selfcheck,
either the master gain has changed or the entered sensitivity of the transducer
deviates from the actually set one. If you start a test under these conditions, there
may be damage to the specimen or to the shaker!
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With an error stated, you can either quit the selfcheck log and start the test or abort the test.
To turn the test to standby mode and be able to start it, click the OK button of the Results
window.
To abort the test, click the Cancel button of the Results window.
To print out the selfcheck results, click the Print button.
If the selfcheck has been completed successfully, the test changes to Standby mode.
The control action buttons are activated and the test can be started.

Selfcheck Protocol
You can have a look at the selfcheck results:
Select Selftest results... from the File menu.

Selfcheck results OK (Sine Getting Started)

If the selfcheck results do not show any parameters exceeded, the Remarks column states OK.
With OK, all parameters are within tolerance. You can continue by starting the test run.

3.3.7.6

Printout of Selfcheck Results

To print out the selfcheck log, click the Print button of the Results window.
Close the Results Dialog. With no error stated, you can turn the test to Standby mode and then
start it. With an error stated, you can either start the test, or abort the test.

Go to Standby Mode
To turn the test to standby mode and be able to start it, click the OK button of the Results window.

Go to Idle Mode
To abort the test, click the Cancel button of the Results window. VibRunner returns to "Idle".

3.3.7.7

Saving Selfcheck Results

The selfcheck results and the selfcheck log file are saved under the same name as the test run,
but using the file extensions „___STEST.bin“ for the selfcheck results and „___LOG.bin“ for the
selfcheck log file. This information of every test run can later be used in VibPostTest.
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In the sine, random and shock modes, a complete trace of the selfcheck will also be saved as
a chart in the result file.
The selfcheck results can be saved to the result file.

3.3.7.8

Display of Comments after Selfcheck

If you want the Comment window to be automatically displayed after each selfcheck, select and
activate the Show Comments after Selfcheck option in the Options menu.

Automatic display of comment window after selfcheck

3.4

VibPosttest Program Part, Evaluate the Test Results

Open the VibPosttest program part to view and evaluate the test results graphically and
mathematically.

Test evaluation in VibPostTest

To analyze a test, you load the corresponding result file into VibPostTest. You can also select
VibPosttest during the test run to analyze any previous or on-going test. A measurement is
always stored together with the corresponding error, control and drive spectra in the result file.
The following chapters will explain the m+p VibControl post-test analysis functions.
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To relieve the PC memory, you should delete old result files in the
Windows Explorer from time to time. Before deleting them, you can save
them on an external storage device.

Open VibPostTest from the toolbar.
In VibPostTest, you will find some buttons and selection fields for direct analysis action:
Print out the post-test charts.
Select Print from the File menu.

Alternative:

Load the test definition into VibEdit.
Select Load test definition from the File menu.

Alternative:

Activate single plot analysis (to analyze one measurement per chart), or
activate multi plot analysis (to analyze / print all marked measurements in the
same chart (see chapter 8.3.4 “Singleplot/Multiplot”, page 484).
Either the SinglePlot or the MultiPlot option must be active.
Alternative:

Select Singleplot or Multiplot from the Extras menu.

These selection fields are used to select various display and analysis options.
Filters...

Select Filters... to open a window in which you can select the type(s)
of channel to display (see chapter 8.3.1 “Filter Channels”, page 479).

Alternative:

Select Filters... from the Extras menu.

Peak values...Select Peak values... to open a window where you can select options
for the search and display of peaks
(see chapter 8.5.1 “Peak Values”, page 511).
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Alternative:

Limits...

Select Peak values... from the Extras menu.

Select Limits... to open a window where you can select which types of limits
and reference traces you want to show or hide
(see chapter 8.4.2 “Limits/Reference”, page 491).

Alternative:

Select Limits... from the View menu.

Reference

Check Reference to show the reference spectra/pulses in the main
VibPostTest chart. Uncheck Reference to hide them.

Legend

Check Legend to show the legend to the right of the main VibPostTest chart
(see chapter 8.4.7 “Test Legend”, page 504).
Alternative:

Comments

Select Legend from the View menu.

Select Comments to open a window where you can view the comments
which the test operator has entered for the relevant test (if applicable)
(see chapter 8.4.10 “Comments”, page 508).
Alternative:

Select Comments from the View menu.

Math funcs... Open the Math funcs... drop-down list to activate/deactivate
mathematical functions
(see chapter 8.5.3 “Mathematical Functions”, page 517).
Alternative:

Select Math funcs... from the Extras menu.

For further information on the VibPosttest functions, please refer to chapter 8 “Analyze a Test
(VibPostTest)”, page 469.

3.5

VibMultiPlot

The VibMultiPlot program part offers graphical evaluation across several test runs. For example, you can easily compare the selfcheck results of the current test run with older selfcheck
results of the same test definition.
It is also possible to compare test results of different test definitions or even different test
modes. For an overview on its functions, please refer to chapter 8.3.5 “VibMultiplot Program
Part (Different Result Files)”, page 487.

3.6

m+p VibUtil (Test Sequencing)

The m+p VibUtil tool was created to ensure test sequence automation. It establishes the communication between the m+p VibControl software and the measurement hardware including
digital input or output channel setting to carry out the test sequences you defined. m+p VibUtil
provides automation of your testing processes across several test modes. A detailed protocol
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is generated during the sequence and is saved to a protocol file. If any problems occur, an information service immediately sends an e-mail to the given recipient.

m+p VibUtil: test sequence definition

For more details, see chapter 7 “m+p VibUtil (Test Sequencing)”, page 453 or contact your
local m+p international representative.

3.7

Utils - Configuration and Additional Applications

Click the Utils icon of the toolbar to access the m+p VibControl configuration and setup
windows. Here, you choose the program language, enable program parts using the keywords
and start and stop the program service.
For more information on Configuration and Setup, please refer to chapter 2.3 “Install the m+p
VibControl Software”, page 4.

3.7.1

m+p VibControl - Additional Applications

The Utils icon of the toolbar also offers access to several small applications. The Line Modifier
and VibSlideRule are provided as freeware while the Pulse and RoadLoad editors are licensed
for use with SRS and RoadLoad test modes, respectively.
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Pulse Editor for Defining Classical Shock Pulses
This tool enables you to define shock pulses for classical shock testing. It covers Halfsine, Haversine, Initial Sawtooth, Terminal Sawtooth, Rectangle and Trapezoid pulses. Define the pulse
parameters, compute the pulse and verify its acceleration, velocity and displacement shown in
the charts.

Classical shock pulse editor
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External ASCII Pulse Editor for Classical and SRS Shock Testing

External pulse builder

This utility is dedicated to preparing an external ASCII pulse to be used in the m+p VibControl
Shock program. It corrects measurement anomalies. Applying up to two sets of band pass
filters allows for filtering out lower and/or higher frequency contents, a shaker will not be able
to accommodate. A final velocity and displacement compensation algorithm helps insuring the
shaker end movement is zero. The DC removal will correct a common problem with real life
measured data and will condition the pulse for shaker testing. Since the pulse control is in
blocksizes in power of 2, an ASCII pulse of non-standard length needs to be zero-padded in
order to be used in the m+p VibControl Shock programs. The ASCII pulse data can be in
several formats, but most commonly they are formatted as time vs. amplitude or plain amplitude with a defined constant delta time. For more advanced testing the utility allows for
increase/decrease of amplitude rescale, acceleration and time offset. Once the pulse has been
imported and conditioned using the above, the pulse can be stored in the m+p VibControl
Shock format for use in both the m+p VibControl classical and SRS shock testing programs.
This feature is included in the default setup of the toolbar utility list. The program is located at
"C:\VcpNT\Bin\ External Pulse Builder.exe".

RoadLoad Editor
This graphical editor reads ASCII and RPC3 raw sample data files and provides comprehensive compilation and editing facilities so that the resultant output can be used by the
m+p VibControl Time Domain Replication and External Pulse functions. This allows for easy
reviewing and compiling of field sample data in the test lab.
For more information on this editor, please refer to chapter 6.7.7 “Time Domain Replication
RoadLoad Editor”, page 427.
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Line Modifier
This optional program enables you to define line colors and background colors for the chart
printout in a pdf file.

m+p VibSlideRule - Multi-Function Vibration Calculator
The m+p VibSlideRule offers a wide range of useful calculating tools for vibration testing and
structural analysis. It helps to visualize the relationships that apply and includes units
conversions.
Typical applications:
•

Test development

•

Analysis

•

Test set-up

•

Calibration and error analysis

m+p VibSlideRule can be downloaded as freeware from the customer login page of our
website. It provides tools for:
Signal sinosoidal

- calculate displacement, velocity, acceleration and frequency
- supports translational as well as rotational/angular motion

Sweep

- calculate sweep time and number of cycles for a sine sweep defined by start- and
stop frequency, sweep type and sweep rate

PSD Spectrum

- definition of arbitrary PSD spectrum using linear interpolation between data
points
- calculate corresponding RMS and peak values for displacement, velocity,
acceleration
- export PSD-spectrum for use in m+p VibControl using linear-linear or linearlogarithmic axis scaling (e.g. according to IEC 61373 – random testing)

PSD-RMS

- calculate RMS value for given bandwidth and constant PSD-spectrum

Shock

- half-sine, saw tooth, rectangle and trapezoid pulse shapes
- compute pulse width, peak acceleration and velocity change

Force-Moment

- compute moment, force and distance

Gain

- compute output - input ratio (linear and dB)
- supports amplitude and power input values

Error

- compute errors for true and actual measurements (% and dB)

Units Conversion

- convert values between different units:
Force: N ↔ lbf
Transducer Sensitivity: mV/’Unit’ ↔ ‘Unit’/V
Acceleration: m/s² ↔ g
Velocity: m/s ↔ in/s
Displacement: mm ↔ in

The m+p VibSlideRule operating manual is included in the program download. Open the pdf
file to get more information on the program functions.
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3.7.2

m+p VibControl - Software Options

VibCoPilot
The VibCoPilot is a software option that allows a network remote PC to setup a test and/or
analyze test data from the local desktop. The remote PC user can be granted full or limited
access to the setup and data files, based on the Windows network security protocol. Please
contact your local m+p international for more information on this software option.

Full m+p VibControl External Control via Visual Basic Commands/Programs
The m+p international m+p VibControl software allows for complete external control using
Visual Basic programs. All online parameters (i.e. current sweep frequency, elapsed time,
gRMS values, …) and action (i.e. run test, hold sweep, next level, …) are available to write customized programs for test stand automation. This requires an optional Visual Basic module.
Please contact your local m+p international representative for information on this module.

Transducer Calibration
Regular transducer calibrations are vital for generating reliable test results. m+p international
provides the optional "SensCal" program which enables users of vibration control systems to
calibrate acceleration transducers in a test run. You only need a calibrated transducer serving
as reference, which is mounted on your shaker. Then, the transducers for calibration are fixed
on top of this reference transducer and connected to the measurement front-end. A sine sweep
test is started and the test results for the transducer undergoing calibration are compared to
those of the reference. After the calculation process, a detailed calibration certificate will be created, showing, among other things, the sensitivity and the transmissibility with phase information.
m+p SensCal offers two calibration modes which are significantly faster than the calibration via
a sine sweep:
•

Calibration with fixed sine frequencies: You specify a set of discrete sine frequencies.
These are driven step by step and the transducer will be calibrated for exactly the frequencies required.

•

Calibration using random signals: The transducer will be calibrated over a specific frequency range using a random excitation signal. As the entire frequency range is excited at
once, the procedure is very effective.

m+p international offers an entire calibration package consisting of a calibration shaker, the
reference transducer and the software upon request.
For further information on transducer calibration, please refer to our SensCal manual.
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4

Define a Shaker (VibShakerDef)

The VibShakerDef application enables you to specify one or multiple shakers used in your lab.
You create a separate file for each shaker in use. Later you load the shaker file into VibEdit to
check whether your current test setup may exceed your shaker’s limits.

4.1

Open VibShakerDef

To start VibShakerDef, click the appropriate icon in the toolbar (if included), or use the Windows
Start menu, go to m+p VibControl and select VibShakerDef.

Test parameters of the Getting Started dummy shaker

The dummy shaker used in connection with the tutorial Getting Started
tests is "GS_Dummy_Shaker.shk". This file can be found in the
"C:\VcpNT\Data\m+p" directory.
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4.2

Load a Shaker File

In VibShakerDef, you can create a new shaker file or open an existing file.

Title field with no file loaded

1. When opening VibShakerDef, there is initially no shaker file being selected. The title field
states "Untitled".
2. To open an existing shaker file, click

and select the desired file.

The ".shk" extension is automatically given to shaker files only.

3. Now, the title field states the file name defined.

4.3

Create Shaker Definition File

For creating a shaker definition file, you enter the shaker data into the VibShakerDef window
as described below. Then, you save the file using the File menu and the Save as function.

Force, Acceleration, Velocity, Displacement

Shaker limits

In this part of the shaker definition window, you specify the maximum force, acceleration,
velocity and displacement of the shaker. The values for these dimensions vary for different test
modes, therefore there are separate entries for random, sine and classical shock.
Enter the maximum force, acceleration, velocity and displacement as stated in your shaker’s
technical specifications.
Choose the appropriate unit from the drop-down list.

Switching to another unit does not convert the numerical value. Please
adjust the value as appropriate!
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1. Select the corresponding units. Double-check these, e.g. is it "m" or "mm" for displacement. Both are peak values not peak-to-peak values.
2. Enter the peak force, acceleration, velocity and displacement ratings as stated in your
shaker´s technical specifications.
3. Note that all limits should be entered as their maximum peak values in the above table.
Take care to interpret the shaker specifications correctly:
Sine acceleration and force ratings will normally be defined as peak values so these
values can be entered directly.
Random acceleration and force ratings will be defined as rms values.
Shock force rating is often not defined. A value of 2*sine peak is often suitable - but
check with your shaker manufacturer. Unless otherwise specified use the same acceleration limit value for shock as entered for sine.
Velocity is usually defined as a peak rating that will usually apply in all three test types.
Displacement is usually stated as a peak value.

Expansions

Expansions

Per shaker you can specify a pre-selection of up to 5 different expansions used in combination
with the shaker. When defining an individual test, expansions not defined in this pre-selection
can be defined in the Specimen tab of VibEdit.
1. Give each expansion a name and specify its weight.
2. Select the corresponding unit.

Switching to another unit does not convert the numerical value.
Please adjust the value as appropriate!

m+p international

m+p VibControl Rev. 2.16

63

Create Shaker Definition File

Frequency (fMin, fMax)

Optimum frequency range

1. Enter the frequency range (fMin = minimum frequency, fMax = maximum frequency) in
which the shaker has optimum performance without load.
2. Select the corresponding unit.

This frequency range is displayed during test definition in VibEdit where it
is for information.

Switching to another unit does not convert the numerical value. Please
adjust the value as appropriate!

Other Values

Other values

Other values are Moving coil mass, Axial stiffness and Maximum input voltage.

Switching to another unit does not convert the numerical value. Please
adjust the value as appropriate!

Moving Coil Mass
Enter the armature weight without load. Select the corresponding unit.

Axial Stiffness
Enter the axial stiffness. This dimension defines the force that has to be
applied for the vibration process.
Select the corresponding unit.
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Maximum Input Voltage
Enter the maximum input voltage of the power amplifier. The signal output
provides a maximum voltage of ± 10 Vpk.
Select the corresponding unit.
This value will be compared to the calculated Drive before the force is
applied. If the calculated Drive signal is higher than this value, it will not be
applied and the process will be stopped.

4.4

Save the Shaker File and Close VibShakerDef

To save the data as new file, select Save As from the File menu.
To save the data as original file, click

.

To close VibShakerDef select Exit from the File menu.
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5

Chart Display Functions

5.1

General Chart Display Functions

Charts are used in every program part.
In the VibEdit program part, charts display the reference trace you defined, together with all
limits set. You can access the chart functions via the Data view window. Open this window by
a double-click on the chart.
In the VibRunner program part, charts show the progress of the test and provide real-time data
which enable you to monitor and control your test runs. You can also overlay previous test runs
with the current one. Cursor functions help you to identify maxima and minima and read axis
values. All chart display functions are accessed using the context menu.
In VibPosttest the measurement results are shown in the chart. Traces can be compared and
mathematical functions applied.These functions are available in the VibPosttest window and
the chart context menu.
The following chapters describe the basic chart functions which apply to all program parts:
•

Scaling

•

Zoom

•

Colors

•

Cursors

•

Markers and Labels

5.1.1

Scaling

We describe the scaling functions using the Data view window in VibEdit. Open this window by
a double-click on the chart. Enable or disable the scaling controls using the context menu
(Show scaling controls).
In VibRunner the scaling controls can be accessed via the chart context menu. Select the Axis
configuration function. In this window you will also find the Settings section which is described
in chapter 5.3.1.
m+p VibControl displays the x and y ranges as defined. In the scaling area, you can change
the y- or x-axis scales as desired.

Scaling area
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Auto
The charts are automatically scaled to the ranges defined in the Reference
tab. To rescale the chart, change from Auto to Fixed.
To activate automatic scaling again, check the Auto function of the axis to
scale.

Fixed
You can rescale the axes by entering a range.
To rescale an axis, check the Fixed function with a click of your mouse button.
Enter at from where to fix the start of the axis.
Enter at to where to fix the end of the axis.
To confirm the setting, press the Enter key.
You can shift the axes using the mouse.
To shift an axis, check the Fixed function with a click of your mouse button.
Press the left mouse button and hold.
To shift the y-axis upwards, drag the mouse pointer along the y-axis upwards.
To shift the y-axis downwards, drag the mouse pointer along the y-axis downwards. To end the shifting, release the left mouse button.
The same applies to the x-axis.

Single Autoscale
To autoscale an axis set to Fixed, click the Single Autoscale button.

Grid
You can activate and deactivate horizontal and vertical scaling lines (grid
lines).
To activate scaling lines, check the Grid box of the corresponding axis.
To deactivate scaling lines, leave the Grid box(-es) unchecked.

Grid lines deactivated

68

m+p VibControl Rev. 2.16

m+p international

Scaling

Logarithmic/Linear
You can switch from logarithmic scaling to linear scaling, or vice versa.
To have logarithmic scaling, check the Logarithm. box.
To have linear scaling, leave Logarithm. unchecked.

Logarithmic scaling for x- and y-axes

Logarithmic scaling for the y-axis
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5.1.2

Zoom

You can zoom the y-axis in and out.
Select Fixed from the y-axis scaling bar.
Press and hold the Ctrl key.
To zoom in, press and hold the left mouse button while dragging the y-axis downwards.
To zoom out, press and hold the left mouse button while dragging the y-axis upwards.

Zooming in

The context menu of the Data View provides access to further functions.
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5.1.3

Colors

Each chart element is displayed in an individual color changeable in the Color selection
dialog. Configure the colors as appropriate.

Color configuration

1. Right click on the chart to open the context menu and select the Color configuration
option. (In VibEdit you double-click on the chart to open the Data View window, Then, use
the context menu to chose the Color configuration option).
2. Open the drop-down list and choose the chart component to configure, e.g. the graphics
background as shown in the above figure. The currently used color is displayed in the
Color/Solid field.
You can select from an ample palette of Basic colors or define your own colors (Custom
colors).
3. To select a new basic color, click this color. This color is then displayed at Color|Solid, and
the selected chart component changes its color. Confirm by clicking OK or go on
searching for your favorite color.
4. To define a color different from the basic colors, select a basic color with a click of your left
mouse button. This color is then displayed at Color|Solid.
To configure this color, change its red, green and blue components by moving the little
pointer to the right of the color scale with the left mouse button held down.
Go on configuring this color by defining its hue, saturation and luminosity.
To add this color to Custom colors, click Add to Custom Colors. Colors added to Custom
colors are available in this palette for the current dialog only. If the color selection is closed
and re-opened, Custom colors show the default palette only. To select a newly defined
Custom color, select the component set to this Custom color and re-load it into the Custom colors palette so that it is available for further components.
5. Click OK to confirm the new configuration or click Cancel to keep the former configuration
unchanged.
This dialog also offers a line style selection option. Choose a channel and select a line style for
its representation in the chart.
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Line Style and Line Width Selection

5.1.4

Line Style and Line Width Selection

In order to provide a flexible chart display m+p VibControl offers the option to change the line
style for any trace on your chart. Traces can be shown and printed in one color and different
line styles, enabling a black and white printout for any chart. Of course, you can also select the
line styles in different colors to create clearer chart representations in color prints. For the line
style selection, open the Color selection dialog, select the trace and assign the desired line
style.

Selecting a line style

For an enhanced quality of your printouts, you can adjust the line width of the measurement
traces using a drop-down selection field below the line style selection.
Selecting a line width disables the line style selection.
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5.1.5

Cursors
In VibEdit, the cursor functions only apply to the single chart and can be
opened by a double-click on the desired chart. This opens the Data view
window.

Cursors assist you in checking the signal trace. You can move the cursors along the trace and
read the cursor’s coordinates from the axes or in the cursor summary.
To activate the cursor, press and hold the Shift key and click with the left mouse button into the
trace.
Hold the Shift button and use your mouse to drag the cursors along the trace.
To deactivate the cursor, just drag it off the chart.

Cursor activated

The context menu offers all cursor options.
Open the context menu with a click on your right mouse button.

Context menu with cursor options
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Cursors

The following cursor options are available:
•

Show 1st cursor (shortcut: Shift + left mouse click)

•

Show 2nd cursor (shortcut: Shift + Ctrl + left mouse click)

•

Show horizontal cursor

•

Show cursor summary (this option is enabled automatically as soon as you enable a
cursor. It can be disabled, when desired).

•

Scale x-axis to cursor (zoom-in function)
The section between cursor 1 and cursor 2 is expanded and shown in the new chart.
This function is helpful for large throughput files which are shown using a min-max
decimation filter. Zooming into the chart shows the original data.

Scale to x-axis option used
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5.1.6

Markers and Labels

You can mark and label the traces with numerical and/or text information.

In VibEdit, the cursor functions only apply to the single chart and can be
opened by a double-click on the desired chart.

Text and numerical markers on reference trace

Set a Marker
To set a marker, press and hold the Alt key.
To mark any point on the trace, select it with a click of your left mouse button.
With the left mouse button held down, you can move the marker to any point.
To test this function, set more markers.
You change a marker‘s position by clicking the marker with the left
mouse button and moving it with the mouse button held down.
You change a label position by clicking the label with the left mouse
button and moving it with the mouse button held down.
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Marking breakpoints

Position Markers
You can position markers stating the data of their current position, e.g. mark
the breakpoints defined.
To enter the point‘s exact position, double click its cross. The “Modify label“
dialog is displayed.
By default, the marker‘s label displays the amplitude only. To have a closer
look at the label text, double click the red cross presenting the marker:
“%2 %4“ is displayed.
“%2“ is the command used to display the amplitude value.
“%4“ is the command used to display the amplitude unit.

Define Marker Label
To have the marker labeled with both x- and y- axis numerical data, add the
corresponding commands into the Label text field.
%1 = x-coordinate
%3 = x-unit
%2 = y-coordinate
%4 = y-unit
To have both frequency (or time) and amplitude being displayed together
with their units,
type: “%1 %3, %2 %4“.
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To confirm the setting, click the OK button.
To cancel, click Cancel.

Setting a marker and defining its label text

Now, all markers come with both frequency (or time) and amplitude as the
default setting for the next marker is always the previous one.
To exactly position a marker to - for example - 4g on the reference trace, first
position a marker right into the chart.
To get the exact amplitude at 4g, activate the cursor and drag it to 4g.
Double click the marker. The “Modify label“ dialog is displayed. Copy both the
Y Position and the X Position from the cursor display to the Modify label entry
fields.
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Markers

Text
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Additional Text for Labels
You can add additional text to the chart. You proceed as with the numerical
markers.
Press and hold the Alt key. To provide the label with text information, double
click the marker‘s red cross.
The “Modify label“ dialog is displayed for this marker.
To not delete the numerical information, make sure that the Label text field
states both “%1“ (control command to show the x-coordinate in the label) and
“%2“ (control command to show the y-coordinate).
Add text information into the Label text field.
To confirm the marker, click the OK button.
All next markers come with both frequency (or time) and amplitude and the
text entered as the default setting for the next marker is the same as previous
one.
To delete any unwanted text, double click the marker‘s red cross. The “Modify
label“ dialog is displayed for this marker.
Delete this text from the Label text field.
To confirm the marker, click the OK button.

Hide the marker and present the label only
For example, to position the text at the top left corner of your chart, click this
part of the chart with the Alt key held. A marker is displayed. Release the Alt
key.
To hide this marker and display the label only, drag the label right onto the
marker with the left mouse button held down.
First, the label displays the default data of the previous one, e.g. frequency
(or time) and amplitude. To enter the text, double click the label and overwrite.
To confirm the setting, click the chart background or press .
The next label will contain the same text as the previous one since
the default setting for a label is always the setting of the previous
label. So, you might need to re-define. To report frequency (or time)
and amplitude see above for numerical markers.

Remove a Label
To remove a label, double click the label and press the Remove button of
your keyboard.
To confirm, click the chart background or press .
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Remove a Marker
To remove a marker, double click it and click Remove label in the “Modify
label“ dialog.

Modify label

Standardized Label Format
If you always need the same data label format, you can define this format in the file:
"VcpNT.ini".
Here you‘ll find the following section:
[common]
DefaultLabelFormat=%2 %4
Modify the entry according to your needs.
You can also define the label font size within the VcpNT.ini file. Modify the RulerFontSize line
by entering a negative value which sets the font size in points.
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5.2

VibEdit Chart Display Functions

5.2.1

Single Charts

Double-click one of the reference charts to open it as single chart. The Data View window offers
the general chart display functions for optimum documentation.
For example, to open the Acceleration chart, double-click it in the VibEdit‘s Reference tab.

Defined acceleration trace in full view

5.2.1.1

Copy Single Chart to Clipboard

Copy to clipboard
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Printout of the Single Chart

You can copy any chart to the clipboard from where it can be pasted into any other software
tool (e.g. Microsoft Word). Select Copy to Clipboard from the context menu.
To make full use of your screen, hide the scaling controls using the context menu.
To copy the single chart to clipboard, open the context menu of the chart and select the Copy
to clipboard function. Then, open the desired program (e.g. Microsoft Word) and choose the
Paste function from the context menu or from the Edit menu.

5.2.2

Printout of the Single Chart

Before making a printout of your single chart containing all numerical and text information
added, you can preview this printout.

Preview the Printout

Preview printout in GraphPrint

Select Print preview... from the single chart window‘s context menu. If this preview is alright,
you can directly start the printout by clicking Print. To further edit the printout, select Exit from
the File menu in GraphPrint.

Logo on Printout
Test reports can wear your company‘s logo. The only thing you need is the logo in bmp format.
By default, the m+p international logo is embedded. Of course, this can be replaced or deleted.
Put the logo to “C:\VcpNT\Config\“. Open “C:\VcpNT\Config\TG_Logo.ptf“ in WordPad.
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[Bitmaps]
NumberOfBitmaps=1
[Bitmap001]
File=..\\config\\m+p.bmp
RectLeft=2150
RectRight=2560
RectTop=150
RectBottom=280
Graphic=1
Save “TG_Logo.ptf“ with the change. End Wordpad.
The embedded logo is now active for charts report in VibEdit and VibPostTest.

Printout

Printout

To make a printout of your current chart, select Print graphics from the chart window‘s context
menu.
The print command is sent to your default printer.
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Printout in Color / Black and White

Reference chart in color in GraphPrint print preview

By default, printing is made in color. Printing in black and white requires a modification to the
user‘s configuration setting which is done in the "VcpNT.ini" file. This file can be found in the
user’s configuration folder under “C:\VcpNT\Config\Users\[User Name]\“.
To disable screen colors for print, open “VcpNT.ini“ of this folder and set:
UseScreenColorsForPrint=0.
Save “VcpNT.ini“ with the change and print preview and printout will be done in black and white.
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5.3

VibRunner Chart Display Functions

Online chart

With the online chart, you can directly monitor the test run online. There are several VibRunnerspecific chart display functions to support your control job:
•

Online chart configuration (scaling, cursors, etc.)

•

Online chart as a client window

•

Multiple channel selection

•

Import of a result data graph

•

Time domain view

•

Multiple charts and monitors

•

Mathematical functions

•

Freeze the online signal

•

Online charts layout format storage

We recommend going through these functions step by step. In the next chapters, these
functions are described. If your test has been completed before having gone through all these
functions, please start the test again and try them out!
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5.3.1

Online Chart Scaling and Settings

For accessing the online chart scaling functions and settings, open the chart context menu and
choose the Axis configuration function.
Scaling in online charts (VibRunner program part) is similar to scaling in reference charts
(VibEdit). So please refer to chapters 5.1.1 “Scaling”, page 67, 5.1.2 “Zoom”, page 70, 5.1.3
“Colors”, page 71 and 5.1.5 “Cursors”, page 73 for the scaling functions description.
In this chapter we describe the Settings and the Apply to... sections of the Axis configuration
window. It can be accessed via the context menu of a VibRunner chart.

Settings

In the Settings section of the axis configuration dialog you can define which
limit lines shall be shown in the charts (e. g. alarm limits, abort limits), and
whether the reference signal shall be displayed or not.
You also find several cursor functions, such as:
Show first cursor,
Show second cursor
Show horizontal cursor
Couple cursors
Furthermore, test mode specific functions are available:
Show all filter modes,
Show frequency,
Cursor follows frequency.

Apply to...

In the Apply to ... section you can define the charts to which all the above settings shall apply.
Enable ... this chart to apply the settings to the active chart only.
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Enable ... all charts of the same unit to apply the settings to all charts with the
same x-axis unit.
Enable ... specified charts to apply the settings to certain charts you define
by entering their number into the active field. Separate numbers using a
comma or a semicolon, or define a range, e.g. "6-14". Use an asterisk to
apply the settings to all charts.
(The charts are numbered row by row from the left to the right.)
Click Apply to preview. To confirm, click OK. To keep the display as it was,
click Cancel.

5.3.2

Online Chart as a Client Window

Online client window

m+p VibControl allows the user to branch off an online chart as a slave window.
You activate this function by clicking with the right mouse button into the online chart and
choosing the Open as client window... function.
This window is now sizeable, re-scalable, features independent cursors, and allows for copy
and paste. More importantly, by using third party software, it can be shared with remote network PCs for live analysis during test, without active interaction with the test.
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5.3.3

Multiple Channel Selection

By default, one online chart is displayed. However, you can open more charts and have multiple charts displayed online and in parallel.
With accelerometers, you have up to 16 channel responses displayed online in one chart. In
total, you can open up to 16 charts resulting in up to 256 channel responses from accelerometers displayed online.

Channel Selection via the Add Channels Window

VibRunner window with Add Channels dialog opened

Double-click on the chart for which you want to select channels.
The Add Channels dialog will open.

Add Channels dialog in Random test mode

The Master Channel selection field offers all channels you defined in VibEdit‘s Channels tab.
Select a channel and its axis and define its data format in the Data Format selection field.
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Then, select a reference channel and its axis.
If you want to display a Secondary Channel, select the channel with a check mark.
Up to three secondary channels can be displayed on the online chart.
X-Axis Data Type field: You can select a data types. According to the test type selected there
are different data types available. In Random mode you can choose between time domain, frequency domain, RMS over time and Probability Density Function.
Y-Axis Data Type field: You can select the data type for the y-axis. In Random test mode this
type is preset to Amplitude.

Channel Selection via the Chart’s Context Menu
Alternatively, you can choose channels using the Signal selection function of the chart’s context menu. Open the context menu with a right mouse click on the chart.

Select a signal

Choose Signal selection, then move to the next column and mark the signal to be displayed.
(The menu’s listing shows the input channel setup in VibEdit’s Channels tab.)
The channel‘s data format can be chosen in the first block of the chart’s context menu
(e.g. PSD, Frequency).
As soon as you release the mouse button the selected channel will be displayed.
If you want to display further channels on the chart, you can select these channels by choosing
Signal selection and More channels in the next menu block. The function offers a list of available channels. Up to three further channels can be displayed.

Signal Types
These are the signal types available:

Control signal
For a control channel, you can hide or show the reference, and the alarm and
abort limits. By default these spectra are shown. To hide, click the background of your online display with your right mouse button. The chart’s context menu is opened. Select Signal selection and drag the mouse pointer to
the spectra to be hidden.
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In SoR and SoRoR, only the random spectrum will be displayed. There will
be no sine tones overlaid.
Warn limits:
Abort limits:
Reference signal:

Alarm limits of control channel.
Abort limits of control channel.
Reference spectrum/pulse of control channel.

Level scaled:
(available in random and classical shock only)
Scale the reference and the alarm and abort limits to the actual level.
Please refer to chapter 6.1.8.7, page 142 for more information.

Error signal:
Error.

Drive signal:
Drive.
In SoR and SoRoR, the drive spectrum displays the random test mode only.

Sine tones:
(available in SoR and SoRoR only)
Sine amplitudes (acceleration versus frequency).

"No"/ "Name"
Response of a defined channel.
In SoR and SoRoR, the measurement channels show the power spectral density calculated
from the combined signal of sine and random.
If you want to mark the maximum and/or the minimum of the online chart, press Ctrl + M to
make the cursor jump to the maximum and Ctrl + N to jump to the minimum.
The online chart may contain up to 16 graphs. m+p VibControl displays all y-values for the current cursor position. These y-values have the color of the corresponding graph and are shown
at the bottom of the chart if the Cursor legend function has been activated in the chart’s context
menu.

Display Multiple Y-Values and RMS Values
The online window shows up to 16 charts at a time. In order to call these charts click with the
right mouse button into the window. The context menu appears.
Choose Signal selection and More channels. (see chapter "Channel Selection" above.
In the top right corner of the online chart you will find the RMS button.
If you click this button the following menu appears:
RMS values of all channels
RMS values left
RMS values vertical
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You activate these functions with a mouse click and deactivate them with a second mouse
click.
In the online charts, which contain several traces, m+p VibControl indicates all y-values corresponding to an x-value. The y-values are of the same color as the trace and are shown in a line
at the bottom of the window.
If you want to return to the simple RMS legend, select the Simple RMS Legend function in the
Options menu.

RMS Legend

RMS legend for several graphs

5.3.4

Import of Result Data Graph into the Online Chart

m+p VibControl enables you to compare the current measurement with old measurements you
stored in VibPostTest.
Open the VibPostTest result file you want to copy. Select the Copy Data function of the Edit
menu.
Then open the VibRunner, and click with the right mouse button into the chart. The context
menu opens. Choose Compare Signal and Paste data from clipboard. The signal will be copied
into the chart.
With the context menu function Edit channel name, it is possible to rename the imported trace.
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Time Domain View

Imported result data graph in the online chart

In VibPostTest a similar function exists which enables you to copy data from one VibPostTest
chart into another.

5.3.5

Time Domain View

In Sine and Random test modes you can choose between a time domain view and a frequency
domain view.
For further information please refer to chapter 6.1.8.11 “Frequency Domain View and Time
Domain View”, page 145 and page 204.

5.3.6

Multiple Charts and Monitors

To have multiple signals and/or channels being displayed online, open more charts.
To open ONE more chart, click the

button from the upper icon bar once.

To close a chart, click its background with your right mouse button. Select Close window from
the chart’s context menu.
If you want to open more charts without losing time, click the small arrow symbol right next to
the Chart button to open a drop-down list from which you can directly select the desired number
of charts (e.g. 16, see below).
It is possible to open up to 16 charts showing a maximum of 16 traces each. Therefore,
operators of multi-channel m+p VibControl systems have all necessary information available
at a glance. If you need even more overview, it is recommended to switch to a multi-monitor
system (see chapter 5.3.6.2, page 94).
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16 charts

Application example: The display of many channels in one chart is helpful when crosstalk
channels of several triaxial accelerometers are to be compared with the drive signal.

Crosstalk channels of several triaxial accelerometers compared with the drive signal
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5.3.6.1

Several Channel Responses in One Online Chart

VibRunner, sine, three channel responses in one online chart

With accelerometers, have up to 16 channel responses displayed online in one VibRunner
chart. In total, you can open up to 16 charts; thus you can view a high number of channel
responses online.
To open the chart’s context menu, click the chart background with your right mouse button.
Select Signal selection, More channels and the channel to include in the online chart. Those
channels displayed are checked.
(To delete a channel from the display, select Signal selection, More channels and the channel
to delete from the chart. Those channels not displayed are unchecked).
Read from the bottom legend which channel is displayed in which color.

5.3.6.2

Multi-Monitor Function

You can also connect additional monitors (up to 4) in order to increase the number of monitored
channels in high channel count systems. These monitors can be connected either to the host
PC (depending on the number of physical interfaces of your graphics adapter) or to any remote
PC within the corporate LAN (e.g. in case you prefer to monitor test runs outside the test lab).
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Multi-Monitor Transducer Check
Especially for systems with high channel counts it makes sense to check the transducer function and their wiring before you start your test. Monitoring every individual channel is done in
multi-monitor mode. Choose the transient capture mode, where the software displays any
vibration signal it receives. By tapping every transducer you check whether a signal is transmitted or not. When all transducers and their connections are fully operational you can start
your test.

5.3.6.3

Parallel Use of Multiple VibRunner Windows (Slave Mode)

You can open and work with multiple VibRunner windows in parallel (slave mode).
In order to optimize the screen arrangement for multiple charts, click the
button.
This will remove the left part of the standard screen layout to get more space for the charts.

5.3.7

Mathematical Functions

In the random, sine and classical shock test modes, the context menu of the chart also offers
the Math funcs... option. It enables you to integrate or differentiate the signal and thus to convert it into other parameters which then will be displayed online.
For example: If you used an accelerometer and you want to calculate and display the velocity
and the displacement, then select the corresponding chart and choose 1 x Integr within the
Maths funcs... menu to display the velocity, and choose 2 x Integr to display the displacement.
For further information please refer to the corresponding test mode chapters 6.1.8.6 “Displacement and Velocity Selectable for the Online Display”, page 141 and page 202.

5.3.8

Freeze the Online Signal

You can freeze the online signal. Even if the display is frozen, the control continues!
To freeze the online signal, click

from the upper icon bar.

To make the VibRunner pick up the online signal again, click
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5.3.9

Storing the Online Chart Layout Format

Storing the online chart layout format

The m+p VibControl online chart display functions are very user-friendly.
m+p VibControl stores a customized online chart layout format for re-use later or for use as
default layout format.
Some parameters of this format are defined using the chart’s context menu. Open it with a click
of the right mouse button into the background of the chart.

Chart context menu: online chart functions
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In VibRunner you can define and save online layouts for every test mode. The layout includes:
•

Number of charts (max. 16 charts)

•

Number of channels displayed in one chart

•

Display of reference signal, alarm limits, abort limits and notch limits in a chart

•

Scaling information (x, y, automatic scaling, fixed scaling, grid lines
linear/logarithmic scaling,)

•

Color settings

•

Cursor legend enabled or disabled

•

Beep at test end enabled or disabled

•

Automatic incrementation of identical result files names

•

Automatic saving when you leave the program

The chart layout saving option provides the identical representation of a test or a series of similar tests.
Every user can define a default layout for each test mode, so that all executed tests are shown
with the appropriate online representation and all information needed. All configurations will be
saved under "Filename.cfg" Each test mode has a default configuration with the name
"Default_test mode.cfg", which can be found in the folder: "VcpNT\Config\Users\Username"
Whenever a test mode is loaded, the software configures the layout corresponding to the layout
configuration for this test mode.

When a new user account is set up, only default configurations are
installed. The user has to define their own user configurations or may copy
them from other users.

These configuration files are saved for each user separately in the folder
"VcpNT\Config\Users\Username"
If a user wants to modify the default settings, he adapts the chart settings according to his
needs and saves the settings using the Save settings as default option of the File menu.
The Load settings function enables the user to load another configuration file with different
chart layout settings.
The Save settings as function enables the user to save chart layout settings with a new name.
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VibPosttest Chart Functions

5.4

VibPosttest Chart Functions

m+p VibControl offers a large variety of display options in VibPosttest. Thus, you can display
signals together with compare signals, show/hide the legend, mark peaks and display peak values and overall RMS values, as well as labels and comments. You can show history, and display magnitude, phase and coherence, etc.

Posttest options screenshot

The VibPosttest chart functions are described in the VibPosttest chapter 8.4 “Chart Display
Options”, page 490.
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6

Define and Run Vibration Tests

6.1

Random Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: define the test run profile/s

•

Specimen: enter the properties of the shaker and the specimen

•

Schedule: define the selfcheck properties and the test schedule

•

Channels: define the channel properties

6.1.1

Define the Reference for the Random Test Mode (VibEdit)

Reference random spectrum defined

m+p international

m+p VibControl Rev. 2.16

99

Define the Reference for the Random Test Mode (VibEdit)

6.1.1.1

Define the Parameters for the Random Test Mode

General Random Test Mode Parameters

General random parameters

Frequency Range
Select the frequency range for the test in [Hz].
Frequency ranges, which are not supported by the hardware in use,
are marked by a gray background. You can select these frequency
ranges for defining a test with another (not connected) front-end.
This test definition can be saved, but needs the required hardware
to start.

Number of Lines
Select the number of lines.

Frequency Resolution
m+p VibControl calculates the frequency resolution in [Hz].
frequency range
frequency resolution = ------------------------------------------number of lines

Sigma Clipping
Select the sigma clipping (a multiple of the sigma RMS value). Detect from
the bottom RMS display what would be the maximum values resulting from a
“3“ sigma clipping.

Display with RMS Sigma and 3*Sigma values
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Kurtosis
Structural life testing applications can be significantly accelerated using
kurtosis control.
Usually, structural life testing is executed with random excitation - it seeks to
achieve a Gaussian distribution which is concentrated about mean and
shows a low probability of extreme values. These conditions generate peak
accelerations which are often too low for simulating natural strain. Kurtosis,
however, offers a third "dimension" to control the excitation as it allows the
adjustment of the probability density function (PDF). Increasing the kurtosis
means increasing the peak levels in a defined way. Therefore, the damageproducing area of the test can be adjusted independently of the PSD and the
RMS settings of the test.

Kurtosis

Select a Kurtosis value to increase peak levels in a defined way. Enabling the
kurtosis function disables sigma clipping.
The following screenshot shows the probability functions for a Kurtosis setting 3 (Gaussian distribution) and a Kurtosis setting 5.

Probability function for kurtosis setting 3 and kurtosis setting 5
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6.1.1.2

Define Profiles (PSD)

In random mode it is possible to define several excitation profiles which can be run in sequence
without any delay. This feature is also called “Mission Profiles“. In the Schedule tab you define
in which order the profiles will run.

Defining several excitation profiles (PSDs)

Define the Power Spectral Density (PSD)

Reference spectrum definition table

You define a power spectral density (PSD) in [g²/Hz] or [EU²/Hz] as a function of frequency. A
segment, i.e. the band between two consecutive frequencies, is defined by levels and/or
slopes. You have to enter a level at least for one frequency to enable a clear mathematical
definition.
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EU (Engineering Unit) is the unit of the corresponding reference (e.g. inch
for displacement or [m/s²] for acceleration). To activate the spectrum definition table, click the No. row.

Let m+p VibControl calculate an unknown level of power spectral density (PSD) at a particular
frequency from the preceding and following slopes and levels.

VibEdit, random test setup, level at 500 Hz calculated

Enter the frequency for which the level is to be calculated (“500“ in below figure). If this is the
last frequency of the spectrum, enter a level = 0 and let the slope undefined, i.e. enter “9999“
(“Slope“ is then displayed). Press the Enter key. The level is calculated.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field.
To activate an empty row, double click this row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.
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Frequency/Acceleration/Slope
Type the reference spectrum frequencies and amplitudes (power spectral
density (PSD) in [g²/Hz] or [EU²/Hz] as a function of frequency) together with
the slope valid until the next frequency is reached.
To change the acceleration unit, use the Units selection field.

f

2
Slope in dB/Oct: y 2 = y 1  ----f

Slope
-----------------------------10 log 10 (2)

1

y2, f2 = calculated level at frequency 2
y1, f1 = reference level at frequency 1
0 dB/Oct = no slope
9999 = constant slope (“Slope“)

A segment, i.e. the band between two consecutive frequencies, is defined by
level and/or slope. You have to enter a level or slope at least for one frequency to enable a clear mathematical definition.
If the last breakpoint has a slope (NOT showing “Slope“), the reference will
continue to the end of the frequency range.
Linear PSD Slopes Between Frequency Points
Railway standard IEC 61373 and other standards require random tests with
linear PSD slopes between the frequency points for testing items of equipment. These spectra can be defined in the Reference section.
Enter frequency and acceleration, then select the slope and choose the unit
[db/Hz] or [EU/Hz].

Railway standard IEC 61373 - linear PSD slopes between frequency points
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Alarm/Abort
Type the lower and upper alarm and abort limits.
To set the same lower or upper alarm or abort limit for multiple lines, click the
first line to set with your left mouse button, press and hold the Shift key. Click
the last line to set with your left mouse button. Due to the Shift key being held,
now all lines in between are selected. Select the field of the limit to set with a
click of your left mouse button. Release the Shift key and type in the lower or
upper alarm or abort limit.
Press to globally set all lines selected to this lower or upper alarm or abort
limit.
You can enter a level from which each line will be checked for an exceeding
of alarm and abort limits.
If during the test run an alarm limit is exceeded, the test log will state a message and the “W“ lamp of the corresponding channel will light up in the
VibRunner‘s WANO field.
If during the test run an abort limit is reached, the test will change to standby
mode and the “A“ lamp of the corresponding channel will light up in the
VibRunner‘s WANO field.

6.1.1.3

Import of ASCII Reference Spectrum in Random Control

m+p VibControl offers a function to import a recorded reference spectrum into VibEdit in order
to use them as a test definition for a random test run.
The data of the reference spectrum can be imported as an ASCII-file which is created by
inserting the data into a Microsoft Excel table and saving them as an ASCII-file (e.g. a .txt file).

Please make sure, that all decimal values are written with a point or a
comma according to the parameter definition of your PC, because they
can only be imported in this notation.

The following table shows the frequency values in the first row and the amplitude values in the
second row.
The amount of data which can be imported is restricted to 3200 lines. You define the number
of lines in the Number of Lines selection field (see page 100).
Frequency
4
8
12
16
20
24
28
32
36
40
44

Amplitude
0.000203656
1.50E-05
4.15E-05
0.000273324
0.000492902
0.000430695
0.000393226
0.000548226
0.0005726
0.000667165
0.000699403
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48
52
56
60

0.000739477
0.00067242
0.000696962
0.0011492

Example of a file that can be imported

You import these data via the Import button of the VibEdit window:

Import of a reference spectrum

Select the file that you want to import and click the Open button.
The reference spectrum will be copied into VibEdit and will be shown in the chart.

6.1.1.4

Define Advanced Random Test Mode Parameters

To set advanced random parameters, click the

button.

Advanced random parameters
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If you only have DOF (Degrees of Freedom) available, you can enter the value into the DOF
Calculator which can be accessed on our Website. The calculator will provide the possible
combinations of K and N values.

Averages per loop K
Type the number of averages used for one control loop.

Average weighting factor N
The linear averaging is followed by an exponential weighting.
The “N“ weighting factor defines how sensitive the controller is to react to a
change of the actual value.
Type an integral value “N > 1“.
The integral value “N > 1“ appears in the following form:
Sa+1 =

(Se - Sa) · 1/N + Sa

Sa+1 =

value used for next control loop

Sa

=

value used for last control loop

Se

=

value resulting from current linear averaging

N

=

weighting factor of exponential averaging

The exponential weighting factor influences the behavior of the controller. For
small “N“, the controller reacts faster than for large “N“.

DOF = 2K*(2N-1)
The degrees of freedom DOF are calculated from “Averages per loop“ and
“Averaging weighting factor“. The term “DOF“ is from statistics and indicates
the number of independent variables (measurements) used to calculate the
final results. The higher the degrees of freedom there are the larger the number of measurements taken. DOF are calculated as follows:
DOF for C and W channels: DOF = 2 · K · (2 · N - 1)
DOF in spectrum ("Average" control): DOF = n · [2 · K · (2 · N - 1)]
where K = number of averages/control loop
N = averaging weighting factor
n = number of control channels

Please note that the DOF value for individual M-channels is calculated from
the number of averages defined in the Channels tab.
DOF for M-channels:

DOF = 2 · KM

where KM = number of averages defined in the Channels tab.

Line-by-line check start level
Enter a level from which each line will be checked for an exceeding of alarm
and abort limits.
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If the current level of a testing schedule is at or above this start level,
the following inputs are valid:
- upper and lower frequency limits (see next two entries)
- number of lines tolerated out of abort and alarm limits
(see 3rd and 4th entries ahead).

Take limits from reference
When you activate this function, the fmin and fmax values from the spectrum
are automatically transferred to the advanced parameters line-by-line check
section as lower/upper frequency limits.

Lower frequency limit/Upper frequency limit
Enter a minimum and maximum frequency of the reference spectrum, but
take into account that the frequency limit range must not exceed the frequency range defined in the reference spectrum definition table.

No. of lines tolerated out of abort limit
This parameter defines the number of frequency lines that may be violated
until the test is aborted. Enter the number of lines tolerated out of abort limits
in [%] or [lines] relative to the number of lines in the defined frequency range.
If the defined number of lines is exceeded, the test will abort. The frequency
of the line that triggered the abort will be logged into the test log. m+p
VibControl checks for such exceeding of abort limits only after the measurement value of the control channel has exceeded the value entered under
Line-by-line check start level (see above).
This function enables you to test specimens whose sharp resonances would
normally abort the test.

Be aware that you weaken the criteria for a test abort when you use
this function. As you tolerate exceedings of the abort limits, this
function may cause damage to the specimen.

Example:
Reference spectrum: 10-3200 Hz
Abort limits: 3 dB for the complete spectrum
Lines: 400
 Resolution: 8 Hz
Lower frequency limit: 160 Hz
Upper frequency limit: 400 Hz
 30 lines (100%) lie in this frequency range
Number of lines tolerated out of abort limits: 10% or 3 lines.
The test will be aborted if 4 lines exceed the abort limit of  3 dB.
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No. of lines tolerated out of alarm limit
Enter the number of lines tolerated out of alarm limits in [%] or [lines] relative
to the number of lines in the defined frequency range (see last item above).
When an alarm limit is exceeded, it is entered in the test log.

Lower alarm limit (RMS)/Upper alarm limit (RMS)
Enter the alarm limits relative to the RMS value of the control spectrum in
[dB]. The RMS value of the control spectrum is displayed in the field of the
feasibility check.

Overall RMS abort
Enter the abort limit relative to the RMS value of the control spectrum in [dB].
The RMS value of the control spectrum is displayed in the field of the feasibility check.
To confirm the settings, click the OK button.
To cancel the changes, click the Cancel button.

6.1.1.5

Rescale a Spectrum

You can time-efficiently rescale, i.e. dampen or amplify, the complete spectrum (all values
defined). It is also possible to rescale the spectrum to a target gRMS value.
To open the Rescale dialog, click the

button.

Select the rescaling unit [g] or [dB].

Rescaling dialog

•

Select the unit [g] if you want to rescale the spectrum to a target gRMS value. Enter the target value.

•

Select the unit [dB] if you want to dampen or amplify the spectrum and enter a factor:
To dampen the spectrum, enter a negative factor (negative sign).
To amplify the spectrum, enter a positive factor (no sign).



To dampen the spectrum by a factor of 0.5, type “-3“ [dB].
To amplify the spectrum by a factor of 2, type “3“ [dB].
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6.1.1.6

Select the Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All numerical and graphical reference data will be converted automatically.

6.1.1.7

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.

File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.

6.1.1.8

Feasibility Check (Shaker)

Display of shaker load
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The test defined is constantly checked against the shaker limits defined in VibShakerDef. The
necessary force is calculated using an SDOF model.
Frms = m  ( arms² + 2  c/m  vrms² + (c/m)²  drms² )½
m

=

c
arms

=
=

total load moved (shaker system mass + armature mass
+ specimen mass · number)
axial stiffness of the shaker
effective acceleration value, calculated from the spectrum

vrms

=

effective velocity value, calculated from the spectrum

drms

=

effective displacement value, calculated from the spectrum

with Lehr's damping factor  = d/dc = 1
with:

d = damping factor
dc = critical damping factor
= 2 · (c · m)

The RMS values of acceleration, velocity and displacement are calculated for the defined spectrum. When changing the unit of acceleration, velocity or displacement, m+p VibControl will
automatically convert the values. In addition, the maximum values for a 3*Sigma limitation will
be given. The sigma value to which the signal output to the shaker will be limited is set in the
Sigma Clipping field. Check at the bottom shaker load display whether the defined parameters
may exceed the shaker limits. The estimated shaker load is given not only in numerical but also
in graphical data (color of signal lamps):
Color

Shaker load

Red
Yellow
Green

 100% (shaker limits exceeded)
 90% < 100%
<90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
100%. The program does not block the Start button!
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6.1.2

Load the Shaker and Define the Specimen in
Random Test Mode

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.
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6.1.2.1

Shaker

Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
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To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.

General Shaker Settings

General shaker settings in random

Mass Unit Selection
Select the desired mass unit [lbs] or [kg]. When you change the mass unit,
the values will be converted accordingly.

Moving Coil Mass
The moving coil mass entered in VibShakerDef is displayed.

Total Weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial Stiffness
The axial stiffness entered in VibShakerDef is displayed.

Maximum Input Voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input Voltage Limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in VibShakerDef by setting an input voltage limit for the power
amplifier.

Max voltage 1st drive (RMS)
This function provides a drive limitation for random test modes.
The max. voltage 1st drive (RMS) value has the same function as the Input
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Voltage Limit but applies to random and mixed mode tests. It has to be set
as RMS value.
After selfcheck the system calculates the probable RMS value for the first
drive signal. If this value is above the entered maximum RMS value, a test
start will be rejected.
The input voltage of the power amplifier corresponds to the output voltage of
the source module. If the admissible voltage is exceeded, the test will be
aborted.
Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

6.1.2.2

Define the Specimen

Define the specimen

Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.

6.1.2.3

Define a Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.
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Weight:

6.1.2.4

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.

6.1.2.5

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in the VibShakerDef.
The necessary force is calculated using an SDOF model.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of
signal lamps):
Color

Shaker load

Red
Yellow
Green

 100% (shaker limits exceeded)
90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%. The program does not block the Start button!
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6.1.3

Define the Schedule for the Random Test Mode

Random testing schedule

With the testing schedule, you define the sequence and the duration of the test levels, and
when to take a measurement.

External shutdown time
Enter the time in [ms] to ramp down the drive signal in case of an emergency
shutdown. This function requires an Emergency OFF switch being connected
to the bridged output channels of the front-end in use. For further information
on the emergency shutdown, please refer to chapter 2.9 “External Shutdown”, page 14.

Rampdown rate
Enter the Rampdown rate in [dB/s].
The rampdown rate is the slope used for ramping down to the abort level in
case of test end or abort.

Ground level
Enter the ground level in [dB].
The controller ramps down from the current level to the ground level at the
defined rampdown rate and then shuts down.
The controller will ramp down to the ground level
- if the test ends regularly,
- if you abort the test,
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- if a channel is open or
- if the abort limit is exceeded.
This function protects the shaker from being overloaded.

Start measurement every ...
Enable this function to start a scheduled measurement. The test runs will be
repeated in regular intervals. Enter the interval time in [hh:mm:ss].

Selfcheck
Selfcheck is useful for verifying the test definition and the channel setup as
well as for recording a first structural response of the specimen. The standard
selfcheck is done with a fixed output level. For more information on the selfcheck function, please refer to chapter 3.3.7 “Selfcheck”, page 44.

Selfcheck mode
- Fixed Level:
Standard selfcheck is done using a fixed output level. This level is defined
in the Selfcheck level (100 mV) field.
You can manually define an attenuation shape using the >> button. For
further information please refer to the Selfcheck Attenuation paragraph on
page 119.

Selfcheck - fixed level settings

- Limiter Mode:
In Limiter mode, selfcheck is done using variable output levels. Starting with
a low level that is defined in the Min. selfcheck level (100 mV) field, the selfcheck will gradually increase to the value specified in the Max. selfcheck
level (100 mV) field. In order to achieve a good signal-to-noise ratio while
avoiding a too high load on the specimen, the response is limited to a reasonable value. Any spectral lines which are too close to the reference spectrum or notch limits are automatically reduced to a safe value.

Selfcheck - Limiter mode settings
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Selfcheck level (100mV)
Enter a lowering of the drive signal for the selfcheck in [dB] referred to 0.1
Vrms. The selfcheck level [dB] = 20 log (Vrms/100 mVrms )
0 dB = 0.1 Vrms in selfcheck. Lowerings of  0 dB are allowed.
You determine the selection of the selfcheck level through experience and
engineering judgement. Be aware that a very low selfcheck level may result
in very small signals which do not lie above the system background noise.
For applications such as servo-hydraulic exciters where selfcheck levels of
0.1 Vrms do not cause accelerometer response to run a test, selfcheck levels
of > 0 dB are also accepted by m+p VibControl for Sine, Random and RoadLoad modes. A maximum level of 0.5 Vrms should be sufficient for selfcheck
with such applications.

Selfcheck gain level limit
The selfcheck gain level limit states by what tolerance the system gain
measured during the selfcheck is allowed to deviate from the system gain
defined in the Channels tab.

Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line.

Selfcheck attenuation defined

Throughput section
The Throughput section in the Schedule tab offers several options for
throughput start and stop settings.
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Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.

6.1.3.1

Define the Commands

Command table

Command table using several excitation profiles (“Mission Profiles“)

In the Command table you define which control command to perform at which level and for how
long. The commands will be performed chronologically as listed.
To copy, delete or paste a command line, mark it and use the common Cut-Copy-Paste functions via context menu or shortcut.
The following commands are available:
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Level
Define the level in [dB] and [h min sec] relative to the reference level.
You define how long the controller remains on a level. You can enter negative
values and "0".
The 0 dB level is the maximum level; it corresponds to the reference level
specified in the Reference tab.

Hold
Define the hold level in [dB] and [h min sec] relative to the reference level.
You can hold the structure on a defined level until you manually release the
fixed level in VibRunner. Afterwards, the next command defined in this table
is executed.

Measurement
Start a measurement at any level and save this measurement.
After the test, you can analyze the measurements in VibPostTest.
It is recommended to enter a short delay before starting the measurement at
the test level. In this way, you can be sure that the measurement is not taken
at two different levels.

 Level -9 dB
Level -6 dB
Measurement
Level -6 dB
Level -3 dB
Measurement
Level -3 dB

3 min
0 min

0 sec
2 sec

5 min
0 min

0 sec
2 sec

5 min

0 sec

The controller remains at -9 dB for 3 min. Then it moves to -6 dB where a
measurement starts after 2 sec. The controller remains at this level for 5 min.
Afterwards, it advances to -3 dB where the measurement starts again after
2 sec., etc.
At the end of the test, all data will be saved automatically.

Marker, Repeat
Define a loop that executes the same commands several times.
You can enter any number of loops in the testing schedule.
Start the loop with Marker and finish it with Repeat.
At Repeat, enter an integer to define how often the loop is to be repeated.

Standby
Enter the Standby (timed pause) in [s].
You can define a time interval during which the test will remain in standby
before continuing automatically.
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Profile
Select the excitation profile you want to run. The profile consists of a completely defined PSD. The profiles, also called “Mission Profiles“, can be run
one after the other without any delay.

Start Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput start using this command.

Stop Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput stop using this command.

Disable Control
Using this command you can disable the control strategy of the test and set
it to open loop mode.
This option should be used very carefully, because it is not possible to return
to closed loop mode.
To change to open loop mode, it is preferable to use the VibRunner
control buttons, because this offers the option to return to closed
loop by another click on the Open Loop button.
But this way also should be used very carefully!

Total Test Time
Below the command window, VibEdit displays the total test time for the test you are editing,
giving you a good overview of the expected test duration.

6.1.4

Define the Channels for the Random Test Mode

For the random channels definition change to the Channels tab.

Channels tab for a random test mode
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6.1.4.1

Select the Control Strategy

Average
The average value of all control channels serves as reference. In random test
mode the control signals can be weighted differently, so that averaged
control signal can be adapted to the test situation.

Maximum
The maximum of all control channels serves as reference.

Minimum
The minimum of all control channels serves as reference.
The "Minimum" control strategy may cause an overloading of the
specimen. If the control channel exceeds the abort limit, the test will
stop and change to standby mode. Select this control strategy only
for control and limiting channels CW having an upper and lower
abort limit (Tolerance mode).

6.1.4.2

EU Control Channel

Control channels can be defined for accelerometers only. Select a unit of acceleration
The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.

6.1.4.3

Import Notch Table

Importing a notch table is useful for systems with high channel counts. In Sine and Random
test modes, you define an ASCII file containing the optimum notch limits for each channel and
import it every time you need them. You can import this file even if you don’t work with the maximum channel count as notch limits for channels not in use are skipped.
First define the ASCII file containing the desired notch limits. Then click the
button and select the corresponding file. Click Open to start the file
import.

m+p international

m+p VibControl Rev. 2.16

123

Define the Channels for the Random Test Mode

6.1.4.4

Transducer Database

The TRANS button leads you to the Transducer database list.

Transducers’ list

m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.

6.1.4.5

TEDS Support

Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to
IEEE 1451.4. This feature is useful for high-channel count vibration control systems and for
applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of
the sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, as well as by VXI Technology's
digitizer module VT1435/1436.
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6.1.4.6

Low-Pass Filter Option with m+p Hardware

For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled.
Filtering is available for sine, random, sine dwell, sine reduction, random reduction test types.
The filter is a fourth order butterworth low-pass filter.
If the filter option is available the desired cutoff frequency can be entered.
The same filter settings are used for all input channels.
The filter frequency cannot be set lower than the maximum frequency of the reference
spectrum.
Filtering may be useful, if interfering signals above a specific frequency should be attenuated.

6.1.4.7

Channel Parameter Definition Table

Channel parameter definition for the Random Getting Started file

No.
The number of channels depends on your software license.
In sine and random modes, all channels can be used as control
channels. For Average control strategy these channels can be
weighted.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input
modules, take the slot number into account.
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Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel

W

= watchdog (= limiting) channel

M

= measurement channel (not suitable for monitoring;
if you want to connect this function with a measurement channel,
the measurement channel must be set up as WM channel.
In any case, the measurement channel is stored when
measurements are triggered automatically or manually).

CW

= control and watchdog channel

CM

= control and measurement channel

WM

= watchdog and measurement channel

CWM

= control, watchdog and measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.

Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its Unit [EU].
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
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With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditionning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crest
factor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".

Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.
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Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer
positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
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The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

Weighting
For the Average control strategy, the average signal of all control channels is
used. The weighting function enables a single channel to participate more by
including it several times while others are only included once. Thus, difficult
test situations can be controlled in an effective way.
For Example:
Channel 01

Weighting = 2

Channel 02

Weighting = 1

Channel 01 will be responsible for 66.66% of the averaged control signal
while channel 02 will be responsible for only 33.33%.

Averages
Enter the number of averages. These linear averages (KM) are only used with
measurement channels for the calculation of the degrees of freedom (DOF).
DOF for M channels: DOF = 2 * KM
where KM = number of averages defined in the Channels tab
The averages entered here are not related to the logarithmic averages used
for the test run control.
This quite often used to generate a linear averaged measurement at the end
of the test.

Av mode
For watchdog channels in random test mode.
Select the Watchdog mode (Notch, Tolerance, Notch/Tolerance, Monitor) or
a notching mode (VectorAdd, Vector RSS, MNotch).
Notch:
In Notch mode, the excitation is limited in a defined frequency range (bandwidth) such that the defined level will not be exceeded. With Notch selected,
the notch spectrum of the selected channel can be defined in the bottom
notch table.
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As long as a notch channel does not exceed the defined level, m+p
VibControl uses the test spectrum. If the specimen is overloaded at the
defined measuring point (= notch channel), the notch channel presenting the
highest exceeding of the notch level will be used as reference. Where the
frequency range is exceeded, the notch channel becomes the only control
channel. Notching changes the test spectrum.

Notching is always a limitation of the upper level, not of the lower
one. There are no abort limits (RMS). If you want to check the abort
limits (RMS), select Notch/Tolerance mode.

If you use a pure watchdog channel in the Notch mode, the lower
level is not limited. Therefore, the controller will not abort the test if,
for instance, the transducer is defective or the cable is parted.

Tolerance:
The watchdog channel is checked for its upper and lower abort limits (RMS).
If the tolerance is exceeded, the test will abort.
Notch/Tolerance:
This function combines notching and checking of upper and lower abort limits
(RMS), ensuring that the controller will abort the test if it acquires no signal
that lies above the background noise (e.g. when the transducer is defective
or the cable is parted).
With Notch/Tolerance selected, the notch spectrum of the selected channel
can be defined in the bottom notch table.
Monitor:
The watchdog channel is exponentially averaged but the test will not be
aborted when overload conditions (e.g. due to DC offsets, or out of band
energy) occur. (This feature only applies for Random excitation.)
VectorAdd:
Select VectorAdd to enable the Summed Force notching mode, Then, define
the notching parameters in the lower part of the window.
Vector RSS:
Select VectorRSS to enable the Vector RSS notching mode Then, define the
notching parameters in the lower part of the window.
MNotch:
Select MNotch to enable the Moment Notching mode. Then, define the
notching parameters in the lower part of the window.

Abort

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.
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Enter the lower (Low) and upper (High) abort limits (RMS). The RMS values
of the channels depend on the structure of the specimen. In case of control
channels, select the unit of the abort limits in EU control channels.

If you select an absolute unit [g] or [m/s²], the upper abort limit is
independent of the current test level. The lower abort limit becomes
effective after reaching the line-by-line-check start level.

If you select a relative unit [dB], the abort limits will be activated as soon as
the current level is greater or equal to the line-by-line-check start level.
If you define several control channels, the RMS values which are to be
expected are derived from the system gain. So m+p VibControl considers the
fact that not all channels have the same RMS value. The system gain is calculated for every level.
When Notch/Tolerance mode or Notch mode was selected for the watchdog
channels, the unit can be chosen in the Sensitivity column. If the abort limit
(RMS) is exceeded, the test will be aborted.

6.1.5

Notching in Random Test Mode

Notching is available for sine and random test modes. For information on how to define the
notching parameters and on how to run notching tests, please refer to the corresponding chapters in the sine test mode section 6.2.5 “Notching in Sine Test Mode”, page 179.

6.1.6

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.

6.1.7

Microphone Calibration

In the configuration file C:\VcpNT\Config\VcpNT.ini you can choose between two methods of
calibration: Calibration Type 0 and Calibration Type 1:

CALIBRATION_TYPE: 0
This is the default way which was previously available in the older versions of m+p VibControl.
Usually you need two persons for this calibration process. One person is working in the reverberation chamber and connects the channel/s to the pistonphone/s. The number of channels
to be calibrated at a time is restricted to the number of pistonphones available. The second
person is working at the PC and clicks the Calibrate button whenever the channels have been
connected to the pistonphones. During the whole process both persons communicate about
the state of their work.
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At start-up, all fields in the New Value column are set to zero (no entry). The default value for
Frequency can be modified by changing the value for AC_CalibrationFreq=1000 in the
VcpNT.ini file. The default value for Level can be modified by changing AC_CalibrationLevel=120 in the same file.
The values for Frequency and Level can also be modified in the Calibration window, and should
match the characteristics of the pistonphone you are using to calibrate this channel.

Channel selected for calibration

Please make sure that the pistonphone is attached correctly to the microphone(s)
before starting the calibration.

New value shows high deviation compared to old value

If the new sensitivity value calculated from the calibration deviates more than 10% from the
original value, it is displayed in red. You can now decide to accept this sensitivity or to reattach
the pistonphone and redo the calibration.
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Calibration is done, new value is satisfactory

If the new calculated sensitivity is satisfactory, select Update Values to copy the new sensitivity
to the test definition. Then, select another channel to calibrate and repeat the procedure.

Next channel is selected for calibration

You are free to close the window and/or to stop the calibration procedure at any time.
In doing so, this will return the sensitivities to the old values. Close the window and you will be
asked whether you want to accept the new values or not. Click the No button and the old values
will reappear in the table.

CALIBRATION_TYPE: 1
This is the automatic calibration. It can be executed by one person only. The software verifies
whether a pistonphone is attached to the microphone and then starts the calibration process
automatically.
Choose the channels that need to be calibrated and click the Calibrate button.
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Channels selected for calibration, calibration is in progress

Go to your measurement setup and attach the pistonphone to one of the channels that needs
to be calibrated. The system will detect the signal presence and will calibrate the channel as
long as the signal is present. When OK is shown in the status line, you can attach the pistonphone to the next channel to calibrate and so on.

Calibration of one channel leads to a new value which shows high deviation compared to the old value

If the new sensitivity value calculated from the calibration deviates by more than 10% from the
original value, it is displayed in red. You can now decide to accept this sensitivity or reattach the
pistonphone and redo the calibration.
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Calibration of the channel leads to satisfactory value

When the result is satisfactory, select Update Values to copy the new sensitivity to the test definition.
You are free to close the window and/or to stop the calibration procedure at any time.
In doing so, this will return the sensitivities to the old values. Close the window and you will be
asked whether you want to accept the new values or not. Click the No button and the old values
will reappear in the table
It is also possible to change the default calibration frequency and level for the type of pistonphone you are using, by modifying the following parameters in the configuration file:
"C:\VcpNT\Config\Users\[user name]\ VcpNT.ini"
AC_CalibrationFreq=1000
AC_CalibrationLevel=94

Whenever you modify parameters in the configuration file "C:\VcpNT\
Config\VcpNT.ini" (e.g. the calibration type), you have to close and reopen
the VibRunner program part to make the change effective.
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6.1.8

Test Control in Random Test Modes (VibRunner)

VibRunner in random testing (Getting Started)

6.1.8.1

Online Controls

Test Status Window
A separate status (monitoring) window can be opened by clicking into the online time section.
Pull it to the desired size. This numerical display shows the target value and the current value
and enables you to monitor the measurement values even if the operator is working at another
workplace. Double-click this window if you want to adapt the window size.

Test status window

Time
The VibRunner displays the current test time:
Total / Elapsed Total time into test.
Total / Remaining Total time remaining.
Level / Elapsed Time into test at current level.
Level / RemainingTime remaining at current level.
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Level
The VibRunner displays the previous, current and next test level:
Next Level

Next test level: 0 dB

Current Level

Current test level: - 6 dB.

Previous Level

Previous test level: - 12 dB

Manual action will override the schedule.

You can manually hold a level, go to the next or previous level or release a Hold level.
Level up
Hold
Level down

Go to the next test level.
Hold/Release current test level.
Go to the previous test level.

Open Loop
You can manually open the control loop and close the open control loop. In
Open Loop mode, the last drive signal remains unchanged and no more
adjustments will be performed to keep the test in control.

In open loop control, only the upper abort limit is active. Once you select
closed loop control, the lower abort limit will be taken into account, too.
So the test will be aborted as soon as the upper or lower abort limit is
exceeded.Manual action will override the schedule.

To open the control loop, click the Open Loop button. In Open Loop control, this button shows
green light. In open loop mode, the Time remaining display stops counting.
Before closing the control loop, check the reference spectrum in any case. If the reference
spectrum deviates considerably from the measured one, you must not close the control loop.
In this case it is recommended to start the test at a lower level.
To close the control loop, click the Open Loop button. In closed loop control, this button does
not show the green light.

Save Timer
(available in standby mode only)
If the test is aborted, you do not have to repeat the complete run at the current
level. Click the Save Timer button to save the time remaining at test abort.
Restart the test from the previous level.
Reaching the test level at which the abort occurred, the remaining time will be tested.
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Test Log

Online test log

The lower left part of the VibRunner window displays the
test log.
The test log lists all relevant test events in chronological
order. The online test log displays the latest information
only. To have a look at the complete test log after test
end, open the offline test log.
Select Protocol file from the File menu or double-click
the test log field to open the offline test log and to print it.

Online test log

Offline test log

6.1.8.2

Online Charts

The online charts are a useful control tool. See chapter 5.3 “VibRunner Chart Display Functions”, page 82.
For random tests it is possible to show a RMS over time graph for drive and control channels:
•

Open the chart context menu, select the Add channels function.

•

Define a new channel and its data format.

•

One of the selectable data formats is RMS over Time.

The data are stored to a file which is saved in parallel to the *.sot file. They can be displayed
in VibRunner and VibPostTest.
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6.1.8.3

Averages Display

If you defined Averages for your measurement channel in VibEdit, the status line at the bottom
of the VibRunner window displays the number of averages done and the number of averages
remaining.

Averages display

There is a larger averages display available. Open the Options menu and select Show average
count window to enable it.

6.1.8.4

Run the Getting Started Test

By running a Getting Started test you can check the performance of your signal processing and
data acquisition system on a bare wire, i.e. neither a shaker nor a specimen are involved in this
testing - allowing you to learn the m+p VibControl control functions with only the measurement
front-end and a BNC cable being required.
To start up the test, first perform a selfcheck. Then you can start the test by clicking the Run
button.
The online control window displays the measured signals. The test run is performed as defined
in VibEdit’s Schedule tab.
Please try the online control functions:
•

Manually change the level by clicking the Level up or the Level down button.

•

Manually hold a level by clicking the Hold button. Release it with another click on Hold.

•

To manually open the control loop, click the Open Loop button. In Open Loop mode, the
drive signal will not be updated.
In open loop control, only the upper abort limit is active. Once you select
closed loop control, the lower abort limit will be taken into account, too.
So the test will be aborted as soon as the upper or lower abort limit is
exceeded.

•

Before closing the control loop, check the reference spectrum in any case. If the reference
spectrum considerably deviates from the measured one, you must not close the control
loop. In this case, we recommend starting the test at a lower level. To close the control
loop, click Open Loop again.

•

To halt an on-going test, click the Standby button.

•

To continue a test from standby mode, click the Run button.

•

To take a manual measurement, click the Measure button. The responses of the measurement and control channels together with the corresponding drive signal, error and control
spectra are saved to hard disk.
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•

Use the online chart functions (see chapter 5.3 “VibRunner Chart Display Functions”,
page 82)

•

To definitely abort the test after the test end has been reached and store the results, click
the Abort button. Then, the test will switch from Standby mode to Idle mode and the test
spectra will be stored automatically so that they can be analyzed using VibPostTest.

6.1.8.5

Coherence Measurement

The coherence is measured in random tests between each measurement channel and the first
measurement channel.
The results of this measurement can be displayed in VibPostTest (see chapter 8 “Analyze a
Test (VibPostTest)”, page 469).
It is only present for measurement channels when a measurement was done during the test
and if the number of averages has been specified in the channel definition (see chapter 6.1.4
“Define the Channels for the Random Test Mode”, page 122). The coherence of the first measurement channel is of course always "1" as it is compared to itself.
The formula used here is:
2

N Averages

i = 1 G y i x i
Coh = -------------------------------------------------------------------------N Averages

i = 1

N Averages

G yi yi  

i=1

G xi xi

where y is the measurement channel and x is the first measurement channel.
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6.1.8.6

Displacement and Velocity Selectable for the Online Display

In VibRunner Sine and Random tests, it is possible to calculate displacement and velocity from
the measured acceleration using the corresponding math function and to display the results
online.
Right-click the relevant online display to open a context menu and select one of the mathematical functions Differentiate or Integrate, depending on the parameter you want to display.

Online display showing calculated velocity (upper chart)



You have used an accelerometer and you would like to calculate both
velocity and displacement:
Velocity:
Select the data set and "1 x Integr".
Displacement: Select the data set and "2 x Integr".
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6.1.8.7

Adapt Limits and Reference Traces to Actual Level

By default, the control channels are displayed with their corresponding reference spectra/
pulses, their alarm and abort notch limits. You can hide these reference and tolerance traces
or - if hidden - show them. Moreover, for test levels < 0 dB you can adapt the traces defined and by default shown for a test level of 0 dB - to the actual test level.

Level scaled

Use your right mouse button to click the background of the online display. Select Level scaled
from the menu.
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6.1.8.8

Probability Density Function View in Kurtosis Controlled Tests

Double-click on the displaying or empty chart where you want to open the Probability Density
Function (PDF) view or the Probability Function (PF) view. The Add Channels dialog will open:

The Master Channel selection field offers all channels you defined in VibEdit‘s Channels
tab. Select a physical control channel (no calculated channel!) and its axis.
Then select a reference channel and its axis.
If you want to display a Secondary Channel, select this channel with a check mark.
Up to three secondary channels can be displayed on the online chart.
In the X-Axis Data Type field you now select the Probability Function data type.
The Y-Axis Data Type is preset to Amplitude.
Close the dialog and the chart will display the Probability Function relating to your test run.

Random test run with probability function view
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6.1.8.9

Notch References Displayed Online

m+p VibControl includes display overlay of the notch profiles in both the data controls. The
feature allows the user to verify online the notch performance or any notch selected channel.

Notch reference overlay screenshot

Show/Hide
Warn limits
Abort limits
Reference signal

Alarm limits.
Abort limits.
Reference spectrum/pulse.

To hide the reference spectra/pulses, their alarm and/or abort limits, use your right mouse button to click the background of the online display.
To hide a trace, click its name from the menu with your mouse button so that it is un-checked.
To show a trace, click its with name from the menu so that it is checked.
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6.1.8.10 Online Calculation of Transfer Functions
VibRunner is able to provide online calculation of transfer functions.
Right-click anywhere in the graphic area to open the context menu and select a signal and a
reference.
m+p VibControl will then automatically calculate the transfer function between the selected signal and the reference signal, and will display it online when running the test in VibRunner.

Select reference signal for online calculation of transfer function

6.1.8.11 Frequency Domain View and Time Domain View
In Random and Sine test mode you can decide whether your online data shall be displayed as
frequency data or as time data.

Random frequency data

Random time data

To switch from frequency domain view to time domain view right-click with your mouse on the
desired chart. The context menu opens where you can select the Time Domain option.
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VibRunner context menu

The Time Domain mode only shows measured channels from the channels table. Error and
drive channel cannot be displayed in this mode.
It is also possible to simultaneously switch all frequency data charts to time domain charts with
a click on the Time Domain View button.

Time Domain View button

The selected button will turn red. With another click on the button you switch back to the Frequency Domain view.
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6.2

Sine Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: define the test run profile/s

•

Specimen: enter the properties of the shaker and the specimen

•

Schedule: define the selfcheck properties and the test schedule

•

Channels: define the channel properties

6.2.1

Define the Sine Reference (VibEdit)

Sine reference spectrum defined

The sine reference of VibEdit shows two sub-categories:
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6.2.1.1

Accelerations - Slopes

Reference amplitude of acceleration

Define the reference amplitude of acceleration in [g] or [m/s²]. A segment, i.e. the band
between two consecutive frequencies, is defined by kinematic dimensions (acceleration, velocity, displacement) and/or slopes. You have to enter a dimension value at least for one frequency. It is not necessary to enter all three values for one frequency, the missing ones will be
calculated and displayed automatically.
Slopes refer to acceleration, velocity or displacement. They can be defined in logarithmic
(dB/Oct) or in linear form (EU/Hz). EU is the engineering unit of the corresponding reference
(e.g. [inch] for displacement or [m/s2] for acceleration).
The following relations apply to the conversion of kinematic dimensions and to their calculation:
Amplitude of displacement
Amplitude of velocity
Amplitude of acceleration

=A
=A·
= A · ²

where  = 2 · f
f = frequency

Frequency

1 Hz

1000 Hz

Acceleration

1g

1g

Velocity

1.56 inch/s

0.00156 inch/s

Displacement

248.5 inch

0.000249 inch

Let m+p VibControl calculate unknown cross-over frequencies for sine test setups with
constant slopes of displacement, velocity or acceleration.
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VibEdit, sine test setup with cross-over frequencies unknown

Paste a line between the two known frequencies.
Enter a “0“ for Frequency and define the Slope by Type, Value and Unit. For example, select
Def Acc if the next frequency has a constant slope of acceleration and set Value to “0“.
Defined values are displayed in black. Calculated values are displayed in gray.
Press the Enter key. The cross-over frequency is calculated.

Cross-over frequency 123.2 Hz calculated
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Cross-over frequency 123.2 Hz calculated

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Define the breakpoint in [Hz].
Available frequency range: 0.1 Hz to 40.0 kHz depending on the hardware.

Accel./Vel./Displ.
Define acceleration, velocity or displacement for this breakpoint. If you enter
“0“, the amplitude will be calculated from the previous and next slopes.
It is not necessary to enter all three parameters per frequency since the
missing ones will be calculated from the given parameters and displayed
automatically.
To change the acceleration, velocity and/or displacement units, go to the
"Units" selection field and select from the pop-up menus. All numerical and
graphical reference data will be converted automatically.
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Slope
To define a slope, select to which dimension the slope is to refer (Type) and
enter the slope value (Value and Unit).
Slopes refer to acceleration, velocity or displacement. They can be defined
in logarithmic [dB/Oct] or in linear form [EU/Hz]. Auto acceleration signals a
constant slope.
Type:
Select the dimension the slope is to refer:
Def. Acc. = Slope refers to the defined acceleration.
Def. Vel. = Slope refers to the defined velocity.
Def. Displ. = Slope refers to the defined displacement.
Auto Acc. = Constant acceleration slope referred to double logarithmic scale.
Value/Unit:
With Auto Acc. selected, this entry cannot be made. The displayed value
must be ignored. Enter a positive or negative slope value and select the corresponding unit.
Slope in [dB/Oct]:

y2 = y1

f
 ----2-

Slope
-----------------------------20 log 10 (2)

f1

Slope in [EU/Hz]: y2=y1 + slope (f2 - f1)
y2

=

calculated engineering unit at frequency 2

y1

=

reference of engineering unit at frequency 1

EU (Engineering Unit) is the unit of the corresponding reference (e.g. [inch]
for displacement or [m/s²] for acceleration.
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6.2.1.2

Alarms - Aborts

Alarm and abort limits defined

To copy the breakpoints from the Accelerations - Slopes table to the Alarms - Aborts table,
mark the breakpoints, open the context menu with a right mouse-click and select the Copy
option. Then, change to the Alarm - Aborts section, right-click into the table and choose Paste
from the context menu.
Enter the limits required for each breakpoint.
To set the same lower or upper alarm or abort limit for multiple rows,
click the first row to set with your left mouse button, press and hold
the Shift key. Click the last row to set with your left mouse button.
With the Shift key held, all rows in between are selected. Select the
field of the limit to set with a click of your left mouse button. Release
the Shift key and type in the lower or upper alarm or abort limit.
Press  to globally set all rows selected to this lower or upper alarm
or abort limit.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
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To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Copy the breakpoints from the Accelerations - Slopes table.

Alarm
Enter the lower and upper alarm limits at every frequency (breakpoint). Any
exceeding of the alarm limits during the test run will be entered into the test
log.
Low:
Enter the lower alarm limit in - [dB] or in [%].
High:
Enter the upper alarm limit in [dB] or in [%].

Abort
Enter the lower and upper abort limits at every frequency. If the abort limits
are exceeded during the test run, the test will be aborted.
Low:
Enter the lower abort limit in - [dB] or in [%].
High:
Enter the upper abort limit in [dB] or in [%].

Select the Units

Units

To change the acceleration, velocity, displacement and/or force units, go to the Units selection
field and select from the drop-down lists. All numerical and graphical reference data will be converted automatically.

Rescale the Spectrum
You can time-efficiently rescale, i.e. dampen or amplify, the complete spectrum (all values
defined) by a factor.



To amplify the spectrum by a factor of 2, type “6“ [dB].
To dampen the spectrum by a factor of 0.5, type “-6“ [dB].
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To open the “Rescale“ dialog, click the

button.

•

Select the unit for the rescale factor in the unit selection field.
Available units are [dB], [%], [g]

•

Type the rescale factor.

•

To dampen the spectrum, type a negative factor (negative sign).

•

To amplify the spectrum, type a positive factor (no sign).

•

Tick the Include notch limits field if you want to rescale the notch limits, too.

•

Tick the Include upper abort field, if you want to rescale the upper abort limit, too.

Rescaling

Measurement - Number of Lines Selection
In the Measurement section of the Reference tab you select the Number of lines to define the
number of spectral lines used for data storage.

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.

File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.
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Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in VibShakerDef. The
necessary force is calculated using an SDOF model. Check at the bottom shaker load display
whether the defined parameters may exceed the shaker limits.
The necessary shaker force is calculated as follows:
Fpk = A  [(c - m  ²)² + (4 · c · m · ²)]½
A
c
m

=
=
=



=
=

f

displacement amplitude
axial stiffness of the shaker
total load moved (shaker system mass + armature mass
+ specimen mass · number)
2f
frequency

with Lehr's damping factor  = d/dc = 1
with:

d = damping factor
dc = critical damping factor
= 2 · (c · m)

The estimated shaker load is given not only in numerical but also in graphical data (color of
signal lamps):
Color
Shaker load
Red
100% (shaker limits exceeded)
 90% < 100%
Yellow
Green
< 90%
Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%. The program does not block the Start button!
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6.2.2

Load the Shaker and Define the Specimen in Sine Test Mode

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.
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6.2.2.1

Shaker

Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
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To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.

General Shaker Settings

General shaker settings

Mass Unit Selection
Select the desired mass unit [lbs] or [kg]. When you change the mass unit,
the values will be converted accordingly.

Moving Coil Mass
The moving coil mass entered in VibShakerDef is displayed.

Total Weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial Stiffness
The axial stiffness entered in VibShakerDef is displayed.

Maximum Input Voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input Voltage Limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in
VibShakerDef by setting an input voltage limit for the power amplifier.
The input voltage of the power amplifier corresponds to the output voltage of
the source
module. If the admissible voltage is exceeded, the test will be aborted.
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Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

6.2.2.2

Define the Specimen

Define the specimen

Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.

6.2.2.3

Define a Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.

Weight:

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.
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6.2.2.4

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.

6.2.2.5

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in the VibShakerDef.
The necessary force is calculated using an SDOF model.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of
signal lamps):
Color

Shaker load

Red
Yellow
Green

 100% (shaker limits exceeded)
90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%. The program does not block the Start button!
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6.2.3

Define the Sine Schedule

Sine testing schedule

With the testing schedule, you define the sequence and the duration of the test levels, and
when to take a measurement.

Filter bandwidth
This variable allows to define the Filter Bandwidth used for the amplitude estimators for the control, watchdog, and measurement channels.
Filter bandwidth is the reverse of time integration, which means that a value
of 0.2 corresponds to five periods. The lower the Filter Bandwidth the slower
the control loop becomes. So a trade-off should be found between sweep
rate and measurement accuracy (Filter Bandwidth).

External shutdown time
Enter the time in [ms] to ramp down the drive signal in case of an emergency
shutdown. This function requires an Emergency OFF switch being connected
to the bridged output channels of the front-end in use. For further information
on the emergency shutdown, please refer to chapter 2.9 “External Shutdown”, page 14.
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Selfcheck
Selfcheck is useful for verifying the test definition and the channel setup as
well as for recording a first structural response of the specimen. The standard
selfcheck is done with a fixed output level. For more information on the selfcheck function, please refer to chapter 3.3.7 “Selfcheck”, page 44.

Selfcheck mode
- Fixed Level:
Standard selfcheck is done using a fixed output level. This level is defined
in the Selfcheck level (100 mV) field,
You can manually define an attenuation shape using the >> button. For
further information please refer to the Selfcheck Attenuation paragraph on
page 119.

Selfcheck - fixed level settings

- Limiter Mode:
In Limiter mode, selfcheck is done using variable output levels. Starting with
a low level that is defined in the Min. selfcheck level (100 mV) field, the selfcheck will gradually increase to the value specified in the Max. selfcheck
level (100 mV) field. In order to achieve a good signal-to-noise ratio while
avoiding a too high load on the specimen, the response is limited to a
reasonable value. Any spectral lines which are too close to the reference
spectrum or notch limits are automatically reduced to a safe value.

Selfcheck - Limiter mode settings

Selfcheck level (100mV)
Enter a lowering of the drive signal for the selfcheck in [dB] referred to 0.1
Vrms. The selfcheck level [dB] = 20 log (Vrms / 100 mVrms ).
0 dB = 0.1 Vrms in selfcheck. Lowerings of  0 dB are allowed.
You determine the selection of the selfcheck level through experience and
engineering judgement. Be aware that a very low selfcheck level may result
in very small signals which do not lie above the system background noise.
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For applications such as servo-hydraulic exciters where selfcheck levels of
0.1 Vrms do not cause accelerometer response to run a test, selfcheck levels
of > 0 dB are also accepted by m+p VibControl for Sine, Random and RoadLoad modes. A maximum level of 0.5 Vrms should be sufficient for selfcheck
with such applications.

Selfcheck gain level limit
The selfcheck gain level limit states by what tolerance the system gain
measured during the selfcheck is allowed to deviate from the system gain
defined in the Channels tab.

Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line.

Selfcheck attenuation defined

Throughput section
The Throughput section in the Schedule tab offers several options for
throughput start and stop settings.

Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.
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Sweep Conditions
You define the sweep schedule either sweep wise or frequency wise.
You can sweep wise define the sine testing schedule or activate a sweep table to sweep
frequency wise.
With sweep wise scheduling, the frequency of the sine waveform is swept from some starting
point to some ending point at a defined rate. If the sweep reaches one of these points, the
sweep is finished and the sweep direction is reversed. Thus for each frequency, two sweeps
are run.
For sweep wise definition, leave Sweep Table active unchecked. Define the parameters
shown.
Using the sweep table, single frequency ranges can be swept once or multiple times at varying
rates.
To define the sweep frequency wise, check Sweep Table active. Define the parameters shown.

Sweep conditions

Take limits from reference
Check this option to import the limits you already defined in the Reference
tab.

Lower/Upper frequency limit
Pick a frequency range within the defined reference spectrum. Thus, you can
partially test a spectrum without defining a new test setup.
Note:
If you activate the “Take Limits from Reference“ check box (top left),
no entries are possible in the Lower frequency limit and Upper frequency
limit fields.

Starting frequency
Define the frequency - within the frequency limits - at which the sweep is to
start.

Sweep direction
Check the direction in which the sweep is to start:
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Up:
The sine goes to the upper frequency limit.
Down:
The sine goes to the lower frequency limit.
You can manually change the sweep direction during the on-going test run
whenever you want.

Start drive (100 mV)
Define a lowered start drive in [dB] (reference: 0.1 Vpk). At start, the test drive
will be increased from this drive towards the reference drive. Select the start
drive such that it is far larger than the background noise.

Startup time
The rate at which the drive signal is increased towards the reference level.
Enter the startup time in [s].
If it is not possible to reach the reference level within the startup time, the test
will be aborted.

Startup tolerance
Enter the admissible tolerance at start-up in [dB] to the reference spectrum
amplitude.
If, at start-up, the error, i.e. the comparison between reference value and
measured one, remains within tolerance, the sweep will start. The error is displayed in VibRunner.

Shutdown time
Enter the shutdown time in [s] during which the controller will turn the current
drive signal off if the abort limit is exceeded.

Define the Repetition Parameters

Repetition parameters

Sweep rate
Enter the sweep rate for logarithmic sweeps in [Oct/min] or [Dec/min] and for
linear sweeps in [Hz/min].
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m+p VibControl calculates the sweep duration from this sweep rate and the
frequency limits defined.
Alternative: Enter the sweep duration. m+p VibControl calculates the sweep
rate from this sweep duration and the frequency limits defined.

Number of sweeps/ Number of repetitions
When defining the schedule sweep wise (Sweep Table active unselected),
enter the number of sweeps.
When defining the schedule frequency wise (Sweep Table active selected),
enter the number of repetitions.
m+p VibControl calculates the test duration from this number of sweeps (or
number of repetitions) and the sweep duration.
Alternative: Enter the test duration. m+p VibControl calculates the number of
sweeps (or number of repetitions) from this test duration and the sweep
duration.

Auto measure every _ sweeps up/Auto measure every _ sweeps down
You can define an automatic data storage every time the upper (sweeps up)
or lower frequency limit (sweeps down) is reached. The measured data is
stored to the result file.
If you set for instance the automatic measuring to every sweep up and down
for a test with 100 sweeps, this may well generate a sine test result with
several MB on your hard disk!

Stop at Sweep End
Enable the Stop at Sweep End function if you want to stop the test at the end
of a sweep.

Sweep duration
m+p VibControl calculates the sweep duration from the sweep rate and the
frequency limits defined.
Alternative: Enter the sweep duration. m+p VibControl calculates the sweep
rate from this sweep duration and the frequency limits defined.

Test duration
m+p VibControl calculates the test duration from the number of sweeps (or
number of repetitions) and the sweep duration defined.
Alternative: Enter the test duration in [hh:mm:ss]. m+p VibControl calculates
the number of sweeps (or number of repetitions) from this test duration and
the sweep duration.
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Cycles
The Cycles field displays the number of cycles corresponding to the defined
number of sweeps.
If you often run sine tests based on the number of cycles, you have the
possibility to enter the desired number of cycles and m+p VibControl will
calculate the corresponding number of sweeps for the test.

Sweep Table

Sweep table active

With Sweep table active selected, you can frequency wise define the sweep and let the sweep
run up and down at different rates between some starting and ending frequencies.
To make the sweep table active, check Sweep Table active.

No.
Consecutive row numbering.
To edit a row, click the row’s No. field.
To activate an empty row, double click the row’s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Start [Hz]/End [Hz]
Enter at which frequency to start and end the sweep.

Rate/Unit
Enter the sweep rate for logarithmic sweeps in [Oct/min] or [Dec/min] and for
linear sweeps in [Hz/min].

Damping
Select the controller damping and thus, the compression speed.
These values are allowed: 0, 1, 2, 4, 8.
0 = no damping, high compression speed,
8 = high damping, low compression speed.

Direction
Select the direction in which the sweep is to start:
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Up:
The sine goes to the upper frequency limit.
Down:
The sine goes to the lower frequency limit.
You can manually change the sweep direction during the on-going test run
whenever you want.

Duration
m+p VibControl calculates the sweep duration from the sweep rate and the
frequency limits defined.

6.2.4

Define the Sine Channels

Channel definition for sine test modes

6.2.4.1

Control Strategy

Select the control strategy.

Average
The average value of all control channels serves as reference. In sine test
mode, the control signals can be weighted differently so that averaged control signal can be adapted to the test situation.

The "Average" control strategy does not use values which are 1/64
below the maximum (vibration nodes) for averaging.

Maximum
The maximum of all control channels serves as reference.

Minimum
The minimum of all control channels serves as reference.

168

m+p VibControl Rev. 2.16

m+p international

Define the Sine Channels

The "Minimum" control strategy may cause an overloading of the
specimen. If the control channel exceeds the abort limit, the test will
stop and change to standby mode. Select this control strategy only
for control and limiting channels CW having an upper and lower
abort limit (Tolerance mode).

6.2.4.2

Damping

Select the controller damping and thus the compression speed (available values 0. 1, 2, 4 8).
0  no damping/high compression speed
8  high damping/low compression speed.
The damping and the maximum error of a control channel enter into the control algorithm which
determines the following control.
The algorithm works as follows:
Aa+1 = Aa  (K + 1/E)/(K + 1); E < 1
Aa+1 = Aa  (K + 1)/(K + E);
E>1
Aa+1 = next amplitude
Aa

= current amplitude

E
K

= maximum error
= factor of damping

A high K factor (i.e. high damping) weights the old Aa value more and slows down the control.
The damping depends on the dynamics of the specimen. You can improve some tests by using
different dampings in the frequency intervals of the spectrum. Therefore, you can change the
damping in VibRunner.

6.2.4.3

Transducer Database

The TRANS button leads you to the Transducer database list.

Transducer list

m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.
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6.2.4.4

TEDS Support

Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to IEEE
1451.4. This feature is useful for high-channel count vibration control systems and for applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of the
sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, aa well as by VXI Technology's
digitizer modules VT1435/1436.

6.2.4.5

Import Notch Table

Importing a notch table is useful for systems with high channel counts. In Sine and Random
test modes, you define an ASCII file containing the optimum notch limits for each channel and
import it every time you need them. You can import this file even if you don’t work with the maximum channel count as notch limits for channels not in use are skipped.
First define the ASCII file containing the desired notch limits. Then click the
button and select the corresponding file. Click Open to start the file
import.

6.2.4.6

EU Control Channel

EU control channels (sine)

Control channels can be defined for accelerometers only; in sine mode, it is possible to also
define displacement transducers or force transducers to be control channels.
Select a unit of acceleration or length (for displacement control).
The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.
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6.2.4.7

Low-Pass Filter Option with m+p Hardware

For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled.
The filter is a fourth order butterworth low-pass filter.
If the filter option is available the desired cutoff frequency can be entered.
The same filter settings are used for all input channels.
The filter frequency cannot be set lower than the maximum frequency of the reference
spectrum.
Filtering may be useful, if interfering signals above a specific frequency should be attenuated.

6.2.4.8

Define the Sine Channel Parameters Table

Channel definition for sine test modes

No.
The number of channels depends on your software license.

In sine and random modes, all channels can be used as control
channels. For Average control strategy these channels can be
weighted.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box (bob). The numbering of the
breakout box starts with 0, so that 0 (bob) corresponds to channel 1
in the channel parameters table, channel 1 (bob) corresponds to
channel 2 in the channels table etc. If you use several input
modules, take the slot number into account.

Type
Select the type of channel.
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Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel

W

= watchdog (= limiting) channel

M

= measurement channel (not suitable for monitoring;
if you want to connect this function with a measurement channel,
the measurement channel must be set up as WM channel.
In any case, the measurement channel is stored when
measurements are triggered automatically or manually).

CW

= control and watchdog channel

CM

= control and measurement channel

WM

= watchdog and measurement channel

CWM

= control, watchdog and measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.

Filter
Select the measuring method.
Each channel type (C, W, M) has its own amplitude estimation (Filter, RMS,
Average, Peak). In case of a CM channel, for instance, you can select RMS
for the C channel and Filter for the M channel.
If RMS, Average or Peak is selected, the RMS, average or peak value of the
broadband signal for each channel is measured and used for control. If the
Filter mode is selected, the signal for each channel is filtered using a digital
filter (similar to a tracking filter).
The measured signal amplitudes depend on the measuring methods:
Peak  RMS  Average  Filter

Sine amplitude relationships
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Filtered:
The Filter mode uses the principle of single-frequency FFT. The filter accepts
only the fundamental frequency. Harmonic waves will be rejected. To avoid
overtesting the specimen, this measuring mode should be used with care for
control channels.
Peak:
The Peak mode searches the data for absolute peak values. Where a system
is noisy, the peak value may be considerably greater than the average and
RMS values. If peaks vary considerably and if the damping is low, control
often becomes slightly unstable. Therefore, Peak mode should only be used
for "clean" systems featuring a linear behavior.
Special feature of Peak mode:
All four measuring modes use only the AC signal, regardless of the
chosen coupling. The Peak mode, however, measures also the DC
signal provided that it is greater than 50 % of the peak value.

Example application:
DC-coupled tolerance channel for monitoring a stretching wire.
RMS:
The RMS mode adds the squares of each input data point, divides the result
by the number of data points and takes the root of this result. This RMS value
will be multiplied by a factor of 2 which represents the peak-to-RMS ratio of
a pure sine. The RMS mode provides a measure of averaging compared to
the Peak mode, but tends to emphasize the larger values compared to the
Average mode. The RMS mode is used to avoid overtesting the specimen.
Averaged:
The Average mode performs a summation on the rectified values of the data
and divides the result by the number of points. This average will then be multiplied by a factor of /2 which represents the peak-to-average ratio of a pure
sine wave.
Selecting Combinations of Filters:
In sine and sine data reduction test modes you can also select combinations
of filters for each measurement channel.
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Filter type selection

Select M in the Type column and choose a combination of Filter, RMS, Peak
and Average in the Filter, M column and the test results will be recorded
accordingly.
During the test run the first filter of the filter type combination will be shown
(e.g. if you selected the filter combination Peak, RMS, Averaged ("PRA"),
VibRunner will display the Peak filter chart.)
It is also possible to display all selected filter types online: Open the context
menu and enable the Show all filter modes function.
After test run the result files, which were recorded with different filters, can be
opened in VibPostTest to compare the traces (see chapter 8.3.1 “Filter Channels”, page 479).

Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
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With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditionning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".

Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.
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Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
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defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only. Enter the measuring range.

Weighting
For the Average control strategy, the average signal of all control channels is
used. The weighting function enables a single channel to participate more by
including it several times while others are only included once. Thus, difficult
test situations can be controlled in an effective way.
For Example:
Channel 01

Weighting = 2

Channel 02

Weighting = 1

Channel 01 will be responsible for 66.66% of the averaged control signal
while channel 02 will be responsible for only 33.33%.

Av mode
For watchdog channels in sine and random and displacement control in sine
only:
Select the Watchdog mode (Notch, Tolerance, Notch/Tolerance) or displacement control (Control, Control/Tolerance) or notching functions (VectorAdd,
Vector RSS, MNotch)
Notch:
In Notch mode, the excitation is limited in a defined frequency range (bandwidth) such that the defined level will not be exceeded. With Notch selected,
the notch spectrum of the selected channel can be defined in the bottom
notch table.
As long as a notch channel does not exceed the defined level, m+p
VibControl uses the test spectrum. If the specimen is overloaded at the
defined measuring point (= notch channel), the notch channel presenting the
highest exceeding of the notch level will be used as reference. Where the
frequency range is exceeded, the notch channel becomes the only control
channel. Notching changes the test spectrum.

Notching is always a limitation of the upper level, not of the lower
one. There are no abort limits (RMS). If you want to check the abort
limits (RMS), select Notch/Tolerance mode.
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If you use a pure watchdog channel in the Notch mode, the lower
level is not limited. Therefore, the controller will not abort the test if,
for instance, the transducer is defective or the cable is parted.

Tolerance:
The watchdog channel is checked for its upper and lower abort limits (RMS).
If the tolerance is exceeded, the test will abort.
Notch/Tolerance:
This function combines notching and checking of upper and lower abort limits
(RMS), ensuring that the controller will abort the test if it acquires no signal
that lies above the background noise (e.g. when the transducer is defective
or the cable is parted).
With Notch/Tolerance selected, the notch spectrum of the selected channel
can be defined in the bottom notch table.
Control:
This function is available in sine mode only. It enables you to specify displacement control. In this way, tests starting at very low frequencies can be
controlled on displacement if the resolution of the frequency range of the
accelerometer is not sufficient.
For displacement control, please select a unit of length (m, dm, cm, mm, µm
or inch) in the drop-down list next to EU control channels.
If you select Control for a watchdog channel, the control spectrum of the
selected channel can be defined in the bottom notch table.
Control/Tolerance:
This function is available in sine mode only. It combines displacement control
and checking of upper and lower abort limits.
For displacement control, please select a unit of length (m, dm, cm, mm, µm
or inch) in the drop-down list next to EU control channels.
If you select Control/Tolerance for a watchdog channel, the control spectrum
of the selected channel can be defined in the bottom notch table.
VectorAdd:
Select VectorAdd to enable the Summed Force notching mode, Then, define
the notching parameters in the lower part of the window.
Vector RSS:
Select VectorRSS to enable the Vector RSS notching mode Then, define the
notching parameters in the lower part of the window.
MNotch:
Select MNotch to enable the Moment Notching mode. Then, define the
notching parameters in the lower part of the window.

Abort

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.
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Enter the upper and lower abort limits. The amplitudes of the channels
depend on the structure of the specimen.
In case of pure control channels C, only the upper abort limit will be checked.
Select the unit in the EU control channels field above the table.
If tolerance, notch/tolerance or control/tolerance was selected for the watchdog channels, the upper and lower abort limits will be checked. The unit can
be chosen in the Sensitivity column. If the abort limit is exceeded, the test will
be aborted.

6.2.5

Notching in Sine Test Mode

Notch table

Notching limits the input signal to pre-defined limiting spectra. It is available for watchdog channels in Notch or Notch/Tolerance mode. You can enter a maximum of 50 limiting spectra.
If you select Notch or Notch/Tolerance for a watchdog channel, the notch spectrum of the
selected channel can be defined in this notch table.
You specify the limiting spectra by entering either center frequency and bandwidth or minimum
and maximum frequencies.
In addition, you can specify linear or logarithmic slopes for all limiting spectra.
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Notching is always a limitation of the upper level, not of the lower one.
Therefore the controller will not abort the test if, for instance, the transducer is defective or the cable is parted. If you want to check the abort
limits (RMS), select notch/tolerance.

Select the watchdog channel that will define notch channels with a click of your left mouse button. This channel is then highlighted.
With this channel highlighted, click the white background of the Notches for selected channel
table.
Enter the notch parameters.
Please note that in VibRunner, the test log will automatically display messages whenever
an active notch channel starts or stops notching. As the test log can be opened and saved
after test run completion, all the logged notching activities can be analyzed at any time.

No.
Consecutive row numbering.
To edit a row, click the row’s No. field.
To activate an empty row, double click the row’s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Enter either center frequency and bandwidth or minimum (Low) and maximum (High) frequencies.
Center:
Enter the center frequency of the band.
Bandwidth:
Enter a frequency band relative to the center frequency.

 Center frequency
Bandwidth
Band limitation

= 100 Hz
= 50 Hz
= 75 Hz to 125 Hz

Low:
Enter the minimum frequency (left band limitation).
High:
Enter the maximum frequency (right band limitation).

Level
Low:
Specify the level used for notching at minimum frequency.
High:
Specify the level used for notching at maximum frequency.
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Slope
Select a Linear or Logarithmic slope.
The default slope type now used by m+p VibControl is Logarithmic since this
is more consistent with the notch profile definition used in acceleration and
force limiting tests, a technique that was introduced some years ago and is
included in more and more vibration test projects.
For random tests, a third slope type has now been added: RMS. If you select
this option, you have to enter the RMS value for the frequency band you want
in the lower level field.
When running this test, m+p VibControl will notch the specified band to the
RMS value entered before. In practice this means that the highest lines are
reduced in level so that the RMS notch criterion is satisfied. There is no
limitation in the definition of RMS notches. Different and overlapping notches
can be defined in combination with notch capabilities used before.

RMS Notching

Alarm
Enter the alarm limit.

Abort
Enter the abort limit.
If the abort limit is exceeded, the test will be aborted.
With a doubleclick on the notch profile chart, you can have a closer look on the profile. The
graphics functions of the chart are described in chapter 5.1 “General Chart Display Functions”,
page 67.
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6.2.5.1

Notch Profile

Notch profile

Double click the notch charts to display the notch profile (vertical lines). The notch bands are
only displayed when you notch accelerometers with the corresponding PSD in [g2/Hz].
The test spectrum defined is represented in charts of acceleration, velocity and displacement.

6.2.5.2

Import Notch Table

Importing a notch table is useful for systems with high channel counts. In Sine and Random
test modes, you define an ASCII file containing the optimum notch limits for each channel and
import it every time you need them. You can import this file even if you don’t work with the maximum channel count as notch limits for channels not in use are skipped.
First define the ASCII file containing the desired notch limits. Then click the
button and select the corresponding file. Click Open to start the file
import.

6.2.5.3

Momentum Notching

In Sine and Random test modes, you can use some channels measuring force to calculate the
momentum sum. After which, you can employ these channels for moment notching (MNotch
function).
The momentum can only be calculated using transducers which measure a force
(unit: Newton).
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Define MNotch Channels

VibEdit - definition of the MNotch channels

You will first need to define the channels where the force transducers are connected to. Set the
EU of these channels to N (Newton). To define a moment notch, open VibEdit, change to the
Channels tab. Here you define a watchdog channel W with the Av-Mode MNotch (Moment
Notch) and the unit is set for "Nm". Highlight this channel and change to the section Notches
for selected channel to specify the limiting spectra by entering either Center Frequency and
Bandwidth or the Low and High frequencies as well as the Level, the Slope and the Alarm and
Abort limits.
The moment values will be checked in this frequency range. When exceeding the moment
notch spectrum, the notch function limits the drive signal in the frequency range of exceedance.
s

VibEdit - M-Notch section of the Channels tab

When you select the Av-Mode MNotch in the upper part of the window, a third section opens
in the lower part where you can define the channels used for the MNotch calculation and enter
the coordinates of the transducer.
Up to 32 channels can be defined for calculating the momentum sum. The values of the
momentum sum form the momentum spectrum of the MNotch channel. For calculating the
momentum of a transducer, you need its position (x and y-coordinate). As all transducers are
on the same level, you need not indicate a z-coordinate.
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Front

Transducer

Shaker

Top

Shaker

Transducer
A2

A3

A1

A4

Transducers and its coordinates

The calculated momentum values of the MNotch channels are checked in the entered frequency range. If the values reach the limiting spectrum, the system reduces the input signal.
It is possible to define several channels as MNotch channels.
Each MNotch channel defined is a virtual channel and can be added to the measurement
channels.
Example: If your system has eight channels and you define two MNotch channels, these
channels can be added as channel number 9 and 10.
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Moment Notching Chart in VibRunner

VibRunner chart of a MNotch channel with moment notch of frequency bands

The online chart of the MNotch channel shows the moment notch of frequency bands.

Moment Notching Chart in VibPostTest

VibPostTest chart of a MNotch channel with moment notch of frequency bands

The PostTest chart of the MNotch channel shows the moment notch of frequency bands.
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6.2.5.4

Vector RSS Notching

By calculating the resulting vector amplitude the damage to critical parts can be reduced.
This notching feature is typically used with a triaxial accelerometer. The amplitudes of the three
measurement directions are merged to one resulting vector which can be used for notching.

Define Vector RSS Notching Channels

Vector RSS notching channel definition

In the Channels tab of VibEdit you define your measurement channels as usual and a watchdog and measurement channel WM with the Av-Mode VectorRSS (channel calculating the
Vector RSS).
Highlight this channel and change to the section Notches for selected channel to specify the
limiting spectra by entering either Center Frequency and Bandwidth or the Low and High frequencies as well as the Level, the Slope and the Alarm and Abort limits.
The Vector RSS values will be checked in this frequency range. When exceeding the Vector
RSS notch spectrum, the notch function limits the drive signal in the frequency range of
exceedance.
By selecting the Av-Mode VectorRSS in the upper part of the window you open the Vector RSS
section in the lower part of the window where you can define the channels to be used for the
Vector RSS calculation.

VibEdit - section Vector RSS of the Channels tab
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Up to 32 channels can be defined for calculating the Vector RSS. The software only proposes
channels with the same unit as the Vector RSS channel.
Each Vector RSS channel defined is a virtual channel and can be added to the measurement
channels.
Example: If your system has eight channels and you define two Vector RSS channels, these
channels can be added as channel number 9 and 10.
Vector RSS charts in VibRunner and in VibPostTest are similar to those of Momentum Notching.

6.2.5.5

Summed Force Notching

Using this function e.g. force transducers can be summed digitally to eliminate the need for an
analog external summing junction as well as to ensure all transducers are within limits.
The notching feature can be used with force channels but also with acceleration channels and
other channels (e.g. to calculate the total acceleration of your test object and to limit it by
notching).

Define Summed Force Notching Channels

Summed force notching channel definition

In the Channels tab of VibEdit you define your measurement channels as usual and a watchdog and measurement channel WM with the Av-Mode VectorAdd (channel calculating the geometrical vector sum). Highlight this channel and change to the section Notches for selected
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channel to specify the limiting spectra by entering either Center Frequency and Bandwidth or
the Low and High frequencies as well as the Level, the Slope and the Alarm and Abort limits.
The values of the vector sum will be checked in this frequency range. When exceeding the
Vector Add notch spectrum, the notch function limits the drive signal in the frequency range of
exceedance.
By selecting the Av-Mode Vector Add in the upper part of the window, you open the Vector Add
section in the lower part where you can define the channels to be used for calculating the vector
sum.

VibEdit - Vector Add section of the Channels tab

Up to 32 channels can be defined for calculating the vector sum. The software only proposes
channels with the same unit as the Vector Add channel.
The selected channels can then be weighted differently using the assigned weighting factors
from the Weighting column. This function can be used e.g. with force transducers which are
fixed at a point where they do not measure exactly in notching direction. Applying the weighting
function you can perform sin φ and cos φ transformations and thus calculate a force vector in
notching direction.
Each Vector Add channel defined is a virtual channel and can be added to the measurement
channels.
Example: If your system has eight channels and you define two Vector Add channels, these
channels can be defined as channel number 9 and 10.
Summed Force charts in VibRunner and in VibPostTest are similar to those of Momentum
Notching.
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6.2.5.6

Advanced Notching

In order to eliminate the overshoot experienced in sine notches (level measured on the notch
channel is higher than the level to which the channel should notch), it is recommended to run
the sine test with notches at low level. The result file of this test can then be loaded in VibEdit.
Select Recalc. notch profile from the Extras menu.

Recalculate notch profile

Now the measurement results will be compared to the notches defined for this channel and new
notches that will limit the overshoots as much as possible will be calculated and added to the
channel notch profile. These calculated notch profiles can be displayed in VibEdit by checking
the corresponding check box.

Notch profile with recalculated values
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It is possible to store this test definition and run the test. If required, redo the calculation on the
new results.
In VibPostTest, the original notch profile always shows up on the notch channel. It is possible
to also select viewing the calculated notch profile by checking this option.

6.2.6

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.

6.2.7

Combined Acceleration/Displacement Control

Combined acceleration/displacement control

This function is available in sine mode only. It enables you to specify displacement control.
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In this way, tests starting at very low frequencies can be controlled on displacement if the accelerometer does not provide a sufficient resolution of the frequency range.
At a defined frequency you can switch from displacement control to acceleration control.
To define frequency bands to be displacement controlled, first click the line of the channel to
be defined so that the corresponding notch table is activated. Then, enter the frequency bands
into the table.

EU Control Channels

For displacement control, please select a unit of length (m, dm, cm, mm, µm
or inch) in the third drop-down list next to EU control channels.

AV mode
With a W channel and Control or Control/Tolerance selected as AV mode,
you can specify frequency bands where the sine test is to be controlled on
displacement.
To define frequency bands to be displacement controlled, first click the channel to be defined so that the corresponding notch table is activated. Then,
enter the frequency bands into the table.
Specify frequency bands by selecting either center frequency and bandwidth
or minimum and maximum frequencies. The corresponding level is read from
the reference spectrum.

No.
Consecutive row numbering.
To edit a row, click the row’s No. field.
To activate an empty row, double click the row’s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Enter either center frequency and bandwidth or minimum and maximum frequencies.
Center:
Enter the center frequency of the band.
Bandwidth:
Enter a frequency band relative to the center frequency.

 Center frequency= 5 Hz
Bandwidth
= 8 Hz
Displacement control= 1 Hz to 9 Hz
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Low:
Enter the minimum frequency (left band limitation).
High:
Enter the maximum frequency (right band limitation).

Level
The corresponding level is read from the reference spectrum.

Slope/Alarm/Abort
Not used.

6.2.8

Sine Force Control

In some cases it may be necessary to control on force, e.g. when using modal shakers and
force transducers.

Force Control

EU Control Channels
Select the required unit of the force transducer (N or lbf).

Selecting the Force Unit
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6.2.9

Sine Test Control (VibRunner)

VibRunner in sine testing (Getting Started)

Having performed the selfcheck to check the test setup on feasibility, you can now start up the
test run.

6.2.9.1

Test Status Window

A separate status (monitoring) window can be opened by clicking into the online time section.
Pulled it to the desired size. This numerical display shows the target value, the current value,
as well as the current frequency and enables you to monitor the measurement values even if
the operator is working at another workplace.

Test status window
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Time/Sweeps

Timer and sweep counter

The VibRunner displays the remaining/elapsed testing time and the number of sweeps.
The sweep counter indicates the number of sweeps done and the total number of sweeps to
go. Once the total number is reached, the test will change to standby mode. Reset the counter
before restarting the test by clicking the Reset Counter button.
Time / Elapsed
Time / Remaining
Sweeps / Elapsed
Sweeps / Remaining

6.2.9.2

Total test time which has elapsed.
Total test time remaining.
Number of sweeps done.
Number of sweeps to be done.

Sweep Direction

Reverse the sweep direction

You can manually reverse the current sweep direction.
Please take into account:
Manual action will override the schedule!

Sweep up

Reverse the sweep direction:
Sweep will run to upper frequency limit.

Sweep down Reverse the sweep direction:
Sweep will run to lower frequency limit.

6.2.9.3

Lower/Upper Frequency Limits, Sweep Rate, Sweep Factor

Sweep frequency limits, sweep rate and

sweep factor

Please take into account:
Manual action will override the schedule!
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Frequency min/Frequency max.
The lower and upper frequency limits defined in VibEdit’s Schedule tab are
displayed.
Freq. min Lower frequency limit defined.
Freq. max Upper frequency limit defined.
When reaching the upper or lower frequency limit, the sweep changes its
direction.

Sweep Rate
The sweep rate defined in VibEdit’s Schedule tab is displayed ("Sweep
rate:").
You can manually reduce or increase the sweep resolution step wise.
To change the sweep resolution, first hold the sweep by clicking the Hold
button.
Click the above sweep factor button and select an octave between 1/10
(coarse) and 1/50000 (fine). This will define the step size for the sweep
frequency steps when the manual arrow buttons are used to manually
change the sweep frequency upwards or downwards.
A finer resolution will lead to a longer sweep time while a coarser one will
sweep more quickly.
To continue the test run, click the Hold button again.

6.2.9.4

Frequency, Drive, Damping, Error

Online information

Please take into account:
Manual action will override the schedule!

Current Frequency
The current frequency is displayed in this section.
You can manually reduce or increase the current frequency by clicking the
arrow buttons. To reduce or increase the current frequency, first hold it by
clicking the Hold button.
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With the Hold button active, the arrow buttons next to Frequency will be
enabled. By clicking these buttons you can reduce or increase the current frequency.
To continue the test, click Hold again.

Drive
Drive: indicates the current drive voltage of the corresponding frequency.
You can manually reduce or increase the current drive voltage by clicking the
arrow buttons.
To reduce or increase the current drive, first hold the sweep by clicking the
Hold button.
Open the control loop by clicking the Open Loop button. With open loop control, the arrow buttons next to Drive will be enabled. (The Time Remaining
display will stop.)
To reduce the current drive level, click the arrow button pointing downwards.
To increase the current drive level, click the arrow button pointing upwards.
To continue the sweep, click the Hold button again.
To close the control loop, click the Open Loop button again.

To have the drive signal displayed in the online chart, see chapter
5.3.2 “Multiple Channel Selection”, page 83.

Damping
Damping: indicates the current controller damping.
You can manually change the damping at any time during the test run using
the two arrow buttons next to Damping.
Allowed damping factors: 0, 1, 2, 4, 8.
0 = no damping (maximum compression speed)
8 = maximum damping (minimum compression speed)

Error
Error: indicates the control error of the corresponding frequency.

To have the control error displayed on the online chart, see chapter
5.3.2 “Multiple Channel Selection”, page 83.
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Rescale Spectrum

Rescale spectrum

When your sine test is in standby mode, VibRunner allows you to rescale the test spectrum.
To do so, click the R button on the right to open the Rescale window.

Rescale spectrum factor entry

In the window above, enter the factor (in dB) by which you want to increase or decrease your
spectrum. Finally click OK to confirm.

6.2.9.5

Sine Test Specific Controls

Open Loop
In Open Loop mode, you can manually increase or reduce the drive signal.
To change to Open Loop control, click the Open Loop button. When Open Loop
shows green light, the loop is opened. In Open Loop mode, the Time remaining
display stops counting.
To close the control loop, click the Open Loop button again. The test will be continued in Closed
Loop mode.

Reset Counter
(available in standby mode only)
You can manually reset the sweep counter to "0" and restart the test.

Manual action will override the schedule.

To reset the sweep counter to "0", click the Reset Counter button. You run the complete test
again. This will reset all values to the original schedule.

m+p international

m+p VibControl Rev. 2.16

197

Sine Test Control (VibRunner)

Reset Measurement
(available in standby mode only!)
You can manually delete the traces in the online chart.
To delete the traces in the online chart, click the Reset Meas. button.

Hold/Release the Sweep
To fix the current frequency and hold the sweep, click the Hold button. The time
defined in the Schedule tab will be ignored.
To release a frequency, click the Hold button again.
With a Hold level defined in the testing schedule, the Hold button shows green light when the
Hold level is reached. A Hold level requires manual release.
To manually release a Hold level, click the Hold button.

Some test items may be damaged if a sweep is held at one frequency
where there is a resonance in the structure.

6.2.9.6

Test Log

Online test log

The lower left part of the VibRunner displays the test log. The test log lists all relevant test
events in chronological order. The online test log displays the latest information only. To view
the complete test log after test end, open the offline test log.
Select Protocol file from the File menu. Print out the test log.

Offline test log
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6.2.9.7

Run the Getting Started Test

By running a Getting Started test you can check the performance of your signal processing and
data acquisition system on a bare wire, i.e. neither a shaker nor a specimen are involved in this
testing - allowing you to learn the m+p VibControl control functions with only the measurement
front-end and a BNC cable being required.
To start up the test, first perform a selfcheck. Then you can start the test by clicking the Run
button.
The online control window displays the measured signals. The test run is performed as defined
in VibEdit’s Schedule tab.

Please try the online control functions:
•

To start up the test, click the Run button.

•

To open the control loop, first hold the sweep by clicking Hold. Then, click Open Loop.

•

To release the sweep, click Hold again.

•

To close the control loop, click Open Loop again.

•

To halt the test, click Standby. The drive signal is ramped down and the current test
status is saved.

•

To continue the test, click Run.

•

To take a manual measurement after the sweep has reached the upper or lower frequency
limit, click the Measure button. The responses of the measurement and control channels
together with the corresponding drive signal, error and control spectra are saved to hard
disk.

•

Use the online chart functions as described in chapter 5.3 “VibRunner Chart Display Functions”, page 82.

•

To definitely abort the test after the test end has been reached and store the results, click
the Abort button. This will switch the test run status from Standby to Idle and the test
results will be saved.
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6.2.9.8

Online Charts

The online charts are a useful control tool. See chapter 5.3 “VibRunner Chart Display Functions”, page 82 for the general online chart functions.
Special Sine functions are described in the following sub-chapters.

Tracking Cursor

Tracking cursor in sine

In sine mode, you can select whether to position a cursor at a fixed frequency or to have a tracking cursor which follows the current frequency.
Activate the cursor as described above.
To have a tracking cursor, use your right mouse button to click the background of the online
display.
Select Cursor follows frequency. The cursor tracks the actual frequency.
To deactivate the cursor, just drag it off the chart.
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6.2.9.9

Display of Sine Responses and Drive after Selfcheck

After performing a selfcheck in sine mode, the sine responses of the control, watchdog, and
measurement channels and the pre-calculated drive will now be displayed graphically.

Display of sine responses and pre-calculated drive

6.2.9.10 Filter Modes Display Selectable
For sine and sine data reduction test modes it is possible to define several filter modes for a
measurement channel and to view them in the VibRunner software application window. For
information on the filter type selection, please refer to chapter 6.2.4.8 “Define the Sine Channel
Parameters Table”, page 171.
Open the chart context menu and select the Show all filter modes function and the selected
filter modes will be displayed on the chart.
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6.2.9.11 Displacement and Velocity Display Selectable
In VibRunner Sine and Random tests, it is possible to calculate displacement and velocity from
the measured acceleration using the corresponding math function and to display the results
online.
Right-click the relevant online display to open a context menu and select one of the mathematical functions Differentiate or Integrate, depending on the parameter you want to display.

Online display showing calculated velocity (upper chart) and displacement (lower chart)
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velocity and displacement:
Velocity:
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6.2.9.12 Notch References Displayed Online
m+p VibControl includes display overlay of the notch profiles in both the data controls. The
feature allows the user to verify online the notch performance or any notch selected channel.

Notch reference overlay screenshot

Show/Hide
Warn limits
Abort limits
Reference signal

Alarm limits.
Abort limits.
Reference spectrum/pulse.

To hide the reference spectra/pulses, their alarm and/or abort limits, use your right mouse button to click the background of the online display.
To hide a trace, click its name from the menu with your mouse button so that it is un-checked.
To show a trace, click its with name from the menu so that it is checked.
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6.2.9.13 Online Calculation of Transfer Functions
VibRunner is able to provide online calculation of transfer functions.
Right-click anywhere in the chart area to open the context menu and select a signal and a
reference.
m+p VibControl will then automatically calculate the transfer function between the selected signal and the reference signal, and will display it online when running the test in VibRunner.

Select reference signal for online calculation of transfer function

6.2.9.14 Frequency Domain View and Time Domain View
In Random and Sine test mode you can decide whether your online data shall be displayed as
frequency data or as time data.

Frequency data (random)
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To switch from frequency domain view to time domain view right-click with your mouse on the
desired chart. The context menu opens where you can select the Time Domain option.

VibRunner context menu

The Time Domain mode only shows measured channels from the channels table. Error and
drive channel cannot be displayed in this mode.
It is also possible to simultaneously switch all frequency data charts to time domain charts with
a click on the Time Domain View button.

Time Domain View button

The selected button will turn red. With another click on the button you switch back to the
Frequency Domain view.

m+p international

m+p VibControl Rev. 2.16

205

Classical Shock Test Mode

6.3

Classical Shock Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: define the test run profile/s

•

Specimen: enter the properties of the shaker and the specimen

•

Schedule: define the selfcheck properties and the test schedule

•

Channels: define the channel properties

6.3.1

Define the Classical Shock Reference (VibEdit)

Reference pulse defined (Getting Started)

Define the classical shock reference pulse as acceleration versus time.
When using an electrodynamic shaker, the pulse is often limited by the
maximum displacement of the shaker. The chart shows you whether the
displacement of the defined pulse is too large for the shaker or not.
In addition, feasibility of this setup is checked.
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Wave form
Have a look at the wave form buttons. Here, you select which pulse type to define.

Selectable wave forms

Select which wave form to define by clicking the corresponding button. If you have selected
Half Sine, Sawtooth (Triangle), Rectangle or Trapezoid, proceed with entering the time and frequency parameters (see following chapters).
HaverSine wave forms can also be defined as shock pulses.
This is done by using the following formula:
ai = A/2 * ( 1 – cos ( 2i/N ),
where N stands for the number of samples in the shock and i loops from 1 to N.
If you have selected External Pulse, proceed with chapter 6.3.1.4 “External Pulse Builder”,
page 225 and then return to the chapters following here.

6.3.1.1

General Parameters

The following parameters are defined for the wave forms:
Half Sine, Haversine, Sawtooth-Triangle-Trapezoid,
and partly for the External pulse and the Crashtest.
Parameters which are only needed for a special waveform are explained in the corresponding
chapter.
In the following paragraphs we describe the sections of the Classical Shock Reference window.

Main Pulse

Main pulse section

Main Pulse Peak
- Type the main pulse peak (acceleration) in [g] or [m/s²].
- To change the unit, see chapter 6.3.1.5 “Select the Units”, page 228.

RMS Value
m+p VibControl calculates the RMS pulse. This value is a reference value
when defining the effective alarm and abort limits in the Channels tab.
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Main Pulse Length
Type in the main pulse length in [ms].

The main pulse length must not exceed one third of the total pulse
length. If the main pulse length selected is too long, the data field
will be high-lighted red.

Measurement

Measurement section

Sampling Rate
Select the sampling rate in [Hz].
Available values: 128, 256, 512, ... , 65536
Sampling rate = 2.56 filter cut-off frequency
Sampling rates, which are not supported by the hardware in use, are
marked by a gray background. You can select these sampling rates
for defining a test with another (not connected) front-end. This test
definition can be saved, but needs the required hardware to start.

Number of Samples
Select the number of samples in the pulse.
Available values: 256, 512, 1024, ... , 65536

Total Window Length
m+p VibControl calculates the total window length in [s]:
number of samples
total window length = --------------------------------------------------sampling rate

Window Usage
Specify the length of the pulse in the graphics window (chart) in [%]. The
maximum length of the pulse is 100% (default setting). If you select a value
less than 100%, the pulse in the graphics window will shift to the beginning.
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The pre- and the post-pulse will change, and consequently, the displacement
and the velocity will also change.

Offset
With an External Pulse file loaded, the pulse defined can be delayed by a
time offset.
Enter the time offset in [ms].

Compensation

Compensation section

Compensation Type
The available compensation types are:
Symmetric, Custom, Drop Table, Fit displ., Optimal displacement
The compensation types are described in detail in chapter 6.3.1.2 “Compensation”, page 213

Peak-Peak Displacement
To have a pulse displacement in both directions (Peak-peak displacement),
check the box with a click of your mouse button. To have a pulse displacement in one direction, leave the box unchecked. “Peak-to-peak displacement“ optimizes the pulse displacement since the pulse will show a
displacement in both directions.
When selecting “Peak-Peak displacement“, make sure that the
shaker is in center position. Otherwise, it may happen that the
shaker reaches its overtravel limit.

Pre-Pulse Tolerance
Enter the pre-pulse tolerance in [%] relative to the main pulse peak.
For kinematic reasons, the pulse defined by the main pulse length is preceded and followed by a pre- and a post-pulse. Specify the total pulse length
such that the pre-pulse will not be cut off. If the pulse is one third of the total
pulse length, m+p VibControl accepts the user-defined
pre-pulse tolerance. Otherwise, m+p VibControl will specify a pre-pulse tolerance. When changing the pre-pulse tolerance, m+p VibControl will adapt
displacement and velocity accordingly.
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Postprocessing

Postprocessing section

Clipping
With the clipping function selected, you enter a lower (Min) and upper (Max)
amplitude limitation. In this way, the amplitude will be clipped above or below
the entered value. To activate the clipping, check the Clipping box. Enter a
lower (Min) and upper (Max) amplitude limitation in [g] or [m/s²].
To deactivate the clipping, leave the Clipping box unchecked.

Filtering
Frequency analysis is necessary to reveal the individual frequency components that make up the broadband signal. Filtering the output allows to measure frequency components of a specific frequency band only. To have a
separate testing at individual frequencies, move the pass band of the filter
sequentially over the whole frequency range. Select the filtering.

Cut-Off Frequency
The filter cut-off frequency in [Hz] is calculated from the above sampling rate:
sampling rate
filter cut-off frequency = ------------------------------------2.56

Alarm/Abort Limits

Alarm and abort limits section

Alarm Limit
With Alarm Table active unselected, you define an alarm limit. The alarm limit
will be at constant distance from the trace.
Enter the alarm limit in [%] of the maximum absolute acceleration. Positive
and negative values are allowed. For a positive value, do not enter a positive
sign; but for a negative value, enter a negative sign.
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Abort Limit
Alarm Table active unselected:
Define the abort limit in [%] of the maximum absolute acceleration. Positive
and negative
values are allowed. For a positive value, do not enter a positive sign; but for
a negative value, enter a negative sign. The abort limit will be at constant distance from the trace.
With Alarm Table active selected:
Define the abort limit in [%] of the entered alarm limits. Positive and negative
values are allowed.

Alarm Table

Alarm table active

With Alarm Table active selected, you can specify alarm limits according to any industry testing
standard (e.g. MIL-STD 810, DIN, GAM-EG 1B, ...). At the same time, the Alarm limit field
below is disabled and replaced by a comment field.
The table specifies breakpoints; the alarm trace results from the connection of these breakpoints. To enter a jump in amplitude, enter the same time twice with different amplitude values.
The amplitude of the first breakpoint will also be used for the samples before the first breakpoint
and the amplitude of the last breakpoint will also apply to the samples after the last breakpoint.
To activate the alarm table, check the box with a click of your mouse button. To deactivate the
alarm table, leave the box unchecked.
With the alarm table active, click the “>>>“ button to open the alarm limits definition table.

Alarm limit definition table (half sine according to MIL-STD 810E)
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Enter the breakpoints for upper and lower alarm limits.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Time
Enter a time relative to the main pulse length.
0: Start of the main pulse
1: End of the main pulse
The table will be sorted by increasing times.

Amplitude
Enter an amplitude relative to the main pulse peak.

Type
R: Amplitude is relative to the pulse amplitude.
A: Amplitude is absolute.

Saving and Loading of Alarm Tables
VibEdit allows you to save alarm tables in ASCII format, allowing you to load them later for
reuse.
Click the Save button to open a File Save dialog window in which you can enter your preferred
file name and target directory of the alarm table to be stored in ASCII format. Finally click OK
to confirm, or click Cancel to abort.
In order to load an alarm table you have saved previously, click Load and select your preferred
alarm table file in the File Open dialog window.
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6.3.1.2

Compensation

For the Half Sine, Haversine, Sawtooth-Triangle-Trapezoid waveforms you can define various
compensations.
First you define the general parameters as described in the previous chapter (6.3.1.1).
Then select the compensation types to vary the form of the pulse.

Compensation types

Select Symmetric to define symmetric pulse forms. You only need to define the pre-pulse as
it already determines the form of the post-pulse.
Choose Custom to define modified sine pulses, e.g. Sine Rounded or Sine Square. You need
to define the pre- and post-pulses for theses waveforms because they are not symmetric.
Select Drop Table to carry out a Drop Table Simulation. It simulates the pulse which occurs
when an object drops on a table. The characteristical element of this waveform is the pre-pulse
phase without an amplitude. Then the pulse follows and a post-pulse which is defined in a table.
Choose Opt. displ. (optimal displacement) to use rectangular waveforms for the pre- and postpulses, in order to minimize the required displacement.
Choose Fit Displ. (Fit Displacement) if you want to fit a pulse into a given displacement distance.

Symmetrical Pulse
For symmetrical pulses, you only need to define the pre-pulse as it already determines the form
of the post-pulse.
The symmetrical acceleration and displacement compensation is the usual method up to m+p
VibControl Revision 2.10. You have to determine window length and tolerance and both are
fully utilized.
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Symmetrical pulse

If the determined window length is too large, very low accelerations will be used for the Peakpeak-displacement. This effect can be avoided by increasing the Number of samples or decreasing the Window usage in the Measurement section.

Symmetrical pulse, window length too large
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Minimum Compensation Frequency
It is also possible to define a Min. comp. frequency (minimum compensation frequency). This
will limit the frequency of the waveforms used to create the compensation pulses in order to
prevent waveforms with low frequencies and amplitudes.
Low frequencies and amplitudes are responsible for large displacements. It is difficult to measure them using acceleration transducers.

Minimum compensation frequency defined

If the displacement usage is above 50 % of the shaker limit and the minimum frequency is set
to a value below the recommended limit, a warning will be shown.

Minimum compensation frequency is too low

When you toggle the mouse button over the Min. comp. frequency field, a help text will pop up
providing further information.
Min. comp. frequency is used to limit the frequency of the waveforms used to generate the compensation pulses. A higher value will prevent waveforms with low frequency and amplitude and
improve the displacement usage.
The following chart shows an example of a symmetric compensation without frequency limit.
The compensation signal uses the whole window length and has very small amplitudes.
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Symmetric compensation without frequency limit

Setting the minimum frequency to 12 Hz will compress the signal and generate larger amplitudes of acceleration, which are easier to control.

Symmetric compensation with frequency limit

In case of problems with the pre-pulse tolerance see also the Optimal Displacement compensation type,

Controller Displacement Check
The controller now checks the displacement usage during runtime and stops the test as soon
as the shaker limits are violated. This is checked with every change in amplitude level.

Displacement check - problem detected
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Sine Rounded/Sine Square
The Sine Rounded and the Sine Square require a pre- and post pulse definition as the waveform is not symmetrical.
Select the Custom compensation type. Now further selection windows are provided for
choosing the pre- and post-pulse types:

Selecting pre- and post-pulse types

The compensation is done using different pre- and post-pulse types:
•

Sine: Full sine wave. Positive and negative half-wave are weighted differently.

•

Rounded: Mixed sine waves {1.155 · sin(x) + 0.231 · sin(3x)}. Positive and negative halfwave are weighted differently.

•

Square: Full square wave. Positive and negative half-wave are weighted differently.

•

Sine Decay (for post-pulse only): Full sine wave, weighted using the exponential function
{sin(x) · x^y}.

•

Rounded Decay (for post-pulse only): Full rounded wave, weighted using an exponential
function.

Define the tolerances. The pre-pulse tolerance will always be fully utilized. Depending on the
selected parameters it can happen that the post-pulse tolerance cannot be fully utilized,
because this would lead to invalid pulses.
In addition you can determine a frequency limit and a displacement limit for the pre-pulse.
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Sine Rounded wave form

A pre-pulse frequency limit or displacement limit is indicated by a yellow input field. The window
usage depends on the length of the generated pulse. A window usage above 100% means that
the defined pulse will not fit into the given window. In this case you should modify the corresponding parameters so that the pulse will not exceed the window usage.

Sine Square wave form with exceeding window usage
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Drop Table Simulation
The Drop table simulation shows what happens when an object falls on a table. The shaker
replicates the generated pulse. The characteristical element of this waveform is the pre-pulse
phase without amplitude. Then the pulse follows and a post-pulse which is defined in a table.
The compensation without pre-pulse is done making the best possible usage of the maximal
displacement. The window length and the maximal displacement are defined by the user. The
tolerances displayed are calculated from the necessary acceleration and cannot be determined. A yellow input field indicates that the displacement limit (max. displacement) is active.
A maximum displacement which is too short or too long can lead to unusable results.

Drop Table simulation waveform

If the maximal displacement is not reached, the time for the closing displacement compensation (the shaker returns to the start position) is too short. This results in very high accelerations
which can be avoided by defining a shorter maximal displacement or a larger window length.
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Drop Table simulation, maximal displacement too long

If the main pulse displacement is close to the maximal displacement, very high accelerations
are needed for staying within the maximal displacement limit. This can be avoided by defining
a longer maximal displacement. Another possibility is to reduce the length and the amplitude
of the main pulse.

Drop Table simulation, maximal displacement too short
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Optimal Displacement
The Optimal Displacement compensation type uses rectangular waveforms for the pre- and
post-pulses to minimize the required displacement.

Optimal Displacement compensation type selected

The following chart shows a half-sine pulse with optimal displacement compensation.

Half sine pulse with optimal displacement compensation

Fit Displacement
The compensation is done staying within the limit of the maximal displacement or making best
possible usage of the maximal displacement. The window length and the maximal displacement are determined by the user. The indicated tolerances result from the necessary acceleration and cannot be defined by the user.
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Fit Displacement wave form

A yellow input field indicates that the displacement limit (max. displacement) is active. A maximal displacement which is too short can lead to unusable results.

Fit Displacement with active displacement limit

If the window length was chosen too large, very low accelerations can occur. In this case the
number of samples or the window usage should be reduced.
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Fit Displacement, window length too long

Too short maximal displacements can lead to very high accelerations. To avoid this, you should
define a longer maximal displacement. Or you should reduce the length and the amplitude of
the main pulse.

Fit Displacement, maximal displacement too short
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6.3.1.3

Sawtooth - Triangle - Trapezoid

When you have activated this tab, you can define the waveform using the initial slope and the
final slope time.

T1 / T2 (Initial and Final Slope Time)
To generate the desired pulse, dimension initial slope time T1 and final slope time T2 as appropriate according to the following relations:
T1 = T2 = 0 Rectangle
T1 = D, T2 = 0Sawtooth (Triangle)
T1 = T2 < DTrapezoid

The initial slope time T1 and the final slope time T2 must not exceed
the main pulse length D.

Classical waveforms

From top to bottom:
Half sine
Sawtooth/Triangle (T1 = D; T2 = 0)
Trapezoid (T1 = T2)
Rectangle (T1 = T2 = 0)

where:

D = main pulse length, D1/3 T
T = total window length (T = number of samples
/sampling rate)
V = pre-pulse tolerance
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6.3.1.4

External Pulse Builder

External pulse in classical shock

You can specify any pulse shapes by entering only some values. These pulses will then be output by the shaker. m+p VibControl checks the pulse shapes specified by you for their shaker
compatibility and carries out a compensation. Thus, damage to the shaker is excluded.
You can also use measured time sequences which saves you the time-consuming synthesis
of pulses. For instance, you can test airbags using measured crash signals.
External pulses can be integrated both into classical shock tests and shock response spectrum
tests. They will be specified directly in the Reference tab of these test modes.
With External Pulse selected, you can load an external pulse file:

Selecting an external file

1. To load an external pulse file, click the “>>“ button.
2. To edit an external pulse file, use the External Pulse Builder:
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VibEdit, external pulse builder

The External Pulse Builder allows you to specify shock pulses from either individual shocks or
from an external ASCII file such as is acquired through crash testing or earthquake tests.
Open the Windows Explorer and select “C:\VcpNT\Bin\External Pulse Builder.exe“.

Filter Band 1/Filter Band 2
Two filter bands are definable for lower and upper Fourier Band-pass filter
frequencies. These allow the user to filter out unwanted frequencies such as
low frequencies that can cause shaker-damaging high displacements or high
frequencies which can flood an amplifier.

Max. Acceleration
Allows the user to change the maximum acceleration of the pulse. For example if a pulse shape is entered in values ranging from -1 to 1 g, the control
system will automatically adjust the pulse so the +-1 = Max. Acceleration.

Compensation
The compensation function forces the displacement, velocity, and acceleration to be 0 at the end of the pulse. As a result this function will change the
shape of the original pulse. Compensation is usually necessary so that there
is 0 displacement and/or velocity at the end of the pulse output.
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Zero Padding
Normally the system will automatically center the pulse in the pulse window.
With this function selected, the pulse will be placed to the left of the pulse window by entering 0‘s for acceleration values after the pulse.

DC Removal
Used primarily when an ASCII file is imported from test data that may have
had a DC offset from acquisition.

Time offset
Enter the time offset in [sec]. The pulse defined below will be delayed by this
time.

Acceleration offset
Enter the acceleration offset in [g‘s]. The pulse defined below will be shifted
by this value.

Pulse Encoding
Individual parts of the overall pulse can be defined as follows:
Time/Accel:
Enter an acceleration value and time.
Half Sine:
Enter Starting time T, duration, and Acceleration to define a half-sine wave.
Sine:
Enter starting time T, duration, period, phase and acceleration offset to define
a sine wave.
PrePulse:
Enter duration 1 and duration 2. Velocity and displacement will be compensated for by defining two waves. This is an alternative to using the compensation function which will not change the defined pulse.
Postpulse:
Enter Starting time, duration 1 and duration 2. Velocity and displacement will
be compensated for by defining two waves. This is an alternative to using the
compensation function which will not change the defined pulse.

Import of a Pulse File (ASCII)
To import an external ASCII file, click Read Pulse File. The “Choose Data Type“ dialog opens.

Choose data type
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Check Constant time step and enter a time value if your ASCII file only contains amplitudes at
a predetermined sampling rate. If your ASCII file has time and acceleration values, click OK.
The Open file dialog box opens.

The ASCII file you wish to import should be able to be viewed with
Wordpad. Find the ASCII file you wish to import and click “OK“.

6.3.1.5

Select the Units

Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All numerical and graphical reference data will be converted automatically.

6.3.1.6

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.
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File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.

6.3.1.7

Check the Reference Charts

The spectrum defined is also represented in the charts. Check the defined spectrum with the
m+p VibControl chart display functions. To switch from time to frequency domain or vice versa,
click the Freq. or Time check box above the charts. There are different types of shock spectra
to be taken into account. The following charts are available:
Time:

Acceleration:
Velocity:
Displacement:

Control channel as acceleration versus time.
Velocity of the control channel.
Displacement of the control channel.

Frequency:

Acceleration:
FFT Phase:
FFT Error:

Control channel as acceleration versus time.
Fast-Fourrier-Transformation with phase.
Fast-Fourrier-Transformation with magnitude.
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6.3.1.8

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in VibShakerDef. The
necessary force is calculated using an SDOF model.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of
signal lamps):
Color
Red
Yellow
Green

Shaker load
100% (shaker limits exceeded)
 90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%.The program does not block the Start button!
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6.3.2

Load the Shaker and Define the Specimen
in Classical Shock Test Mode

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.
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6.3.2.1

Shaker

Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
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To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.

General Shaker Settings

General shaker settings

Mass Unit Selection
Select the desired mass unit [lbs] or [kg]. When you change the mass unit,
the values will be converted accordingly.

Moving Coil Mass
The moving coil mass entered in VibShakerDef is displayed.

Total Weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial Stiffness
The axial stiffness entered in VibShakerDef is displayed.

Maximum Input Voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input Voltage Limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in VibShakerDef by setting an input voltage limit for the power
amplifier.
The input voltage of the power amplifier corresponds to the output voltage of
the source module. If the admissible voltage is exceeded, the test will be
aborted.
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Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

Max. voltage first drive
This function provides a drive limitation for classical shock test modes.
The Max voltage 1st drive applies to Classical Shock tests.
It defines the permitted maximum voltage for the first drive signal (applies to
the first pulse after selfcheck).
This is a safety feature, therefore it is important to enter a sensible value!
As a guideline you can enter a value which is 12 dB below full scale of the
amplifier input voltage. It is a realistic choice for many cases, but of course
the entered value depends on the current system setup.
If you still want to start the test you can select a lower value for the first level
(e.g -18 dB instead of -12 dB) or increase the Max. voltage 1st drive value.

The Max. voltage first drive is a safety feature preventing an unintended test start with too high levels.

6.3.2.2

Define the Specimen

Define the specimen
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Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.
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6.3.2.3

Define a Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.

Weight:

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

6.3.2.4

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.
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6.3.2.5

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in the VibShakerDef.
The necessary force is calculated using an SDOF model.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of
signal lamps):
Color

Shaker load

Red
Yellow
Green

 100% (shaker limits exceeded)
90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%. The program does not block the Start button!
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6.3.3

Define the Classical Shock Schedule

Classical shock testing schedule

With the testing schedule, you define the sequence and the duration of the test levels, and
when to take a measurement.

External shutdown time
Enter the time in [ms] to ramp down the drive signal in case of an emergency
shutdown. This function requires an Emergency OFF switch being connected
to the bridged output channels of the front-end in use. For further information
on the emergency shutdown, please refer to chapter 2.9 “External Shutdown”, page 14.

External trigger
With External Trigger selected, the shock can be triggered by an external
device, e.g. a climatic chamber control.



The specimen is located in a climatic chamber. The climatic chamber control will trigger the pulse generation at a specified temperature (e.g. - 10°).

Bypass low-pass input filter
With Bypass low-pass input filter selected, the integrated anti-aliasing filter is
bypassed and you will work with the unfiltered signal. By default, this function
is unselected.
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Repetition rate
In VibRunner, you can either run single or repetitive pulses. The repetition
rate is interesting for repetitive pulses only.
Select the repetition rate such that it does not exceed the rate allowed by the
total pulse length.



A total pulse length of 250 ms permits a maximum rate of 4 pulses
each second.
In addition, you must take the computing time into account.

Define the number of pulses which are output to the shaker each second.
1 Hz = 1 pulse/sec

The repetition rate must allow a complete pulse length in time before
a new pulse is delivered.

Control Strategy
Choose a control strategy.
Either Update after each pulse
or Update after five pulses.

Selfcheck
Selfcheck is useful for verifying the test definition and the channel setup as
well as for recording a first structural response of the specimen. The standard
selfcheck is done with a fixed output level. For more information on the selfcheck function, please refer to chapter 3.3.7 “Selfcheck”, page 44.

Selfcheck mode
- Fixed Level:
Standard selfcheck is done using a fixed output level. This level is defined
in the Selfcheck level (100 mV) field,
You can manually define an attenuation shape using the >> button.
For further information please refer to the Selfcheck Attenuation paragraph
on page 119.

Selfcheck - fixed level settings
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- Limiter Mode:
In Limiter mode, selfcheck is done using variable output levels. Starting with
a low level that is defined in the Min. selfcheck level (100 mV) field, the selfcheck will gradually increase to the value specified in the Max. selfcheck
level (100 mV) field. In order to achieve a good signal-to-noise ratio while
avoiding a too high load on the specimen, the response is limited to a reasonable value. Any spectral lines which are too close to the reference spectrum or notch limits are automatically reduced to a safe value.

Selfcheck - Limiter mode settings

Selfcheck level (100mV)
Enter a lowering of the drive signal for the selfcheck in [dB] referred to 0.1
Vrms. The selfcheck level [dB] = 20 log (Vrms / 100 mVrms )
0 dB = 0.1 Vrms in selfcheck. Lowerings of  0 dB are allowed.
You determine the selection of the selfcheck level through experience and
engineering judgement. Be aware that a very low selfcheck level may result
in very small signals which do not lie above the system background noise.
For applications such as servo-hydraulic exciters where selfcheck levels of
0.1 Vrms do not cause accelerometer response to run a test, selfcheck levels
of > 0 dB are also accepted by m+p VibControl for Sine, Random and RoadLoad modes. A maximum level of 0.5 Vrms should be sufficient for selfcheck
with such applications.

Selfcheck gain level limit
The selfcheck gain level limit states by what tolerance the system gain
measured during the selfcheck is allowed to deviate from the system gain
defined in the Channels tab.

Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line
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Selfcheck attenuation defined

Throughput section
The Throughput section in the Schedule tab offers several options for
throughput start and stop settings.

Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.

Pulse Table

Pulse table

The pulse table defines how many pulses will be output on each level.
Define which control command to perform at which level and for how many pulses. Also enter
the initial pulse polarity (Direction). This definition can be modified in VibRunner during the test
run.
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The commands will be performed chronologically as listed.

No.
Consecutive row numbering.
To edit a row, click the row’s No. field.
To activate an empty row, double click the row’s No. field.
To copy or move a command: Mark the command line and use the usual copy
and paste functions.

Level
Pulses:
Define the level in [dB] and the number of pulses relative to the reference
level. You define how long the controller remains on a level. You can enter
negative values and "0". The level refers to the nominal pulse. The 0 dB level
corresponds to the reference value of the main pulse peak specified in the
Reference tab.
With a click into the command column you can choose a command for this
line. For the level definition go to the Level column to enter a level and to the
Pulses column to enter the number of pulses for the test.
After the first pulse there is an estimation of coherence used to increase or
decrease the level. Therefore, m+p VibControl provides a very fast signal
output control.
If, at a lower level, the abort criteria of the control channel are exceeded, the
test will enter standby mode.

Available Pulse Table Commands
Level
Using the Level command, you can define how long the controller remains on
a level.

Hold:
Define the hold level in [dB] and number of pulses.
You can hold the structure at a defined level until you manually release the
fixed level in the VibRunner. Afterwards, the next command defined in the
testing schedule definition window is executed.
To define a Hold level, go to the Level column and enter the desired level in
[dB] in relation to the specified level and enter the desired number of pulses
into the Pulses column.

Measurement:
Using the Measurement command you trigger a measurement at any level
and store it.
After the test, you can analyze the measurements in VibPostTest.
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You should prepare the measurement within the pulse table. This means that
the controller should have remained on the level for some time before you
start the measurement. Thus, you make sure, that the measurement is carried out on the given level. You avoid that the desired level has not been
reached yet when the measurement is triggered which would lead to a measurement at two different levels and corrupted measurement results.
At test end, the measurement results are saved automatically.
To define a measurement, select Measurement in the commands list.
Insert a line before and the Measurement command line containing a Level
command, defining the level for the measurement.
When a measurement is performed, the last pulse is stored.

Direction:
Select up or down to define the initial pulse polarity.
Make sure you check the specimen characteristics and the position
of the shaker table before you change the pulse polarity. Otherwise,
changes in the pulse polarity may cause severe damage, if the
specimen has non-linear characteristics or if the shaker table has
been removed from its center position. Changes in the pulse polarity
could then exceed the displacement limit of the shaker. Please
check carefully!

Marker, Repeat
Define a loop that executes the same commands several times.
You can enter any number of loops in the testing schedule.
Start the loop with Marker and finish it with Do repeat = ?.
At Do repeat, enter an integer to define how often the loop is to be repeated.



Marker, Do-repeat=4
The commands between "Marker" and "Do repeat = ?" will be executed five times (four repetitions). Then, the next command will be
executed.

Standby
Enter the Standby (timed pause) in [s].
You can define a time interval during which the test will remain in standby
before continuing automatically.

Start Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput start using this command.
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Stop Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput stop using this command.

Disable Control
Using this command you can disable the control strategy of the test and set
it to open loop mode.
This option should be used very carefully, because it is not possible to return
to closed loop mode.
To change to open loop mode, it is preferable to use the VibRunner
control buttons, because this offers the option to return to closed
loop by another click on the Open Loop button.
But this way also should be used very carefully!

6.3.4

Define the Classical Shock Channels

Classical shock channels tab

In the Channels tab you define where the control signal is connected. Additional measurement
channels are possible in any unit. If, for example, the position/displacement has to be
monitored, a displacement transducer must be connected to a measurement channel.

General Channel Parameters
EU Control Channel
Control channels can be defined for accelerometers only. Select a unit of acceleration.
In the classical shock mode, only one control channel can be defined. All other channels must
be measurement channels.
The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.
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Transducer Database
The TRANS button leads you to the Transducer database list:

Transducers’ list

m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.

TEDS Support
Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to IEEE
1451.4. This feature is useful for high-channel count vibration control systems and for applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of the
sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, as well as by VXI Technology's
digitizer module VT1435/1436.
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Define the Classical Shock Channel Parameters Table

Classical shock - channel parameters definition

No.
The number of channels depends on your software license.

In classical shock mode, only one control channel is allowed. All
other channels must be measurement channels.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input modules, take the slot number into account.

Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel
only one control channel can be defined

W

= watchdog (= limiting) channel

M

= measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.
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Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit. If - for instance - a displacement transducer is used, enter mm
and [mV/mm] will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditionning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".
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Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.

Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.
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SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

V-Type
Select the virtual channel type, e.g. Vector add.

Alarm
Low, High:
Enter the lower (Low) and upper alarm limits (High).
The alarm limits refer to the RMS value of the pulse. The reference RMS
value is calculated in the Reference tab.
For the control channel, set the unit in the EU control channel field above the
table. [g] or [EU] are absolute entries, whereas [dB] refers to the current level
(relative value).
The lower/upper alarm limit values must be lower than the lower/upper abort
limit values.

Abort

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.
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Enter the abort limits (RMS). The abort limits are always entered as RMS
values. The system only aborts at 0 dB and in repetitive mode.
The abort limits refer to the RMS value of the pulse. The reference RMS
value is calculated in the Reference tab.
For the control channel, set the unit in the EU control channel field above the
table. [g] or [EU] are absolute entries, whereas [dB] refers to the current level
(relative value).
The lower/upper abort limit values must be higher than the lower/upper alarm
limit values.

6.3.4.1

Vector Add Function

This feature can be used with force transducers (e.g. force transducers can be summed
digitally to eliminate the need for an analog external summing junction), accelerometers
(e.g. to calculate the total acceleration of your test object), or any transducer where summing is
useful.

Define Vector Add Channels

Vector add virtual channel definition

In the Channels tab of VibEdit, define the channels to be summed as a M (measurement) type
channel. Then, configure a W (watchdog) channel as a virtual channel with the V-Type
VectorAdd (channel calculating the geometrical vector sum).
Note that the virtual channel must be selected above the number of physically available channels. For example on a system with 16 channels, the 17th channel or higher may be used as a
virtual channel.
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The V-Type Vector Add selection opens the Vector Add section in the lower part of the window
where you can select the channels to be used for calculating the vector sum and define the
weighting factors to be applied.

VibEdit - Vector Add section of the Channels tab

Up to 32 channels can be defined in the Vector Add section. (Note that the software only proposes channels with the same unit as the Vector Add channel). The selected channels can
then be weighted differently using the assigned weighting factors from the Weighting column.

6.3.4.2

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.

6.3.5

Classical Shock Test Control (VibRunner)

VibRunner in classical shock testing
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Having performed the selfcheck to check the test setup on feasibility, you can now start up the
test run.

Pulses

Pulse counter

The VibRunner displays the total number of pulses done/remaining and the number of pulses
done/remaining on the current level.
Total / Elapsed
Total / Remaining
Level / Elapsed
Level / Remaining

Total number of pulses done.
Total number of pulses to do.
Number of pulses done on current level.
Number of pulses to do on current level.

Generate a Pulse

In VibEdit’s Schedule tab, you have defined how many pulses to output on which level, and a
repetition rate for repetitive pulses.
To generate repetitive pulses, click Rep. Pulse or,
to generate pulse by pulse, click Single Pulse as required.
To generate the pulse(s), click the Run button.
With Single Pulse selected, click Single Pulse for every pulse to be generated.
With Rep. Pulse selected, the pulses are now generated automatically.
You can change between Single pulse and Repetitive pulse at any time. The active mode
shows green light.
After 5 pulses there is an estimation of coherence used to increase or
decrease the level. Therefore the number of pulses at a lowered level (< 0
dB) should always be 5 or a multiple of 5 (10, 15, ...). If, at a low level, the
abort limits of the control channel are exceeded, the test will change to
standby mode.

Repetitive Pulse
If you click the Rep. Pulse button, followed by a click on Start, pulses are output at the repetition rate entered in VibEdit’s Schedule tab. After reaching the
defined number of pulses, the system advances automatically to the next
level provided that the pulse has not exceeded the abort limits (see below calculation of abort limits). Otherwise, a message is displayed after the defined
number of pulses has been reached.
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Single Pulse
Clicking the Single Pulse button generates a single pulse. To generate further pulses, wait until the preceding pulse is output and the response is measured. When reaching the number of pulses defined in the testing schedule
definition window, the system advances automatically to the next level provided that the pulse has not exceeded the abort limits.
The abort limits are calculated as follows:
(level (dB)/20
abort level(%)
a abort  t  = a ref (t)   a nominal  -------------------------------------  10


100
with anominal = maximum magnitude of aref.

The upper and lower abort limits are shifted parallel to the reference curve in the time domain,
when the alarm table has been disabled in VibEdit’s Reference tab.
aref

anominal

Abort level

Level

5g

10 g

40%

-3 dB

= 5 g + 10 g · 40%
------------ · 10(-3 dB/20)

aupper abort (t1)

100

= 7.83 g
= 5 g - 10 g · 40%
------------ · 10(-3 dB/20)

alower abort (t1)

100

= 2.17 g
If the pulse exceeds the abort limits, the reference signal remains at the current level. Now you
can generate further single pulses. The number of pulses defined in VibEdit’s Schedule tab is
ignored; at 0 dB level, however, only the defined number of pulses can be output.
If the level is fixed (Hold), you can generate more pulses than you defined in VibEdit’s Schedule
tab.

Level

Level controls

The VibRunner displays the previous, current and next test level.
Next Level
Current Level
Previous Level

Next tested level.
Currently tested level.
Previously tested level.

You can manually go one level up or down, or hold a test level until manual release.
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Up
Hold

Go to the next level.
Hold / Release the current level.

With Hold activated in Single Pulse mode, the number of pulses defined in VibEdit’s Schedule
tab is ignored. If a hold level was defined, the level remains fixed until you click Hold.
Down

Go to the previous level.

Non-Linearity (Drive)

VibRunner, classical shock, drive is increased by 2 %

By default, the drive output is linear to the control channel response. If required, manually
increase or reduce the drive output online in the VibRunner by entering a non-linearity factor
in [%].
At Non-Linearity [%], define a factor in [%] by which to increase (positive factor) or reduce (negative factor) the drive.
Confirm with the Enter key or directly perform the next action (e.g. generate a new pulse with
a click on Single Pulse). The new non-linearity is already active and documented in the test log.

Open Loop
In Open Loop mode, the drive signal will not be updated and the pulse counter
will stop.
To change to Open Loop control, click the Open Loop button. When Open Loop
shows green light, the loop is opened.
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In open loop control, only the upper abort limit is active. Once you select
closed loop control, the lower abort limit will be taken into account, too.
So the test will be aborted as soon as the upper or lower abort limit is
exceeded.

Before closing the control loop, check the reference spectrum in any case.
If the reference spectrum deviates considerably from the measured one,
you must not close the control loop.
In this case it is recommended to start the test at a lower level.

To close the control loop, click the Open Loop button again. The test will be continued in Closed
Loop mode.

Save Counter
(available in standby mode only)
If the test is aborted, you do not have to repeat all pulses at the current level but
can save the pulses remaining at this level.



You defined 100 pulses at - 3 dB level in VibEdit’s "Schedule" tab. As the
abort limit is exceeded during the test run, the test is aborted after 70
pulses and changes to standby mode. If you click "Save Counter" now, the
program will store the remaining 30 pulses. If you restart the test, only the
remaining 30 pulses will be output at - 3 dB level.

To save the pulses at test abort, click the Save Counter button.
Restart the test from the previous level.
Reaching the test level at which the abort occurred, the remaining number of pulses is output.

Pulse Polarity
By default, classical shock test definition always has a positive initial pulse
polarity. To start a test with a negative pulse polarity, select - Polarity in
the VibRunner prior to test start.
You can manually invert the pulse polarity at any time during the ongoing
test. The current pulse polarity shows green light.
Please note that if the shaker is not in the center position, the displacement in the opposite direction will be different. Therefore it is recommended to test in the direction of the smaller displacement first.
An inversion of the pulse polarity is suited for linear systems only.

+ Polarity
- Polarity

Shock in positive pulse polarity.
Shock in negative pulse polarity.

Pulse polarity can also be inverted by entering a negative sensitivity in VibEdit.
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Test Log
The lower left part of the VibRunner displays the test log.
The test log lists all relevant test events in chronological
order. The online test log displays the latest information
only. To have a look at the complete test log after test
end, open the offline test log.
Select Protocol file from the File menu.
Print out the test log.

Offline test log

Online Charts
In the online chart you can control the test run. In VibEdit Schedule you have already defined
how many pulses shall be driven on each level.

Online integration and differentiation
Classical shock control has a special function which enables you to integrate
and differentiate a trace online. Thus you can e.g. compare the velocity to the
reference velocity etc.

The online charts are a useful control tool. See chapter 5.3 “VibRunner Chart Display Functions”, page 82.
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Adapt Limits and Reference Traces to Actual Level
By default, the control channels are displayed with their corresponding reference spectra/
pulses, their alarm and abort notch limits. You can hide these reference and tolerance traces
or - if hidden - show them. Moreover, for test levels < 0 dB you can adapt the traces defined and by default shown for a test level of 0 dB - to the actual test level.

Level scaled

Run the Getting Started Test
By running a Getting Started test you can check the performance of your signal processing and
data acquisition system on a bare wire, i.e. neither a shaker nor a specimen are involved in this
testing - allowing you to learn the m+p VibControl control functions with only the measurement
front-end and a BNC cable being required.
To start up the test, first perform a selfcheck. Then you can start the test by clicking the Run
button.
The online control window displays the measured signals. The test run is performed as defined
in VibEdit’s Schedule tab.
Please try the online control functions:
After 5 pulses there is an estimation of coherence used to increase or
decrease the level (see next page, "Coherence and Smoothing").
Therefore the number of pulses at a low level (< 0 dB) should always be 5
or a multiple of 5 (10, 15, ...). If, at a low level, the abort limits of the control
channel are exceeded, the test will change to standby mode.
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•

To minimize the control error and achieve optimum control performance, first generate 5
single pulses. To do so, click Single Pulse once. Prior to generating the next single pulse,
wait until the preceding pulse has been output and the response has been measured.
Generate 4 more single pulses this way.

•

To output the pulses at the repetition rate defined in the Schedule tab (VibEdit), click Rep.
Pulse.

•

To open the control loop, click Open Loop. The drive signal will not be updated.
In open loop control, only the upper abort limit is active. Once you select
closed loop control, the lower abort limit will be taken into account, too. So
the test will be aborted as soon as the upper or lower abort limit is
exceeded.

•

Prior to closing the control loop, check the reference pulse in any case. If the reference
pulse deviates considerably from the measured one, you must not close the control loop.
In this case, we recommend to start the test at a lower level.

•

To close the control loop, click Open Loop again.

•

To halt the test, click Standby. The drive signal is ramped down and the current test status
is saved.

•

To continue the test, click Run.

•

To take a manual measurement, click the Measure button. The response of the control
channel together with the corresponding drive and error and the responses of the measurement channels are saved to hard disk.

•

To hold the current level, click Hold.

•

To go to the previous level, click down.

•

To go to the next level, click up.

•

Use the online chart functions (see chapter 5.3 “VibRunner Chart Display Functions”,
page 82).

•

To definitely abort the test after the test end has been reached and store the results, click
the Abort button. This will switch the test run status from Standby to Idle and the test
results will be saved.

Coherence and Smoothing
In classical shock mode and SRS mode, VibRunner performs a line-by-line check on the
coherence and smoothing. You are able to skip this check by entering the necessary command
in the configuration file "shock.ini" which you will find the directory \VcpNT\Bin\ .
•

To skip the coherence check, enter OPTIMISE _FIRST_DRIVE: NO

•

After the selfcheck, VibRunner performs a smoothing on the transfer function. You can
define the number of smoothing repetitions of your choice.
To select e.g. five repetitions (typical value), enter NR_SMOOTH_REPETITIONS: 5.

•

One repetition does Ai = .25*Ai-1+.5*Ai+.25*Ai+1 for all spectral lines.

•

To skip the smoothing, enter NR_SMOOTH_REPETITIONS: 0.

•

After this smoothing, if the coherence is lower than the specified minimum coherence
value, the corresponding frequency line in the drive is set to 0.
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•

Example for Configuration File "shock.ini"
*.ini files are basic program files. You should be aware that modifying them
can negatively affect program reliability and function!
If you wish to modify the shock.ini file or any other *.ini file, please contact
local support for assistance.

[CONTROLLER]
OPTIMISE_FIRST_DRIVE: YES
Perform hann smoothing and minimum coherence elimination.
COHERENCE_MINIMUM: 0.95
Minimum coherence needed, or line will be taken out of the drive.
NR_SMOOTH_REPETITIONS: 5
Number of times the hann smoothing should be repeated.
ZERO_DRIVESTART: NO
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•

For some pulses it is important that nothing is happening before the main pulse (like in a
crash). For such pulses, you can add zeros before the pulse, and when ZERO_DRIVESTART is not set to NO, the drive will be forced to 0 in this area.

•

In a similar way, the end of the pulse will be forced back to zero with a cosine ramp.
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6.4

SRS Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: define the test run profile/s

•

Specimen: enter the properties of the shaker and the specimen

•

Schedule: define the selfcheck properties and the test schedule

•

Channels: define the channel properties

6.4.1

Define the SRS Reference

SRS test mode reference

The shock response spectrum (SRS) is a mathematical method of studying a system‘s
response (acceleration versus frequency) to a specific shock pulse. It is obtained by applying
a shock pulse to several linear, damped SDOF systems having an individual resonance frequency f N = --1- . All SDOF system responses to this specific input pulse are recorded and from
T
this record the SRS is calculated.
In VibEdit, the reference SRS (SRS In) is defined and the pulse is synthesized. The actual SRS
is calculated and compared to the reference SRS. If required, the pulse is optimized.
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The SRS can be generated from several, individual pulses subjecting the specimen to
individual stresses.
The reference pulse is generated using damped/undamped sine waves.
You can choose Hanning or rectangular windowing for each sine wave.
The reference pulse is specified as acceleration versus time. Velocity is obtained by integrating
acceleration versus time once and displacement is obtained by double integration.
When using an electrodynamic shaker, the pulse is often limited by the
maximum displacement of the shaker. The reference chart shows you
whether the displacement of the defined pulse is too large for the used
shaker or not. In addition, feasibility is checked and displayed at the
bottom.

Effective Shock Duration
The effective shock duration is displayed in a box at the right side below the charts
. It displays the action duration of the pulse,
which starts with the first exceedance of the "10% of the maximum value" level ("peak RMS
magnitude" according to MIL-STD 810 F) and ends with the last fall below this level.

External Pulse

Load an external pulse file

To load and edit an external pulse file in either Classical Shock or Shock Response Spectrum,
see chapter 6.3.1.4 “External Pulse Builder”, page 225.
m+p VibControl displays the name of the pulse file that was last used in the field under Load
external pulse.
In order to load an external pulse file, activate this function by clicking the relevant check box.
Then click >> in order to open the dialog window allowing you to select the required pulse file.
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6.4.1.1

Base Parameters

SRS - Base parameters

Frequency Range
Select the frequency range to be used for the test.
Frequency ranges, which are not supported by the hardware in use,
are marked by a gray background. You can select these frequency
ranges for defining a test with another (not connected) front-end.
This test definition can be saved, but needs the required hardware
to start.

Number of Samples
Select the number of samples N.
Allowed values: 256, 512, 1024, .....
Number of samples, which are not supported by the hardware in
use, are marked by a gray background. You can select these
number of samples for defining a test with another (not connected)
front-end. This test definition can be saved, but needs the required
hardware to start.
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Output Time
The number of samples N and the sampling rate are used to calculate the
Output time T:
N
T = -----------------------------------sampling rate

(Sampling rate = 2.56 · frequency range)
The inverse of the output time equals the minimum frequency:
f

min

1
= --T

SDOF Damping
Enter the damping which is used for SDOF calculation (SDOF = single
degree of freedom). Define the damping in [%] of the critical damping.
Some SRS specifications require a quality factor Q for SDOF damping.

d
dc

SDOF damping:  = -----1
Q = ----------2

SDOF damping: 5%
1
Q = -------------------- = 10
2  0.05

Octave Spacing (anal.)
Select the Octave spacing. The octave spacing is the same for both analysis
and synthesis.

RMS Value
After specifying the desired component frequencies, you can have the pulse
and the actual SRS calculated. Afterwards the calculated RMS value of the
synthesized pulse will be displayed. This RMS value will help you define the
alarm and abort limits (RMS) in the Channels tab. To change the unit, see
chapter 6.3.1.5 “Select the Units”, page 228.

Whenever you change the setup, recalculate a new analysis by
clicking the “Recalc“ button.

Peak-Peak Displacement
To activate peak-to-peak displacement, check the box with a click of your
mouse button.
To deactivate peak-to-peak displacement, leave the box unchecked.
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With peak-to-peak displacement selected, the pulse will show a displacement in both directions. With peak-to-peak displacement unselected, the
pulse will only show a displacement in one direction.
When selecting peak-peak displacement, make sure that the shaker
is in center position. Otherwise, the shaker may reach its overtravel
limit.

Prepulse Optimization
Synthesized pulses are normally compensated (i.e. no velocity and displacement left at pulse end) by superimposing acceleration or velocity each with a
Hanning window. With pulses that have been synthesized from a small number of dampened wavelets, this usually leads to large shaker displacements.
You can avoid this by adding a suitable prepulse, the frequency and damping
of which can be defined and the amplitude and time delay of which are automatically calculated by m+p
VibControl such that no velocity and displacement are left at the end of the
pulse.
Enter the required values for frequency and damping in the relevant entry
fields and activate Prepulse Optimization by checking the control field using
a mouse click.
If required, click Calculate.

SRS-Optimization (as described in section 6.4.1.5) can be performed before pre-pulse optimization.

It is not recommended to use pre-pulse for pulses consisting of
several Hanning-weighted wavelets. You should rather use
standard compensation combined with alternating initial slopes of
the wavelets.

Alarm Limit
Enter the alarm limit in [%] of the maximum absolute acceleration before saving the synthesized pulse. Positive and negative values are allowed. For a
positive value, do not enter a
positive sign; but for a negative value, enter a negative sign.

Abort Limit
Enter the abort limit in [%] of the maximum absolute acceleration before saving the synthesized pulse. Positive and negative values are allowed. For a
positive value, do not enter a positive sign; but for a negative value, enter a
negative sign.
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Reference SRS

Reference SRS

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Specify the frequency in [Hz].
A segment or a band between two consecutive frequencies can be specified
either by defining a level or a slope. At least one frequency of the table has
to be defined as level for a mathematically correct definition.

Type
To define the reference spectrum, you determine a level and/or a slope:
Select
- L to define a level
- Sl to define a slope
- LSl to define both level and slope
Enter at least one level.

Level
Enter the level.
The unit of acceleration is chosen in the Units field. The next level is calculated using the entered slope:

f2
Level 2 = level 1  ----f1
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Slope
Enter the slope to specify the reference spectrum.
Make sure that components of synthesis that are higher than the
shaker can handle are NOT included.

Abort
Enter low and high abort limits in [dB].

Select the Units

Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All numerical and graphical reference data will be converted automatically.
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6.4.1.2

Synthesis

Switch from Base parameters to Synthesis

Pulse synthesis

Damping, Delay, Slope, Window type and Window time define the wavelets used for synthesizing the pulse. The wavelets are weighted in the interactive SRS analysis such that the analyzed SRS very closely matches the reference spectrum. A wavelet is based on an undamped
sine wave.

Pulse synthesis table

The pulse synthesis table displays the octaves available for synthesizing the pulse and the
component frequencies.

No.
Consecutive octave numbering.
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Octave/Frequency
To select an octave, click it so that it is highlighted.
The component frequencies of this octave are displayed according to the
octave spacing.
The number of octaves is calculated from the output time T. The inverse of
the output time is the minimum frequency fmin. The initial frequency of the first
octave is the quadruple of fmin. The highest frequency of the last octave is half
of the sampling rate. All available component frequencies f are calculated as
follows:
f = 4 · fmin · 2m/nk
m
nk
fmin

= 0, 1, 2, ...
= 1, 2, ..., 12
= 1/T

counter
octave spacing

4 · fmin  f  1.28 frequency range
To select a component frequency, check its box. When activated, its row is
highlighted. Then specify damping, delay, slope, window type and window
time.
When selecting a frequency, the boxes next to some octaves show a check.
This check indicates that at least one component frequency is specified for
this octave.
To take a specified component frequency into the synthesis, its box must
show a check. To take the specified component frequency out of the synthesis, click the check box to remove the check. This allows you to try out different synthesizing setups easily and fast without entering “0“ for damping,
delay and window time.

Damping
Enter the damping in [%].
0 < d < 100 %.
0 % corresponds to an undamped sine wave.

Delay
Enter the delay in [ms].
0 < delay < output time T
The start of the wavelet will be delayed. The Window Time function serves as
reference.

Slope
Select
- Up to have a positive initial slope of the sine wave, or
- Down to have a negative initial slope of the sine wave
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Window type
Select
- H for Hanning window, or
- R for rectangular window
The specified type and time of window will be multiplied by the sine wave.
A delay will be taken into consideration.

Window time
Enter the opening time of the window in [ms].
0 < window time < output time T

Level
Enter the amplitude of the component frequency in [g].
Amplitudes specified other than “0“ will not be modified during the synthesis
procedure. If, however, amplitudes are set to “0“, the corresponding value will
be displayed after the synthesis.
The defined wavelets can be saved to a text file using the Store... button. Saved wavelet files
can be loaded using the Load button.

6.4.1.3

Update VibRunner

In VibEdit SRS Test Mode, an Update VibRunner button allows you to directly update the target
time pulse of the test in progress.

Update VibRunner
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It happens in high level SRS tests that SRS spectra are not in specification and linear control
by the control system will not help to improve the result. At that point, you can go to the SRS
test setup if you want to re-synthesize the target pulse based on a change weighting on the
SRS octave component that does not meet the test specification. Using the Update VibRunner
button, this synthesized pulse can be sent to the active SRS controller. This update changes
the target pulse of the test in progress. Consequently, the drive of the test will change. This
feature allows for non-linear compensation of the SRS pulse in case linear control does not do
the job good enough.
This is a very powerful feature, however caution should be taken for increased level changes
since this might damage the specimen.

Always make sure to check the drive signal before applying the shock to
the specimen.

6.4.1.4

Generate SRS Wavelets

For displacement optimization select the Gen. SRS Wavelets button. This function searches
for a solution with minimum displacement. The number of repetitions entered defines how
many random solutions will be searched. To reset the search first click the Synthesis button,
select ALL wavelets and click the Recalc button. The Gen. SRS Wavelets window can then be
re-opened and a new search performed.

6.4.1.5

SRS Wavelets Optimization

m+p VibControl offers a function to optimize SRS wavelets automatically. You enter the desired
maximum displacement and SRS error. m+p VibControl calculates the available wavelet combinations with reference to the initial slopes, until it finds a combination which remains under
the entered limits.
If it does not find the appropriate combination for either the displacement or the SRS error, the
field which shows the current value will be highlighted red.

Do not use the normal optimization for more than 20 wavelets. The number
of possible wavelet combinations will be extraordinarily high, so that the
calculation time will be too long.

Fast optimization calculates less combinations than the normal optimization. The program
decides which wavelet (pos. or neg.) is the best to follow the first wavelet, the first and second
wavelet, etc. Thus the number of possible combinations is reduced and the result does not take
into account limits.
To optimize the wavelets, proceed as follows:
1. Select the SRS Optimize button - the SRS Optimize window opens.
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SRS Optimization

2. Normal Optimization:
Deactivate the SRS Fast Optimize check box. Enter the SRS Error Limit in dB and the
desired peak-to-peak Displacement Limit in displacement units. Then click the Recalculate button.
The right fields show the calculated optimization values of the SRS Error and the Displacement. The chart will be updated accordingly. (The calculated values may be highlighted red if the entered limits are exceeded.)
3. Fast Optimization:
Activate the SRS Fast Optimize check box and click the Recalculate button.

The optimization only effects the first slopes of the wavelets (pos. or neg.).

If you want to accept the optimized wavelets, click the Apply button.
Then m+p VibControl will overwrite the entries for the initial slopes (in the Slope column) of the
synthesis wavelet table.

If you want to return to the original state, do not click the “Apply” button,
but the “Cancel” button in order to close the dialog.

6.4.1.6

Recalculate

After specifying the desired component frequencies, you can have the pulse and the actual
SRS calculated. Afterwards the calculated RMS value of the synthesized pulse will be displayed. This RMS value will help you define the alarm and abort limits (RMS) in the Channels
tab. To calculate the pulse, RMS value, velocity, displacement, actual SRS and SRS error, click
the Recalc button.
Whenever you change the synthesizing setup, a system message appears stating that a new
analysis is required:

Recalculation required
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6.4.1.7

SRS Editor Displacement Optimization

SRS editor toggle polarity

m+p VibControl provides automatic synthesis of component polarity toggling. Together with the
enhanced display of all synthesis components, an optimum displacement is guaranteed. The
entire row can be changed by highlighting the frequency components, using the shift key, and
selecting the parameter you wish to change.

6.4.1.8

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in VibShakerDef.
The necessary force is calculated using an SDOF model.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits. The estimated shaker load is given not only in numerical but also in graphical
data (color of signal lamps):
Color

Shaker load

Red
Yellow
Green

100% (shaker limits exceeded)
 90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is

 100%. The program does not block the Start button!
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6.4.1.9

Check the SRS Reference Charts

Frequency domain charts

The spectrum defined is also represented in charts. Check the defined SRS with the m+p
VibControl chart functions. To switch from time to frequency domain or vice versa, click the
Freq. or Time check box. There are different types of shock spectra to be taken into account.
These charts are available:
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Time:

Acceleration:
Velocity:
Displacement:

Control channel as acceleration versus time.
Velocity of the control channel.
Displacement of the control channel.

Frequency:

SRS In:
SRS Maximax:
SRS Error:

Specified SRS.
Calculated SRS.
Calculated SRS‘s deviation from specified reference
SRS.
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6.4.1.10 Sine Burst / Sine Chirp Testing
Define a Sine Burst Test
To define a sine burst test, proceed as follows:
After loading an SRS test in VibEdit, click the Sine Burst button.

Sine burst mode selection

This will open the SRS Sine Burst window where you can select the burst mode and define the
burst data.

SRS SineBurst window

Enter the parameters required for your sine burst test.
In the Reference SRS section, define a level (e.g. 1g).

Level definition
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Define the Alarm and Abort limits.

Alarm and abort limits

When you have finished defining your sine burst test, click OK in the SRS Sine Burst window.
The window will close and you will return to the SRS test mode definition. A green light within
the Sine Burst button is now indicating that the Sine Burst definition is active.

The acceleration, velocity and displacement of your new test will be displayed graphically.
The picture below shows an example with one burst (beat).

Sine burst test with one beat

If you enter "2" under Number of beats, the test will include two sine bursts and the resulting
chart display will look like this:
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Sine burst test with two beats

Define a Sine Chirp Test
To define a sine chirp test, proceed as follows: In the SRS SineBurst window, select CHIRP.

Sine chirp window

Define the burst data for your sine chirp test.
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Sine chirp tests can have either constant or variable acceleration.
To define a test with constant acceleration, define just one level (e.g. of 1g) in the Reference
SRS section.

Level definition

The picture below shows the charts for a test with constant acceleration.

Sine chirp test with constant acceleration

To define a test with variable acceleration, you need to define two levels in the Reference SRS
section.

Level definition
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The picture below shows the resulting charts for a test with variable acceleration.

Sine chirp test with variable acceleration

6.4.2

Load the Shaker and Define the Specimen
in SRS Test Mode

For information on the SRS Specimen, please refer to the Classical Shock chapter 6.3.2 “Load
the Shaker and Define the Specimen in Classical Shock Test Mode”, page 231.

6.4.3

Define the SRS Schedule

For information on the SRS Schedule, please refer to chapter 6.3.3 “Define the Classical Shock
Schedule”, page 237
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6.4.4

Define the SRS Channels

SRS channel parameters definition

No.
The number of channels depends on your software license.
In SRS mode, only one control channel is allowed. All other channels must be measurement channels.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input
modules, take the slot number into account.

Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel
only one control channel can be defined

W

= watchdog (= limiting) channel

M

= measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
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The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.

Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditioning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
.

Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".
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Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.

Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
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Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

V-Type
Select the virtual channel type, e.g. Vector add.

Alarm
Low, High:
Enter the lower (Low) and upper alarm limits (High).
The alarm limits refer to the RMS value of the pulse. The reference RMS
value is calculated in the Reference tab.
For the control channel, set the unit in the EU control channel field above the
table. [g] or [EU] are absolute entries, whereas [dB] refers to the current level
(relative value). The lower/upper alarm limits must be less than the lower/
upper abort limits.

Abort
Enter the abort limits (RMS). The abort limits are always entered as RMS
values. The system only aborts at 0 dB and in repetitive mode.
The abort limits refer to the RMS value of the pulse. The reference RMS
value is calculated in the Reference tab.
For the control channel, set the unit in the EU control channel field above the
table. [g] or [EU] are absolute entries, whereas [dB] refers to the current level
(relative value).
The lower/upper abort limits must be greater than the lower/upper alarm
limits.
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6.4.5

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.

6.4.6

SRS Test Control

VibRunner in SRS testing

Having performed the selfcheck to check the test setup on feasibility, you can now start up the
test run.

Online SRS with Representation of the Reference SRS
m+p VibControl enables you to show both the reference SRS-graphics and the online SRSgraphics in one window for immediate evaluation of the test. You can see at a glance whether
the measured signal lies within the alarm and abort limits.
For SRS and classical shock, the online controls provided in the VibRunner are the same. For
information on SRS testing, please refer to chapter 6.3.5 “Classical Shock Test Control
(VibRunner)”, page 250.
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6.5

Mixed Mode Testing

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: Define the test run profile/s

•

Specimen: Enter the properties of the shaker and the specimen

•

Schedule: Define the selfcheck properties and the test schedule

•

Channels: Define the channel properties

6.5.1

Define the Mixed Mode Reference

Mixed mode reference tab

In the Reference tab you make your choice which type of mixed mode test you define:
Mixed modes are
Sine-on-Random (SoR)

= broadband random + sine tones

Multi-sine

= several sine tones in parallel

Random-on-Random (RoR)

= broadband random + narrowband random

Sine-on-Random-on-Random
(SoRoR)

= broadband random + narrowband random
+ sine tones
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To define a special type of Mixed mode in VibEdit, a broadband random signal has to be overlaid with sine tones and/or narrowband random.

Note that in the mixed test modes it is possible to define notching limits for
the broadband random but not for the sine tones and the narrowband
random.

Sine-on-Random (SoR)
In sine-on-random (SoR), you can define up to 16 independent sine tones (using m+p
VibPilotE, m+p VibRunner or m+p VibMobile frontends) which are laid over a broadband random signal.
SoR is used, for instance, for gunfire and helicopter simulation.
Define the broadband random signal as described in chapter 6.5.1.1 “Define the Broadband
Random”, page 286. To overlay the sine tones, leave the Disable Sine Tones box unchecked.
It is located in the center part of the window.

Define the sine tones as described in chapter 6.5.1.2 “Define the Sine Tones”, page 295.
Check that the narrowband random is disabled.

Multi-Sine
The multi-sine test mode was developed for the automotive industry and the defense sector,
where it is known as "no random option for mixed mode".
Multi-sine allows you to simultaneously sweep up to 16 sine tones at different levels across the
desired frequency range.The sine sweeps are running synchronously with a typical sweep rate
of 1 octave/min. The sine tones are independent from each other and have their own digital
tracking filters allowing for precise, fast control. They can be switched on/off individually.
Your multi-sine test is defined as a sine-on-random test mode. Define the sine tones as
described in chapter 6.5.1.2 “Define the Sine Tones”, page 295 and enable the Multi-Sine function (which disables the random bands).
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Sine-on-random with Multi-Sine enabled

Random-on-Random (RoR)
In random-on-random (RoR), you can define up to 25 independent narrowbands which are laid
over a broadband random signal. RoR is used, for instance, for simulating tracked vehicles.
Define the broadband random signal as described in chapter 6.5.1.1 “Define the Broadband
Random”, page 286. Check that the Sine tones are disabled.

To overlay the narrowbands, leave Disable Narrowbands unchecked.
Define the narrowbands as described in chapter “Narrowbands”, page 302.

Sine-on-Random-on-Random (SoRoR)
In sine-on-random-on-random (SoRoR), you can define up to 16 independent sine tones (using
m+p VibPilotE, m+p VibRunner or m+p VibMobile frontends) and 25 narrowbands which are
laid over a broadband random signal. Define the broadband random signal as described in
chapter 6.5.1.1 “Define the Broadband Random”, page 286.
To overlay the sine tones, leave the Disable Sine Tones box unchecked.

Define the sine tones as described in chapter 6.5.1.2 “Define the Sine Tones”, page 295.
To overlay the narrowbands, leave Disable Narrowbands unchecked, too.
Define the narrowbands as described in chapter “Narrowbands”, page 302.
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6.5.1.1

Define the Broadband Random

Broadband random

General Random Test Mode Parameters

General random parameters

Frequency Range
Select the frequency range for the test in [Hz].
Frequency ranges, which are not supported by the hardware in use,
are marked by a gray background. You can select these frequency
ranges for defining a test with another (not connected) front-end.
This test definition can be saved, but needs the required hardware
to start.

Number of Lines
Select the number of lines.
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Frequency Resolution
m+p VibControl calculates the frequency resolution in [Hz].
frequency range
frequency resolution = ------------------------------------------number of lines

Sigma Clipping
Select the sigma clipping (a multiple of the sigma RMS value). Detect from
the bottom RMS display what would be the maximum values resulting from a
“3“ sigma clipping.

Display with RMS Sigma and 3*Sigma values

Define the Power Spectral Density (PSD)

Reference spectrum definition table

You define a power spectral density (PSD) in [g²/Hz] or [EU²/Hz] as a function of frequency. A
segment, i.e. the band between two consecutive frequencies, is defined by levels and/or
slopes. You have to enter a level at least for one frequency to enable a clear mathematical
definition.

EU (Engineering Unit) is the unit of the corresponding reference (e.g. inch
for displacement or [m/s²] for acceleration). To activate the spectrum definition table, click the No. row.

Let m+p VibControl calculate an unknown level of power spectral density (PSD) at a particular
frequency from the preceding and following slopes and levels.
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VibEdit, random test setup, level at 500 Hz calculated

Enter the frequency for which the level is to be calculated (“500“ in below figure). If this is the
last frequency of the spectrum, enter a level = 0 and let the slope undefined, i.e. enter “9999“
(“Slope“ is then displayed). Press the Enter key. The level is calculated.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field.
To activate an empty row, double click this row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency/Acceleration/Slope
Type the reference spectrum frequencies and amplitudes (power spectral
density (PSD) in [g²/Hz] or [EU²/Hz] as a function of frequency) together with
the slope valid until the next frequency is reached.
To change the acceleration unit, use the Units selection field.

f

2
Slope in dB/Oct: y 2 = y 1  ----f

Slope
-----------------------------10 log 10 (2)

1
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y2, f2 = calculated level at frequency 2
y1, f1 = reference level at frequency 1
0 dB/Oct = no slope
9999 = constant slope (“Slope“)

A segment, i.e. the band between two consecutive frequencies, is defined by
level and/or slope. You have to enter a level or slope at least for one frequency to enable a clear mathematical definition.
If the last breakpoint has a slope (NOT showing “Slope“), the reference will
continue to the end of the frequency range.

Alarm/Abort
Type the lower and upper alarm and abort limits.
To set the same lower or upper alarm or abort limit for multiple lines, click the
first line to set with your left mouse button, press and hold the Shift key. Click
the last line to set with your left mouse button. Due to the Shift key being held,
now all lines in between are selected. Select the field of the limit to set with a
click of your left mouse button. Release the Shift key and type in the lower or
upper alarm or abort limit.
Press to globally set all lines selected to this lower or upper alarm or abort
limit.
You can enter a level from which each line will be checked for an exceeding
of alarm and abort limits.
If during the test run an alarm limit is exceeded, the test log will state a message and the “W“ lamp of the corresponding channel will light up in the
VibRunner‘s WANO field.
If during the test run an abort limit is reached, the test will change to standby
mode and the “A“ lamp of the corresponding channel will light up in the
VibRunner‘s WANO field.

Units

Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All reference numerical and graphical data will be
automatically converted.

Import of ASCII Reference Spectrum in Random Control
m+p VibControl offers a function to import a recorded reference spectrum into VibEdit in order
to use them within a mixed mode test run.
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The data of the reference spectrum can be imported as an ASCII-file which is created by
inserting the data into a Microsoft Excel table and saving them as an ASCII-file (e.g. a .txt file).

Please make sure, that all decimal values are written with a point or a
comma according to the parameter definition of your PC, because they
can only be imported in this notation.

The following table shows the frequency values in the first row and the amplitude values in the
second row.
The amount of data which can be imported is restricted to 3200 lines. You define the number
of lines in the Number of Lines selection field (see page 100).
Frequency
4
8
12
16
20
24
28
32
36
40
44
48
52
56
60

Amplitude
0.000203656
1.50E-05
4.15E-05
0.000273324
0.000492902
0.000430695
0.000393226
0.000548226
0.0005726
0.000667165
0.000699403
0.000739477
0.00067242
0.000696962
0.0011492

Example of a file that can be imported

You import these data via the Import button of the VibEdit window.
The following window opens:

Import of a reference spectrum

Select the file that you want to import and click the Open button.
The reference spectrum will be copied into VibEdit and will be shown in the charts.
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Advanced Random Parameters
To set advanced random parameters, click the

button.

Advanced random parameters (Getting Started)

If you only have DOF (Degrees of Freedom) available, you can enter the value into the DOF
Calculator which can be accessed on our Web Site. The calculator will provide the possible
combinations of K and N values.

Averages per loop K
Type the number of averages used for one control loop.

Average weighting factor N
The linear averaging is followed by an exponential weighting.
The “N“ weighting factor defines how sensitive the controller is to react to a
change of the actual value.
Type an integral value “N > 1“.
The integral value “N > 1“ appears in the following form:
Sa+1 =

(Se - Sa) · 1/N + Sa

Sa+1 =

value used for next control loop

Sa

=

value used for last control loop

Se

=

value resulting from current linear averaging

N

=

weighting factor of exponential averaging

The exponential weighting factor influences the behavior of the controller. For
small “N“, the controller reacts faster than for large “N“.
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DOF = 2K*(2N-1)
The degrees of freedom DOF are calculated from “Averages per loop“ and
“Averaging weighting factor“. The term “DOF“ is from statistics and indicates
the number of independent variables (measurements) used to calculate the
final results. The higher the degrees of freedom there are the larger the number of measurements taken. DOF are calculated as follows:
DOF for C and W channels:
DOF = 2 · K · (2 · N - 1)
DOF in spectrum ("Average" control): DOF = n · [2 · K · (2 · N - 1)]
where K = number of averages/control loop
N = averaging weighting factor
n = number of control channels

Please note that the DOF value for individual M-channels is calculated from
the number of averages defined in the Channels tab.
DOF for M-channels:

DOF = 2 · KM

where KM = number of averages defined in the Channels tab

Line-by-line check start level
Enter a level from which each line will be checked for an exceeding of alarm
and abort limits.
If the current level of a testing schedule is at or above this start level,
the following inputs are valid:
- upper and lower frequency limits (see next two entries)
- number of lines tolerated out of abort and alarm limits
(see 3rd and 4th entries ahead)

Take limits from reference
When you activate this function, the fmin and fmax values from the spectrum
are automatically transferred to the advanced parameters line-by-line check
section as lower/upper frequency limits.

Lower frequency limit/Upper frequency limit
Enter a frequency range within which each line will be checked for an
exceeding of alarm and abort limits (line-by-line check).
This frequency range must not exceed the frequency range defined in the
reference spectrum definition table.

No. of lines tolerated out of abort limit
This parameter defines the number of frequency lines that may be violated
until the test is aborted. Enter the number of lines tolerated out of abort limits
in [%] or [lines] relative to the number of lines in the defined frequency range.
If the defined number of lines is exceeded, the test will abort. The frequency
of the line that triggered the abort will be logged into the test log. m+p
VibControl checks for such exceeding of abort limits only after the measure-
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ment value of the control channel has exceeded the value entered under
Line-by-line check start level (see above).
This function enables you to test specimens whose sharp resonances would
normally abort the test.
Be aware that you weaken the criteria for a test abort when you use this function. As you tolerate exceedings of the abort limits, this function may cause
damage to the specimen.
Example:
Reference spectrum: 10-3200 Hz
Abort limits: 3 dB for the complete spectrum
Lines: 400
 Resolution: 8 Hz
Lower frequency limit: 160 Hz
Upper frequency limit: 400 Hz
 30 lines (100%) lie in this frequency range
Number of lines tolerated out of abort limits: 10% or 3 lines.
The test will be aborted if 4 lines exceed the abort limit of  3 dB.

No. of lines tolerated out of alarm limit
Enter the number of lines tolerated out of alarm limits in [%] or [lines] relative
to the number of lines in the defined frequency range (see last item above).
When an alarm limit is exceeded, it is entered in the test log.

Lower alarm limit (RMS)/Upper alarm limit (RMS)
Enter the alarm limits relative to the RMS value of the control spectrum in
[dB]. The RMS value of the control spectrum is displayed in the field of the
feasibility check.

Overall RMS abort
Enter the abort limit relative to the RMS value of the control spectrum in [dB].
The RMS value of the control spectrum is displayed in the field of the feasibility check.
To confirm the settings, click the OK button.
To cancel the changes, click the Cancel button.

Rescale
You can time-efficiently rescale, i.e. dampen or amplify, the complete spectrum (all values
defined) by a factor.



To amplify the spectrum by a factor of 2, type “3“ [dB].
To dampen the spectrum by a factor of 0.5, type “-3“ [dB].

To open the “Rescale“ dialog, click the Rescale button.
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Type the rescale factor in [dB]:
To dampen the spectrum, type a negative factor (negative sign).
To amplify the spectrum, type a positive factor (no sign).

Rescale dialog

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.

File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.

Feasibility Check (Shaker)

Display of shaker load
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The test defined is constantly checked against the shaker limits defined in VibShakerDef. The
necessary force is calculated using an SDOF model.
The RMS values of acceleration, velocity and displacement are calculated for the defined spectrum. When changing the unit of acceleration, velocity or displacement, m+p VibControl will
automatically convert the values. In addition, the maximum values for a 3*Sigma limitation will
be given. The sigma value to which the signal output to the shaker will be limited is set in the
Sigma Clipping field.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of the
signal lamps):
Color

Shaker Load

Red
Yellow
Green

 100% (shaker limits exceeded)
 90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is

 100%. The program does not block the Start button!

6.5.1.2

Define the Sine Tones

Sine tones definition

The entries made for No. of Sweeps, Ramp Time and Start Level apply to all sine tones defined.
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No. of Sweeps
Enter the number of sweeps to be done.

Ramp Time
Enter the time to start up and ramp down the sine signal in [s].

Start Level
Enter the level from which the sine tones will start.

Sine Tones

Sine tones

Control
If several control channels are defined you can select minimum, maximum or
average control strategy.

Damping
Enter the controller damping.
Define up to 16 independent sine tones in m+p VibPilotE, m+p VibRunner
and m+p VibMobile systems and up to 20 independent sine tones in Oros
systems.
The sine tones may cross. However, they must be within the defined
frequency range of the random signal. If necessary, select a larger
frequency range of the random signal and enter extremely low
levels at the new frequencies.

The entries made for Control and Damping apply to all sine tones defined.

No.
Consecutive row numbering.
To edit a row, click the row’s No. field. To activate an empty row, double click
the row‘s No. field.
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To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Low:
Enter the lower frequency limit in [Hz].
High:
Enter the upper frequency limit in [Hz].
Start:
Enter the starting frequency in [Hz].
For multi-sine test mode, enter the desired low and the high frequency limits
as well as the number of sine tones. The software will then automatically
calculate the frequency sections per sine tone.

Sweep
Type:
Select linear or logarithmic sweeps.
Direction:
Enter the direction in which the sweep will start.
Rate:
Enter the sweep rate in Oct./min.

Time
Time:
Define the time in [s] that it takes to perform one sweep.
Offset:
Enter the length of time in [s] after which the sine tone will start at starting
level.
On: (only holds for sine tone = fix frequency)
Enter the length of time in [s] that the sine tone will be active after the random
signal has reached the starting level and after the offset time is over.
If on time is set to zero, the sine tone will be inactive all the time.With on/off
times set to non-zero, they are repeated cyclically.
Off: (only holds for sine tone = fix frequency)
Enter the length of time in [s] that the sine tone will be inactive after the random signal has reached the starting level and after the offset and on times
are over.
If off time is set to zero, the sine tone will be active all the time. With on/off
times set to non-zero, they are repeated cyclically.
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Selected Tone

Breakpoints for selected tone

In this window, you can enter up to 15 breakpoints to define the reference
amplitude. You can add breakpoints to the end of the list at any time.
Mark the sine tones for which you want to define breakpoints.
The corresponding breakpoints definition table will appear.
When you leave the breakpoints table, the breakpoints will be sorted automatically according to their frequencies.
Conversion of sine amplitudes into power spectral density and vice versa:
aP = 2 · 2 · (aPSD · 3
--- · f)
8

where
aPSD =

random PSD

aP

=

peak acceleration of sine component („X“ in the online charts)

=

random frequency resolution

f

Minimum distance between sine components and broadband random:
MIN distance = 10 log · (aPSD sine components / aPSD random components) > 10 dB
The following figure graphs the aPSD and aP equations which define the
minimum allowable sine amplitudes.
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Sine-on-random: minimum allowable sine amplitudes

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Enter the frequency of the breakpoint.
You only have to enter one of the amplitudes (acceleration, velocity or displacement). The other two amplitudes will be calculated automatically.
If you change the frequency later, the acceleration value will always remain
unchanged, whereas the velocity and displacement values will be updated.
A frequency segment is defined by amplitudes (acceleration, velocity, displacement) and/or slopes. You have to enter an amplitude value at least for
one frequency.

Accel.
Enter the amplitude of acceleration.

Vel.
Enter the amplitude of velocity.
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Displ.
Enter the amplitude of displacement.

Slope
Slopes refer to acceleration, velocity or displacement. They can be defined
in logarithmic (dB/Oct) or in linear form (EU/Hz). EU is the engineering unit of
the corresponding reference (e.g. [inch] for displacement or [m/s2] for
acceleration).
Type:
Select the dimension the slope is to refer:
Def. Acc. = Slope refers to the defined acceleration.
Def. Vel. = Slope refers to the defined velocity.
Def. Displ. = Slope refers to the defined displacement.
Auto Acc. = Constant acceleration slope referred to double logarithmic scale.
With Auto Acc. selected, the Value and Unit entries cannot be made.
The displayed value must be ignored.
Value:
Enter a slope in [g/Hz] or [dB/Oct].
Unit:
Select [g/Hz] or [dB/Oct].

Abort
Low:
Enter the lower abort limit in - [dB] or in [%].
High:
Enter the upper abort limit in [dB] or in [%].
The alarm limits are pre-configured at + 3 dB.
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6.5.1.3

Define the Narrowband Random

Narrowbands

The narrowbands may cross. However, they must be within the defined frequency range of the
broadband random signal.
If necessary, select a larger frequency range of the broadband random signal and enter
extremely low levels at the new frequencies.
Narrowbands are added to the broadband spectrum. This means that the frequency resolution
of the narrowbands is determined by the frequency resolution of the broadband signal.
If the frequency resolution of the broadband signal is too large, the narrowband frequencies will
be rounded up to the next possible value.
The entries made for No. of Sweeps, Ramp Time, Start Level and Envelope apply to all narrowbands.

No. of Sweeps
Enter the number of sweeps to be done.

Ramp Time
Enter the time to start up and ramp down the signal in [s].

Start Level
Enter the level from which the narrowbands will be active.
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Narrowbands

Narrowbands

Envelope
Select MAX or ADD envelope.
MAX = the maximum value of broadband and narrowband levels will be taken
ADD = the narrowbands are added to the broadband spectrum



Broadband level: 0.1 g²/Hz
Narrowband level: 1.0 g²/Hz
MAX: 1.0 g²/Hz for narrowband
ADD: 1.1 g²/Hz for narrowband

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.
You can define up to 20 narrowbands.

Frequency
Bandwd.:
Define the bandwidth of the narrowband in [Hz].
Low:
Enter the lower frequency limit in [Hz].
High:
Enter the upper frequency limit in [Hz].
Start:
Enter the start frequency in [Hz].
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Sweep
Type:
Select linear or logarithmic sweeps.
Direction:
Enter the direction in which the sweep will start.
Rate:
Enter the sweep rate in [Hz/min].

Time
Time:
Define the time in [s] that it takes to perform one sweep.
Offset:
Enter the length of time in [s] after which the narrowband will be turned on at
starting level.
On:
Enter the length of time in [s] that the narrowband will be active after the random signal has reached the starting level and after the offset time is over.
If on time is set to zero, the narrowband will be inactive all the time. With on/
off times set to non-zero, they are repeated cyclically.
Off:
Enter the length of time in [s] that the narrowband will be inactive after the
random signal has reached the starting level and after the offset and on times
are over.
If off time is set to zero, the narrowband will be active all the time. With on/off
times set to non-zero, they are repeated cyclically.
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Selected Narrowband

Breakpoints for selected narrowband

Mark the narrowband for which you want to define breakpoints. The corresponding breakpoints
definition table is then shown. For each narrowband, you can enter up to 15 breakpoints to
define the reference power spectral density. You can add breakpoints to the end of the list at
any time.
Please take care that the breakpoints are sorted in upwards or downwards order.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Enter the frequency of the breakpoint.
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Accel.
Enter the level of the breakpoint.
A frequency segment is defined by levels and/or slopes.
You have to enter a level value at least for one frequency.

Slope
Enter a slope in [dB/Oct].

The alarm and abort limits will be taken from the broadband
random test.

6.5.1.4

Variable Sweep Rate

In sine-on-random and random-on-random you can define one or more sine tones/narrowbands with a variable sweep rate.

Sine-on-random test definition with variable sweep rate
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Random-on-random test definition with variable sweep rate

To change the sweep rate of the sine tone/narrowband, you have to define the time offset as
"-1".
Then, the sine tone/narrowband will sweep up to the high frequency defined in the current line
and will continue in the new frequency area with the sweep rate of the line where the time offset
was defined as -1. The spectrum for the sine tone/narrowband that has more than one sweep
rate must be completely defined for the line that starts the sine tone/narrowband. You must
copy this spectrum to all the lines that this sine tone/narrowband sweeps through (so where the
time offset is defined as -1).
In the examples above you can see one sine tone and one narrowband each with different
sweep rates in different frequency ranges.
Of course, it is possible to define more than one sine tone/narrowband, with varying sweep
rates or fixed sweep rates.
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6.5.1.5

Check the Reference Charts

The spectra defined are also represented in charts. Check the defined acceleration, velocity
and displacement traces with the m+p VibControl chart display functions. Charts are available
for broadband random, sine tones and narrowbands.

Broadband Random (Charts)

Broadband random charts
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Sine Tones (Charts)
Verify the parameters defined with the help of the charts:
•

The above chart is named Summary and shows the sum signal of all sine tones.

•

The lower chart shows the selected Single Tone - that is the individual tone currently marked
in the table.

Sine tone charts

Summary:

Sum signal of all sine tones.
To show the broadband random signal, check Show Random Base Signal.

Single Tone:

Individual tone currently marked in the table.
Mark the tone to be displayed.
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Narrowband Random (Charts)

Narrowband charts

Summary:

Sum the signal of the narrowbands.

Single Band:

Individual narrowband currently marked in the table.
Mark the narrowband to be displayed.
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6.5.2

Load the Shaker and Define the Specimen
in Mixed Mode Test Modes

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.
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6.5.2.1

Shaker

Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
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To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.

General Shaker Settings

General shaker settings

Mass unit selection
Select the desired mass unit [lbs] or [kg].When you change the mass unit, the
values will be converted accordingly.

Moving coil mass
The moving coil mass entered in VibShakerDef is displayed.

Total weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial stiffness
The axial stiffness entered in VibShakerDef is displayed.

Maximum input voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input voltage limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in
VibShakerDef by setting an input voltage limit for the power amplifier.
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The input voltage of the power amplifier corresponds to the output voltage of
the source
module. If the admissible voltage is exceeded, the test will be aborted.
Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

Max voltage 1st drive (RMS)
This function provides a drive limitation for random test modes.
The max. voltage 1st drive (RMS) value has the same function as the Input
Voltage Limit but applies to random and mixed mode tests. It has to be set
as RMS value.
After selfcheck the system calculates the probable RMS value for the first
drive signal. If this value is above the entered maximum RMS value, a test
start will be rejected.
The input voltage of the power amplifier corresponds to the output voltage of
the source module. If the admissible voltage is exceeded, the test will be
aborted.
Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

6.5.2.2

Define the Specimen

Define the specimen

Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.
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6.5.2.3

Define the Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.

Weight:

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

6.5.2.4

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.

6.5.3

Define the Mixed Mode Schedule

See chapter 6.1.3 “Define the Schedule for the Random Test Mode”, page 117.
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6.5.4

Define the Mixed Mode Channels

Mixed mode channels definition

Control Strategy
Select the control strategy.

Average
The average value of all control channels serves as reference. In mixed
mode tests, the control signals can be weighted differently so that averaged
control signal can be adapted to the test situation.

Maximum
The maximum of all control channels serves as reference.

Minimum
The minimum of all control channels serves as reference.
The "Minimum" control strategy may cause an overloading of the
specimen. If the control channel exceeds the abort limit, the test will
stop and change to Standby mode. Select this control strategy only
for control and limiting channels CW having an upper and lower
abort limit (Tolerance mode).

EU Control Channel
Control channels can be defined for accelerometers only.
Select a unit of acceleration
The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.
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Import Notch Table
Importing a notch table is useful for systems with high channel counts. In Sine and Random
test modes, you define an ASCII file containing the optimum notch limits for each channel and
import it every time you need them. You can import this file even if you don’t work with the maximum channel count as notch limits for channels not in use are skipped.
First define the ASCII file containing the desired notch limits. Then click the
button and select the corresponding file. Click Open to start the file import.

Transducer Database
The TRANS button leads you to the Transducer database list

Transducers’ list

m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.

TEDS Support
Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to IEEE
1451.4. This feature is useful for high-channel count vibration control systems and for applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of the
sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, as well as by VXI Technology's
digitizer module VT1435/1436.
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Low-Pass Filter Option with m+p Hardware
For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled.
Filtering is available for sine, random, sine dwell, sine reduction, random reduction test types.
The filter is a fourth order butterworth low-pass filter.
If the filter option is available the desired cutoff frequency can be entered.
The same filter settings are used for all input channels.
The filter frequency cannot be set lower than the maximum frequency of the reference
spectrum.
Filtering may be useful, if interfering signals above a specific frequency should be attenuated.

Channel Parameters Table

Channels table

No.
The number of channels depends on your software license.
In sine and random modes, all channels can be used as control
channels.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input
modules, take the slot number into account.

Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.

m+p international
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W

= watchdog (= limiting) channel

M

= measurement channel (not suitable for monitoring;
if you want to connect this function with a measurement channel,
the measurement channel must be set up as WM channel.
In any case, the measurement channel is stored when
measurements are triggered automatically or manually).

CW

= control and watchdog channel

CM

= control and measurement channel

WM

= watchdog and measurement channel

CWM

= control, watchdog and measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.

Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
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general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditionning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".

Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.

Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
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- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

Weighting
For the Average control strategy, the average signal of all control channels is
used. The weighting function enables a single channel to participate more by
including it several times while others are only included once. Thus, difficult
test situations can be controlled in an effective way.
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For Example:
Channel 01

Weighting = 2

Channel 02

Weighting = 1

Channel 01 will be responsible for 66.66% of the averaged control signal
while channel 02 will be responsible for only 33.33%.

Averages
Enter the number of averages. These linear averages (KM) are only used with
measurement channels for the calculation of the degrees of freedom (DOF).
DOF for M channels: DOF = 2 * KM
where KM = number of averages defined in the Channels tab
The averages entered here are not related to the logarithmic averages used
for the test run control.
This quite often used to generate a linear averaged measurement at the end
of the test.

Av mode
For watchdog channels in sine and random and displacement control in sine
only (There are no watchdog channels in classical shock or SRS shock):
Select the Watchdog mode (Notch, Tolerance, Notch/Tolerance, Monitor).
Notch:
In Notch mode, the excitation is limited in a defined frequency range (bandwidth) such that the defined level will not be exceeded. With Notch selected,
the notch spectrum of the selected channel can be defined in the bottom
notch table.
As long as a notch channel does not exceed the defined level, m+p
VibControl uses the test spectrum. If the specimen is overloaded at the
defined measuring point (= notch channel), the notch channel presenting the
highest exceeding of the notch level will be used as reference. Where the
frequency range is exceeded, the notch channel becomes the only control
channel. Notching changes the test spectrum.

Notching is always a limitation of the upper level, not of the lower
one. There are no abort limits (RMS). If you want to check the abort
limits (RMS), select Notch/Tolerance mode.

If you use a pure watchdog channel in the Notch mode, the lower
level is not limited. Therefore, the controller will not abort the test if,
for instance, the transducer is defective or the cable is parted.
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Tolerance:
The watchdog channel is checked for its upper and lower abort limits (RMS).
If the tolerance is exceeded, the test will abort.
Notch/Tolerance:
This function combines notching and checking of upper and lower abort limits
(RMS), ensuring that the controller will abort the test if it acquires no signal
that lies above the background noise (e.g. when the transducer is defective
or the cable is parted).
With Notch/Tolerance selected, the notch spectrum of the selected channel
can be defined in the bottom notch table.
Monitor:
The watchdog channel is exponentially averaged but the test will not be
aborted when overload conditions (e.g. due to DC offsets, or out of band
energy) occur. (This feature applies only for Random excitation.)

Notching is applied to the random signal, not on the sine amplitudes.

Abort

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.

For Random only:
Enter the lower (Low) and upper (High) abort limits (RMS). The RMS values
of the channels depend on the structure of the specimen. In case of control
channels, select the unit of the abort limits in EU control channels.

If you select an absolute unit [g] or [m/s²], the upper abort limit is
independent of the current test level. The lower abort limit becomes
effective after reaching the line-by-line-check start level.

If you select a relative unit [dB], the abort limits will be activated as soon as
the current level is greater or equal to the line-by-line-check start level.
If you define several control channels, the RMS values which are to be
expected are derived from the system gain. So m+p VibControl considers the
fact that not all channels have the same RMS value. The system gain is calculated for every level.
When Notch/Tolerance mode or Notch mode was selected for the watchdog
channels, the unit can be chosen in the Sensitivity column. If the abort limit
(RMS) is exceeded, the test will be aborted.
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6.5.5

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.

6.5.6

Mixed Mode Test Control

VibRunner in sine-on-random testing

Having performed the selfcheck to check the test setup on feasibility, you can now start up the
test run.
The sine tones/narrowbands will be turned on as soon as the broadband random signal
reaches the starting level defined in VibEdit’s Reference tab. The sine tones/narrowbands will
be turned off when the defined number of sweeps is done or when the level of the random
signal decreases below starting level.
The drive signal and all measurement signals are shown with sine tones included. If you want
to show the sine tones separately, you can enable the sine tone display in a third chart using
the context menu.
In addition to the functions you already know from the VibRunner for random mode, the
VibRunner contains further functions for sine tones and narrowbands.
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Time
The VibRunner displays the current test time:
Total / ElapsedTotal test time which has elapsed.
Total / RemainingTotal test time remaining.
Level / ElapsedTime elapsed at current test level.
Level / RemainingTime remaining at current test level.

6.5.6.1

Sine Tone Controls
You can have the sine amplitudes (acceleration versus
frequency) displayed in the online chart.
Sine tones can be defined for the following test modes:
multi-sine, sine-on-random, sine-on-random-onrandom.

The online trace is displayed as drive signal with sine tones included so that voltage peaks are
recognized immediately and the test spectrum can be set to a lower level, if necessary. The
reference traces for the measurement, control, and watchdog channels also show the signal
with included sine tones but, as mentioned in section 6.5.6, it is possible to switch to a pure
sine tone display.

Drive signal with sine tones included

It is possible to switch to a pure sine tone display.
Use the following buttons for the sine tones control.
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Open Loop
In Open Loop mode, the last drive signal remains unchanged.
To change to open loop control, click the Open Loop button of the Sine Tones
field. When Open Loop shows green light, the loop is opened.
In Open Loop mode, the Time remaining display stops counting.
To close the control loop, click the Open Loop button again. The test will be continued in Closed
Loop mode.

Off
You can manually turn off and on the sine tones with the ramp time defined in
VibEdit’s Sine Tones tab.
To turn off the sine tones, click the Off button of the Sine tones field. With the
sine tones turned off, the Off button shows green light.
To turn on the sine tones, click the Off button of the Sine tones field again.

Sweep Stop
You can manually stop and continue the current sweep.
To stop the current sweep, click the Sweep Stop button. With the sweep
stopped, the Sweep Stop button shows green light.
To continue a stopped sweep, click the Sweep Stop button again.

Change the Sweep Direction
You can manually reverse the sweep direction.To reverse the current sweep
direction, click the Change Sw. Dir. button.
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6.5.6.2

Multi-Sine Testing

The mixed mode sine tone controls are also used to perform multi-sine testing (see chapter
6.5.6.1).
Multi-sine reduces testing times of durability tests: For example, if you need 100 hours for a
standard sine sweep test, the test duration can be reduced to about 20 hours with five sine
tones performed in parallel (depending on the specimen).

Multi-sine: 10 sine sweeps in parallel

6.5.6.3

Broadband and Narrowband Random Controls

Broadband and narrowband random controls

When a VibRunner mixed mode test is aborted, the narrowband signal and the broadband
signal are stopped exactly at the same time so that the state of both the control and drive signal
at the moment of the abort can be analyzed as displayed below.
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Control and drive signal in Random-on-Random mixed mode test run

Level

The VibRunner displays the previous, current and next test level.
Next Level
Current Level
Previous Level

Next tested level.
Currently tested level.
Previously tested level.

You can manually hold a level, go to the next or previous level or release a Hold level.

Manual action will override the schedule.

Level up
Hold
Level down

Go to the next test level.
Hold/Release the current test level.
Go to the previous test level.
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Open Loop
You can manually open the control loop and close the open control loop.
In Open Loop mode, the last drive signal remains unchanged and dynamic
control is lost.
In open loop control, only the upper abort limit is active. Once you select
closed loop control, the lower abort limit will be taken into account, too. So
the test will be aborted as soon as the upper or lower abort limit is
exceeded.

Manual action will override the schedule.

To open the control loop, click the Open Loop button. In Open Loop control, this button shows
green light. In Open Loop mode, the Time remaining display stops counting.
Before closing the control loop, check the reference spectrum in any case. If the reference
spectrum deviates considerably from the measured one, you must not close the control loop.
In this case it is recommended to start the test at a lower level.
To close the control loop, click the Open Loop button. In closed loop control, this button does
not show green light.

Off
You can manually turn off and on the narrowbands with the ramp time defined in
VibEdit’s Narrow Bd. tab.
To turn off the narrowbands, click the Off button of the Random: field. With the
narrowbands turned off, the Off button shows green light.
To turn on the narrowbands, click the Off button of the Random: field again.

Save Timer
(available in standby mode only)
If the test is aborted, you do not have to repeat the complete run at the current
level. Click the Save Timer button to save the time remaining at test abort.
To save the time remaining at test abort, click the Save Timer button.
Restart the test from the previous level.
Reaching the test level at which the abort occurred, the remaining time will be tested.
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6.5.6.4

Test Log

The lower left part of the VibRunner displays the test log. The test log lists all relevant test
events in chronological order, including the activation of narrowbands. The online test log
displays the latest information only. To view the complete test log after test end, open the offline
test log.
To open the offline test log, select Protocol file from the File menu. Print out the test log.

6.5.6.5

Online Charts

The online charts are a useful control tool. See chapter 5.3 “VibRunner Chart Display Functions”, page 82.

6.5.6.6

Run the Getting Started Test

By running a Getting Started test you can check the performance of your signal processing and
data acquisition system on a bare wire, i.e. neither a shaker nor a specimen are involved in this
testing - allowing you to learn the m+p VibControl control functions with only the measurement
front-end and a BNC cable being required.
To start up the test, first perform a selfcheck. Then you can start the test by clicking the Run
button.
The online control window displays the measured signals. The test run is performed as defined
in VibEdit’s Schedule tab.
Please try the online control functions as described in chapters 6.5.6.1 to 6.5.6.3.
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6.6

Sine Dwell Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: Define the test run profile/s

•

Specimen: Enter the properties of the shaker and the specimen

•

Schedule: Define the selfcheck properties and the test schedule

•

Channels: Define the channel properties

6.6.1

Define the Sine Dwell Reference (VibEdit)

Sine dwell

Every mechanical part reacts to a mechanical excitation (vibration) in a different way,
depending on the frequency of excitation.
In speculative mechanics the term of resonance is clearly defined by the phase shift between
excitation and response.
In vibration control and environmental simulation, however, every distinct super-elevation of
the system response is called resonance.
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At the resonance frequency, the part is easily destroyed. If the mechanical characteristics of
the specimen change during the test (e.g. fissure, temperature change), the resonance frequency will shift.
The sine dwell option lets the sweep remain on one or several selected resonances for a userdefined period.

Detect Resonances
Before starting the sine dwell function, you have to search the signal for resonances. The
phase relationship will be displayed in VibPostTest using the phase information function (see
chapter 8.5.2 “Transfer Functions”, page 514).

Sine Dwell Reference Subcategories
The sine dwell Reference tab of VibEdit shows two sub-categories:

Accelerations - Slopes

Dwell frequency table

Define the reference amplitude of acceleration in [g] or [m/s²]. Up to 10 resonance points can
be defined. You have to enter a dimension value at least for one dwell frequency. It is not
necessary to enter all three values for one frequency, the missing ones will be calculated and
displayed automatically.
Slopes refer to acceleration, velocity or displacement. They can be defined in logarithmic
(dB/Oct) or in linear form (EU/Hz). EU is the engineering unit of the corresponding reference
(e.g. [inch] for displacement or [m/s2] for acceleration).

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.
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Frequency
Specify a resonance and enter it in the sine dwell list.
Allowed frequency range: 0.1 Hz - 12.8 Hz
The resonances are listed automatically according to their frequencies.

Accel./Vel./Displ.
Define acceleration, velocity or displacement for this dwell frequency. If you
enter “0“, the amplitude will be calculated from the previous and next slopes.
It is not necessary to enter all three parameters per frequency since the
missing ones will be calculated from the given parameters and displayed
automatically.
To change the acceleration, velocity and/or displacement units, go to the
Units selection field and select from the drop-down lists. All reference
numerical and graphical data will be automatically converted.

Slope
To define a slope, select to which dimension the slope is to refer (Type) and
enter the slope value (Value and Unit).
Slopes refer to acceleration, velocity or displacement. They can be defined
in logarithmic [dB/Oct] or in linear form [EU/Hz].
Type:
Select the dimension the slope is to refer to:
Def. Acc. = Slope refers to the defined acceleration.
Def. Vel. = Slope refers to the defined velocity.
Def. Displ. = Slope refers to the defined displacement.
Auto Acc. = Constant acceleration slope referred to double logarithmic scale.
Value/Unit:
With Auto Acc. selected, this entry cannot be made.
The displayed value must be ignored.
Enter a positive or negative slope value and select the corresponding unit.
Slope in [dB/Oct]:

f2
y 2 = y 1  ----f1

Slope
-----------------------------20 log 10 (2)

Slope in [EU/Hz]:
y2 = y1 + slope (f2 - f1)
y2

=

calculated engineering unit at frequency 2

y1

=

reference of engineering unit at frequency 1

EU (Engineering Unit) is the unit of the corresponding reference (e.g. [inch]
for displacement or [m/s²] for acceleration.
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Alarms - Aborts

Alarm and abort limits

To copy the dwell frequencies from the Accelerations - Slopes table to the Alarms - Aborts
table, open the Accelerations - Slopes sub-category and mark and copy the frequencies to the
clipboard. (Copy function from the Edit menu).
To change from Accelerations - Slopes to Alarm - Aborts, click the Alarm - Aborts button.
Activate the alarms/aborts table with a click of your mouse button and paste the frequencies
from the clipboard.
Enter the limits required for each frequency.
To set the same lower or upper alarm or abort limit for multiple rows, click
the first row to set with your left mouse button, press and hold the Shift key.
Click the last row to set with your left mouse button. Due to the Shift key
being held, now all rows in between are selected. Select the field of the
limit to set with a click of your left mouse button. Release the Shift key and
type in the lower or upper alarm or abort limit. Press "Enter" to globally set
all rows selected to this lower or upper alarm or abort limit.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field. To activate an empty row, double click
the row‘s No. field.
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To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Frequency
Copy the dwell frequency defined in the Accelerations - Slopes category.

Alarm
Enter the lower and upper alarm limits at every frequency (resonance point).
Any exceeding of the alarm limits during the test run will be entered into the
test log.
Low:
Enter the lower alarm limit in - [dB] or in [%].
High:
Enter the upper alarm limit in [dB] or in [%].

Abort
Enter the lower and upper abort limits at every frequency. If the abort limits
are exceeded during the test run, the test will be aborted.
Low:
Enter the lower abort limit in - [dB] or in [%].
High:
Enter the upper abort limit in [dB] or in [%].

Select the Units

Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All reference numerical and graphical data will be
automatically converted.

Measurement - Number of Lines Selection
In the Measurement section of the Reference tab you select the Number of lines to define the
number of spectral lines used for data storage.
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Rescale
You can time-efficiently rescale, i.e. dampen or amplify, the complete spectrum (all values
defined) by a factor.



To amplify the spectrum by a factor of 2, type “6“ [dB].
To dampen the spectrum by a factor of 0.5, type “-6“ [dB].

To open the Rescale dialog, click the Rescale button.
•

Select the unit for the rescale factor in the unit selection field.
Available units are [dB], [%], [g]

•

Type the rescale factor.

•

To dampen the spectrum, type a negative factor (negative sign).

•

To amplify the spectrum, type a positive factor (no sign).

•

Tick the Include notch limits field if you want to rescale the notch limits, too.

•

Tick the Include upper abort field, if you want to rescale the notch limits, too.

Rescaling

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.
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File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.

Check the Reference Charts
The spectrum defined is also represented in charts of acceleration, velocity and displacement.
Check the defined acceleration, velocity and displacement traces with the m+p VibControl
chart functions.

6.6.2

Load the Shaker and Define the Specimen
in Sine Dwell Test Mode

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
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You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.

6.6.2.1

Shaker

Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

m+p international

m+p VibControl Rev. 2.16

337

Load the Shaker and Define the Specimen in Sine Dwell Test Mode

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.

General Shaker Settings

General shaker settings

Mass Unit Selection
Select the desired mass unit [lbs] or [kg]. When you change the mass unit,
the values will be converted accordingly.

Moving Coil Mass
The moving coil mass entered in VibShakerDef is displayed.

Total Weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial Stiffness
The axial stiffness entered in VibShakerDef is displayed.
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Maximum Input Voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input Voltage Limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in
VibShakerDef by setting an input voltage limit for the power amplifier.
The input voltage of the power amplifier corresponds to the output voltage of
the source
module. If the admissible voltage is exceeded, the test will be aborted.
Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.

6.6.2.2

Define the Specimen

Define the specimen

Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.

6.6.2.3

Define the Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
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If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.

Weight:

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

6.6.2.4

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.
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6.6.3

Define the Sine Dwell Schedule

Sine dwell testing schedule

Before starting the sine dwell function, search the signal for resonances. The phase relationship will be displayed using the phase information function (see chapter 8.5.2 “Transfer Functions”, page 514).

External shutdown time
Enter the time in [ms] to ramp down the drive signal in case of an emergency
shutdown. This function requires an Emergency OFF switch being connected
to the bridged output channels of the front-end in use. For further information
on the emergency shutdown, please refer to chapter 2.9 “External Shutdown”, page 14.

Selfcheck
Selfcheck is useful for verifying the test definition and the channel setup as
well as for recording a first structural response of the specimen. The standard
selfcheck is done with a fixed output level. For more information on the selfcheck function, please refer to chapter 3.3.7 “Selfcheck”, page 44.

Selfcheck mode
- Fixed Level:
Standard selfcheck is done using a fixed output level. This level is defined
in the Selfcheck level (100 mV) field,
You can manually define an attenuation shape using the >> button.
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For further information please refer to the Selfcheck Attenuation paragraph
on page 119.

Selfcheck - fixed level settings

- Limiter Mode:
In Limiter mode, selfcheck is done using variable output levels. Starting with
a low level that is defined in the Min. selfcheck level (100 mV) field, the selfcheck will gradually increase to the value specified in the Max. selfcheck
level (100 mV) field. In order to achieve a good signal-to-noise ratio while
avoiding a too high load on the specimen, the response is limited to a reasonable value. Any spectral lines which are too close to the reference spectrum or notch limits are automatically reduced to a safe value.

Selfcheck - Limiter mode settings

Selfcheck level (100mV)
Enter a lowering of the drive signal for the selfcheck in [dB] referred to 0.1
Vrms. The selfcheck level [dB] = 20 log (Vrms / 100 mVrms )
0 dB = 0.1 Vrms in selfcheck. Lowerings of  0 dB are allowed.
You determine the selection of the selfcheck level through experience and
engineering judgement. Be aware that a very low selfcheck level may result
in very small signals which do not lie above the system background noise.
For applications such as servo-hydraulic exciters where selfcheck levels of
0.1 Vrms do not cause accelerometer response to run a test, selfcheck levels
of > 0 dB are also accepted by m+p VibControl for Sine, Random and RoadLoad modes. A maximum level of 0.5 Vrms should be sufficient for selfcheck
with such applications.

Selfcheck gain level limit
The selfcheck gain level limit states by what tolerance the system gain
measured during the selfcheck is allowed to deviate from the system gain
defined in the Channels tab.
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Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line

Selfcheck attenuation defined

Throughput section
The Throughput section in the Schedule tab offers several options for
throughput start and stop settings.

Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.
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Sweep Conditions

Sweep conditions

Sweep rate
With Amplitude type selected in the dwell table, enter the sweep rate for logarithmic sweeps in [Oct/min] or [Dec/min] and for linear sweeps in [Hz/min].

Start drive (100 mV)
Define a lowered start drive in [dB] (reference: 0.1 Vpk). At start, the test drive
will be increased from this drive towards the reference drive. Select the start
drive such that it is far larger than the background noise.

Startup time
Enter the startup time in [s].
This is the rate at which the drive signal is increased towards the reference
level.

Startup tolerance
Enter the admissible tolerance at start-up in [dB] to the reference spectrum
amplitude.
If, at start-up, the error, i.e. the comparison between reference value and
measured one, remains within tolerance, the sweep will start. The error is displayed in VibRunner.

Shutdown time
Enter the shutdown time in [s] during which the controller will turn the current
drive signal off if the abort limit is exceeded.
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Repetition Parameters

Repetition parameters

Number of repetitions
Enter the number of repetitions.

Auto measure every _ sweeps up
You can define an automatic data storage every time all of the dwells in the
dwell table are completed. The measured data are stored to the result file.

If you set for instance the automatic measuring to every sweep up
for a test with 100 repetitions, this may well generate a sine dwell
test result with several MB on your hard disk!

Sweep duration
m+p VibControl calculates the total sweep duration from the durations
defined in the dwell table.

Test duration
m+p VibControl calculates the test duration from the number of repetitions
and the sweep duration.

Stop at end of each Dwell
When this function is enabled, the test run status changes to Standby after
each dwell and waits for the next Start command to start with the next dwell.
(Usually, this test mode runs dwell after dwell without any stop in between.)
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6.6.3.1

Sine Dwell Type Selection and Parameter Settings

Importing Peak Values Tables
Using the Peak Values function in VibPostTest (see chapter 8.5.1, page 511) you can save
either a selection of peak values or all acquired peak values of a resonance search to a table.
These values are saved together with their parameters (frequency, amplitude and Q factor).
The Peak Values table can be saved as *.txt file e.g. in a subdirectory of the corresponding
m+p VibControl project file.

Peak values search before running a sine dwell test

In the VibEdit Schedule tab, you can import the acquired frequency results from the Peak
Values table. Click the Import button below the sine dwell table and choose the desired file
containing the peak values. Click Open and the values will be written to the dwell table.
By default, all data is loaded as sine dwell type Fixed. Adjust all other parameters accordingly,
e.g. Duration, Channels, Amplitude, Unit and Log.

Import of Peak Value tables
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Dwell Table Parameters
In the sine dwell table, select the desired dwell type. The available dwell types are Fixed,
Phase, Phase def., Amplitude, Auto Phase, New level and Stepped Sine. If licensed accordingly, the dwell types HCF and HCF_Step are also available.

Sine Dwell Table

The parameters Duration, Channels, Amplitude and Log have to be defined for all dwell types.
Other parameters, e.g. the Q factor, are only used with certain dwell types.

No.
Consecutive row numbering.
To edit a row, click the row‘s No. field.
To activate an empty row, double click the row‘s No. field.
To easily cut, copy and/or paste a row, right-click on the row’s No. field or use
the menu available under Edit.

Type
Choose one of the following dwell types.
- Fixed (see p. 351)
- Phase (see p. 352)
- Phase def. (see p. 353)
- Amplitude (see p. 354
- Auto Phase (see p. 355)
- New Level (see p. 356)
- Stepped Sine (see p. 357)
- HCF and HCF Step (see chapter 6.6.4, page 358)
On the given pages you will find a detailed description of the different sine dwell types.

Q
The quality factor Q describes the resonance quality. It is determined using
the peak value search in VibPosttest. The defined Q factor influences the
control strategy.
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The following selections can be made:

L Q < 50 (Low)

M 50 < Q < 200 (Middle)

H Q > 200 (High)

f0
f
Q = ----0- = ------------f
f2 – f1
The above values are only recommendations. In some cases the “H” setting
can also be used for low Q factors. When using the “H” setting, the measurement time is extended (more periods) in order to strengthen the control stability.

Duration
Enter the sine dwell duration using the parameters Value and Unit.
Value:
Enter the duration or the number of cycles.
Unit:
Select whether the sine dwell duration is given in Seconds, Minutes or
Cycles).
If you select Cycles, the test duration will be calculated by dividing the
specified number of load cycles by the (moving) frequency.

Frequency [Hz]
Define the resonance frequency using the parameters Start, Min, Max and
Band.
Start:
Enter the frequency at which the test run shall start.
Min:
(only for type Phase, Phase def., Auto phase and Amplitude)
Enter the lower frequency limit at which the test shall be stopped. If the resonance frequency shifts “downward" and reaches the lower limit, the test will
be stopped (VibRunner state: Standby).
Max:
(only for type Phase, Phase def., Auto phase and Amplitude)
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Enter the upper frequency limit at which the test shall be stopped. If the resonance frequency shifts “upward" and reaches the upper limit, the test will be
stopped (VibRunner state: Standby).
Exception:
For sine dwell type Stepped Sine the frequency band width is defined by
Frequency Min./Max.
Band:
(only for type Def. Phase, Auto Phase and Amplitude)
Enter the frequency band, where the sweep shall move upward and downward.
delta f:
- When using Phase, Auto phase, Phase def. and HCF, the following applies:
If the phase changes more than delta f between two consecutive measurements, the test stops. If delta f is set to 0, an abrupt change of the frequency
will be ignored.
- When using Stepped Sine, delta f defines the step width of the frequency.

Sweep rate
(only for type Amplitude, Phase def. and Auto phase )
Enter the sweep rate in [Hz/min].

Phase
(only for type Phase def.).
Define the Phase in [°].

Channels
With the sine dwell types Phase, Phase def. and Amplitude, define the
channels by entering the parameters Meas and Ref.
Meas:
Enter the number of the channel which shows a resonance frequency
(usually a measurement channel M or a watchdog channel W).
Ref.:
Enter the number of the channel which serves as reference for the phase
position (usually the control channel C). Please ensure that the transducer of
the reference channel is not mounted at a nodal point.
If you choose the drive signal (source 1 on m+p frontends) as reference, this
will result in a high Q factor. Please make sure that the signal of the reference
channel is above the background noise at the chosen resonance point. With
sine dwell type Phase def. the drive signal can be very low at strongly pronounced resonances. In this case, you should use the COLA signal (source 2
on m+p frontends) as the reference channel. The COLA signal has a constant amplitude (standard 1 V) and the same phasing as the drive signal. It
can be adjusted in the range from 0-10 V.
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Amplitude
In the Value field of the table you enter the amplitude of the control channel
C in the given unit.
The default setting is 0 dB. An entry in [dB] means that the specified value of
the Reference tab serves as reference.
Alternatively, you can define the amplitude in absolute values (g) (which is
more simple as the entry is independent from the specified value of the
Reference tab).
The alarm and abort limits defined in the Reference tab apply to the amplitude, even if it differs from the reference amplitude.

Error [Degree]
For sine dwell types Phase and Phase def. you define the permitted error by
entering the parameters Max and Avg.
Max:
Enter the maximum permitted phase drift in [°] that applies during the test run.
If the current phase deviates more than the specified value from the reference phase, the test status will change to Standby.
Average:
Enter the permitted average phase drift in [°] that applies during the test run.
If the average of the current phase deviates more than the specified value
from the reference phase, the test status will change to Standby.

Log [s]
The current frequency and the phase (as well as other values) can be saved
periodically to the VibRunner test log. Enter the time in [s] after which the values shall be periodically saved to the test log. After the test run, the complete
test log can be loaded from the result file (*.rsd). Additionally, a separate text
file (*.txt) containing the essential information (Frequency, Cycles, Amplitude) will be saved to the hard disk.
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6.6.3.2

Characteristics of Sine Dwell Types

Sine Dwell Type “Fixed"
In this mode, fixed frequencies are used for the test run. The stimulation frequency (Frequency
Start) remains constant for the duration defined by the user, even if the resonance frequency
of the system shifts over the time.
The example below shows the behavior of a bending beam which is stimulated at three fixed
excitation frequencies. At time (a) the bending beam is detuned by applying an additional
mass. This results in a drift of the resonance frequencies of the beam which can be observed
by a phase drift.

Example for the “Fixed” sine dwell type
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Sine Dwell Type "Phase"
(Phase ratio between measurement channel and reference channel).
The phase between two defined channels (Meas. and Ref.) is measured and locked at the
defined start frequency. When the system is detuned this phase is kept constant by adapting
the frequency.
The test changes to Standby mode, if:
•

the phase cannot be kept constant after ten attempts,

•

the frequency exceeds the specified frequency range (Frequency Min/Max),

•

an abrupt frequency change (delta f) occurs,

•

the phase differs from the reference phase by more than the permitted maximum phase
error (Error Max/Avg).

Five phase measurements are taken and averaged at the beginning of the sine dwell test. If
the phase is unstable an error message is displayed. In this case, please check whether the
signal is too low or whether the signal interferences are too high. If necessary, choose another
transducer position on the specimen for the control channel.
In the example below, a bending beam is excited at a starting frequency of 787.7 Hz and a
phase of 96.47° is locked and kept constant. Applying an additional mass detunes the bending
beam (a). The controller corrects the phase (by adjusting the frequency) in order to reach the
formerly locked phase of 96.47° (b).

Example of the "Phase” sine dwell type
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Sine Dwell Type “Phase Def."
(Phase ratio between measurement channel and reference channel)
The phase between two defined channels (Meas. and Ref.) is kept constant in a specified
frequency range. Typically, a phase of 90° is specified.
To search for the defined phase, VibRunner starts sweeping at the defined start frequency. The
sine sweep moves in steps of frequency band/10 Hz with a maximum step size of dwell frequency x 0.002 Hz. The sine first sweeps to the upper frequency (start + band/2) and then to
the lower frequency (start - band/2). As soon as the defined phase is found, VibRunner displays
the locked phase and the sine dwell duration. The phase is held for the specified duration.
In order to quickly lock onto the phase ratio between the measurement and reference channels,
set the start frequency a little to the left of the resonance.
The test changes to Standby mode, if:
•

the defined phase cannot be found in the specified frequency range (Frequency Min/Max),

•

the frequency exceeds the specified frequency range (Frequency Min/Max),

•

an abrupt frequency change (delta f) occurs,

•

the phase differs from the reference phase by more than the permitted maximum phase
error (Error Max).

In the bending beam example below, the test starts with a frequency of 790 Hz and runs
upward to a frequency of 795 Hz (790 Hz + 10/2 Hz) while searching for the defined phase of
90°. After the sweep direction has been reversed, the phase of 90° is found and held (a). At
time (b) the bending beam is detuned by applying an additional mass. The controller corrects
the phase (by changing the frequency) in order to reach the previously locked phase (c).

Example for the "Phase def.” sine dwell type
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Sine Dwell Type "Amplitude"
(Amplitude ratio between measurement channel and reference channel)
The center frequency of a defined frequency band follows the maximum amplitude ratio (resonance) between the measurement channel and the reference channel. Within this frequency
band the sine sweep moves constantly at the defined sweep rate from the upper value (resonance frequency + frequency band/2) to the lower value (resonance frequency - frequency
band/2).
The test changes to Standby mode, if:
•

no maximum can be found in the specified frequency range (Frequency Min/Max), or

•

the current excitation frequency exceeds the specified frequency range (Frequency Min/
Max).

In the bending beam example below, the sweep starts at a frequency of 785 Hz and moves
upward while searching for a maximum (resonance frequency) until it is found (a). From this
point on the center frequency of the 2 Hz band follows the resonance frequency. At time (b) the
bending beam is detuned by applying an additional mass. The controller detects the resonance
frequency shift and repositions the center frequency onto the resonance frequency (c).

Example for the "Amplitude” sine dwell type
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Sine Dwell Type "Auto Phase"
In Auto Phase mode, the sweep starts at the frequency defined in the Frequency Start field
minus half the value defined in the Band field.
(StartSearch = Start - Band/2)
The sweep runs at the defined sweep rate to the frequency defined in the Frequency Start field,
plus half the value defined in the Band field.
(StopSearch = Start + Band/2)
The sweep looks for the maximum amplitude in the frequency range (Channel Meas./Channel
Ref., both measured in Filtered mode). After the frequency range has been traversed, the
sweep returns to the determined frequency with the maximum amplitude (resonance). At this
frequency the phase is measured and locked. From this time on, the phase is kept constant
even if the frequency changes (resonance shifts). The amplitude can be increased using the
New Level sine dwell type, without the need for another phase search.
The test changes to Standby mode, if:
•

no peak value can be found in the specified frequency range (Frequency Min/Max),

•

the resonance frequency exceeds the specified frequency range (Frequency Min/Max),

•

an abrupt frequency change (delta f) occurs,

•

if the phase changes more than Error [Deg] Max between two successive measurements.

In the bending beam example below the sweep starts at a frequency of 784 Hz (785 Hz - 2/2
Hz) and moves upward while searching for a maximum amplitude (resonance frequency).
When the maximum is found, the phase is locked and kept (a). At time (b) the bending beam
is detuned by applying an additional mass. The controller detects the change in phase and corrects it by adapting the frequency (c).

Example for the "Auto Phase” sine dwell type
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Sine Dwell Type “New Level"
In this mode, entries are only possible in the Amplitude and Duration fields. The New Level type
can only be applied in combination with another available sine dwell type. When switching to a
new level, the controller stays locked on a resonance point and only the amplitude is modified.
The resonance point has already been detected using one of the sine dwell types which are
listed above New Level.
For weakly damped systems, it is not recommended to change the level too drastically. If a
large level change is required, it is recommended to perform several small changes until the
targeted level has been reached.

Example for the “New Level” sine dwell type
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Sine Dwell Type "Stepped Sine"
In a Stepped Sine test, the frequency is changed step by step, whereas every step comprises
several waves at the specified frequency. At each frequency, the system response is measured
before the sine moves to the next specified frequency. The individual frequencies are
approached with a step size delta f while the amplitude remains constant.
As soon as the target amplitude has been reached, the test dwells for the specified duration at
this frequency and the measured data is saved. A maximum of 10 frequency ranges are available where up to 1000 frequencies may be defined in each frequency range.
The total number of frequencies used in your Stepped Sine test can be calculated according to
the following formula:
N (number of frequencies) = (FMax - FMin) [Hz] / delta f [Hz] + 1
In the below example, this results in:
N1 = (100 - 80) / 0.5 + 1 = 41
N2 = (120 - 100) / 0.1 + 1 = 201
N3 = (150 - 120) / 0.5 + 1 = 61
Ntotal = 303 Frequencies

Example for the "Stepped Sine” sine dwell type

Sine Dwell Types "HCF" and "HCF_Step":
Please refer to the following chapter.
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6.6.4

Sine Dwell Mode: High Cycle Fatigue Testing

Turbine blades can have resonances with a Q-factor of 1000 or more. To test such a blade, it
is imperative to have good dynamic range on the accelerometer and on the measurement
channel. It is necessary at all times to have a clean signal with a good signal-to-noise ratio,
otherwise phase and amplitude will be random and it will be impossible to control.

6.6.4.1

Sine Dwell Modes HCF and HCF_Step

These sine dwell modes are defined in the Dwell table of the Schedule tab.

In HCF mode, a sweep is started with the frequency you entered at Frequency Start and with
the Amplitude Value in [mHz] you defined. The sweep will run to Start + Bandwidth / 2 and back
to Start - Bandwidth / 2 with a step that is proportional to the bandwidth and will look for the
requested phase in this band (Channels Meas. / Channels Ref., both of which must be measured in Filtered mode). If during the sweep up, it becomes clear that the slope of the phase is
wrong, and we are moving in the wrong direction, the sweep is reversed. As soon as the correct
phase is reached, the requested phase is locked. If the phase cannot be found, it cannot be
locked, and the test is aborted.
Because the phase search will take some time, there is a different entry for Duration in the HCF
parameters than in the HCF_STEP parameters.
The Value in [mHz] is kept with changing frequencies, so the value in mm will change.
Once the phase is locked, the resonance reference frequency is updated, and the phase will
be kept constant even if the frequency changes (resonance moves). If the resonance shifts
below
(resonance reference frequency) * (100 - delta f) / 100,
this is considered as rupture, and the test is aborted. Also, if the phase changes more than Max
(Error [Deg]) between two successive measurements, the test is aborted.
The dwell will continue for time Duration - the time the sweep took.
At the end of this HCF, the level is increased by the level selected in HCF_STEP. The level will
change linearly to the requested level, and the time this change takes can be selected by the
user with the "Startup time" parameter. Once the new requested level is reached, the resonance reference frequency is updated, and the level is held for the selected time. The level will
continue to be increased until the resonance shifts below:
(resonance reference frequency) * (100 - delta f) / 100.
At this point, the test is aborted.
The choices for Q are L (Q < 50), M (50 <= Q < 200), H (Q >= 200).
The control algorithms will be adjusted accordingly.
An entry in the Log file will be made every Log seconds, also the time history data will be stored
in the time history traces at this interval.
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6.6.4.2

Channel Definition in High Cycle Fatigue Testing

As mentioned before, all channels that are used for High Cycle Fatigue Testing, need to be
defined in Filtered mode, otherwise the phase is not measured.

High Cycle Fatigue Testing - channel definition

To get the correct amplitude control values, consider the following points for the channel setup:
•

Place the laser vibrometer to the point where the amplitude in [mHz] will be obtained.

•

Define the channel, to which the laser vibrometer is connected, in [mm] and the corresponding sensitivity in [mV/mm]. This channel should be defined as a measurement
channel. Then, the signal needs to be connected in parallel to a control channel using a Tpiece. The control channel is defined in [m/s2] and with exactly the same sensitivity as the
laser vibrometer channel.
The reason for this is that the amplitude control is still conducted on the C-channels, and
that C-channels must be acceleration channels, and the conversion parameters to [mHz]
are based on this setup.

•

At the example channel definition above, the laser vibrometer is connected to channel 3
and channel 1 in parallel (using a T-piece).

•

Channel 2 is defined as an acceleration channel with the corresponding unit and sensitivity. The acceleration sensor will be mounted on the shaker head

•

The channels selected in the HCF for this example are channel 3 as Measurement channel and channel 2 as Reference channel, as defined in the previous chapter.

6.6.4.3

Resonance Search

To perform a resonance search, define a reference spectrum over the frequency band you
want to investigate in the sine excitation mode, with a low level (for instance, 0.15 m/s2). The
channel definition must be exactly the same as for the HCF setup (see previous chapter). If you
run the sweep in this way, the point where the laser vibrometer is attached will be excited at
0.15 mm pk over the band of excitation. To sweep over a high-Q resonance, it is recommended
to sweep slowly (0.5 Oct/min), enter the number of sine periods (VibEdit - Schedule: Integration
Time) to 8 or higher and the Damping (VibEdit - Channels) to 16 or higher.
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To analyze the results of the resonance search, click on Singleplot and use the laser vibrometer
(channel 3 in the example) as measurement channel and the accelerometer on the head of the
shaker (channel 2 in the example) as the reference channel. Selecting the Peak Values option
allows for automatic selection of the peaks in the resonance search. Furthermore, selecting
Q-factor will provide an estimation of the corresponding Q-factor. Now, the resonant frequency
and phase can be assessed at this level of excitation.

6.6.4.4

Settings

The "[VR_Sine]" section in "VcpNT.ini" (located in the "\VcpNT\Config\Users\xxx" directory,
where xxx is the user name) contains some variables that can help improve stability for
high-Q dwells.
Good settings are the following:

EnableAbortErrorAveraging=1
1 means average the control channel, 0 means don't
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AbortErrorAveragingAverageFactor=6
Exponential averaging factor for the control channel

MaxDriveSteps=30
A high number will slow down the controller, but will
prevent the system from modulating.

6.6.5

Define the Sine Dwell Channels

Sine dwell channel definition

6.6.5.1

Control Strategy

•

The amplitude for the dwell can be defined in dB or in the control unit [EU].

•

If the amplitude for the dwell is defined in the control unit [EU], it is set as control amplitude
and the control strategy is ignored.

•

If the amplitude is defined in dB, the amplitude follows the reference scaled with the
defined dB value. In this case the control strategy is used like in sine with more than one
control channel.
In this case, select one of the following control strategies:

Average
The average value of all control channels serves as reference. In sine dwell
test mode, the control signals can be weighted differently so that averaged
control signal can be adapted to the test situation.

Maximum
The maximum of all control channels serves as reference.

Minimum
The minimum of all control channels serves as reference.
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The "Minimum" control strategy may cause an overloading of the
specimen. If the control channel exceeds the abort limit, the test will
stop and change to standby mode. Select this control strategy only
for control and limiting channels CW having an upper and lower
abort limit (Tolerance mode).

6.6.5.2

Damping

Select the controller damping and thus the compression speed.
These values are available: 0, 1, 2, 4 and 8.
0  no damping/high compression speed
8  high damping/low compression speed.
The damping and the maximum error of a control channel enter into the control algorithm which
determines the following control.
The algorithm works as follows:
Aa+1 = Aa  (K + 1/E)/(K + 1); E < 1
E>1
Aa+1 = Aa  (K + 1)/(K + E);
Aa+1 = next amplitude
Aa

= current amplitude

E
K

= maximum error
= factor of damping

A high K factor (i.e. high damping) weights the old Aa value more and slows down the control.
The damping depends on the dynamics of the specimen. You can improve some tests by using
different dampings in the frequency intervals of the spectrum. Therefore, you can change the
damping in VibRunner.

6.6.5.3

Transducer Database

The TRANS button leads you to the Transducer database list
Click the TRANS button to open the list of transducers.

Transducer list
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m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.

6.6.5.4

TEDS Support

Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to IEEE
1451.4. This feature is useful for high-channel count vibration control systems and for applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of the
sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, as well as by VXI Technology's
digitizer module VT1435/1436.

6.6.5.5

Import Notch Table

Importing a notch table is useful for systems with high channel counts. In Sine and Random
test modes, you define an ASCII file containing the optimum notch limits for each channel and
import it every time you need them. You can import this file even if you don’t work with the maximum channel count as notch limits for channels not in use are skipped.
First define the ASCII file containing the desired notch limits. Then click the
button and select the corresponding file. Click Open to start the file
import.

6.6.5.6

EU Control Channel

EU control channels

Control channels can be defined for accelerometers only; in sine dwell mode, it is possible to
also define displacement transducers or force transducers to be control channels.
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Select a unit of acceleration or length (for displacement control).
The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.

6.6.5.7

Low-Pass Filter Option with m+p Hardware

For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled.
The filter is a fourth order butterworth low-pass filter.
If the filter option is available the desired cutoff frequency can be entered.
The same filter settings are used for all input channels.
The filter frequency cannot be set lower than the maximum frequency of the reference
spectrum.
Filtering may be useful, if interfering signals above a specific frequency should be attenuated.

6.6.5.8

Channel Parameters Table

Sine dwell channels table

No.
The number of channels depends on your software license.
In sine dwell test mode, all channels can be used as control
channels.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input
modules, take the slot number into account.
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Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel

W

= watchdog (= limiting) channel

M

= measurement channel (not suitable for monitoring;
if you want to connect this function with a measurement channel,
the measurement channel must be set up as WM channel.
In any case, the measurement channel is stored when
measurements are triggered automatically or manually).

CW

= control and watchdog channel

CM

= control and measurement channel

WM

= watchdog and measurement channel

CWM

= control, watchdog and measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts’ printout in VibPostTest.

Filter
Select the measuring method.
Each channel type (C, W, M) has its own amplitude estimation (Filter, RMS,
Average, Peak). In case of a CM channel, for instance, you can select RMS
for the C channel and Filter for the M channel.
If RMS, Average or Peak is selected, the RMS, average or peak value of the
broadband signal for each channel is measured and used for control. If the
Filter mode is selected, the signal for each channel is filtered using a digital
filter (similar to a tracking filter).
The measured signal amplitudes depend on the measuring methods:
Peak  RMS  Average  Filter
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Sine amplitude relationships

Filtered:
The Filter mode uses the principle of single-frequency FFT. The filter accepts
only the fundamental frequency. Harmonic waves will be rejected. To avoid
overtesting the specimen, this measuring mode should be used with care for
control channels.
Peak:
The Peak mode searches the data for absolute peak values. Where a system
is noisy, the peak value may be considerably greater than the average and
RMS values. If peaks vary considerably and if the damping is low, control
often becomes slightly unstable. Therefore, Peak mode should only be used
for "clean" systems featuring a linear behavior.
Special feature of Peak mode:
All four measuring modes use only the AC signal, regardless of the
chosen coupling. The Peak mode, however, measures also the DC
signal provided that it is greater than 50 % of the peak value.

Example application:
DC-coupled tolerance channel for monitoring a stretching wire.
RMS:
The RMS mode adds the squares of each input data point, divides the result
by the number of data points and takes the root of this result. This RMS value
will be multiplied by a factor of 2 which represents the peak-to-RMS ratio of
a pure sine. The RMS mode provides a measure of averaging compared to
the Peak mode, but tends to emphasize the larger values compared to the
Average mode. The RMS mode is used to avoid overtesting the specimen.
Averaged:
The Average mode performs a summation on the rectified values of the data
and divides the result by the number of points. This average will then be multiplied by a factor of /2 which represents the peak-to-average ratio of a pure
sine wave.
Selecting Combinations of Filters:
In sine and sine data reduction test modes you can also select combinations
of filters for each measurement channel.
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Filter type selection

Select M in the Type column and choose a combination of Filter, RMS, Peak
and Average in the Filter, M column and the test results will be recorded
accordingly.
During the test run the first filter of the filter type combination will be shown
(e.g. if you selected the filter combination Peak, RMS, Averaged ("PRA"),
VibRunner will display the Peak filter chart.)
It is also possible to display all selected filter types online: Open the context
menu and enable the Show all filter modes function.
After test run the result files, which were recorded with different filters, can be
opened in VibPostTest to compare the traces (see chapter 8.3.1 “Filter Channels”, page 479).

Model
Enter the transducer’s model name.

Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
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With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditioning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".

Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.
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Couple
Select the coupling according to the transducer type.

Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
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Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

Weighting
For the Average control strategy, the average signal of all control channels is
used. The weighting function enables a single channel to participate more by
including it several times while others are only included once. Thus, difficult
test situations can be controlled in an effective way.
For Example:
Channel 01

Weighting = 2

Channel 02

Weighting = 1

Channel 01 will be responsible for 66.66% of the averaged control signal
while channel 02 will be responsible for only 33.33%.

Av mode
For watchdog channels and displacement control only:
Select the Watchdog mode (Notch, Tolerance, Notch/Tolerance) or displacement control (Control, Control/Tolerance) or a notching function (VectorAdd,
VectorRSS, MNotch).
Notch:
In Notch mode, the excitation is limited in a defined frequency range (bandwidth) such that the defined level will not be exceeded. With Notch selected,
the notch spectrum of the selected channel can be defined in the bottom
notch table.
As long as a notch channel does not exceed the defined level, m+p
VibControl uses the test spectrum. If the specimen is overloaded at the
defined measuring point (= notch channel), the notch channel presenting the
highest exceeding of the notch level will be used as reference. Where the
frequency range is exceeded, the notch channel becomes the only control
channel. Notching changes the test spectrum.
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Notching is always a limitation of the upper level, not of the lower
one. There are no abort limits (RMS). If you want to check the abort
limits (RMS), select Notch/Tolerance mode.

If you use a pure watchdog channel in the Notch mode, the lower
level is not limited. Therefore, the controller will not abort the test if,
for instance, the transducer is defective or the cable is parted.

Tolerance:
The watchdog channel is checked for its upper and lower abort limits (RMS).
If the tolerance is exceeded, the test will abort.
Notch/Tolerance:
This function combines notching and checking of upper and lower abort limits
(RMS), ensuring that the controller will abort the test if it acquires no signal
that lies above the background noise (e.g. when the transducer is defective
or the cable is parted).
With Notch/Tolerance selected, the notch spectrum of the selected channel
can be defined in the bottom notch table.
Control:
This function is available in sine mode only. It enables you to specify displacement control. In this way, tests starting at very low frequencies can be
controlled on displacement if the resolution of the frequency range of the
accelerometer is not sufficient.
For displacement control, please select a unit of length (m, dm, cm, mm, µm
or inch) in the drop-down list next to EU control channels.
If you select Control for a watchdog channel, the control spectrum of the
selected channel can be defined in the bottom notch table.
Control/Tolerance:
This function is available in sine mode only. It combines displacement control
and checking of upper and lower abort limits.
For displacement control, please select a unit of length (m, dm, cm, mm, µm
or inch) in the drop-down list next to EU control channels.
If you select Control/Tolerance for a watchdog channel, the control spectrum
of the selected channel can be defined in the bottom notch table.
VectorAdd:
Select VectorAdd to enable the Summed Force notching mode, Then, define
the notching parameters in the lower part of the window.
Vector RSS:
Select VectorRSS to enable the Vector RSS notching mode Then, define the
notching parameters in the lower part of the window.
MNotch:
Select MNotch to enable the Moment Notching mode. Then, define the
notching parameters in the lower part of the window.
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Abort

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.

Enter the upper and lower abort limits. The amplitudes of the channels
depend on the structure of the specimen.
In case of pure control channels C, only the upper abort limit will be checked.
Select the unit in the EU control channels field above the table.
If tolerance, notch/tolerance or control/tolerance was selected for the watchdog channels, the upper and lower abort limits will be checked. The unit can
be chosen in the Sensitivity column. If the abort limit is exceeded, the test will
be aborted.

6.6.6

Printing the Test Specification

To print the test specification, go to the File menu and choose Print test specification. The print
function uses a different default template for each test mode.
For further information on the print templates and their modification, please refer to chapter
.3.2.6 “Modification of the Print Templates for the Test Mode Specifications”, page 29.
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6.6.7

Sine Dwell Test Control (VibRunner)

VibRunner in sine dwell testing

Having performed the selfcheck to check the test setup on feasibility, you can now start up the
test run.

Time, Sweeps, Cycles

Timer, sweep counter, cycles counter

The VibRunner displays the elapsed/remaining testing time, number of sweeps and number of
cycles.
The sweep counter indicates the number of sweeps done and the total number of sweeps to
go. Once the total number is reached, the test will change to standby mode.
The same applies to the cycles counter.
Reset the counter before restarting the test by clicking the Reset Counter button.
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Time / Elapsed
Time / Remaining
Sweeps / Elapsed
Sweeps / Remaining
Cycles / Elapsed
Cycles / Remaining

Total time into test.
Total time to test.
Number of sweeps done.
Number of sweeps to be done.
Number of cycles done.
Number of cycles to be done.

Sweep Direction

Sweep direction buttons

You can manually reverse the current sweep direction.

Manual action will override the schedule.

Sweep down Reverse the sweep direction:
Sweep will run to lower frequency limit.
Sweep up

Reverse the sweep direction:
Sweep will run to upper frequency limit.

Dwell No., Frequency, Drive, Damping, Error

Manual action will override the schedule.

Dwell No.
The sine dwell number in the VibRunner indicates which dwell is currently
running. You can click the arrow button on the right at any time to stop the
dwell and to go to the next dwell frequency.
If an error occurs during the test run, the program changes to standby mode;
click Run to continue the sine dwell test.
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Current Frequency
The current dwell frequency is displayed.
To reduce or increase the current frequency, first hold it by clicking the Hold
button. With the Hold button being activated, the arrow buttons next to Frequency will be enabled. By clicking these buttons you can reduce or increase
the current frequency.To continue the test, click Hold again.

Drive
Drive: indicates the current drive voltage of the corresponding frequency.
• The current drive can be manually reduced or increased:
• First hold the sweep by clicking the Hold button.
• Open the control loop by clicking the Open Loop button.
With Open Loop control, the arrow buttons next to Drive will be enabled.
• To reduce the current drive, click the arrow button pointing downwards.
To increase the current drive, click the arrow button pointing upwards.
• To continue the sweep, click the Hold button again.
To close the control loop, click the Open Loop button again.

To have the drive signal displayed on the online charts, see chapter
5.3.2 “Multiple Channel Selection”, page 83.

Damping
Damping: indicates the current controller damping.
You can manually change the damping at any time during the test run using
the two arrow buttons next to Damping.
Allowed damping factors: 0, 1, 2, 4, 8.
0 = no damping (maximum compression speed)
8 = maximum damping (minimum compression speed)

Error
Error: indicates the control error of the corresponding frequency.

To have the control error displayed on the online charts, see chapter
5.3.2 “Multiple Channel Selection”, page 83.
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Sine Dwell Test Control Buttons
Open Loop
In Open Loop mode, you can manually increase or reduce the drive signal.
To change to Open Loop control, click the Open Loop button. When Open Loop
shows green light, the loop is opened. In Open Loop mode, the Time remaining
display stops counting.
To close the control loop, click the Open Loop button again. The test will be continued in Closed
Loop mode.

Reset Counter (available in standby mode only)
You can manually reset the sweep counter to "0" and restart the test.
To reset the sweep counter to "0", click the Reset Counter button.

Manual action will override the schedule.

Reset Measurement
(available in standby mode only!)
You can manually delete the traces in the online charts.
To delete the traces in the online charts, click the Reset Meas. button.

Reset Cycles
You can manually reset the cycles of your test run.

Hold and Release the Sweep
To fix the current frequency and hold the sweep, click the Hold button. The time
defined in the Schedule tab will be ignored.
To release a frequency, click the Hold button again.
With a Hold level defined in the testing schedule, the Hold button shows green light when the
Hold level is reached. A Hold level requires manual release.
To manually release a Hold level, click the Hold button.
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Test Log

Online test log

The lower left part of the VibRunner displays the test log. The test log lists all relevant test
events in chronological order. The online test log displays the latest information only. To view
the complete test log after test end, open the offline test log.
Select Protocol file from the File menu.
Print out the test log.

Offline test log

Online Charts in Sine Dwell
The online charts are a useful control tool. See chapter 5.3 “VibRunner Chart Display Functions”, page 82.
For sine dwell tests it is possible to show Phase/Frequency over time graphs.
Open the charts context menu, select the Add channels function.
Define a new channel and its data format.
Selectable data formats are Phase over time and Frequency over time.
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Sine dwell test run with "Frequency over time" and "Phase over time" charts

Run the Getting Started Test
By running a Getting Started test you can check the performance of your signal processing and
data acquisition system on a bare wire, i.e. neither a shaker nor a specimen are involved in this
testing - allowing you to learn the m+p VibControl control functions with only the measurement
front-end and a BNC cable being required.
To start up the test, first perform a selfcheck. Then you can start the test by clicking the Run
button.
The online control window displays the measured signals. The test run is performed as defined
in VibEdit’s Schedule tab.
Please try the online control functions as described above.
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6.7

Special Test Modes

6.7.1

Define a Transient Capture Measurement

Transient capture - Parameters window

The transient capture module allows you to acquire any transient event such as droptable,
crashtest, or pyroshock pulses. Additional operating modes make this module an ideal tool for
measuring, displaying and storing signals in general. Select transient capture in VibEdit.
In the File menu select the Open... option and the Transient Capture file type.
If possible load an already existing test definition.
A transient capture test is set up in a single window namely the Parameters Window.

6.7.1.1

Transient Capture Parameters

Sampling rate
Set the sampling rate using the drop-down list.
The possible values are hardware-dependent.
Sampling rates, which are not supported by the hardware in use, are
marked by a gray background. You can select these sampling rates
for defining a test with another (not connected) front-end. This test
definition can be saved, but needs the required hardware to start.
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Number of samples:
Set the number of samples in the drop-down list.
Possible values: 256, 512, 1024, ...., 65536.
The measurement time is calculated from the number of samples divided by
the sampling rate and defined in milliseconds.

Total window length
Displays the resulting total window length in seconds.

Auto. meas. every ... block
Enter the number of measuring blocks to be stored automatically.



If you enter "4", every 4th measuring block will be stored. With "0"
selected, no measuring block will be stored automatically.

Initial Trigger Mode
Select the desired Initial Trigger Mode:
Free Run:
Measurements will be taken and displayed as fast as possible. The Free Run
mode can serve as a scope function. The system is measuring continuously.
The auto-measure setting defines how many measurement values will be
transferred into the results file.
Manual:
The Trigger button will be displayed in the VibRunner window. Clicking Trigger generates a triggered measurement.
Level/Slope:
A measurement will be generated if the signal passes the given trigger level
in the specified direction. Level and direction (slope) are specified in the
Channels section of the window.
External:
The measurement will be generated via a trigger line. (This is a special
Agilent feature. Please contact your local Agilent Office for further information.)

Bypass ADC filter
Enabling this function bypasses the integrated anti-aliasing filter to look at the
unfiltered signal (This feature is only available for Agilent hardware EX143x.)

Trigger delay
Enter a pre- or post-trigger in % relative to the size of the measuring block.
The corresponding time will be calculated and displayed in milliseconds.
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If you enter a positive value, a post-trigger will be generated.
If you enter a negative value, a pre-trigger will be generated.
Entering "0" means that the signal will be captured without any time offset.

Trigger delay (time)
The trigger delay (time) field displays the calculated trigger delay in
milliseconds.

Max. number of pulses to be stored
Check this function if you want to store more than one pulse and enter the
number of pulses you want to store.

6.7.1.2

Define SRS Parameters and Compliance Check

Click the SRS Parameters... button in order to open a separate window where you can define
the SRS parameters for the test run, or import a SRS parameter file via the Load button.
The lower part of the SRS Parameters window enables you to define a compliance check by
specifying pass/fail criteria.

SRS Parameters dialog

Compliance Check as Threshold Check for SRS Parameters
With transient capture measurements, a compliance check can be performed which is defined
as a threshold check for SRS transformations.
You can perform the following threshold checks:
•

Check whether the required number of lines or more exceed the reference you defined in
the table.
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•

Check whether the abort limits have been violated by the indicated number of lines or less.

•

Check whether the effective shock duration (Te) lies in a valid range. Note that it is necessary to specify a reasonable RMS window length which is used for the calculation.

These checks are available whenever an SRS transformation is done. They can be performed
either online while the test is running (VibRunner chart) or offline in the result file (VibPosttest
chart).

6.7.1.3

Define Throughput Settings

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.

File format
Select the throughput file format for saving the file. You can select m+p Analyzer Throughput files (*.sot) or raw binary files (*.dat). The raw binary format
can be read by third party software.
Below m+p VibControl offers several options for throughput start and stop
settings.

Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.
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6.7.1.4

Post-Processing of Throughput Files

Throughput files (*.sot) can be post-processed using sine reduction, random reduction or transient capture modes.

Enabling post-processing

Enable post-processing by checking the box. Then, browse through your files, select the *.sot
file and define Start time and End time of the file section to post-process.
Load the test into VibRunner and start it as usual.
The result file can be viewed and evaluated in VibPostTest.

6.7.1.5

Define the Channels

Special Setting in the Channels Table
For transient capture measurements, you can only define a single control
channel. The control channel is used for triggering the measurement if the
trigger mode is set to Level/Slope.

Transducer

Select Coupling

Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
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- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.

6.7.1.6

Starting Transient Capture Measurements (VibRunner)

Online chart

1. Click the VibRunner icon in VibEdit to directly change to the VibRunner software part. The
defined test run will be imported into VibRunner.
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2. If you need another test definition open the File menu, click Open... and choose the
desired Transient Capture test definition.
3. Click Selfcheck to prepare the transient capture test. m+p VibControl will arm the measurement hardware and will then change to standby.
4. If necessary you can modify the Trigger Mode you preselected in VibEdit by clicking one
of the following buttons: Free Run, Manual, Level/Slope, External. (For more information
on the trigger modes, please refer to chapter “Initial Trigger Mode”, page 380.)
The trigger delay entered in the transient capture Parameters window applies to all types
of triggering except for Free Run and Manual.

You can change the type of triggering in standby mode at any time.

5. Click Run to start the transient capture measurement.
The part of the window below Abort displays the number of total measurements and the number of stored measurements.
To store the current measurement, click Measure.
Clicking Save all stores all following measurements automatically, irrespective of the setting in
the transient capture Parameters window.
If you click Save all a second time, the measurements will be stored as specified in the transient
capture Parameters window.
The measurements can be displayed online. You can abort the test at any time by clicking
Abort. Clicking Exit in the Files menu exits the VibRunner window.

Please refer to chapter 7 “Run a Test (VibRunner)”, page 301 for detailed
information on the selfcheck, the result of the selfcheck and the test run.

Additional Buttons in the VibRunner Online Charts:
Measure

Store the current measurement.

Save all

Store the following measurements automatically.
If you click Save all a second time, the measurements will be stored as
specified in the transient capture Parameters window.

Trigger

(only available for manual triggering type)
Trigger a measurement.
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6.7.1.7

Online-SRS with Representation of the Reference-SRS

The transient capture module also enables you to calculate and visualize an online-SRS.
In addition, you have the possibility to show both the reference SRS-graphics and the
online SRS-graphics in one window for immediate evaluation of the test. You can see at a
glance whether the measured signal is within the alarm and abort limits.

Online SRS-graphics

Import or Definition of SRS Parameters
Right-click on the diagram and select the SRS Parameters ... option in order to open the SRS
dialog to edit the current SRS parameters, or import a SRS parameter file.
In the lower part of the window, you can define a compliance check (for further information
please refer to chapter 6.7.1.2, page 381).
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SRS Parameters dialog

Whenever you enable one or several compliance checks in the SRS Parameters dialog,
m+p VibControl checks the SRS spectrum online against the previously specified pass/fail
criteria and shows directly whether they have been met or not.

Compliance check results displayed in VibRunner chart

The compliance check results can also be displayed and evaluated in the VibPosttest chart.
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VibPosttest chart showing compliance check with pass/fail indication

6.7.1.8

Transient Capture with Imported Shock Limits

To perform Transient Capture with imported Shock limits the Classical Shock module and the
Transient Capture module have to be enabled.

Test Setup
Create a definition for Transient Capture (TransCap_CLS.ttc in the example below) which
includes the set-up of your transducers, Sampling rate, Number of samples, etc. Choose a
Trigger delay of approximately 25-30%.
Open the Classical Shock Editor (TransCap_Classical Shock.tcs) and create a test definition
with the limits of your desired shock. Choose the same Sampling rate and Number of samples
as defined in the Transient Capture setup (see figure next page).
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Transient Capture and Classical Shock setup

Running the Test
Load your setup for Transient Capture into the VibRunner using the File menu and run the Selfcheck. After the Selfcheck is completed the VibRunner switches to "Standby". Go to the File
menu, select the Load Cl. Shock parameters option and choose the Classical Shock setup you
have created before. The limits will be transferred into the Transient Capture test (see figure
below).

VibRunner after importing classical shock parameters
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In the upper right side of the window you find some adjustment features for capturing the shock.
Choose A for automatic so that m+p VibControl will automatically compare the recorded pulse
with the reference. Choose M if you want to adjust the shock manually by editing the x- and ycoordinates.

Choose your preferred Trigger mode and start the test. Every recorded shock is compared to
the reference of your shock data (see figure below).

Recorded shock automatically compared with reference

To take advantage of the automatic overlay it is recommended that you create your reports for
each required shock capture immediately in this VibRunner screen as only manual alignment
is available in VibPostTest, see the following page.

Analyzing the Shock in VibPostTest
The automatic shock capturing is only available in the VibRunner software part. When you
open the results in VibPostTest you have to load the reference from Classical Shock parameters the same way like in VibRunner (see figure below).
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Analyzing shock data

Click on Limits and adjust the Reference manually by defining x- and y-coordinates (see figure
below).

Recorded shock data manually adjusted to reference

6.7.1.9

Postprocessing Transient Capture Measurements

In the VibPosttest program, you can analyze the results of a transient capture test. We describe
the transient capture specific options in chapters 6.7.1.7 and 6.7.1.8. For further options please
refer to chapter 8 “Analyze a Test (VibPostTest)”, page 469).
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6.7.2

Sine Reduction

Sine reduction online charts

The Sine Reduction mode is designed to measure and analyze data from a sine control test,
i.e. it is not a control but only a measuring mode.
Sine Reduction mode is available with m+p VibPilotE and m+p VibRunner, VibMobile frontends and with VXI hardware.
It enables you to significantly increase the number of measurement channels by separating the
excitation system and the measuring system.
The measuring system displays and analyzes online measurements from the sine test running
on the excitation system. Both systems are synchronized using a standard 1 Vpk COLA
(Constant Output Level Amplifier) signal which is used to determine the current sweep
frequency of the excitation system. The signals of all measured channels can be recorded to a
throughput file (*.sot) and later be evaluated in m+p Analyzer.
Using VXI hardware the measurement signals can be recorded online to a throughput file and
stored on the VXI hard disk. This file can later be replayed to the m+p VibControl system and
be evaluated like an online test run.

6.7.2.1

Setting up Sine Reduction Mode (VibEdit)

The Sine Reduction test setup is similar to the normal sine test setup (see chapter 6.2.1 “Define
the Sine Reference (VibEdit)”, page 147). Double click on the VibEdit icon to open VibEdit.
Then choose the Open... function from the File menu, select the “Sine Reduction“ mode from
the File type drop-down list and choose one of the appearing files.
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For the sine reduction setup, only the Reference, Schedule and Channels tabs have to be
defined.
If you work with m+p international hardware, you can preselect a sampling rate which is done
in the Measurements section of the Reference tab (see section below).

If you work with two vibration control systems - one for executing the sine
excitation and another for analyzing the signals in sine reduction mode - it
is recommended to make identical test run definitions for both systems.

The import and export of channel data can be carried out via Cut/Copy/Paste functions (see
chapter 3.6 “General Functions for Editing Tables”, page 27).

Sine Reduction: Reference tab

Sampling Rate Settings
If you work with m+p VibPilotE, m+p VibRunner, or VibMobile hardware you can preselect a
fixed sampling rate for the sine reduction measurement in the Reference tab.
Usually, the sampling rate is selected automatically by the system and is modified during the
test run for optimum performance.
If you prefer a fixed sampling rate, in order to receive identical results for measurement and
throughput, the selection field below offers several settings.
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Sampling rate selection field

•

Automatic (default setting): During the test run m+p VibControl chooses the most
appropriate sampling rate for each sweep frequency defined.

•

Fixed (Minimum): m+p VibControl defines the lowest possible fixed sampling rate for the
selected sweep range. It will provide enough sampling points per sine wave even for the
highest sweep frequency of the given sweep range.

•

Fixed (Maximum): m+p VibControl defines the highest possible fixed sampling rate for
the selected sweep range. This sampling rate is chosen in relation to the size of the internal buffer. Its size will still be sufficient for capturing a complete sine wave using the lowest
given sweep frequency.

•

Fixed (One of the given sampling rates will be chosen): The selected sampling rate will be
used for the test run.

When using a fixed sampling rate (Fixed Minimum, Fixed Maximum or
Fixed) an entry appears in the test log stating the sampling rate used.

If a specific sampling rate value was chosen and this rate is not
suitable for the desired sweep range, m+p VibControl will send an error
message when the test run is started.
If Fixed (Minimum) of Fixed (Maximum) was chosen and m+p VibControl
cannot determine a suitable sampling rate for the desired sweep range, it
will also send an error message when the test run is started.

Measurement - Number of Lines Selection
In the Measurement section of the Reference tab you can select a Number of lines entry to
define the number of spectral lines used for data storage.

Throughput Section
In the Throughput section you enter the parameters for throughput data recording. Enter the
desired throughput sample frequency and choose the Throughput file format for saving the file.
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Post-Processing of Throughput Files
Throughput files (*.sot) can be post-processed using sine reduction, random reduction or transient capture modes.

Enabling post-processing

The option is available in the Reference tab.
Enable post-processing by checking the box. Then, browse through your files and select the
*.sot file you want to post-process.
Enter Start time and End time for the postprocessing procedure.
The result file can be viewed and evaluated in VibPostTest.

Define the Sine Reduction Channels
You must define a single control channel (C channel), which is used for tracking the sweep
frequency of the excitation system. Feed the COLA signal from the excitation system to this
channel.
For the sine reduction channel definition, please refer to chapter 6.2.4 “Define the Sine Channels”, page 168.

Filter Settings
For each measurement channel in Sine Reduction mode you can select different filters and
combinations of filters. m+p VibControl will record a result file for each filter mode.
Select M in the Type column and choose Filter, RMS, Peak or Average or combinations thereof
in the Filter, M column and the test results will be recorded accordingly. The first selected filter
type will be shown in the online chart of the sine reduction test run. To show all selected filter
modes open the context menu and select the Show all filter modes function. After the test run
the result files which were recorded using different filters can be opened in VibPostTest to
compare the charts (see chapter 8.3.1 “Filter Channels”, page 479).
For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled for all channels.

6.7.2.2

Start the Sine Reduction Mode (VibRunner)

As the sine reduction mode is only a measurement mode (no shaker control), the
selfcheck’s only function is to arm the measurement front-end; the source remains inactive.
Click on Selfcheck to start the selfcheck procedure. The status line in the upper part of the
measurement control window displays "Selfcheck". m+p VibControl now arms the
measurement front-end.
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After the selfcheck is completed, the system state will switch to Standby. The system is now
tracking the current sweep frequency of the excitation system, but no data will be stored.
Observe the Frequency and Drive entries in the status area.
If you are ready to start the test run, click the Run button. The system will now analyze and
store the measured data, according to the current sweep frequency.
•

If you click on the Measure button, an additional measurement will be stored. All measured responses of the measurement and control channels as well as the corresponding
tracking signal from the COLA will be stored in the result file. The Measure button is green
and the measurement will be stored as soon as the sweep reaches the defined upper/
lower frequency limit.

•

"Drive" indicates the current voltage of the tracking signal (COLA), which is a
constant 1 Vpk.

•

Any limit violation is indicated by a digital I/O-signal

•

The frequency limits entered in the measuring schedule definition window are displayed
under "min" and "max". When reaching the upper or lower frequency range, the sweep
changes its direction. The current sweep frequency gained by means of the tracking signal
is displayed below "Freq."

m+p VibControl offers 16 online or off-line charts showing, for example, the drive
(COLA signal) and the responses of the defined channels during the running measurement.
Click on Chart to open the charts. With a click on the right mouse button in the online charts
you open the drop-down list where you can choose the channel you want to display. You can
display a maximum of 256 channels (16x16 channels).
Channel
Drive
Control

Response of a defined channel
Tracking signal from the COLA input [V]
Response of the COLA signal [EU]

If you want to change the scaling in the charts, proceed as described in chapter 5.1.1 “Scaling”,
page 67.
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6.7.3

Random Reduction

Random reduction online chats

The Random Reduction mode is designed to measure and analyze data from a random control
test, i.e. it is not a control but only a measuring mode.
The Random Reduction function enables you to significantly increase the number of measurement channels by separating the excitation system and the measuring system. The measuring
system displays and analyzes online measurements from the random test running on the
excitation system. Incidents or failures occurring on the measuring system are not affecting the
excitation system.

6.7.3.1

Setting up Random Reduction Mode (VibEdit)

The Random Reduction mode is defined similar to a usual random test mode setup (see chapter 6.1 “Random Test Mode”, page 99). Double-click on the VibEdit icon to open VibEdit. Then
choose the Open... function from the File menu, select the “Random Reduction“ mode in the
File type drop-down list and choose one of the appearing files.
For the Random Reduction setup the Reference, the Schedule and the Channels tabs have to
be defined.
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If you work with two vibration control systems - one for executing the
random excitation and another for analyzing the signals in random
reduction mode - it is recommended to make identical test run definitions
on both systems.

The import and export of channel data can be carried out via Cut/Copy/Paste functions (see
chapter 3.2.4 “How to Edit Tables”, page 24).
For information on the channel parameter definition, please refer to the Random test mode
chapter 6.1.4 “Define the Channels for the Random Test Mode”, page 122.

One channel has to be defined as control channel (C) so that the control
system accepts the test definition. The defined control channel will not
control the test run.

In the Channels tab, you can select the window types Hanning and Rectangular for all channels
in Random Reduction mode.
For m+p VibPilotE, m+p VibRunner and m+p VibMobile hardware a low-pass filter with a user
defined cutoff frequency can be enabled for all channels.

6.7.3.2

Start the Random Reduction Mode (VibRunner)

As the Random Reduction mode is only a measurement mode (no shaker control), the
selfcheck’s only function is to arm the measurement front-end; the source remains inactive.
Click on Selfcheck to start the selfcheck procedure. The status line in the upper part of the
measurement control window displays "Selfcheck". m+p VibControl now arms the
measurement front-end.
Both systems - the excitation system and the measuring system - should be started at the same
time. The system start is done either manually by clicking the Run button or via a digital input
signal coming from an external system. This enables you to acquire signals in parallel on two
measurement systems, e.g. random signals on a vibration control system in parallel to acoustic
signals on an acoustic control system.
Random Reduction also provides digital output signals, e.g. it can send an output signal when
channel-specific notching limits are violated, in order to control an external system.
m+p VibControl offers 16 online or offline charts showing the responses of the defined channels during the running measurement. Click on Chart to open a chart. With a click on the right
mouse button in the online charts you open the drop-down list where a channel can be chosen
for display.
Channel

Response of a defined channel

Any limit violation is indicated by a digital I/O-signal
If you want to change the scaling in the charts, proceed as described in chapter 5.1.1 “Scaling”,
page 65.
If you need even more overview e.g. with high channel count systems, it is recommended to
switch to a multi-monitor solution (see chapter 5.3.6.2, page 94).
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6.7.3.3

Post-Processing of Throughput Files

Throughput files (*.sot) can be post-processed using sine reduction, random reduction or transient capture modes.

Enabling post-processing

The option is available in the Reference tab.
Enable post-processing by checking the box. Then, browse through your files and select the
*.sot file you want to post-process.
The result file can be viewed and evaluated in VibPostTest.
Enter Start time and End time for the postprocessing procedure.

6.7.4

Strain Measurements

m+p VibControl offers full strain support for both the m+p VibRunner and m+p VibMobile hardware. These front-ends can be equipped with the 102.4 kSa/s per channel bridge module which
is suited for dynamic strain measurements, experimental stress analysis and fatigue testing of
mechanical structures. It enables connection of eight strain gauges in full-, half-, or quarterbridge configurations.
Strain measurement definition is done in the Bridge/Strain tab of VibEdit.
First of all you have to define your strain measurement channels in the Channels tab.

Strain channels definition

Select the Bridge/Strain tab and choose the bridge type you are using for your measurements.
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Bridge type definition

Enter the required parameters for your strain measurement and start the test run.
Strain channels can also be defined as control channels.

6.7.5

Linear Acoustic Control for Progressive
Wave Tube Chambers

Running a test
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General Information
The m+p VibControl system can be optionally configured to control a progressive wave tube
chamber with linear frequency resolution. All control channel displays will be in dB with "Overall
sound pressure levels" (OASPL) automatically calculated. Additional channels can be in any
units the user wishes with the RMS level displayed. The setup of the reference spectrum is
altered from a standard vibration test in that the breakpoints must be entered in PA2/Hz. The
dB reference value can be configured by the user.
Multiple microphones can be used for the control with either averaged, maximal, or minimal
control. Any combination of microphones, accelerometers, strain gauges, etc. can be acquired
during a test with the only limitation being the total number of channels and the given transducers range.
To allow for the high ambient noise during the initial start of an acoustical test, the "open
channel" algorithm is changed for this mode of operation to allow for low signal/noise ratios.
This mode of operation also allows for the use of a pre-stored drive signal to enable quick start
up and equalization of a test that has been run previously.

This feature has to be used carefully, because any modification of the test
chamber configuration can cause significant out of specification results.

Test setup
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Setting up the System
If the Progressive Wave Tube Controller option was purchased from m+p international, the software is already installed with the standard installation of software. Two modifications must be
made to the file "C:\VcpNT\Config\Users\Username\VcpNT.ini" where username is the login
name for the operating system. The following lines must be entered under "[Common]":
OASPL_Reference=2E-05
ExtendedUnits=1
The first line indicates the reference for the dB calculations and is typically set to 2E-05.
The second line allows the software to display dB as well as OASPL values.

Microphone Calibration
In the configuration file C:\VcpNT\Config\VcpNT you can choose between two methods of
calibration: Calibration Type 0 and Calibration Type 1:

CALIBRATION_TYPE: 0
This is the default way which was previously available in the older versions of m+p VibControl.
In this mode you select the channel(s) that need(s) to be calibrated.

Channel selected for calibration

Please make sure that the pistonphone is attached correctly to the microphone(s) before starting the calibration.
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New value shows high deviation compared to old value

If the new sensitivity value calculated from the calibration deviates more than 10% from the
original value, it is displayed in red. You can now decide to accept this sensitivity or reattach
the pistonphone and redo the calibration.

Calibration is done, new value is satisfactory

If the new calculated sensitivity is satisfactory, select Update Values to copy the new sensitivity
to the test definition. Then, select another channel to calibrate and repeat the procedure.

Next channel is selected for calibration
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You are free to close the window and/or to stop the calibration procedure at any time.
In doing so, this will return the sensitivities to the old values. Close the window and you will be
asked whether you want to accept the new values or not. Click the No button and the old values
will reappear in the table

CALIBRATION_TYPE: 1
This is the automatic calibration. The software verifies whether a pistonphone is attached to the
microphone and then starts the calibration process automatically.
Choose the channels that need to be calibrated and click the Calibrate button.

Channels selected for calibration, calibration is in progress

Go to your measurement setup and attach the pistonphone to one of the channels that need to
be calibrated. The system will detect the signal presence and will calibrate the channel as long
as the signal is present. When OK is shown in the status line, you can attach the pistonphone
to the next channel to calibrate and so on.

Calibration of one channel leads to a new value which shows high deviation compared to the old value
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If the new sensitivity value calculated from the calibration deviates by more than 10% from the
original value, it is displayed in red. You can now decide to accept this sensitivity or reattach
the pistonphone and redo the calibration.

Calibration of the channel leads to satisfactory value

When the result is satisfactory, select Update Values to copy the new sensitivity to the test
definition.
You are free to close the window and/or to stop the calibration procedure at any time.
In doing so, this will return the sensitivities to the old values. Close the window and you will be
asked whether you want to accept the new values or not. Click the No button and the old values
will reappear in the table
It is also possible to change the default calibration frequency and level for the type of
pistonphone you are using, by modifying the following parameters in the configuration file:
"C:\VcpNT\Config\Users\[user name]\ VcpNT.ini"
AC_CalibrationFreq=1000
AC_CalibrationLevel=94

Whenever you modify parameters in the configuration file "C:\VcpNT\
Config\VcpNT.ini" (e.g. the calibration type), you have to close and reopen
the VibRunner program part to make the change effective.
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6.7.6

RoadLoad Test Mode

The test mode definition consists of four areas which are represented by the tabulators:

•

Reference: define the test run profile/s

•

Specimen: enter the properties of the shaker and the specimen

•

Schedule: define the selfcheck properties and the test schedule

•

Channels: define the channel properties

6.7.6.1

Define the RoadLoad Reference

RoadLoad test mode (Getting Started)

Define the RoadLoad reference pulse as acceleration versus time.

Sample data file name
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In order to load a sample data file, click the “>>“ button to open the window where you can
select the sample data file you want to load (file extension *.rld).
Once you have opened the file, you can edit the parameters displayed above.

Time Axis Values

Time axis values

Sampling rate
Select the sampling rate in [Hz].
Available values: 100, 200, 400, 800, 1600, 3200, 6400, 12800
Sampling rate = 2.56 filter cut-off frequency
Please note that the sampling rate selected here has to match the sampling
rate used for creating the roadload data file.
Sampling rates, which are not supported by the hardware in use, are
marked by a gray background. You can select these sampling rates
for defining a test with another (not connected) front-end. This test
definition can be saved, but needs the required hardware to start.

Control blocksize
Select the size of control blocks used in the control algorithm.
Available values: 1024, 2048, 4096 and 8192.

Number of samples
The number of samples counted in the RoadLoad time domain replication file
will be displayed here.
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Amplitude Axis Values:

Amplitude axis values

RMS value
m+p VibControl calculates the RMS pulse. This value is a reference value
when defining the effective alarm and abort limits in the Channels tab.

RMS abort high/RMS abort low
Here you can define levels where the program will be aborted if the RMS
value displayed above exceeds an upper or lower level (e.g. 0.6g upper limit
and 0.2g lower limit as shown above).
The RMS values are calculated for every control block.
Enter the abort level(s) in [g].

Alarm Limit
Here you can define a level where the program will generate an alarm if the
value displayed above exceeds the indicated level (e.g. 2.7g as shown in the
example).
Enter the alarm level in [g].

Abort Limit
Here you can define a level where the program will be aborted if the value
displayed above exceeds the indicated level (e.g. 3g as shown in the
example).
Enter the abort level in [g].
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Filter min./max.
Frequency analysis is necessary to reveal the individual frequency components that make up the broadband signal. Filtering the output allows you to
measure frequency components of a specific frequency band only. To have
a separate testing at individual frequencies, move the pass band of the filter
sequentially over the whole frequency range.
Indicate a minimum and a maximum frequency value in [Hz].
When choosing the lower filter frequency (Filter min.), you should take into
account the fact that most accelerometers do not measure very well below
5 Hz.
m+p VibControl will automatically display the maximum filter frequency as the
maximum usable frequency.

Units

Units

To change the acceleration, velocity and/or displacement units, go to the Units selection field
and select from the drop-down lists. All numerical and graphical reference data will be converted automatically.

Define Throughput Settings

Throughput section

Throughput is only enabled if you purchased the Continuous Time Domain Data Recording
license and with suitable front-end hardware. The m+p VibPilotE, m+p VibRunner and
m+pVibMobile front-ends directly save the time domain measurements to a throughput file
(*.sot) which can be evaluated in m+p VibControl or using the m+p Analyzer software.

Sample frequency
Enter the desired throughput sample frequency.
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File format
Select the throughput file format for saving the file. You can select SmartOffice Throughput files (*.sot) or raw binary files (*.dat). The raw binary
format can be read by third party software.

Feasibility Check (Shaker)

Display of shaker load

The test defined is constantly checked against the shaker limits defined in VibShakerDef.
Check at the bottom shaker load display whether the defined parameters may exceed the
shaker limits.
The estimated shaker load is given not only in numerical but also in graphical data (color of the
signal lamp):
Color

Shaker Load

Red
Yellow
Green

 100% (shaker limits exceeded)
 90% < 100%
< 90%

Since it is just an estimated calculation, you can start a test even if the estimated shaker load is
 100%. The program does not block the Start button!
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6.7.6.2

Load the Shaker and Define the Specimen
in RoadLoad Test Mode

Specimen tab

This window combines the shaker, the accessories, the fixture and the specimen used for this
test setup. The m+p VibControl program checks whether the test setup may exceed limit
values.
As the characteristics of the specimen are unknown, the necessary force is calculated using
an SDOF model. The total weight results from all known weights entered. In addition, the
shaker axial stiffness and the values of acceleration, velocity and displacement specified in the
reference spectrum definition window enter into the calculation.
You can detect from the bottom shaker load display whether the test setup may exceed the
shaker’s limit values.
The required shaker force, the acceleration, the velocity and the displacement are displayed in
absolute units and percentage wise relative to the defined shaker data.
To open the Specimen tab, click the Specimen tab.
You first load your shaker definition file defined in VibShakerDef and then specify your specimen and possible fixtures. m+p VibControl checks from this data whether the test setup may
exceed the shaker limits.
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Load a Shaker File
To load a shaker file into the test setup, click the >> button.
Select a shaker file from the "C:\VcpNT\Data\" directory or any of its sub-directories.

Loading a shaker file

Depending on your data management, the shaker file can be found in one of the
"C:\VcpNT\Data\" sub-directories. The Getting Started dummy shaker can be found in the
"m+p" sub-directory. The selected file is now displayed together with its path.

Dummy Shaker loaded

Have a look at the displays of moving coil mass, total weight, axial stiffness and maximum input
voltage. This data comes from the shaker file.

To edit a shaker file, change to VibShakerDef by selecting "Shaker
definition" from the "Extras" menu.

Select a Fixture

Select a fixture

The fixtures defined for the shaker loaded are displayed. If you use one of these fixtures for
your test, select it. To define a fixture which has not been pre-defined in VibShakerDef. The
weight of the fixture selected enters into the shaker load calculation.
To include a fixture into the test setup, check its box with a click of your mouse button.
If required, change the mass unit from [kg] to [lbs], or vice versa. All numerical and graphical
reference data will be converted automatically.
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General Shaker Settings

General shaker settings

Mass unit selection
Select the desired mass unit [lbs] or [kg].When you change the mass unit, the
values will be converted accordingly.

Moving coil mass
The moving coil mass entered in VibShakerDef is displayed.

Total weight
The total weight is calculated:
total weight = fixture weight + moving coil mass + specimen weight

Axial stiffness
The axial stiffness entered in VibShakerDef is displayed.

Maximum input voltage
The maximum amplifier input voltage entered in VibShakerDef is displayed.

Input voltage limit
To avoid overloading the specimen, you can reduce the maximum input voltage defined in
VibShakerDef by setting an input voltage limit for the power amplifier.
The input voltage of the power amplifier corresponds to the output voltage of
the source
module. If the admissible voltage is exceeded, the test will be aborted.
Enter a sensible Input voltage limit for the first drive level (it applies to the first
test level after selfcheck).

The Input voltage limit is a safety feature preventing a test start
with too high voltages during the test.
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Define the Specimen

Define the specimen

Name:

Name the specimen.

Weight:

Enter the specimen weight.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Number:

Enter the number of specimens.

Define the Fixture

Enter a fixture

You can either select a fixture which was predefined in VibShakerDef or enter a new fixture
here. The weight of this fixture enters into the shaker load calculation.
If the spectrum or pulse is known, you can easily assess the maximum weight of the fixture, i.e.
100%, by entering a few different values in the Fixture / Weight field.
Name:

Name the fixture.

Weight:

Enter the weight of the fixture.
If required, change the mass unit from [kg] to [lbs], or vice versa.
All numerical and graphical reference data will be converted automatically.

Enter Comments

Comment lines

To enter individual comments such as spec data, specimen characteristics, test run information
or the tester`s name, make use of 10 comment lines available in the VibEdit’s Specimen tab,
in VibRunner and in VibPostTest.
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If activated for the test legend in VibPostTest, comment lines can be printed out together with
the charts. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the charts, comments 9 to 10 are displayed below the charts.
To have a closer look at where to find which comment, see chapter 8.6.1 “Printout”, page 526.

6.7.6.3

Define the RoadLoad Schedule

RoadLoad testing schedule

With the testing schedule, you define the sequence and the duration of the test levels, and
when to take a measurement.

Startup ramp time
The startup ramp time is the time used by the test for increasing the signal up
to the reference level.
Enter the startup ramp time in [s].

Delay between records
Here you can define the time delay to be used in the test between individual
data records, i.e. the pause between two repetitions of the entire file.
Enter the time delay in [s].

Store result every
Here you can define the time interval in which control blocks are to be stored.
Enter the storage time interval in [s].
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External shutdown time
Enter the time in [ms] to ramp down the drive signal in case of an emergency
shutdown. This function requires an Emergency OFF switch being connected
to the bridged output channels of the front-end in use. For further information
on the emergency shutdown, please refer to chapter 2.9 “External Shutdown”, page 14.

Enable SOT export
All time domain data will be written as *.sot.

Selfcheck
Selfcheck is useful for verifying the test definition and the channel setup as
well as for recording a first structural response of the specimen. The standard
selfcheck is done with a fixed output level. For more information on the selfcheck function, please refer to chapter 3.3.7 “Selfcheck”, page 44.

Selfcheck mode
- Fixed Level:
Standard selfcheck is done using a fixed output level. This level is defined
in the Selfcheck level (100 mV) field,
You can manually define an attenuation shape using the >> button. For
further information please refer to the Selfcheck Attenuation paragraph on
page 119.

Selfcheck - fixed level settings

- Limiter Mode:
In Limiter mode, selfcheck is done using variable output levels. Starting with
a low level that is defined in the Min. selfcheck level (100 mV) field, the selfcheck will gradually increase to the value specified in the Max. selfcheck
level (100 mV) field. In order to achieve a good signal-to-noise ratio while
avoiding a too high load on the specimen, the response is limited to a reasonable value. Any spectral lines which are too close to the reference spectrum or notch limits are automatically reduced to a safe value.

Selfcheck - Limiter mode settings
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Selfcheck level (100mV)
Enter a lowering of the drive signal for the selfcheck in [dB] referred to 0.1
Vrms. The selfcheck level [dB] = 20 log (Vrms / 100 mVrms )
0 dB = 0.1 Vrms in selfcheck. Lowerings of  0 dB are allowed.
You determine the selection of the selfcheck level through experience and
engineering judgement. Be aware that a very low selfcheck level may result
in very small signals which do not lie above the system background noise.
For applications such as servo-hydraulic exciters where selfcheck levels of
0.1 Vrms do not cause accelerometer response to run a test, selfcheck levels
of > 0 dB are also accepted by m+p VibControl for Sine, Random and RoadLoad modes. A maximum level of 0.5 Vrms should be sufficient for selfcheck
with such applications.

Selfcheck gain level limit
The selfcheck gain level limit states by what tolerance the system gain
measured during the selfcheck is allowed to deviate from the system gain
defined in the Channels tab.

Selfcheck attenuation
For certain tests, e. g. when eigenfrequencies of the specimen are expected,
you can attenuate the selfcheck excitation for one or several frequency
range(s).
Selfcheck attenuation reduces the selfcheck level average. The estimated
selfcheck level for the test (including the attenuated bands) is stated at the
bottom of the selfcheck box in the Selfcheck level (estimated) line

Selfcheck attenuation defined

Throughput section
The Throughput section in the Schedule tab offers several options for
throughput start and stop settings.
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Throughput section

Define throughput start with self test or with test run start. Define that throughput pauses during standby and that it stops with the test run.
You can select one or several options to create the optimum settings.

Command Table

Command table

To activate the RoadLoad schedule command table, click it. The commands list will open.
Define which control command to perform at which level and for how long, and how often it is
to be repeated. The commands will be performed chronologically as listed.
To copy , delete or paste a command use the common Cut-Copy-Paste functions of the menu,
the context menu or as shortcuts.

Level
Define the level in [dB] and [h min sec] relative to the reference level.
You define how long the controller remains on a level. You can enter negative
values and "0".
The 0 dB level is the maximum level; it corresponds to the reference level
specified in the Reference tab.

Hold:
Define the hold level in [dB] and number of repeats.
You can hold the structure at a defined level until you release the fixed level
in the VibRunner. Afterwards, the next command defined in the testing
schedule definition window is executed.

Measurement
Start a measurement at any level and save this measurement.
After the test, you can analyze the measurements in VibPostTest.
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It is recommended to enter a short delay before starting the measurement at
the test level. In this way, you can be sure that the measurement is not taken
at two different levels.

 Level -9 dB
Level -6 dB
Measurement
Level -6 dB
Level -3 dB
Measurement
Level -3 dB

3 min
0 min

0 sec
2 sec

5 min
0 min

0 sec
2 sec

5 min

0 sec

The controller remains at -9 dB for 3 min. Then it moves to -6 dB where a
measurement starts after 2 sec. The controller remains at this level for 5 min.
Afterwards, it advances to -3 dB where the measurement starts again after 2
sec., etc.
At the end of the test, the data block last created will be saved automatically.

Start Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput start using this command.

Stop Throughput
If you want to use throughput for a defined sequence during your scheduled
measurement, define the throughput stop using this command.

6.7.6.4

Define the RoadLoad Channels

RoadLoad - Channels tab

EU Control Channel

EU control channels (random)

Control channels can be defined for accelerometers only. Select a unit of acceleration
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The sensitivity, system gain, alarm and abort limits will be given in the unit selected here. If you
change the EU, the values of sensitivity and system gain, alarm and abort limits will be automatically converted.

Transducer Database
The TRANS button leads you to the Transducer database list

Transducers’ list

m+p VibControl will open the default list of transducers which is stored in Microsoft Excel format
under C:\VcpNT\Data\m+p\Transducers.xls. Transducer information managed in this database
can easily be made available in VibEdit by means of simple drag-and-drop.

TEDS Support
Some sensors offer TEDS functionality (Transducer Electronic Data Sheet) according to IEEE
1451.4. This feature is useful for high-channel count vibration control systems and for applications requiring frequent change-over of sensors. TEDS data stored in an EEPROM of the
sensor include not only sensor manufacturer, type and serial number, but also key technical
data, date of last calibration and installation site.
VibEdit offers a TEDS button allowing users to quickly transfer a sensor's TEDS data directly
to VibEdit instead of having to enter them manually one by one.
Please check the following points before you transfer the sensor‘s TEDS data:
•

The channels you want to use for the TEDS data transfer have to be active in the channel
parameters table.

•

The Coupling of the channels has to be set to "ICP AC Flt".

•

The lines of the channel parameters table only show valid values (invalid values would be
marked in red).

The Sensitivity values will be corrected after the data transfer.
Support of this feature depends on the your data acquisition hardware.
TEDS is currently supported by m+p international hardware m+p VibPilotE,
m+p VibRunner, and m+p VibMobile, as well as by VXI Technology's
digitizer module VT1435/1436.
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Channel Parameter Definition Table

RoadLoad channel parameter definition

No.
The number of channels depends on your software license.
In RoadLoad test mode, only one control channel is allowed. All
other channels must be measurement channels.

Use the scroll bar to select the channels. They are numbered consecutively.
You do not have to define the channels consecutively. It is possible to define
channels 3, 4, 6 and 8 only, for instance.
Make sure that the channel numbers in this table correspond to the
channel numbers of the breakout box. If you use several input modules, take the slot number into account.

Type
Select the type of channel.
Click it to open a list of all combinations of control, limiting and measurement
channels available for the current test mode.
-

= channel undefined

C

= control channel
only one control channel can be defined

W

= watchdog (= limiting) channel

M

= measurement channel

Name
Enter a channel description, e.g. some transducer data such as its position.
The name will be displayed in both the VibRunner’s online charts and in the
charts printout in VibPostTest.

Model
Enter the transducer’s model name.
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Serial no.
Enter the transducer’s serial number.

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
For more information on the integration of the Brüel & Kjaer NEXUS™ conditioning amplifier, please refer to chapter 9.1 “Brüel & Kjaer Nexus™ Conditioning Amplifiers”, page 543.

Sensitivity:
Define the transducer sensitivity and its EU.
With control channels (C, CW, CWM), the sensitivity of the accelerometer is
given in [mV/EU] or [mV/g] as defined under EU control channels.
With watchdog and measurement channels (W, WM, M), enter a voltagerelated unit.
If - for instance - a displacement transducer is used, enter mm and [mV/mm]
will be displayed.
To ensure a successful test run, it is very important that the sensitivity of the
accelerometer is correct. A correct sensitivity value optimizes the signal-tonoise ratio.
It is good practice to have a selection of transducers available in the lab. In
general, transducers having a high sensitivity are suitable for tests with a
small amplitude of the spectrum and transducers having a low sensitivity for
tests with a large amplitude of the spectrum. Commonly used sensitivities are
10, 50, 100, 300 and 1000 mV/g. Sensitivities of 10 mV/g should be used for
spectra in the higher RMS range, always to ensure a good electrical signal
conditionning.
The minimum ADC input signal should not fall below 5 mVRMS, regardless of
the system background noise. The signal must always be much larger than
the background noise and the highest value (RMS value multiplied by crestfactor (take 6 with some margin)) should not exceed the 10 V input limit.
Inadequate sensitivities may stress interferences in the signal. For
safety reasons, m+p VibControl will abort the test and display the
messages "Channel open?" or "n channel overload".
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Transducer
Type
Select the transducer type in the drop-down list.
- ICP
If the transducer has an integrated charge amplifier and you decide not to
use an external power source, select ICP mode.
- Volt
Volt mode is used for a transducer having an external charge amplifier or
a voltage source.
- Chrg
Chrg mode is only available for systems using charge breakout boxes.

Couple
Select the coupling according to the transducer type.

Coupling selection
- DC/AC
In AC mode, the signal passes a high-pass filter that removes the DC
component from the signal. In DC mode, the DC component is not removed.
- FLT/GND
With GROUND, the ADC channel is grounded (single-ended),
with FLOAT, the ADC channel is floating (differential).
Grounding is supported by m+p international front-ends
m+p VibPilotE, m+p VibRunner, and m+p VibMobile.

For VXI systems, grounding is selected on the breakout box. "GND":
channel is grounded. "DIFF": channel is not grounded.
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TP
Enable or disable the Throughput data recording function for this channel.

SysGain
Enter the nominal system gain.
Only control channels and watchdog (limiting) channels in the Notch mode
have a system gain. With a measurement channel defined, do not enter the
system gain but the measuring range.
The system gain is the ratio of measured value at the ADC input channel to
output voltage of the source / DAC module. It is calculated as RMS value
from a measuring block (range and lines according to test setup).
The system gain is neither predictable nor a constant, but depends on the
total system (armature, expansion, specimen and accelerometer positioning).
Further factors determining the system gain are parameters such as the
defined frequency range, the selfcheck level, the master gain setting at the
shaker amplifier and the transducer sensitivity.
The actual system gain will be measured during the selfcheck before starting
the measurement. The selfcheck compares the measured actual system gain
to the defined nominal system gain. If the measured gain deviates from the
defined one by more than 20%, the message Check sys. gain will be displayed in the selfcheck log. In this case, correct the values before running the
test. This procedure is an additional security check to protect the specimen
and the shaker.

Range
For measurement channels only:
Enter the measuring range.

V-Type
Select the virtual channel type, e.g. Vector add.

Averages
Enter the number of averages. These linear averages (KM) are only used with
measurement channels for the calculation of the degrees of freedom (DOF).
DOF for M channels: DOF = 2 * KM
where KM = number of averages defined in the Channels tab
The averages entered here are not related to the logarithmic averages used
for the test run control.
This quite often used to generate a linear averaged measurement at the end
of the test.
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Alarm
Low, High:
Enter the lower (Low) and upper alarm limits (High).

Abort
Low, High:
Enter the lower (Low) and upper abort limits (High).

The alarm indication will be logged to the test log when the level is
within 1 dB of the individual channel Abort level.

Enter the lower (Low) and upper (High) abort limits (in [dB] or [g]). The abort
values of the channels depend on the structure of the specimen. In case of
control channels, select the unit of the abort limits in EU control channels.

If you select an absolute unit [g] or [m/s²], the upper abort limit is
independent of the current test level. The lower abort limit becomes
effective after reaching the line-by-line-check start level.

If you select a relative unit [dB], the abort limits will be activated as soon as
the current level is greater or equal to the line-by-line-check start level.
If you define several control channels, the RMS values which are to be
expected are derived from the system gain. So m+p VibControl considers the
fact that not all channels have the same RMS value. The system gain is calculated for every level.
When Notch/Tolerance mode or Notch mode was selected for the watchdog
channels, the unit can be chosen in the Sensitivity column. If the abort limit
(RMS) is exceeded, the test will be aborted.
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6.7.6.5

Vector Add Function

This feature can be used with force transducers (e.g. force transducers can be summed digitally to eliminate the need for an analog external summing junction), accelerometers (e.g. to
calculate the total acceleration of your test object), or any transducer where summing is useful.

Define Vector Add Channels

Vector add virtual channel definition

In the Channels tab of VibEdit, define the channels to be summed as a M (measurement) type
channel. Then, configure a W (watchdog) channel as a virtual channel with the V-Type
VectorAdd (channel calculating the geometrical vector sum).
Note that the virtual channel must be selected above the number of physically available channels. For example on a system with 16 channels, the 17th channel or higher may be used as a
virtual channel.
The V-Type Vector Add selection opens the Vector Add section in the lower part of the window
where you can select the channels to be used for calculating the vector sum and define the
weighting factors to be applied.

VibEdit - Vector Add section of the Channels tab
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Up to 32 channels can be defined in the Vector Add section. (Note that the software only proposes channels with the same unit as the Vector Add channel). The selected channels can
then be weighted differently using the assigned weighting factors from the Weighting column.

6.7.7

Time Domain Replication RoadLoad Editor

This graphical editor reads ASCII and RPC3 raw sample data files and provides comprehensive compilation and editing facilities so that the resultant output can be used by the
m+p VibControl Time Domain Replication and External Pulse functions. This allows for easy
reviewing and compiling of field sample data in the test lab.

RoadLoad Graphical Editor

Sample conversion, data selections, filtering and compensation are available with a graphical
interface. For ASCII files either single column sample amplitude data or dual column (sample
time & sample amplitude) data can be read. Comments and header information are ignored
and space, comma or tab delimited input pairs are automatically detected. m+p VibControl .ext
files can also be read.
Note that Time Replication sample files use the .rld extension.
RPC3 time history files are automatically detected. Individual channels are selected and the file
header detail can be displayed with channel descriptors etc.
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Any input sampling frequency can be used since the output data can be re-sampled to match
the sample frequencies available on the m+p VibControl system. Band pass filtering can also
be applied to avoid alias effects.
Velocity and displacement compensation can also be applied to the input data. The compensation algorithms are suitable for removing constant acceleration and constant velocity offsets,
ie steadily increasing velocity and/or displacements that are typical with road load type data
sets.
The input data can be displayed in graphical form with a zoom selection for detailed views and
the output of selected segments as well as single point and zoom window data clip editing.

6.7.7.1

RoadLoad Editor Basic Layout

"Input File" and "Output File" Parameter Frames

Graphical Editor Input File and Output File Parameter Frames

The graphical editor is organised to read in an "Input" file, do some review and processing and
then save an "Output" file with some final conditioning applied.
The Input File name and sample data details are shown in the upper frame.
The lower Output File frame has a selection of user selectable processing that will be applied
to the input data to create the time history output file.

Charts

Charts

The lower graph always shows the entire input file buffer. The upper graph shows a zoom
selection of data and whatever is displayed in the upper graph is what is saved to the output file.
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Cursors operate independently in the upper and lower graphs. Press and hold the Shift key and
move the mouse to position the cursor.
Note that the slider bar at the bottom is used to scroll through the data and the highlighted area
in the lower graph indicates the current zoom window.

Silder bar

The slider bar and its right and left arrow buttons are used to scroll the zoom window.
The data displayed in the upper graph is controlled by the right hand radio button selections:
'A' selects acceleration
'V' selects velocity
'D' selects displacement
'S' selects FFT spectral amplitude
’P' selects FFT Power Spectral Density (PSD)
Velocity and displacement can be displayed in either metric (m/s and mm) or imperial units
(inSA/s and inSA) as selected from the Options menu.
The above data can be computed and displayed from either the 'In'put or processed 'Out'put
data buffers. The output result includes the user zoom selection and conditioning.

Input/Output selection

Input Buffer Editing
This section applies data processing to the entire input buffer.

Input buffer editing

For details, see section 6.7.7.8.
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Spectra Display

Spectra display selection

Selecting the "S" or "P" button to the right of the upper zoom graph displays the spectra of the
currently selected zoom acceleration data.
"S" displays the spectrum as peak amplitude (g pk).
"P" displays the spectrum as PSD (power spectral density - g2/Hz).

Spectrum display, zoom window

If FFT Averaging is Off (see section “Spectral Averaging”, page 432), then moving the cursor
in the lower graph selects the center of the data points on which the spectrum is computed.
Moving the cursor in the upper display displays the frequency and amplitude values. Note that
the spectral amplitude is scaled to g peak and PSD is scaled to g2/Hz.
Note that the cursor is at the center of the selected points in the lower display. The number of
points in the spectrum and hence the resolution is selected from the Options menu.
If either of the averaging modes (Peak Hold or Average) are selected then the spectrum displayed is the average over the currently selected data range. If the "In" graph is selected, then
this range is the entire input data with no conditioning applied. If the "Out" graph is selected,
then the data range is the zoom area as shown by the zoom highlight box in the lower graph
and this data has the conditioning parameters applied.
To display the spectra of conditioned output data outside of the zoom window, reset the window
by right clicking on the lower graph.
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Reset of zoom window

The "zoom" window is reset to the entire input buffer.
A Hanning window is applied to the spectral display by default. This can be disabled in the
Options menu. When disabled, a rectangular window is applied.

You can zoom into the spectrum display by a mouse left-click and
drag across the required frequency range. Right click to reset.

The displayed spectral result can be saved as a spectral text file ready for import to VibEdit or
Microsoft Excel.

6.7.7.2

RoadLoad Basic Operation

The following steps will lead you through the typical procedures when using RoadLoad.
1. First you should reset all settings to default by selecting the File, New menu.
2. Read in an ASCII text or RPC3 sample data file by selecting the File menu Open option or
click the toolbar open button. File formats are automatically detected and a request to
select an RPC input channel will be displayed, if required.
The data will be read in and resulting statistics displayed in the "Input file" frame together
with a graph of the data.
For single column sample data, the input sample frequency will indicate "Unknown". In
this case the actual sample frequency must be manually entered.
3. First use the Resample button to create an input buffer at a correct sample rate for m+p
VibControl Time Domain Replication. A better result will normally be achieved by doing
this prior to any other editing, filtering or application of end-tapers etc.
4. Click and drag the cursor across either graph to zoom in and select a required section of
data.
5. Use the Edit local buffer controls to edit, clip and filter the data as required prior to saving
to file. In practice, most field sample data will require filtering with a high pass filter set to
between 1 and 5 Hz to minimize DC drift noise and excessive displacement requirements.
6. In the "Output file" frame, select the required output file sample frequency and conditioning parameters as required.
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7. Create the time history output file ready for m+p VibControl using the File menu Save or
Save As selections.
8. Select the next section of data and use the File menu, Save Append function to add this
second data to the end of the first.
9. Review and save the spectrum of the sample data as required.

6.7.7.3

RoadLoad Mathematical Functions

Spectral Averaging

FFT averaging selection

The Options menu contains the FFT Averaging selections. The default instantaneous spectral
settings are shown here with Off and No Overlap selected.
With averaging Off, the spectra displayed is calculated from the sample data centered around
the cursor in the lower graph.

Spectral averaging for "In“ graph

When Peak Hold or Average is selected, then the spectrum displayed is the average over the
currently selected data range. If the "In" graph is selected, then this range is the entire input
data with no conditioning applied as shown in example above.
If the "Out" graph is selected, then the data range is the zoom area as shown by the zoom highlight box in the lower graph and this data has the conditioning parameters applied.
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Spectral averaging for "In“ graph

In this example, only the data within the highlighted zoom selection would be averaged.

Peak Hold

Peak Hold selection

Peak Hold calculates all the spectra over the zoom selection and displays the maximum values
found at each frequency bin.

Average

Average selection

The Average mode computes a simple block average over the selected zoom data.
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Overlap
In No Overlap mode, contiguous FFT blocks are taken from the zoom selection to make up the
average result.
If Overlap is selected, the following data entry is displayed:

Entry of overlap factor

Enter the required FFT block overlap percentage.
Increased overlap will improve the averaging effect and peak detection capability.

6.7.7.4

Output File Conditioning

The Output file frame contains a number of parameters that are applied when the data is displayed or saved as an output file:

Output file frame

Select the output sample frequency required to match that to be used in the VibEdit test
specification.
To smoothly ramp up and ramp down the sample data, enter a non-zero "Haversine taper"
value. This taper function is applied to the selected percentage of sample points at the start
and end of the output file. This ensures that the test will start and end smoothly with zero acceleration.
Enter 0 if no taper is required.
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Haversine taper definition

The Centre tick box positions the output samples within the VibEdit sample window when using
the External Pulse facility. It has no effect when creating Time Replication files. When ticked,
the data is central within the window with leading and trailing zeros filling any space. When unticked, the sample data is positioned at the left of the window (i.e. from t=0) and the trailing area
is set to zero. Note this is a VibEdit function only and so additional zero samples are not added
to the output file.
The Vel. comp. (velocity compensation) tick box removes any acceleration offset hence
ensuring that the residual velocity is zero. Note that this is equivalent to removing a DC offset
from the acceleration sample data.
The Displ. comp. (displacement compensation) tick box removes any velocity offset hence
ensuring that the residual displacement is zero.
Both compensations are added linearly across the window hence favoring typical Road Load
sample data requirements. Displacement compensation adds a low-level sinusoid at 1/100 th
of the output sample frequency. If the required displacement compensation amplitude is
greater than -20dB compared to the grms level then the compensation is not applied and the
"Displ comp" label is flagged in red.

Displacement compensation level too high

In this case, check the "O"utput "D"isplacement display and adjust the taper or zoom window
selection to find a better solution within compensation range. If these changes are not effective,
it is likely that the input signal has too much low frequency content so it should be filtered to
remove this. Setting a low frequency limit of between 2 and 5 Hz should usually be effective. If
not, try applying the filter twice to improve the attenuation or increase the low frequency limit.
When you have selected the required conditioning parameters, the result can be reviewed
using the upper graph data selection radio buttons. Once this is complete, use the File menu,
Save, Save As or Save Append function to write the output to file.
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6.7.7.5

Making an External Sample File or Time Replication File

If you want to make an .rld or .ext file ready for VibEdit import, ensure that the required
sample data is displayed in the upper graph.

Sample data display

The Output file is taken from the upper graph data.

Do not display a spectra when a sample data file is required.

Output file frame

In the "Output file" frame, select the output sample frequency from the drop down list.
See section "Zoom" for details of how to select shorter records from the input file.
The number of samples to be output and the record time are shown in the parameter displays.
To change these use the zoom facility or select the parameter with a mouse click and type in
the required value. Pressing Enter computes the new zoom area.
Select the Save As function from the File menu or click the toolbar Save button. In the Save
File dialog box, first select the type of file you wish to save. Use .rld for Time Replication history
files and .ext for the Shock control External Pulse facility. Enter an output file name and then
save the processed sample data in the selected format.
Once saved, the output file is ready for use with the m+p VibControl Shock or Time Replication
programs.
Note that as well as the .ext format it is also possible to select .txt format in the "Save as type"
entry in the Save dialog box. When .txt is selected, the data is saved in either a single column
(amplitude) or a two-column (time and amplitude) ASCII format (see Options menu). This format can also be read back into the RoadLoad editor.
NOTE that .txt files can be either single or dual column (time/sample) format. Use the Option
menu to change this.
An alternative method to save the output data is via the Copy and Paste clipboard.
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6.7.7.6

Saving an FFT Data File for Import to m+p VibControl

Select the required spectral result in the upper graph. If you are to use the resultant file for
import to the Random vibration controller, please ensure that a PSD result (power spectral density) has been calculated and is currently displayed.

Selection of spectral result

You can zoom into a selection of the spectrum by a left-click and drag across the required
selection. Only the zoom selection of the spectrum will be output in the file. Right click on the
graph to reset.
Select the File menu Save or Save As.

Save As selection

Enter the required file name noting that the default extension for spectral result files is .txt. Take
care not to confuse this data with normal Time Replication files that also use .txt.
A two column text file is created showing frequency and amplitude data. This file can be
imported directly to the VibEdit Random mode breakpoint table using the VibEdit Import button.
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Import of PSD data into VibEdit

Ensure that it is PSD data that is imported into VibEdit. Check that the PSD levels and grms displayed in VibEdit correspond to your data.
As an alternative, the Copy and Paste clipboard function can also be used to quickly put the
spectra result into Excel or another application.

6.7.7.7

Graph View and Zoom Selection

The charts show the input file in the lower graph with a zoom window above.

To select a zoom area, click and drag the mouse over the section of interest in the graph.

Zoom span
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The zoom span will be displayed while dragging and when the mouse button is released the
selected data will be shown in the upper graph. This click and drag selection operates in both
graph areas enabling a zoom within an existing zoom area.
Note the scroll bar along the bottom of the window that allows the zoom selection to be panned
across the entire input data.
To reset the zoom graph, right-click on either graph area.

Direct input of span time

It is also possible to enter either the required span time or number of output samples to select
a zoom window. Simply click the data entry and type the required value.

You must press the enter key to complete this operation and display
the new zoom graph.

With a zoom area selected, it is now possible to create an output file containing only this zoom
data. Simply click the Save Icon or select the File menu, Save or Save As function in either
window.
When saving a small section, it will often be useful to select the Haversine taper in the Conditioning section to ensure that the final test starts and ends smoothly with zero acceleration.

Cursor Readout
Press and hold the shift key while moving the mouse over the graph of interest. The cursor will
move with the mouse and show the corresponding time and amplitude details below the graph.

Cursor readout
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6.7.7.8

Edit Input Buffer Controls

Edit input buffer frame

The "Edit input buffer" frame contains a number of functions that may be applied to the entire
input data buffer.
Resample is a quick way of resampling a zoom selection and making it the current input buffer.
Rescale allows the amplitude of the input buffer data to be modified by a factor or to a peak or
rms level.
Edit point allows individual data values to be changed.
Clip allows the zoom selection to be clipped at a chosen level.
Apply Filter applies a band pass filter to the input data buffer.

Resample Button

Resample button

Time history sample files must be created with sample frequencies that match those of the controller. Many raw field sample data files will be at different frequencies that require re-sampling.
The Resample button is a fast way of processing these files.
As well as resampling, this function also copies only the selected zoom section, thus providing
a quick select and resample in one operation.
It is recommended that resampling is applied before low frequency filtering and the addition of
end tapers and compensation. Improved velocity and displacement data will normally result.
Before resampling you should consider using the Filter function to avoid
aliasing especially if you are choosing a lower output sampling frequency
than the input. Aliasing errors will occur with any input frequencies above
half the output sampling frequency so apply a low pass filter at or below
the output sample frequency.

The following warning is shown when Resample is clicked:
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Resample warning message

Clicking OK will complete the operation. The original input file can of course be re-opened to
return to the original data.

Rescale Button

Rescale button

The Rescale button applies a scaling factor directly to the input buffer data. When clicked, the
following window appears:

Rescale factor input

Your scaling factor can be entered in four ways:
1. A simple scaling value. The current data is multiplied by the factor.
2. A log value entered as e.g. 3.5dB (case ignored). The data is multiplied by 10^(3.5/20).
3. A target g value can be entered as e.g. 5g. Here, the peak g level will be rescaled to this
value.
4. A target grms value will rescale the grms to that value.

Editing point data
The input data file is read into a local buffer store. This data buffer can be edited to adjust any
spurious values or to apply sigma clipping prior to saving the formatted file ready to run the test.
First load in your sample data file and select the required zoom view of the acceleration data.
Ensure that the upper zoom graph is showing the Input file.
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Input file selection

To edit a single point, first move the normal cursor to the point of interest. It may be necessary
to zoom into the data area so that the point can be isolated.

Edit Point button

Either click the "Edit Point" button or double click the left-hand mouse button to activate the
cross hair cursor. Press and hold the shift key and move the mouse to adjust the vertical position of the cross hair.

With the shift key held down, either press the Enter key or double click the left mouse button to
change the data point amplitude to the new cross hair cursor value.

To quickly edit single data values, press and hold down the shift key. Move the normal cursor
to the point of interest, double click, then move the cross hair cursor to the new level and double
click again to change the value and restore the normal cursor, then repeat the process for the
next point.
To undo the last clip or last series of point edits, click the "Undo" button in the toolbar.

Clip data
To clip the data in the zoom window, click the "Clip" button to enable the horizontal clip cursor.
Press and hold the shift key while moving the mouse to adjust the clip amplitude. Note that the
cursor read out now shows both the sigma clip value and the actual amplitude. The sigma clip
value is amplitude/rms.
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To edit the data, either press Enter with the shift key held down or double click the left mouse
button.

In the Edit menu, there is a "Symmetrical clip" toggle selection. When this menu item is ticked,
the clipping is applied to both positive and negative clip amplitudes. When not ticked, the clipping is only applied to the single clip cursor level.

Note that clipping is only applied to the zoom selection data. If you require
all data to be clipped, then first right-click on one of the graphs to reset the
zoom display to the entire data file.

To abandon a data edit when either the cross hair or horizontal cursors have been selected,
simply press the Escape key.
To undo the last clip or last series of point edits, click the "Undo" button in the toolbar.

Apply Bandpass and Notch Filter
A bandpass filter or notch filter can be applied to the input data buffer by clicking the Apply Filter
button. This filter is applied to the entire input data buffer and the result is displayed in the Zoom
graph.

Apply filter selection
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Choose the filter resolution (Res.), minimum and maximum frequencies required, and then
click the Apply Filter button. Note that the min and max frequencies have a resolution of 1/Res.
of the INPUT sample frequency and are updated with the actual frequencies applied by the filter.
Higher values of Res. will take longer to compute. Res. must be less than the number of samples in the input buffer.
When choosing an output sample frequency lower than the input, it is advisable to avoid
aliasing by first applying a low pass filter at less than or equal to half the output sample frequency. In this case enter 0 in MinF and half the output sample frequency value in MaxF, then
click the Apply filter button. The data can now be saved without aliasing.
Applying a high pass filter (e.g. at 2 to 3 Hz) will often avoid excessive test displacement
requirements and bring the time history data within the proper operating range of your amplifier
and shaker.
To undo the filter, click the "Undo" icon in the toolbar.
Ticking the Notch selection will notch rather than bandpass filter between MinF and MaxF.

6.7.7.9

Reviewing Saved Data Files

Once you have saved your selected output record it is possible to review the final result prior
to VibEdit import. Simply use the file open function, selecting the *.ext, *.rld or *.txt file type and
open the file you just created.
This new data can be viewed as normal in the charts.
It is also possible to open two copies of RoadLoad and use copy and paste between them. To
open a second RoadLoad application, simply select RoadLoad again from the m+p VibControl
toolbar Utils list or double click its icon etc.

6.7.7.10 Building Composite Sample Files
Two methods are available to enable selected sample blocks to be compiled into one record
for test purposes.
The Paste Insert option in the Edit menu takes data from the clipboard and inserts the samples
at the point selected by the menu selection and cursor position in the upper graph.

Paste Insert option
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The Save Append option in the File Menu allows selected sample data to be added to an
existing .ext or .txt file.

Save Append option

These functions are particularly useful when compiling repetitive bump samples and enables
quiet periods to be edited out so that test times are reduced or compilation of a series of
representative bumps from different field measurements.
To save a series of selected sample blocks, use the zoom function to select a record of interest
and then select the File menu Save Append option to add that selected block to an existing .ext
or .txt file. A file will be automatically created if it does not currently exist.
To ensure optimum final compensation, it is recommended that you first compile the data with
the compensation options disabled. Having built the complete data set in this way, then the filtering and compensation selections can now be applied to the entire file followed by a Save As
to create a final output file.
Consider also using the "Haversine end taper" for each inserted or appended block of data.
This will taper the start and end of each sub-record ensuring they run smoothly into one other.

6.7.7.11 Copy, Paste, Cut and Insert Functions

Edit menu functions

Copy
The Edit Copy menu or toolbar Copy icon compute an output file according to the current conditioning and zoom settings. The data is saved to the clipboard in dual column .txt file format.
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This is suitable for pasting back into RoadLoad or into Excel or another Windows application
that accepts text from the clipboard.

Paste
The Edit Paste menu and toolbar icon reads text data from the clipboard using formatting rules
similar to the normal Open File function. It is slightly different in that it will also accept data
copied by the VibPostTest Copy Data operation.
Data can also be pasted from other applications such as NotePad, Excel etc where the data is
single or dual column comma, space or tab delimited.
Using copy and paste back is a quick way of experimenting with conditioning parameters prior
to saving a file.

Paste Insert
Data already on the clipboard can be inserted into the current input buffer at the point selected
by the menu. The cursor position is taken from the upper graph.

Paste Insert selection

Note that two copies of RoadLoad can be opened and data copied and pasted between them.
This allows a quick view of a Zoom selection with conditioning applied in a second window prior
to actually saving the file. To open a second RoadLoad application, simply select RoadLoad
again from the m+p VibControl toolbar Utils list or double click its icon etc.
Copying and pasting data from VibPostTest allows for example Transient Capture or shock test
data to be quickly made into a .ext file for creation of a new shock test.
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6.7.7.12 Printing
See the File menu or toolbar icon to print the upper and lower graphs.

Printing selection

Either the upper or lower graphs can be printed. Once selected, the toolbar button repeats the
printout of the selected upper or lower graph.
When selected, you will see a prompt for a comment line that will be added to the printout.
Press enter on the keyboard or click OK to continue.

Graph comment/title entry

The next window shows a print preview:

Graph print preview

If Close is clicked, then the following window is displayed:
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Close graph print preview

From here, the chart can be copied to the clipboard using the toolbar copy button and is ready
to be pasted to Microsoft Word or other Microsoft Office compatible applications.

6.7.7.13 Options
All optional settings are saved when the RoadLoad editor is closed and restored when next
started. This allows you to customize the editor for your normal usage and preferences.

Options menu

Single Column Text Output toggles the format of .txt output files. A single column is sample
amplitude data only. When not selected, two columns with sample time followed by amplitude
are output to the .txt file.
Spectral Averaging - see section “Spectral Averaging”, page 432
Spectral resolution - select the number of FFT samples. The number of displayed lines is half
that number and the frequency resolution is Sample Freq divided by resolution.

Spectral resolution
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Spectrum Hanning Window toggles between a Hanning and rectangular window applied to the
FFT spectra analysis.
Selection of either mm pk or inSA selects the display units for velocity and displacement
graphs.

Symmetric clip option

Symmetric clip in the Edit menu selects the clip mode applied by the Clip function. When
selected, equal plus and minus clipping is performed. When not selected, clipping is applied at
the clip cursor value only.

6.7.7.14 Data Formats
File Type Summary
This editor will accept files with any file extension and the import filter will automatically detect
the file type from it's content.
Normal input files will be:
.txt

Either single or dual column tab delimited text.

.ext

Special m+p ASCII file format used for importing sample data into the
Classical Shock and SRS test specifications.

.rsp

RPC3 sample data file. This is an open binary format by MTS. Note there are
various other RPC3 file extensions used that can be read by this editor.

.wav

Special version of the PC .wav binary format supported by the OROS spectrum
analyser recorder software.
Note that this is not compatible with the PC .wav format.

The following special types are defined for output:
.txt

Either single or dual column tab delimited text. See Options menu for selection.

.ext

Special m+p ASCII file format used for importing sample data into the Classical
Shock and SRS test specifications.

.rld

Special m+p format for sample data files being used by the Time Replication
control function.
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ASCII Data Formats
Any number of header lines will be ignored. Header lines can begin with any non-numeric
characters or can be blank lines. Space, +, - and 0-9 are numeric. Our own .ext files can also
be read, their header contains additional parameters as well as comments. Note that this version of RoadLoad simply ignores the .ext header parameters.
Common header formats such as used by nCode and ASCII RPC3 files are also scanned for
sample frequency data where available. The following are recognized, each followed by a number on the same line that is read as the sample frequency:
SAMPLE RATE =
SAMPLE FREQ =
FS =
DELTA_T
FREQ =
Either single or twin column data can be read. A single column is constant rate sample data.
Two columns are time first and sample data second where the two values are separated by a
space, a single tab or a comma. Any additional spaces are also ignored.

Example:
#header lines ignored
#including blanks
;with a variety of
# time
data
SAMPLE FREQ = 256
0.000000E+00
1.953125E-03
3.906250E-03
5.859375E-03

comment characters
-2.491066E-02
-1.953275E-01
3.349482E-01
6.777124E-01

#
#or
#data
6.777124E-01
3.349482E-01
#etc
Do not add any further delimiters or other characters after the second data value on a line. Input
files use the local Windows language settings for numeric formats. Note however that the .ext
output files always use standard USA/UK numeric format as required for VibEdit.
Note that any file name extensions can be used when reading in sample data files. RoadLoad
interprets the data correctly independently of the file name extension used.

RPC Data Input
RPC file formats and header information
Please refer to www.mts.com/RPC3/file_formats for further details of this open standard. This
program supports the Time_History data file subset in 16 bit binary format. ASCII files saved
with RPC header information can also be read.
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To review the RPC file header information, select the Tools menu, RPC Header option. The
header detail is only available after reading in a file and contains channel description details
among other things.

RPC header information

Note that although the .rsp file type is used as the default in the file Open dialog that many other
RPC3 files may be successfully read by RoadLoad. To read another type, click Open and in
the Open dialog box change the "Files of type" selection to "All files (*.*)" and open the required
file name.

6.7.7.15 System Language Considerations
RoadLoad supports both UK/USA and European conventions for numeric formats. This is automatically selected from the Windows "Regional Settings". UK/USA settings normally use "."
(dot) as the decimal separator in numbers whereas many European languages use ","
(comma).
The appropriate separator is used when outputting data to .txt files and to the clipboard. It is
also used for parameter entries in the application windows.
Note that .ext files always use "." (dot) as the separator for compatibility with VibEdit. This does
not affect the ability to read back .ext files in the various language settings.
If the system setting is "," (comma) then either separator can be used when reading in files or
pasting in data from the clipboard otherwise all data must use "." (dot). This convention allows
.csv format to be used with UK/USA settings.
Note that .ext files must always use "." (dot) for compatibility with VibEdit.
When "," (comma) is selected for numbers it can not be used as a time, sample value delimiter.
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6.8

Direct Change from VibEdit to VibRunner

Define your test and click on the VibRunner button
in the toolbar. A window will appear
asking you to save the test definition. After the saving procedure the test definition will be
loaded directly into the VibRunner as long as there is no active test run at the moment. Now
start your test.

VibEdit toolbar with VibRunner button
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7

m+p VibUtil (Test Sequencing)

7.1

Introduction

m+p VibUtil can be used to automate vibration tests by setting up test sequences, so that you
can define various vibration tests which can be carried out automatically in sequence. The test
run time and the external signal states of the current test are monitored during the test
sequence.
m+p VibUtil offers the possibility to send e-mail messages to one or several addresses.
The m+p VibUtil functions described here can only be used if the m+p VibUtil module is
enabled through your keywords.
For the extended m+p VibUtil functions you need to have the m+p Advanced VibUtil module
enabled through your keywords. m+p Advanced VibUtil offers digital channel support of our
m+p VibPilot, m+p VibRunner and m+p VibMobile frontends. These frontends offer an external
shut-down function via digital channel control.

7.2

Hardware and Software Interaction

The digital channel support is part of the m+p Advanced VibUtil software and has to be purchased separately. It enables you to control the digital channels of your m+p hardware.
The m+p Advanced VibUtil Version supports the digital channels of m+p VibPilot, m+p VibRunner front-ends. These devices provide 7 digital input channels (channel 8 is used for the external shutdown function) as well as 4 digital output channels. The m+p VibMobile front-end is
also supported. It offers 3 digital input channels (channel 4 is used for the external shutdown
function), and 4 digital output channels.
When used, channel 8 of the m+p front-ends’ digital outputs (channel 4 with m+p VibMobile)
serves exclusively for the external shutdown.
For more information on the external shutdown function please refer to chapter 2.9, page 14.

7.3

Window Structure

The m+p Advanced VibUtil main window shows four window parts, the sequence control area,
and four tabulators.
The m+p VibUtil main window only has two window parts, as it does not support digital
channels.

m+p international

m+p VibControl Rev. 2.16

453

Window Structure

m+p Advanced VibUtil main window

The Test Sequence tabulator (main window) is split into four window parts:
During the test sequence setup these window parts are called:
Test Sequence, Digital Channel Setting, Error List Test Sequence and Error List Digital
Channel.
When the test sequence is running the names of the window parts are:
Test Sequence, Digital Channel Setting (window content is grayed out), Current Protocol
File, Status Report.
The single window parts are described in detail in the following subchapters.
Above the window parts you will find four tabulators which enable you to define all parameters
for your test sequence.
The tabulators are: Test Sequence, Current Protocol File, Digital Channels and Settings.
Some of the tabulators show the same content as the window parts. This content can also be
displayed during the test run, when the window part shows further content.
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To the left of the main window you will find the test sequence control area:

The sequence control area displays the states of the
VibRunner Online Control buttons.
Idle, Selfcheck, Running and Standby

Below you will find the Sequence Execution buttons:
Start, Abort and Standby.

The Email section follows. It offers a check box for
activating the status e-mail. Enter the e-mail address
into the second line. Several e-mail addresses are
separated by commas or semi-colons.

The last part displays the digital channel states.
green:
red:

internal state, logical HIGH (> 2 V).
internal state, logical LOW (< 0.8 V).

Channels which are not available due to hardware
restrictions are grayed out.
Use the context menu to refresh the status display.
Test sequence control area

Language
The language used by m+p VibUtil is defined in VibConfig. Whenever you change the language
in VibConfig, you will change the m+p VibUtil language, too. The available languages in
m+p VibUtil are: English and German.
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7.3.1

Test Sequence Window Part

Test sequence example

To define the test sequence, load m+p VibControl test definitions, insert loops, define working
folders, etc.
•

using the context menu commands of the test sequence window part

•

using the Edit menu

•

or by typing the commands or copying them

The following commands can be found in the context menu. Some of them are also available
in the Edit menu:

Insert vibration test
Choose this function to open the file selection dialog and to open the desired
test definition. The command will be written to the test sequence window part.

Insert other command...
Opens the following submenu
- Working directory:
A working directory can be defined for saving the test definitions you want
to use with m+p VibUtil. When a working folder is defined, it is sufficient to
enter/select a test name without giving its directory. The test will be loaded
from the working directory.
It is still possible to load test definitions from other folders by entering the
directories with the file names.
- Utilities directory
You can define a utilities directory for your tools and external programs
which can be started by m+p VibUtil. Choose the folder for your test
sequence. Enter the program name into the test sequence window part and
it will be loaded from this folder. It is still possible to load programs and tools
from other folders by entering the directory with the name.
- Wait x seconds
Choose this function to enter a short time period between the test runs.
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- Wait d:hh:mm:ss
To wait for longer periods, enter the time in days:hours:minutes:seconds.
- Loop
Select this option for inserting a loop. Load the test definition which shall be
run for several times. Replace "x-times" by the number of loops required.

Start sequence at this line
Any line of the test sequence can be selected for starting the sequence. But
the test never starts within a number of loops. It always starts with the first
loop.

Open VibEdit, VibRunner, VibPostTest, Windows Explorer
These context menu commands enable you to change to the other m+p VibControl parts for modifying test definitions, viewing test runs or evaluating the
measurements during the test sequence. You can also open the Windows
Explorer for opening or saving files.
The program parts can also be opened by the corresponding toolbar icons.

Cut, Copy, Paste
Cut-Copy-Paste commands are also available in the context menu.
The test sequence can be modified using Cut - Copy - Paste commands
which are also available in the toolbar or using the common Windows shortcuts.
Highlight parts of the sequence and open the context menu to choose Cut,
Copy or Paste.

Print
Use the Print option of the context menu to include the text you entered into
the protocol file.

Test Sequence Example:
The command for loading a m+p VibControl test definition is:
Load "C:\VcpNT\Data\m+p\Getting Started Sine.tsn"
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7.3.2

Digital Channel Settings Window Part

Digital Channel Settings window part

Digital channel settings are only available with m+p Advanced VibUtil.
Within this window part you can define all digital channel settings you want to use for your test
sequence by entering the commands.
Each test can be related to an own profile, e.g.:
Load "C:\VcpNT\Data\m+p\Getting Started Sine.tsn" Profile 2
This means that the "Getting Started Sine" test will be executed as soon as digital channel 1 is
High (see digital channel profile in figure above).
Furthermore, a profile can have different combinations of digital output and digital input channel
settings in one profile:

Create Profile 2
Input 1 Low Start
Output 2 Running High
End

Please note, that the channel state "High" or "Low" depends on the frontend in use. Please refer to the hardware manual for information on the TTL
states of the frontend.

If you do not want to type the commands, you can use the digital channel tab for the profile
definition (see figure below).
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Digital channel settings in digital channel tab

Click the Add button to open the Add Digital Channel dialog which guides you through the profile definition by offering all necessary commands for each type of profile.

Add digital channel dialog

Click the Digital Input button for creating a digital input channel profile.
Click one of the Digital Output buttons to create a digital output channel profile.
Click the Digital Output (for amplifier) button to create the single amplifier profile.
The line created for the digital channel settings offers all necessary entry fields.
If you want to remove a line, highlight it and click the Remove button.

m+p international

m+p VibControl Rev. 2.16

459

Digital Channel Settings Window Part

The summary below describes the different digital channel settings which can be chosen in the
above dialog.

Summary of Digital Channel Profiles and Corresponding Commands
Digital Input
Create Profile 1
Input 1 High Start Test
End
Below you will find a list of commands for filling the center lines of a digital input profile:
Input

digital input channel

1

channel number 1, alternative 1, …, 7

High, Low

internal state - logical High (Low)

As soon as the defined internal signal logical level is given, one of the following commands will
be executed:
Start Test

start sequence execution

Message

opens a message box with a user defined string. This string is
defined in the entry field to the right of the Message command.
The default text is "Digital Channel". It can be replaced by any
text you desire. The text entered will appear in the digital input
profile.

Log

logs the above message to the protocol file

Abort

aborts the test sequence

Standby

pauses the test sequence

Continue

continues the test sequence

Set Output

sets the corresponding output

Start Test

starts the test run when the digital channel is in the required state

Start Test
+ Continue

460

starts the test run when the digital channel is in the required state.
If the test is in Standby mode, it will be continued as soon as the
digital channel changes to the required state.

Next Test

test sequence continues with the next test

Stop Test

current test is aborted, but the test sequence is still running.
It continues with the next test.
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Digital Output (Event Driven)

Create Profile 2
Output 2 Idle High
End
Below you will find a list of commands for creating an event driven digital output profile:
Output

digital output channel

2

channel number 2, alternative 1, …, 4

Idle

if test is in idle state
Abort

if test is aborted

Running

if test is in running state

Standby

if test is in standby state

Level 0 dB

if test level is 0 dB

Test End

if test is finished according to schedule

Sequence End

if sequence is finished
set digital output to logical level High, alternative Low

High

Digital Output (Time Driven):

Create Profile 2
Output 2 Offset 10 Off 10 On 10 High
End
Which means:
Output

digital output channel

2

channel number 2, alternative 1, …, 4

Offset

offset time before time driven digital channel starts

10

10 seconds offset time

Off

if output is defined to be High, this command sets it to Low for a defined
period of time

10

10 seconds in the Off state

On

if output is defined to be High, this command activates the High state for
a defined period of time

10

10 seconds in the On state
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Only one time driven digital channel can be defined per profile.

Digital Output (for Amplifier):

Create Profile Amplifier
Output 4 High
End
Which means:
Output

digital output channel

4

channel number

High

set digital output channel to logical level High

The amplifier profile is valid for the whole test sequence even if no Load command calls this
profile.
You can use the amplifier profile for starting and/or running down the amplifier via a digital
channel command.

Only one amplifier profile can be defined per test sequence.
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7.3.3

Error List Test Sequence / Current Protocol File Window Part

This window part shows error messages whenever the test sequence is invalid. See figure
below "File not found" error.

"File not found" error

When the test sequence is running, this window shows the current protocol file (see figure
below). The same content can be viewed by a click on the Current Protocol File tab.

Running sequence with digital channel definition
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Error List Digital Channel / Status Report Window Part

7.3.4

Error List Digital Channel / Status Report Window Part

This window part shows error messages if invalid digital channel profiles are detected (see figure below "Digital channel error").
When the test sequence is running, this window part reports occurring events e.g. a digital
channel switches from High to Low (see figure above "Running sequence with digital channel")

Digital channel error

7.4

Starting the Test Sequence

Start the defined or the loaded test sequence by clicking on the Start button.
Once the test has commenced, the test sequence cannot be modified any further, while it is
still possible to edit the test definitions which are part of the sequence.
The toolbar buttons enable you to save the test sequence, to open the error handling tab, to
change to the m+p VibControl program parts VibEdit, VibRunner and VibPostTest and to open
the manual for help.

File Menu
The File menu enables you to open a test sequence file.
You can also open test sequences which were created by other test sequencing programs,
such as the old m+p VibUtil version or VibTestControl. Choose the corresponding menu option.
The test sequence opening function opens the test sequence including digital channel settings.
The Save/Save as options save the current test sequence.
The Recent File List proposes the test sequences you used recently.
Exit closes the program but does not close the m+p VibControl program parts. Thus, VibRunner is still active and the current vibration test will be completed in its entity.
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Status Bar
The bottom part of the m+p VibUtil window serves as status bar and displays:
Elapsed time, Remaining time, Sweep direction, Test name as well as current date and time
or
Elapsed pulses, Remaining pulses, Level, Measured & Stored Transient Capture

E-mail Configuration
When you activated the e-mail feature, m+p VibUtil sends an e-mail with the current protocol
file as soon as the test sequence is completed, or if the test went to Standby due to any unexpected event. To use this feature, just configure the e-mail settings and activate the Status email check box (see figures below) in the main window and insert the e-mail address of the
recipient.

E-mail configuration

Enter the credentials and the settings of your e-mail account. To verify your settings, send a
test e-mail to your account by clicking on the Test Mail button.
The Clear button resets all settings to default.

Status e-mail check box

Here you must enter the credentials and settings of your e-mail account.
Further e-mail settings can be found in the Edit menu. The e-mail settings option opens the
dialog window above.
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Settings Tabulator

Settings tabulator

In the Settings tabulator you can define important test conditions such as:

Selfcheck time out (s)
defines the time period in seconds after which a selfcheck will be aborted.

Retry attempts on selfcheck time out:
Defines the number of retry attempts when a selfcheck has failed.

Rerun attempts after VibRunner abort:
Defines how often VibRunner shall try to resume an aborted test run.

Test reloads allowed after VibRunner abort:
Defines how often a test can be reloaded and restarted after it has been
aborted in VibRunner.

Pause schedule on test failure:
When enabled this option pauses the test sequence when an error occurred.

Auto-load last executed test:
Whenever the autostart file is available the last executed test will be reloaded
automatically into VibRunner when you start m+p VibUtil.
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Invert digital input channels:
Check the box to invert the logical states of the digital input channels.

Suspend test execution after selfcheck
The test run will be suspended after selfcheck. After you verified the selfcheck you can resume the test by a click on Start.

Purge short protocol file (0= unlimited):
Enter a number to define the number of most recent lines to be shown.

Stopping the Sequence Execution
The test sequence can be stopped by a click on the Standby button or Abort button
When you click the Standby button in m+p VibUtil to stop the test sequence, the test is suspended until you resume it with a click on Start.
When you click the Abort button in m+p VibUtil to stop the test sequence, its execution is
stopped and cannot be resumed.
When a test sequence goes into standby or is aborted in the m+p VibControl VibRunner
window due to an unexpected error, the current test run is interrupted (goes into standby) and
a message box appears providing several options:
Resume Test, Restart Test, Execute Next Test, Abort Sequence

Message box when sequence execution has stopped
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Startup Sequence (old Chamber Control)

7.5

Startup Sequence (old Chamber Control)

If there is a test sequence with the name "autostart.vibseq" in the VibControl Config folder, m+p
VibUtil starts using a small/simplified GUI, see figure below.
This program basically executes the defined test sequence but does not offer editing functions
within this simplified GUI.

Simplified GUI
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8

Analyze a Test (VibPostTest)

Post-test analysis in VibPostTest

To analyze a test, you load the corresponding result file into VibPostTest. You can also select
VibPostTest during the test run to analyze any previous or on-going test. A measurement is
always stored together with the corresponding error, control and drive spectra in the result file.
The following chapters will explain the m+p VibControl post-test analysis functions.



To relieve the PC memory, you should delete old result files in the
Windows Explorer from time to time. Before deleting them, you can save
them on an external storage device.

Open VibPostTest from the toolbar.
In VibPostTest, you will find some buttons and selection fields for direct analysis action:
Print out the post-test charts.
Alternative: Select Print from the File menu.
Load the test definition into VibEdit.
Alternative: Select Load test definition from the File menu.
Activate single plot analysis (to analyze one measurement per chart), or
activate multi plot analysis (to analyze / print all marked measurements in the
same chart (see chapter 8.3.4 “Singleplot/Multiplot”, page 484).

m+p international

m+p VibControl Rev. 2.16

469

Analyze a Test (VibPostTest)

Either the Single Plot or the MultiPlot option must be active.
Alternative: Select Singleplot or Multiplot from the Extras menu.

These selection fields are used to select various display and analysis options.
Filters...

Select Filters... to open a window in which you can select the type(s)
of channel to display (see chapter 8.3.1 “Filter Channels”, page 479).

Alternative: Select Filters... from the Extras menu.
Peak values...Select Peak values... to open a window where you can select options
for the search and display of peaks
(see chapter 8.5.1 “Peak Values”, page 511).

Alternative: Select Peak values... from the Extras menu.
Limits...

Select Limits... to open a window where you can select which types of limits
and reference traces you want to show or hide
(see chapter 8.3.4 “Singleplot/Multiplot”, page 484).

Alternative: Select Limits... from the View menu.
Reference
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Check Reference to show the reference spectra/pulses in the main
VibPostTest chart. Uncheck Reference to hide them.
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Legend

Check Legend to show the legend to the right of the main VibPostTest chart
(see chapter 8.4.7 “Test Legend”, page 504).
Alternative: Select Legend from the View menu.

Comments

Select Comments to open a window where you can view the comments
which the test operator has entered for the relevant test (if applicable)
(see chapter 8.4.10 “Comments”, page 508).
Alternative: Select Comments from the View menu.

Math funcs... Open the Math funcs... drop-down list to activate/deactivate
mathematical functions
(see chapter 8.5.3 “Mathematical Functions”, page 517).
Alternative: Select Math funcs... from the Extras menu.

8.1

Handling Result Files

8.1.1

Load a Result File

With every test run, a result file is created. At test end, all results are stored to this result file.
By default, the result file is named as the test setup file. Additionally, the result file shows the
number of the corresponding test run.
For example, to analyze the 4th test run of a test called "Sine_16Ch_" you select "
Sine_16Ch_004.rsn".

Result file explorer

By default, random test mode is set in VibPostTest. To load a result file, select the required test
mode first.
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Delete a Result File

Select the test mode

By default, the explorer box shows the m+p directory. Use the scroll bars to select the result
file to you want to analyze.
The result file selected is shown in the title bar of the measurement table:

Result file title bar

Open Result File in VibPostTest Explorer
You have several options to open a result file in the VibPosttest file explorer. You click the result
file in the tree view to the left and it will be displayed immediately.
Or you either click the
button to the right end of the result file line or open the file tree
context menu and select the Open in Explorer... function. The File open dialog opens the active
folder and you can select the desired result file with a double-click.

8.1.2

Delete a Result File

Result files context menu
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VibPosttest allows interactive deletion of individual result files without using external file management software. A copy of the deleted data file is saved in the system trash can for recovery
in case of erroneous deletion.
A right click of the mouse over a result file will open the context menu to choose the Delete
option.

8.1.3

Sorting of Result File Names

In order to facilitate your browsing through a large number of test result files, VibPostTest
allows you to sort all files in a certain directory either alphabetically by file name or by file date.
Right-click on the relevant directory, select Sorted by, and then select one of the sort criteria.
VibPostTest will then list all files in this directory according to your sort criterion.

Files sorted by name

8.1.4

Result File Search

VibPostTest offers a file search tool to facilitate the task of searching e.g. for test result files
stored before or after a certain date, or for test result files including certain characters.
To open this file search tool, right-click on the relevant directory of the directory tree.
In the context menu which appears now, select the File filter option.

File filter selection
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Result File Search

The "Select file filter criteria" window will come up.

"Select file filter criteria" window

File Search by Date
If you want to search for files stored before or after a certain date, tick the appropriate option
Date after or Date before.

File search by date

In the date selection window, select the required date before clicking OK. VibPostTest will now
display a revised file list according to the latest search criteria.

File Search by Name
If you want to search for files including a certain combination of characters, tick the appropriate
option File name filter.

File search by name

In the example above, enter the characters BNS* if you want VibPostTest to display only those
files including the letters BNS (see below).
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Filtered list of file names

8.1.5

Handling Throughput Files

All throughput data in *.SOT format can be displayed and evaluated in VibPostTest.

Data display of a sine throughput file

Throughput files can be postprocessed using sine reduction, random reduction or transient
capture.
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Saving Selfcheck Results and Selfcheck Log

Enable Post-Processing of Throughput Data
•

Enable post-processing by checking the box and load the desired file into VibEdit

Postprocessing enabled in VibEdit

•

Some parameters of your test definition will be updated to match the throughput file, such
as sampling rate, frequency range and channel configuration

•

Configure your test as needed.

•

Select the relevant control channel:
- Sine reduction: Set the channel which contains the COLA signal as control channel
- Random reduction:
- Transient Capture: Set the channel you want to use for triggering as the control channel.

•

Load the test into VibRunner and run the test as usual.

•

Then, you can view the test in VibPostTest and proceed to post-process it.

In the VibPostTest file structure, each throughput file of a test run will be arranged like an additional measurement file and can be displayed in the VibPostTest chart. Although they might be
extensive, the throughput files are shown as compressed data using min-max decimation. Activating a second cursor provides a zoom function which enables you to zoom into the chart until
you can see the original, uncompressed data.

Define your preferred data path for throughput files In the Configuration
window (see Chapter 2.3.2). Thus, you can save throughput files to SSD
drives and speed up data loading times.

8.1.6

Saving Selfcheck Results and Selfcheck Log

m+p VibControl stores the selfcheck results and the selfcheck log file for each selfcheck which
has been performed before a test run. The file names used for the selfcheck results and the
selfcheck log file are identical to the result file name but they have additional information at the
end: selfcheck results are stored under „___STEST.bin“ while log files are stored under
„___LOG.bin“. These files can be opened in VibPostTest via the File menu Selftest results or
Protocol file options.
In the Sine, Random, and Shock mode, a complete selftest trace will be stored as a chart in the
result file.
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8.1.7

Exporting Result Files

VibPostTest has different possibilities to export test result files for further processing, reporting
or archiving purposes.

Export as Text File
Click File in the VibPostTest menu bar and select the item Save as textfile to open a dialog window in which you can define the name, the target directory and the format of the exported file.

Export Data as Text File

Select Text File to export your result file to the*.txt format, storing a file that includes all measured values as a text file.

Export in Universal File Format
You can export your measurement data in Universal File Format (*.UFF/*.unv) for further processing using sophisticated data analysis software like m+p Analyzer.
Click Edit in the VibPostTest menu bar and select the last item Store data to open a dialog window in which you can define the name, the target directory and the format of the exported file.

Export Data to Universal File Format

Select Universal File in case you want to export your result file to Universal File Format.
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8.2

Changing the Default Data Directory

Change root directory screenshot

The m+p VibControl post-test analysis allows for change of the root data directory.
This feature analyzes data stored on remote PCs and servers and for remote systems to
analyze data on the system in use.

Right click on the root directory at the top of the directory tree to quickly
change the root directory.

8.3

Reporting Options

For analysis and reporting purposes you can filter channels and sort the measurements or display several measurements in one chart, just as required for your reporting tasks.
m+p VibControl offers these reporting functions:
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•

Filter channels

•

Sort and display measurements

•

Show History

•

Singleplot/ Multiplot

•

VibMultiPlot

m+p VibControl Rev. 2.16

m+p international

Filter Channels

8.3.1

Filter Channels

Filter channels

Enabling or disabling one or more channel filters you decide which types of channels and signals are listed in the measurement table.
C Responses of the defined control channels.
By default, the control channels are displayed with their corresponding
- reference spectra/pulses
- alarm limits
- abort limits
- notch limits
You can hide these traces or - if hidden - show them as follows:
Check the Limits... option in the toolbar. The "Limits" dialog is displayed.
All displayed traces have a check in their box (see chapter 8.3.4, page 484).
To hide a limit uncheck the box. You can keep the "Limits" dialog being displayed, or you
can close it by clicking
in the toolbar.

in the Limits dialog window or by unchecking the Limits... option

W Responses of the defined watchdog channels.
For a watchdog channel with notch limits, you can view the notch profile. To do so, open
the Limits dialog by checking the Limits... option in the toolbar. Then enable the Notch limits
display.
M Responses of the defined measurement channels.
In the case of acceleration channels, you can select Reference from the Limits
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box (check the Limits... option in the toolbar) to display the reference value of
the defined spectrum.
SR Selfcheck result files
CN Computed notch channel. If you calculated new notch limits using the result file
of a notch test, you will receive a new result file with a computed notch definition.
Uncheck this filter to hide these files.
#

In this line you filter the channel numbers to display. You can select single
channels or several channels in a row for display. Single channel numbers are
entered as follows: "1,3,7". Channel rows are entered as follows: "1-3; 27-30"
The default entry is "*". All channels are displayed.

X

Control spectrum taking into account the control strategy selected.
You can select all combinations of reference value, alarm limits and abort limits in the Limits
dialog box (click the Limits... option in the toolbar to open it).

D Drive spectrum of the measurement.
The drive signal is the signal that the source/DAC module outputs to the power amplifier.
E

Error spectrum of the measurement.
The error spectrum is the quotient calculated from the measured and the defined value of
the control channels.
To calculate the SRS error in VibPostTest,
see chapter 8.5.3.3 “Shock Response Spectrum (SRS)”, page 521.

H (available in sine mode only)
The history function indicates in plot and in tabular form, when which channel was used for
control.The function takes into account control channels ("Maximum" or "Minimum" control
strategy) as well as notch channels.
ST (available in SoR and SoRoR modes only). Sine tones.
To open the record filter selection, click the F icon from the icon bar.
Select the spectra to be charted, e.g. to analyze the control channels with
reference, drive and error spectrum, select C, X, D and E.
TF Transfer function
Coh Coherence

Sine Filter Modes
If you recorded a Sine or Sine Reduction measurement channel using several filter modes m+p
VibControl will save one file for each filter mode (For information on how to select the filter
modes in VibEdit see chapter 6.2.4.8 “Define the Sine Channel Parameters Table”,
page 171ff).
To display the recorded files in VibPostTest check the corresponding filter(s).
F

Filtered

P Peak
R RMS
A Averaged
Then select the desired file(s). Check the Multiplot option to display all files in one chart.
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8.3.2

Sorting and Displaying Measurements, Renaming Channels,
Changing Measurement Units

Measurement table

All measurement sets selected in the filter selection are listed in the measurement table.
Measurement
No.
Name
Type
MType

Number, date, time of measurement.
Channel number.
Channel description (as given in VibEdit’s Channel tab).
Channel type.
Measurement type.
C, W and M channels are controlled separately and come in separate
data sets.


Mode
Level
Ref
Unit

m+p international

With a CM channel, for example, the measurement table lists two
measurement sets. For both sets, "Type" states "CM". For one set,
"MType" states "C", for the other set, "MType" states "M" since
control and measurement channels are given in separate sets.

Watchdog mode ("Notch", "Notch/Tolerance" or "Tolerance").
Test level.
If marked, reference channel selected for transfer function.
Transducer dependent EU of the displayed magnitude, e.g. "g" for
accelerometers.
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Sorting the Measurements

Measurements sorted by channel type

By default, the measurements are sorted chronologically. You can sort the measurements by
channel number, name, channel type, measurement type, mode or level, too:
Click the column name of what you want to sort by, e.g. "Type".
The table is re-arranged.
You can adapt the column width by dragging the column separating line with the left mouse
button held down.
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Displaying a Measurement

Selected measurement is highlighted

The measurement set highlighted is the one currently displayed.
To display a measurement data set, click it.

Renaming Channels
To rename a measurement channel double-click on the line and edit its name. For confirming
the modification leave the line or press the Return button. The name will automatically be
updated for all measurements.You can also change the date format which is part of the name.
All modifications will be persistent as soon as you save the file. Open the File menu, choose
the Save as option and enter a name for saving the file.

Subsequent Change of the Measurement Unit
It is possible to change the measurement unit in VibPosttest. The measurement values will be
recalculated accordingly.
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Show History (Sine)

8.3.3

Show History (Sine)

The history function is only available in sine mode and it indicates in plot and in tabular form,
when which channel was used for control. The function takes into account control channels
("Maximum" or "Minimum" control strategy) as well as notch channels.

8.3.4

Singleplot/Multiplot

There are two modes of display in VibPostTest. You can have the responses of either one
(Singleplot) or several channels and different data sets (Multiplot) presented in one chart.
In Multiplot mode, you can analyze up to ten measurement data sets of the same result file (e.g
control channel, drive signal and error).
By default, Singleplot is active.

8.3.4.1

Singleplot - View Options

Singleplot

To activate singleplot mode, select the Singleplot option in the toolbar.

Coherence Display
You can display the Coherence of selected channels of one result file in a second chart. To
enable the Coherence chart, go to the View menu and check the Coherence function.
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Phase Display
For Random test modes it is also possible to display the Phase in a third chart. This chart is
also enabled via the View menu.

Triaxial Accelerometer Channel Overlay
All three channels of a triaxial accelerometer can be overlaid and shown in one chart. This function is also available in the View menu.

Channels of a triaxial accelerometer overlaid in one chart
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Singleplot/Multiplot

8.3.4.2

Multiplot (Same Result File)

Multiplot chart

Multiplot displays measurement data of the same result file.
This multiplot function allows you to display and print out the responses of several channels
and different data sets, e.g. control channel magnitude, drive spectrum and error in one chart.
It is also possible to display the sine tones of a mixed mode test run together with the random
signal.
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•

To open Multiplot mode, select the Multiplot option in the toolbar.

•

To show a measurement data set, click it. The selected measurements will be checked.
Uncheck a measurement to remove it from the chart.

•

Have a look at the right-hand multiplot legend: Each trace is shown in a different color.

•

The legend shows all entries which are identical for all channels displayed.
Legend entries can be enabled and disabled using the context menu dialog.

•

Scale the chart as desired.

•

To view the RMS values in a random test result file, go to the View menu and select
Values  RMS (Overall) (see screenshot above).

•

To view the phase or the coherence in a random test result file, go to the View menu and
select Phase or Coherence.

•

To start the printing procedure, select Print from the File menu.

•

To close Multiplot, select the Singleplot option in the toolbar.
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8.3.5

VibMultiplot Program Part (Different Result Files)

"VibMultiplot" in toolbar

The VibMultiplot program part allows you to present and print out the responses of up to 10
channels and different data sets, e.g. control channel magnitude, drive spectrum and error in
one chart. The data may come from different result files.

VibMultiplot with different result files

To start up the VibMultiplot display, select the first result file and the data set to be displayed
from VibPostTest.
Copy the selected data set to the clipboard by choosing Copy data from the VibPostTest’s Edit
menu or the chart’s context menu.
Then, open VibMultiplot by clicking the VibMultiplot icon in the VibControl toolbar and paste the
data from clipboard.
Select the next data set in VibPostTest, copy and paste it to VibMultiPlot.

m+p international

m+p VibControl Rev. 2.16

487
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The color of each trace is represented in the data table above the chart. To modify it, click on
the color field and the color selection dialog will open. Specify the desired color and confirm it.

VibMultiplot table with color selection option

To print out the charts, select Print from the VibMultiplot’s File menu. Select Print Preview to
preview the printout.

Display of Coherence and Phase
If channel data contains phase and/or coherence information, they can be displayed in separate charts. Enable these charts in the View menu.
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Compare Mode
The Compare mode enables you to compare two test run result files or data sets, e.g. the selfcheck trace before a test run with the selfcheck trace after a test run.

Compare mode - selfcheck before and after test run

When you loaded the result files, the Compare mode function filters all channels with exactly
the same name and displays the results in one chart.
In this way you can even compare the result files of different test modes. Therefore, you can
run a sine test for finding the resonances of a system and afterwards you run a random test
with the same channel selection. Using the Compare mode you can overlay the channels of
both result files and read directly how the system behaves at the resonance points during the
random test.
Note, that it is also possible to load whole folders into the Compare mode for comparing them.
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8.4

Chart Display Options

m+p VibControl offers a large variety of display options:
•

Display signals together with compare signals,

•

show/hide the legend,

•

mark peaks,

•

display peak values and overall RMS values,

•

display labels and comments,

•

show history chart,

•

display magnitude, phase and coherence,

•

etc.

VibPosttest options screenshot
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8.4.1

Show/Hide the Post-Test Tools

View menu

To make best use of your screen size, you can show or hide the post-test tools with a click of
your mouse button. To hide a tool or control, open the View menu and uncheck its entry.
To show a tool or control, check its entry.

8.4.2

Limits/Reference

By default, the control channels are displayed with their corresponding reference spectra/
pulses, their alarm, abort and notch limits. You can hide these reference and tolerance traces
or - if hidden - show them. Moreover, for test levels < 0 dB you can adapt the traces defined and by default shown for a test level of 0 dB - to the actual test level.

Show/Hide Limits

Limits box
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The Limits box enables you to decide which limits shall be displayed with the spectrum:
Alarm
Abort
Reference
Notch
Ignore schedule
Follow schedule

Alarm limits.
Abort limits.
Reference spectrum/pulse.
Notch profile (available for a limiting channel (W) only).
Reference and limits for full test level (0 dB).
Reference and limits adapted to actual test level < 0 dB.

By default, all displayed traces have a check in their box. To hide the reference spectra/pulses,
their alarm, abort and/or notch limits, uncheck the corresponding box.
For example, to hide the alarm limits, click the Alarm box. The check and the alarm limits will
disappear.
To display the alarm limits again, just click the Alarm check box again.

Adapt to Actual Level (Random / Classical Shock)
Within the test setup, you have defined the reference spectra/pulses and limits related to the
full test level (0 dB). If the actual pulse level deviates from the nominal value, you can use an
offset to shift nominal value and limits in Y- and X-direction in order to compensate the deviation.
Activate the Limits item in the toolbar. The "Limits" dialog is displayed.
To have the 0 dB reference trace and limits displayed, select Ignore schedule.
To have the reference trace and limits displayed adapted to the actual level, select Follow
schedule.

Shift Limits (all Shock Tests)
VibPostTest offers a special function for Shock Response Spectrum Tests (SRS), Classical
Shock and Crashtests. It enables you to shift all limits. The function is used when a signal
shifted along the y-axis because of an DC or along the x-axis because of a positive or negative
trigger delay. Just enter the offset parameters for the x- and y-axis so that the limits are laid
upon the signal. Thus you can check whether a test run without DC or trigger delay would have
exceeded the limits.

Parameters for shifting the limits along the x- and y-axis
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8.4.3

Cursors

Cursors

Cursors assists you in checking the signal trace. You can move the cursors along the trace and
read the cursor’s coordinates from the axes or in the cursor summary:
To activate the cursor, press and hold the Shift key and click with the left mouse button into the
chart.
Hold the Shift button and use your mouse to drag the cursors along the trace.
To deactivate the cursor, just drag it off the chart.
The context menu offers all cursor options.
Open the context menu with a click on your right mouse button.
All cursors are shown on the printouts.
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Context menu with cursor options

The following cursor options are available:
•

Show 1st cursor (shortcut: Shift + left mouse click)

•

Show 2nd cursor (shortcut: Shift + Ctrl + left mouse click)

•

Show horizontal cursor

•

Show cursor summary (this option is enabled automatically as soon as you enable a
cursor. It can be disabled, when desired.

•

Scale x-axis to cursor (zoom-in function)
The section between cursor 1 and cursor 2 is expanded and shown in the new chart.
This function is helpful for large throughput files which are shown using a min-max decimation filter. Zooming into the chart shows the original data.

Scale to x-axis option used
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8.4.4

Markers and Labels

Labeled markers

m+p VibControl allows you to mark certain points within the curve and to display data labels.
By default, the marker’s label displays the y coordinate only. You can label each marker with its
x and y coordinates and/or with text information. Use the markers to mark characteristic points
of the measurement and add text information related to these points.
You can mark and label the traces with numerical and/or text information.
To activate the display of markers, select Labels in the View menu.

Set a Marker, Define its Position and its Label
To set a marker, press and hold the Alt key.
To mark any point on the trace, just select it with a click of your left mouse button.
To exactly set the marker on the trace, read from the cursor which must be the marker’s exact
coordinates.
Double click the marker’s red cross. The "Modify label" dialog is displayed for this marker.
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Modify label dialog

Copy the x and y coordinates from the cursor display to the respective X Position and Y Position fields of the "Modify label" dialog. To have these coordinates displayed in the label, make
sure that the Label text field states both "%1" (control command to show the x coordinate in the
label) and "%2" (control command to show the y coordinate).
The following list states the available variables for the label display:
%1 = control command to show the x coordinate in the label
%3 = control command to show the x unit in the label
%2 = control command to show the y coordinate in the label
%4 = control command to show the y unit in the label
Use these variables to define what the label shall display. You can also add some text.
To confirm the marker, click the OK button.
With the left mouse button held down, you can move the marker to any point.
To test this function, set more markers.
To change the setting, use the "Modify label" dialog as described above or double-click the
label to directly access the label text field. Here you can change its content and by pressing 
the modified label will be displayed.
Now your defined label serves as default label. The following marker points will come up with
the same information.
You change a marker’s position by clicking the marker with the left mouse
button and moving it with the mouse button held down.
You change a label position by clicking the label with the left mouse button
and moving it with the mouse button held down.

To exactly position a marker to - for example - 800 Hz on the trace, you
first position a marker right into the chart.
To get the exact amplitude at 800 Hz, activate the cursor and drag it to
800 Hz.
Double click the marker. The "Modify label" dialog is displayed. Copy both
the Y Position and the X Position from the cursor display to the Modify
label entry fields. Confirm by clicking the OK button.

For more information on markers, see chapter 5.1.6 “Markers and Labels”, page 75.
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Adding Text to the Label

Text label

To provide the label with text information, double click the marker’s red cross. The "Modify
label" dialog is displayed for this marker.
To not delete the numerical information, make sure that the Label text field states both "%1"
(control command to show the x coordinate in the label) and "%2" (control command to show
the y coordinate). Add further text information into the Label text field.
To confirm the marker, click the OK button.
Now your defined label serves as default label. The following marker points you define will
come up with the same information.
It is also possible to double-click the label to directly access the label text field. Here you can
enter the desired text (or remove unwanted text) and by pressing the  button the modified
label will be displayed.
This modified label will also serve as default label.

Adding Comments or Headings
You can add markers with comments or headings to the charts. Press and hold the Alt key. To
position the text at the top left corner of your chart, click this part of the chart. A marker is displayed. Release the Alt key.
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To hide this marker and display the label only, drag the label right onto the marker with the left
mouse button held down.
First, the label displays the default data of the previous one, e.g. frequency and amplitude. To
enter a headline, double click the label. Delete the text and type your headline, e.g. "Random
Tutorial". In the same way you can add comments to the label.
To confirm the setting, click the OK button.

The next label will contain the same text as the previous one since the
default setting for a label is always the setting of the previous label. To
report frequency (or time) and amplitude see section above.

Deleting Data/Text from the Label
To delete any data from the label, double-click its red cross. The "Modify label" dialog is displayed for this marker. Delete the unwanted data from the Label text field and confirm with OK.

Moving Markers and Labels
With the left mouse button held down and the marker’s red cross selected, you can move the
marker to any point.
With the left mouse button held down and the marker’s label selected, you can move the label.

Hiding Markers and Labels
Markers can be hidden or - if hidden - shown.
To hide all markers, open the View menu and uncheck the Labels option, to show them check
this option.

Removing Markers and Labels
To remove a label,
•

either double-click the red cross to open the “Modify label“ dialog and choose the Remove
label function,

•

or double-click the label, remove the content of the field and click the button.

Standardized Label Format
If you always need the same data label format, you can define this format in the file:
"VcpNT.ini".
Here you‘ll find the following section:
[common]
DefaultLabelFormat=%2 %4
Modify the entry according to your needs.
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Modify Font Size of Label Text
You can also define the label font size within the VcpNT.ini file.
Modify the RulerFontSize line by entering a negative value which sets the font size in points.

Minimum and Maximum Labels
m+p VibControl offers the option to mark and label the minima and maxima of one or several
traces.
In Singleplot mode, open the View menu and select the Labels option. Then enable the Show
labels function together with the Minimum or Maximum option. The active trace will be displayed with labeled points.
Multiplot mode offers the same marker and label options (see below).

Labels shown for all traces in multiplot mode

m+p international

m+p VibControl Rev. 2.16

499

Scale

8.4.5

Scale

Select "Scaling controls" in the View menu to activate the display of the scaling controls.

Scaling controls

By default, you find the y-scales and x-scales showing their ranges as defined (Default). However, you can rescale both axes to optimize the printout (Individual). Specific scaling settings
can be easily adopted for other charts of the same channel type (Scaling...->Copy to Group).

Channel Scaling
You can select either Default or Individual scaling or you can choose one of the options offered
by the Scaling... button.

Default

Default scaling

The y- and x-scales are as defined in VibEdit. The scaling controls for x- and
y-axis are not active.

Individual
The scaling of each axis can be individually changed. The scaling options are
enabled. Scale your chart as needed.

You can first scale one channel as required and transfer this scaling
to all channels of the same type using the Scaling...->Copy to Group
function. Then all printouts will show a uniform scaling.

Scaling...
The Scaling… button in the PostTest axis definition offers the possibility to
transfer an individual scaling of one channel to other channels.
Save as default: Select this function to save the defined scaling as default.
Copy to group: The scaling settings will be adopted to other charts of the
same channel type (channel type = group) so that all printouts will have a uniform scaling.
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Lock scaling: Use this entry to lock the current scaling settings for all plots.
This is useful when reviewing large channels counts for data reliability as well
as comparisons.
To reset a channel group to the default scaling, click Default (channel scaling
option above the Scaling... button).

Axis Scaling
The x-axis and the y-axis are scaled separately. For scaling an axis the Individual function in
the Channel Scaling part of the window must be active.

Axis scaling

Autoscale
You can select the most favorable scaling of the x-axis and y-axis depending
on the displayed maximum and minimum values.
Select Individual.
Select Autoscale for the axis to set.

Fixed Scale
Each axis can be rescaled.
Select Individual. With Individual selected, the scaling of each axis can be
individually changed.
Click Fixed scale for the axis to be rescaled. The from and to fields are
activated.
Enter a new minimum at from and a new maximum at to.
With Fixed Scale, you can directly scale with your left mouse button and drag
the y-axis downwards or upwards.
Press and hold the left mouse button.
Drag the y-axis downwards or upwards with the mouse button held.
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Shifting the y-axis

Single Autoscale
With Individual and Fixed selected, you can have a single autoscaling.
Click the Single Autoscale button for the axis to scale.

Grid Lines
For both x- and y-axis you can show or hide scaling lines.
To show scaling lines for the x-axis, check Grid active in the x-axis’ scale box.
To show scaling lines for the y-axis, check Grid active in the y-axis’ scale box.

Logarithmic/Linear
For both x- and y-axis you can select logarithmic or linear scaling.
To set logarithmic scale, check Logarithmic scaling.
To set linear scale, leave Logarithmic scaling unchecked.

Uniform Axis Scaling
The Scaling... menu provides the Lock scaling option: Use this entry to lock the current scaling
settings for all plots. This is useful when reviewing large channels counts for data reliability as
well as comparisons.
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8.4.6

Zoom

Zooming in the y-axis

You can zoom in and out the y-axis.
Select Fixed scale in the y-axis scale bar.
Press the Ctrl key and hold it while doing the following:
•

To zoom in, also press and hold the left mouse button, while dragging the y-axis
downwards.

•

To zoom out, also press and hold the left mouse button, while dragging the y-axis
upwards.

•

To return to the default setting, click Autoscale.
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8.4.7

Test Legend

Test legend

The right-hand test legend will be shown on the printout. You can eliminate lines which you do
not want to be printed out.
To show or hide the test legend, activate Legend in the toolbar, or alternatively select Legend
in the View menu.
To select the legend text, double click the right-hand test legend. The "Legend texts" dialog is
displayed. By default, all possible legend texts are shown ("Items available" is blank!). The
comment lines can be found at the bottom of this list.
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Selecting the legend texts

To hide certain text, mark it with the Ctrl key held down and a click of your left mouse button,
e.g. click Date and Time.
Marked texts can be moved from one window part to the other using the >> and << buttons.

The gRMS-Value of the Reference Spectrum in the Legend
m+p VibControl displays the gRMS value of the reference spectrum on the post-test plots for
random control tests, allowing for quick verification of the measured gRMS value versus the target reference value.

As with all the entries in the legend they can be removed by clicking in the
legend area of the plot and removing them using the pop up applet.
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8.4.8

Importing and Comparing Result Data Graphs

To compare a signal from the VibPosttest charts with previous test results, load a compare
signal into the chart.
Open the VibPostTest result file and select the signal you want to compare. Choose the Copy
compare signal function from the Edit menu or the chart’s context menu.
Then open a second VibPostTest chart and click with the right mouse button into the chart to
open the context menu. Choose Paste, and the compare signal will be copied into the chart.
The User-defined reference signal...option of the View menu allows the user to define a reference signal which will then be displayed in the chart.
The Copy data option of the chart context menu has three functions:
•

First, it copies the measurement values for evaluation in Microsoft Excel or other tabular
sheets.

•

Second, it copies the measurement values for displaying them in a multiplot chart.

•

Third, the data can be pasted to a VibRunner chart. as compare signal.

Copy graphics copies the active trace.

Imported result data graph in the VibPostTest chart
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8.4.9

Values Display

Display the minimum, maximum, and/or the overall RMS values on the measurement chart by
selecting Values from the View menu. One or several values can be displayed at once.
For minimum and maximum values, the exact position is also marked on the trace.

Selecting one of the options will disable the display of peak values and its markers.

The value display options are available in both Singleplot and Multiplot mode.

Singleplot with minimum values, maximum values and RMS (overall) enabled
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Multiplot with minimum values, maximum values and RMS (overall) enabled

8.4.10 Comments
To enter individual comments such as spec data, specimen characteristics, test run information
or the tester’s name, make use of ten comment lines available in VibEdit’s Specimen tab, in
VibRunner and in VibPostTest.
To open the comment lines in VibPostTest, click the Comments button from the toolbar or
select Comments from the View menu. The "Comments" dialog is displayed.

Comment lines
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Check Comments 1-5 or Comments 6-10, respectively.
To confirm a new or changed comment, click the Apply button.
To confirm a new or changed comment and close the dialog, click the OK button.
To abort the dialog and not confirm any change not yet confirmed with Apply, click the Cancel
button.
If activated for the test legend in VibPostTest, comment lines can be printed out together with
the chart. Comments 1 to 5 are displayed in the test legend, comments 6 to 8 are displayed
above the chart, comments 9 to 10 are displayed below the chart. To have a closer look at
where to find which comment, see chapter 8.6.1 “Printout”, page 526.

Comment lines on all traces
If you prefer to have a certain comment displayed not just on the current trace, but on all traces
or measurements of a test result, tick the "all meas." check box of the relevant comment line.

8.4.11 Colors
Each chart element is displayed in an individual color changeable in the Color selection
dialog. Configure the colors as appropriate.

Color configuration

1. Right click on the chart to open the context menu and select the Color configuration
option.
2. Open the drop-down list and choose the chart component to configure, e.g. the graphics
background as shown in the above figure. The currently used color is displayed in the
Color/Solid field.
You can select from an ample palette of Basic colors or define your own colors (Custom
colors).
3. To select a new basic color, click this color. This color is then displayed at Color|Solid, and
the selected chart component changes its color. Confirm by clicking OK or go on
searching for your favorite color.
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4. To define a color different from the basic colors, select a basic color with a click of your left
mouse button. This color is then displayed at Color|Solid.
To configure this color, change its red, green and blue components by moving the little
pointer to the right of the color scale with the left mouse button held down.
Go on configuring this color by defining its hue, saturation and luminosity.
To add this color to Custom colors, click Add to Custom Colors. Colors added to Custom
colors are available in this palette for the current dialog only. If the color selection is closed
and re-opened, Custom colors show the default palette only. To select a newly defined
Custom color, select the component set to this Custom color and re-load it into the Custom colors palette so that it is available for further components.
5. Click OK to confirm the new configuration or click Cancel to keep the former configuration
unchanged.
This dialog also offers a line style selection option. Choose a channel and select a line style for
its representation in the chart (see chapter below).

8.4.12 Line Style and Line Width Selection
In order to provide a flexible chart display m+p VibControl offers the option to change the line
style for any trace on your VibPostTest chart. Traces can be shown and printed in one color
and different line styles, enabling a black and white printout for any chart. Of course, you can
also select the line styles in different colors to create clearer chart representations in color
prints. For the line style selection, open the Color selection dialog, select the trace and assign
the desired line style.

Selecting a line style

For an enhanced quality of your VibPosttest printouts, you can adjust the line width of the measurement traces using a drop-down selection field below the line style selection.
Selecting a line width disables the line style selection.
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8.5

Analysis

m+p VibControl offers the following post-test analysis functions:
•

Peak values

•

Transfer function

•

Mathematical functions

•

Shock response spectrum

8.5.1

Peak Values

Peak values dialog in SinglePlot mode

The peak values function searches the displayed trace for peaks and lists the peak x and y values in a table. This analysis allows you to search for a peak above or below a pre-defined level
and with a pre-defined change in slope.
The peak values function is available in SinglePlot and in MultiPlot mode. Check the trace/s for
which you want to execute the peak search and select Peak values in the toolbar to open the
"Peak values" dialog.
Select whether to search for peak values lying above the peak level (Maxima) or below the
peak level (Minima).
Below, you can enable the display of the corresponding Q Factor, RMS value and sine peak
value (Sinepk value), if available.
Then, define the Peak Search as follows:
A value is considered a peak if the following criteria are fulfilled:
- The value is a local maximum/minimum.
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- Adjacent values drop off the amount of Peak Epsilon on each side before reaching a value
greater/smaller than the current value.
- [Optional] The value is above/below a specified threshold (Peak Level).
- [Optional] The value is among the requested number of peaks.

To start the peak value analysis, click the Search now! button. The peak values will be displayed in the chart and listed in the table.
To remove certain peak values, mark them in the table and click Remove.
To remove all peak values, click Remove All.
Click the Save as button to save the peak values to the result file

MultiPlot with detected and marked peaks and a values list
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8.5.1.1

Set Peak Marker / Auto Peak Search

Hide/Show Peak Marker
Peak markers can be hidden or shown.
To hide all peak markers, uncheck Peak markers from the View menu.
To show all peak markers, check Peak markers from the View menu.

Cursor to Maximum / Cursor to Minimum

Automatic minimum detection

m+p VibControl easily detects the maximum (Ctrl + M) and/or minimum values (Ctrl + N) on
any chart displayed in post-test analysis using simple keystrokes.
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8.5.2
8.5.2.1

Transfer Functions
Transfer Function (Sine)

Transfer function

In random and sine modes, the transfer function allows you to quickly determine the behavior
of control and measurement channels in the test run. By investigating the behavior of the drive
channels, you can see at a glance how the specimen has changed during the test run.
The transfer function is the quotient calculated from a selected data set and a reference data
set. The reference value is always the denominator.
To display the transfer function, first you should activate Reference in the toolbar.
To define the reference data set, check the Ref box of this set in the measurement table. In the
above figure, channel no. 2 is selected as reference.

Only channels which actually exist may become reference channels. You
can use the drive signal as reference, provided that it was measured by
the input module.
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The chart shows the value of the transfer function (transmissibility). The quotient calculated
from the selected data set and the reference data set is "1", since first the selected data set is
the same as the reference data set.
Now you can compare any measuring data set to this reference data set (channel no. 2) by
marking the required measurement data set. In the above figure, channel no. 8 is the data set
to be compared. The transfer function is the quotient calculated from the selected data set and
the reference data set. The reference value is always the denominator.
To receive useful information, make sure to apply the transfer function to
data sets of the same measurement (same date) only. In the above figure,
both measurements were taken at the same time.
This is particularly important if several measurements have been made. If
the transfer function is applied to measurements made at different times,
the phase information is incorrect since measured at different times (flurry
of snow).

Define measuring method in VibEdit

For those channels to be subjected to a transfer function with phase information, F must be set
in VibEdit’s Channels tab in the Filter column (measuring method). Otherwise, the phase will
look like a flurry of snow.
If the drive signal is to be used for phase presentation, the drive must be looped to one input
channel defined as M or C channel (1000 mV/V sensitivity, F filter).

8.5.2.2

Linear Transfer Function (Random)

m+p VibControl offers the option to calculate the linear transfer function in random post-test
chart.
First you have to select a reference channel by highlighting a channel and activating its check
box in the Ref. row. Then select the Reference option in the toolbar- the channel is now defined
as reference channel and set to 1.
Now select the response channel. The values of this channel including phase are calculated
referring to the reference channel. The transfer function (unit g2/g2) including the phase is
shown in the chart (see screenshot below).
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Graph of a linear transfer function (unit g/g)

In order to calculate the linear transfer function (unit g/g), open the Math function drop-down
list and select Transfer function.

Signal Tolerance (Harmonic Distortion Factor)
The transfer function enables you to determine the signal tolerance (harmonic distortion factor).
The signal tolerance is calculated as follows:
R
T(%) =  ---- – 1
F

where:

 100
R = unfiltered signal coming from RMS measuring method
F = filtered signal coming from Filter measuring method

To determine the signal tolerance, define RMS and Filter for one channel in sine test mode. For
instance, select RMS for C and Filter for M of a CM channel. Take the filtered signal as reference in VibPostTest.
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8.5.3

Mathematical Functions

Mathematical functions

With the help of "Mathematical functions", you can calculate velocity and displacement from
the acceleration and vice versa. The mathematical functions used for conversion are integration and differentiation. In SRS mode, the SRS response spectra and the SRS error can be
calculated.
To call up mathematical functions, open the Math function drop-down list in the toolbar and
select the required mathematical function, or select the Math funcs... sub-menu from the Extras
menu.
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8.5.3.1

DC Offset Removal

DC offsets can be removed from shock or transient capture signals in your VibPostTest chart.
To enable this feature, select Remove DC offset from the Math functions context menu. The
offset can be removed with any of the math functions enabled.

Time signal with DC offset

Time signal with removed DC offset

518

m+p VibControl Rev. 2.16

m+p international

Mathematical Functions

The Remove DC offset function is used by default when an integration function is selected. The
average value is subtracted before the signal is integrated which prevents deviations caused
by the integration of DC components in the signal.

If an integration function is selected, the Remove DC offset is enabled by default.

8.5.3.2

Integration/Differentiation (Random/Sine)

Depending on the transducer used, you have to differentiate or integrate your signal for conversion. See the formulas and examples below
The results of integration are now displayed in an Engineering Unit (EU) selected by the user,
e.g. in mm.
To convert the signal, select the corresponding formula from the Math funcs... sub-menu.
The title bar of the chart displays the formula applied.
To deactivate the conversion applied, select No function from the Math funcs menu.
Conversion formulas for random and sine:

Random:

Sine:

PSDa (f)

a = A · ²

PSD a (f)
PSD v (f) = --------------------2


v=A·
s=A
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Mathematical Functions

Random:

Sine:

PSD a (f)
PSD s (f) = --------------------4


(A = displacement magnitude)
where  = 2 ·  · f [Hz]

(PSD = power spectral density)



You have used an accelerometer and you would like to now calculate both
velocity and displacement:
Velocity:
Select the data set and "1 x Integr".
Displacement: Select the data set and "2 x Integr".

Integration/Differentiation (Classical Shock)

Integrating the acceleration signal

The response of the control channel is given as acceleration versus time. You can display the
velocity of the control channel as a function of time by integrating the measured acceleration
signal once. Moreover, you can display the displacement of the control channel as a function
of time by integrating the measured acceleration signal twice.
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Mathematical Functions

As integration has a smoothing effect, the curve presents a smoothed
trend. Please note that small DC components in the acceleration signal,
when selecting 2 x Integr, can lead to large distance values which would
not occur in reality.

To integrate the acceleration signal once and receive the velocity, select 1 x Integr from the
mathematical functions.
To integrate the acceleration signal twice and receive the displacement, select 2 x Integr from
the mathematical functions.
To display the acceleration signal as FFT, select Fourier Transform from the mathematical
functions.
To undo any mathematical calculation, select No function from the mathematical functions list.

8.5.3.3

Shock Response Spectrum (SRS)

In VibPostTest, you use mathematical functions to calculate the SRS from the measured pulse
and study the different shock spectra.

SRS Transformation / SRS Error

SRS functions

When performing SRS post-test analysis, you can have the shock response spectra and the
error calculated from the measured pulse responses.
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Mathematical Functions

To perform the SRS transformation, open the mathematical functions by selecting the Math
funcs... from the Extras menu.
To have the response spectra calculated, select SRS Transformation.
To have the error calculated, select SRS Error.
A window will come up, asking you to enter the constant damping value of the SDOF systems.

Entering the damping

There are different types of shock spectra available.
To select, activate the Limits option in the toolbar to open the "Limits" dialog.
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SRS +

Positive residual response after the pulse has occurred.

SRS -

Negative residual response after the pulse has occurred.

SRS Maximum

Maximum response in magnitude taken from the primary and
residual responses, where the primary response is the maximum
response while the shock pulse is still acting.
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Mathematical Functions

Selecting from the shock spectra

To return to the measured signal, select No function from the mathematical functions list.
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Creating Reports

8.6

Creating Reports

VibPostTest provides automated report generation features.
Go to the File menu and select the Create report option.

Create report selection

This will open the following dialog window.

Create report dialog
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Creating Reports

In this dialog window you select:
•

the report template (Microsoft Word format *.dot) to be used for your new report

•

the measurements to be reported

•

channel data options like reference channel, mathematical functions, phase,
coherence, etc. to be included in your new report

Having completed your selections, click OK to confirm and start creating the new report
in Microsoft Word. VibPostTest now starts the Word application (if available on your PC) and
opens the m+p VibControl report.

Report in Microsoft Word

If you decided to use the default template (C:\VcpNT\Config\VcpNtresults.dot) provided by
m+p, this report includes the following sections:
•

General parameters

•

Stimulation / specimen / masses

•

Sweep table

•

Channel configuration

•

Selftest results

•

Selftest log

•

Chart displays

You are of course free to create and use your own templates according to your individual
reporting requirements.
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Printout

8.6.1

Printout

With your post-test analysis completed and all scaling optimized, you can now start the printing
procedure. Before you print out, use the preview to check the charts’ layout.
You can have one chart or a series of pre-selected charts (Autoplot) printed out.

Preview the Printout

Preview

To preview the printout prior to printing, select Print Preview from the File menu. The chart is
opened in GraphPrint.
To turn the GraphPrint window to full screen size, click

from the GraphPrint title bar.

Note the positions of the comments, if selected for the test legend:
Comments 1 to 5 are positioned in the test legend.
Comments 6 to 8 are positioned above the charts.
Comments 9 to 10 are positioned below the charts.
To print out the charts from GraphPrint, click the Print button.
The charts are printed in color.
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Marker of the Current Cursor Position on Printout
The position of the cursor selected in the on-line charts is shown on the printout. The corresponding markers and their values appear along the x- and y-axis of the charts.
Vertical and horizontal cursors are also shown on printout

Position of the cursor on printout
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Printout

Logo on Printout

Logo on printout in print preview GraphPrint

Test reports can wear the company`s logo. The only thing you need is the logo in bmp format.
By default, the "m+p" logo is embedded. Of course, this can be replaced or deleted.
Put the logo to "C:\VcpNT\Config\".
Open "C:\VcpNT\Config\TG_Logo.ptf" in WordPad.
[Bitmaps]
NumberOfBitmaps=1
[Bitmap001]
File=..\\config\\m+p.bmp
RectLeft=2150
RectRight=2560
RectTop=150
RectBottom=280
Graphic=1
Save "TG_Logo.ptf" with the change. End Wordpad.
The embedded logo is now active for chart report in VibEdit and VibPostTest.

Single Printout/Multiplot
Preview the printout prior to printing.
To directly print out the charts without using GraphPrint, select Print from the File menu or click
.
You can select a series of charts to be printed out automatically one after another (Autoplot).
You can also select multiple charts to be printed out on the same printout (Multiplot).
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Autoplot

Autoplot

The autoplot function enables you to set up unattended printing of large amounts of data. You
first select which charts to print out and then start the complete series.
Define SinglePlot mode by selecting the SinglePlot option in toolbar.
Click each measurement to be printed out. To check the printouts, select Print Preview from
the File menu.
The measurements selected must show a check in their box.
To delete a measurement from the series, just click it to make the check in its box disappear.
To start the printing procedure, select Print all checked records from the File menu. VibPostTest displays the number of printouts in stack and asks you whether or not to print out.
To cancel the printing procedure, click Cancel.

MultiPlot
Select the MultiPlot option to display and print several measurements in one chart.
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Printout

Test Definition Export (Sine and Random)
For Sine and Random modes, m+p VibControl offers supplementary print templates for test
definitions with a very compact channel list view:

Use low-pass Filter: No

Low-pass Filter Frequency:

2000 Hz

Sine / Sine reduction:
No.
2
4
8

C W M Name
Sensitivity
W
100 mV/g
C
control channel 1000 mV/g
W
100 mV/g

Coupling
Volt AC Gnd
Volt AC Gnd
Volt AC Gnd

Mode
Notch
Notch

Coupling
Volt AC Gnd
Volt AC Gnd
Volt AC Gnd

Averages
50
50

Random / Random Reduction:
No
1
4
5

CWM
Name
WM
Channel 1
C
Control channel
M
Channel 5

Sensitivity
100 mV/g
100 mV/g
100 mV/(m/s2)

The installer will provide new default templates "VcpNT\config\<LANGUAGE>\s_sine.fmt.default" and "s_random.fmt.default".
To activate these templates on updated systems, please copy any of these files to "VcpNT\config\<LANGUAGE>\s_sine.fmt" or "s_random.fmt"
These template files can be edited in order to enter customer specific information or logo.
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Post-Test Charts Format Storage

8.6.2

Post-Test Charts Format Storage

Post-test charts format storage

m+p VibControl stores a customized post-test analysis charts layout format for re-use later or
for use as default layout format. The layout format includes:
- what graphs need to be displayed
- all axis information (X, Y, Log/Lin, scaling) of all charts
- colors definitions
- data filter (C, W, M, Drive, Error, …)
- reference setting for transmissibility and transfer functions
- data overlays (reference, alarm, abort, notch, …)
- level scaled or not
- legend turned on/off or turn on/off of individual legend items
The chart layout format storage function connects the test or a set of similar tests to be displayed identically by retrieving the store and earlier defined layout format. Moreover the option
sets a default layout per mode of excitation giving the user the right charts and information on
all tests executed.
The File menu offers several options for loading a previously saved configuration or saving the
current layout configuration: Load configuration, Save configuration, Save configuration as
default.
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Export Data to Microsoft Office Tools

8.6.3

Export Data to Microsoft Office Tools

You can directly copy test results from VibPostTest to Microsoft Office applications using the
clipboard function.

Export data or charts

Export to Microsoft Word
You can export your charts or data to a Microsoft Word document.
Select the charts/data to be exported so that it is displayed in the VibPostTest window.
To copy the charts/data to the clipboard, select Copy graphics or Copy data from the Edit menu
or from the chart’s context menu.
Open your Microsoft Word document.
To paste the charts, select Paste from the Microsoft Word’s Edit menu.

Copy Charts to Word
The Copy diagram(s) to Word function of the Edit menu enables you to copy multiple charts
into a Microsoft Word document.
Mark the charts you want to copy and choose the Copy diagram(s) to Word function of the Edit
menu.
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The message: "Do you want to print x checked result files?" comes up.
Click the OK button to proceed.
Microsoft Word opens and the charts are inserted automatically into the document using a predefined template.

m+p VibControl Report Word

It is easily possible to modify the template.
To do so, open the file "VcpNtResults.dot" in the "C:VcpNT\Config" directory.
You will see text frames which contain the text: "<vcGraph>“.
The size of these text frames define the size of the charts which will later be inserted.
You can modify both size and number of the frames.

If you want to define a template by yourself, make sure that you define text
frames containing "vcGraph". These frames will later be replaced by the
charts.

Around the frames the document can be created like a normal Word document. You can define
headers and footers, insert logos etc.
Make sure that the file is saved as "VcpNtResults.dot".
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Test-Mode Specific Functions

Copy to Microsoft Excel
You can copy your measurement data to a Microsoft Excel spreadsheet for further processing.
Select the measurement to be exported so that its chart is displayed in the VibPostTest
window.
To copy the data to the clipboard, select Copy Data from the Edit menu.
Open your spreadsheet.
To paste the data, select Paste from the Excel’s Edit menu.
When using the copy data selection from the edit menu (or pressing Ctrl-e) the data on the clipboard will be in Engineering format. This allows other software such as a spreadsheet to have
the same accuracy as m+p international software.

8.7

Test-Mode Specific Functions

8.7.1

Transient Capture: SRS Transformation

m+p VibControl is able to store SRS parameters in the result file and make them available for
viewing and editing.

SRS Parameters selection
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Transient Capture: SRS Transformation

In the VibPostTest Extras menu, select the SRS Parameters ... option in order to open a
separate window where you are able to edit the current SRS parameters or to enter new SRS
parameters. It is also possible to load an existing file.
In the lower part of the window you can define a compliance check.

SRS Parameters dialog

If no SRS file has yet been imported, this dialog will be displayed automatically once you
activate SRS transformation.

Transient Capture Measurements Threshold Checking for SRS Transformations
With transient capture measurements, a Compliance Check can be performed which is defined
as a threshold check for SRS transformations.
For verifying whether the measured SRS meets specific requirements, you can perform the following checks:
•

Check whether the required number of lines or more exceed the reference you defined in
the above part of the window.

•

Check whether the abort limits have been violated by the indicated number of lines or less.

•

Check whether the effective shock duration (Te) lies in a valid range. Note that it is necessary to specify a reasonable RMS window length which is used for the calculation.

These checks are available whenever an SRS transformation is done. They can be performed
either online while the test is running or offline in the posttest file.
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Transient Capture: SRS Transformation

Transient capture measurement with threshold check stating pass or fail
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Storing Control and Drive in Mixed Mode

8.7.2

Storing Control and Drive in Mixed Mode

VibPostTest results in a mixed mode test (random-on-random) include the narrowbands in the
control and drive signal (see below).

Mixed mode test results including narrowbands
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Coherence Measurement in Random Test Mode

8.7.3

Coherence Measurement in Random Test Mode

The coherence is measured in random tests between each measurement channel and the first
measurement channel (see chapter 8.7). The results of this measurement can be displayed in
VibPostTest using the View menu in the menu bar. If you select Coherence and Magnitude, but
unselect Phase, VibPostTest will display a split window showing the results of the coherence
and magnitude measurement.

Coherence measurement display

In case you want VibPostTest to show all three displays, you need to select Coherence and
Magnitude and Phase.
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Coherence Measurement in Random Test Mode

Combined display showing coherence, magnitude, phase

It is not possible to generate a combined printout of amplitude, phase and
coherence - m+p VibControl will print only amplitude and phase in this
case.
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Import of Graphical Results into VibPostTest Chart

8.7.4

Import of Graphical Results into VibPostTest Chart

m+p VibControl offers comparison of stored measurements.
In VibPostTest, open the result file you want to copy. Select the Copy data function of the Edit
menu.
Then, open a second result file and paste the trace using the context menu or the known Copy
and Paste features.

Import of graphical results into VibPostTest
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Last Drive for Classical and SRS Shock Control (VXI only)

8.7.5

Last Drive for Classical and SRS Shock Control (VXI only)

Drive signal export screenshot

m+p VibControl offers the possibility to re-use a pre-stored drive pulse without re-running a self
check or pre-equalization levels.
This feature was originally implemented to improve the seismic application covered by the SRS
control software. The enhancement can also be used in high level, high speed pyroshock testing. The approach in either application is that a test is run on a dummy or similar structure as
the test item. Any of the stored used drive signals (independent of the level of excitation) can
then be exported for re-use, and allowed to by-pass any self check or pre-test levels.

Drive signal import screenshot

One should however be cautious that all external equipment involved in the test are set to the
exact same values as at the time the pre-stored drive signal was obtained.
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Close VibPostTest

8.8

Close VibPostTest

To close VibPostTest, select Exit from the File menu.
To view the test setup of the currently loaded test run, click
into VibEdit.
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Appendix

9.1

Brüel & Kjaer Nexus™ Conditioning Amplifiers

m+p VibControl enables parameterization and remote control of Brüel & Kjaer NEXUS™
conditioning amplifier type 2692 via the RS232 interface. This conditioning amplifier supports
up to four piezoelectric accelerometers.
In the channel setup (see below), you enter the accelerometer sensitivity "pC/g" and the amplifier sensitivity "mV/g" which will be downloaded to the instrument before the test starts. This
avoids typing errors in the channel setup and makes the time-consuming manual programming
of the amplifiers unnecessary. And the report clearly shows the accelerometers being used.
This channel setup is done in the VibEdit program part. Go to the Channels tab and make your
settings as described below.

9.1.1

VibEdit: Settings in the Channels Tab

NEXUS
m+p VibControl enables parameterization and remote control of Brüel &
Kjaer NEXUS™ conditioning amplifier type 2692 via RS232 interface. This
conditioning amplifier supports up to four piezoelectric accelerometers.
m+p VibControl processes voltages, but often sensors measure capacities.
The NEXUS™ conditioning amplifiers measure capacities and convert them
to voltages which can be processed by m+p VibControl. The NEXUS™
conditioning amplifier is remote controlled. The software transfers mV/g to
the NEXUS™ amplifier via remote control and the NEXUS™ amplifier
transfers pC/g to the sensor. In the reverse direction the NEXUS™ amplifier
measures pC/g and converts it to mV/g which can be processed by m+p
VibControl.

Channel definition with channels connected via NEXUS™ amplifier

In the channel set-up, you enter the accelerometer sensitivity "pC/g" and the
amplifier sensitivity "mV/g" which can be downloaded to the instrument
before the test starts. Additionally, you enter the Name, the Model and the
SerialNo. of your NEXUS™ device and define to which NEXUS™ channel
the sensor is connected.
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Channel Parameter Transfer to NEXUS™ Conditioning Amplifier After Selfcheck

You can freely configure the existing analog input channels of the used m+p
VibControl hardware (m+p VibPilot or m+p VibRunner) with the individual
channels of one or several conditioning amplifiers and IEPE accelerometers
without the need to follow a certain order.

9.1.2

Channel Parameter Transfer to NEXUS™ Conditioning
Amplifier After Selfcheck

The NEXUS™ conditioning amplifier enables you to connect up to four piezoelectric accelerometers.
A click on the Selfcheck button starts the selfcheck and opens the NEXUS™ Settings box. It
gives an overview of channel parameters as defined in the m+p VibControl channel definition
(see previous chapter).

Nexus settings window opens

Compare these parameters to the parameters shown on the NEXUS™ amplifier display.
•

If the parameters are identical to those defined in m+p VibControl, click the No button.
The parameter setting on the NEXUS™ device will be left unchanged.

•

If the parameters differ, click the Yes button to transfer the m+p VibControl settings to your
NEXUS™ amplifier.

The update takes some time, but it avoids type errors in the channel setup and makes the timeconsuming manual programming of the amplifiers superfluous.
And the test definition report clearly shows the accelerometers used.
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Create NEXUS™ File

9.1.3

Create NEXUS™ File

The Create NEXUS™ file option of the Tools menu of the VibRunner program part enables you
to modify the parameter settings of the NEXUS™ amplifier.

Create NEXUS™ file dialog window

Select NEXUS™ file
to change:
NEXUS™ files define the parameter setting at the NEXUS™ device.
Use the file browser to select a NEXUS™ file which shall be modified.
m+p VibControl will write its parameter settings to this NEXUS™ file.
Select NEXUS™
file to store:

Use the file browser to select where the NEXUS™ file shall be saved.

Generate:

Click on Generate to save the modified NEXUS™ file.

For more information on the integration of the NEXUS™ Conditioning Amplifier, please do not
hesitate to contact us.
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Create NEXUS™ File
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Classical shock test mode
Sine dwell schedule 350

Analysis
VibPostTest

212

511

Anti-alias filter Agilent hardware 380

A

ASCII data
RoadLoad editor

Abort
Sine dwell test mode

Abort limit
Channel parameters
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334
130, 178, 248, 281, 322,

Classical shock test mode 211
Define the channels 181
Mixed mode 289
Notch parameters 181
Random test mode 105
RoadLoad test mode 408
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Sine test mode 152
SRS test mode 263
Define a shaker 62
Mixed mode 288
Random test mode 104
Selected tone definition (sine tones)
Sine dwell test mode 331, 332
Sine test mode 148, 150
SRS test mode 259
External pulse builder

Acceleration, max.
External pulse builder

Classical shock test mode 227
External pulse builder 226

ASCII pulse editor

58
ASCII reference spectrum 105, 289
Classical shock, SRS shock

Auto measure

300

Sine dwell schedule 345
Sine schedule 166
Transient capture 380

Auto peak search

Automated ICP settling time 46
Automatic shock capturing (VibRunner) 390

299

227
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Acceleration/displacement control

190
Active notch channel 180
Actual amplitude display 39
Add channels online 88, 143
Advanced notching 189

Autoplot
Report

Advanced random parameters 106, 291
Channel parameters

Autoscale
Reference graphics
Report 501

Channel parameters

Classical shock test mode 210
Mixed mode 289, 293
Notch parameters 181
Random test mode 105, 109
RoadLoad test mode 408
Sine dwell test mode 333
Sine test mode 152
SRS test mode 263
Classical shock test mode
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129, 177, 321, 370

Average weighting factor N
Mixed mode 291
Random test mode

107

Averages

139

Random test status line

Averages per loop

Mixed mode 291
Random test mode

107

Axial stiffness

Define a shaker 64
Shaker 114, 158, 233,

Alarm limit

Amplitude

68

Av mode

281

Alarm table
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Auto-save settings 38

Sine test mode

Alarm

513
39

Post-test analysis

Auto-load settings

Acceleration

Acceleration offset

450

ASCII file

Axis scaling

68

B
Bandpass filter
RoadLoad editor

Base parameters
SRS test mode

211

312, 338, 413

443

261

Breakpoints

Linear acoustic control (wave tube chambers) 401
Reference graphics 76
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Selected tone 298
Sine test mode 153
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VibPosttest
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Classical shock test mode
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Broadband random

Controls 326
Graphics 307
Mixed mode 286

Random control 140
VibPostTest 538

Colors
Reference graphics
Report 509
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Building composite sample files
RoadLoad editor

Coherence measurement

COLA = Constant Output Level Amplifier

Brüel & Kjaer NEXUS™
see NEXUS™

484

444

Bypass low-pass input filter 237
Classical shock schedule

237

392

71

Command table
RoadLoad schedule

418

Commands
Classical shock schedule
Random schedule 120

241

Comments

Online test log 37
Report 508
Shaker definition 116,

C

414
Test run 36

Calculate pulse and SRS
SRS test mode

270

Chamber control
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468

troubleshooting

Change data directory 478
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Channel scaling

Online graphics
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Check reference graphics
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336

Classical shock

Control 250
Drop table simulation
Schedule 237
Test mode 206

Client window
Online graphics
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Control strategy 123, 168, 315, 361, 395
Sine tones 296
Copy 24
Data to clipboard 81
Data to Microsoft Excel 534
In tables 25
RoadLoad editor 445
Online graphics
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Cursor

Classical shock test mode
Classical shock control
trouble shooting 50

407

Transducer coupling

87

Coherence

RoadLoad test mode

392

Control signal

Couple

219

Clipping

210

257

Coherence chart in VibMultiplot 488
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213

257

Control blocksize

Check reference charts
SRS test mode

Sine pulse definition (classical shock)

Constant Output Level Amplifier = COLA

88

Classical shock test mode 243
Renaming in VibPostTest 483
Online graphics

221

Compensation types

Shock.ini

Channels

Charts

External pulse builder 226
Fit displacement (classical shock)

Configuration file

500

Channel, select

489
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horizontal cursor 74, 494
Reference graphics 73
Report 493
scale x-axis to cursor 74, 494
second cursor 74, 494
Shown as RMS 39
Shown as sine-peak 39
To maximum 513
To Minimum 513
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Cursor label font size

Multiple y-values 90
RMS display 39
Sine responses 201
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Cursor readout

439
Cursor summary 74, 494
RoadLoad editor

Cursor, tracking
Online graphics
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424

Mixed mode 292
Random test mode

200

Cycles
Sine dwell control

292, 321,
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Dongle 3

373

Drive

Sine control 196
Sine dwell control

D

375

Drive signal

Export 541
Online graphics

Damping

Sine 169, 362
Sine control 196
Sine dwell control 375
Sine tones 296
SRS test mode 267

Data directory change

Drop table simulation
Classical shock pulse definition

Duration
Sine dwell schedule

478

Dwell no.

Data labels
Report

Sine dwell control

500

DC offset removal (VibPostTest)
DC removal
External pulse builder

518

227

Degrees of Freedom (DOF) 107, 129, 292, 321,

424

SRS test mode

RoadLoad schedule

RoadLoad editor

415

VibPostTest

SRS test mode
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255
Digital channel settings 458

Narrowbands

Sine control 196
Sine dwell control
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Displacement optimization
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Charts to Word 532
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External control via Visual Basic 60
External pulse
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External pulse builder 225
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Final slope time

SRS test mode

Classical shock test mode
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Fixed scale

436

External shutdown
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Report 501
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Font size
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Sine test mode
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Online graphics
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Narrowbands 302
Notch parameters 180
Random test mode 104
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Sine dwell schedule 348
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Sine tones 297
SRS test mode 264, 267

Classical shock test mode 230
Mixed mode 294
Random test mode 122
RoadLoad test mode 410
Sine test mode 155
SRS test mode 271

FFT averaging
RoadLoad editor

432

FFT data file
Saving

437

File
Auto-increment result files
Shaker file 62

38

Frequency data
Online display

File export, VibPostTest result files 477
File extension

21

Mixed mode 292
Random test mode 108
Sine control 194
Sine schedule 164

449

Files
Sorting result files

Frequency over time

473

Filter
Channel parameters

Sine dwell online graphics

External pulse builder

Mixed mode 286
Random test mode 100
SRS test mode 261

226

Frequency resolution

Filter channels
Report

Mixed mode 287
Random test mode

479

Filter combinations
Sine

Anti-alias filter Agilent hardware
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Frequency, current

173, 366

Filtering

377

Frequency range

172, 365

Filter band

92

Frequency limits

474
File search by name 474
RoadLoad editor

145, 204

Frequency domain view
Online graphics

File search by date
File types

95

Frequency

Feasibility check (shaker)

550

224

Fit displacement compensation

External sample file generation
RoadLoad editor

Classical shock test mode 213
RoadLoad test mode 409

380

Sine control 195
Sine dwell control

375
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Functions, mathematical
VibPostTest

Import

517

ASCII reference spectrum (Random control)

289
FFT data file 437
Notch table 123, 170, 182, 316, 363
Result data graph 91
Result data graph (VibPostTest) 541
SRS parameters (transient capture) 386

G
Gain error in selfcheck log
Measures to take

Getting Started files

50
11

Initial slope time
Classical shock test mode

Getting Started test

Classical shock control 256
Mixed mode control 329
Random control 139
Sine control 199
Sine dwell control 378

Graph view
RoadLoad editor

224

429

RoadLoad editor

Input file parameters

428

RoadLoad editor

Input voltage

114, 158, 233, 312, 339, 413
8

Shaker

438

Install service

Graphics

Installation

Broadband random 307
Narrowband random 309
RoadLoad editor 428
Sine tones 308

Software

4

Integration time
Sine schedule

161

Integration, classical shock

Grid
Reference graphics

VibPostTest

68

gRMS-value of reference spectrum
Report

Input buffer editing

105,

520

Integration, online
Classical shock control

505

255

Integration, random, sine

Ground level
Random schedule

VibPostTest

117

519

K

H

Kurtosis (VibEdit)

Half sine wave form

213
Harmonic distortion factor 516
Haversine wave form 207
HCF shaker control 358
History channel 480, 484
History function 480, 484
Classical shock test mode

Hold

Classical shock schedule 241
Random schedule 121
RoadLoad schedule 418

Hold sweep

Sine control 198
Sine dwell control

376
Horizontal cursor 74, 494

101
Kurtosis (VibRunner) 143
Random test mode

L
Label 75

Adding text 497
Deleting data/text 498
Hiding labels 498
Labelling Markers 495
Moving labels 498
Removing labels 498
Report 495
Standardized format 80,

498

Labels
Minimum, maximum (VibPostTest)

Language

I

499

7

Lehr’sche Dämpfung 111

ICP settling time, automated
Idle
VibRunner

33
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Sinus

155

Level
Acceleration/displacement control (sine)
Classical shock control 252

192
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Index

Classical shock schedule 241
Notch parameters 180
Random control 137
Random schedule 121
RoadLoad schedule 418
SRS test mode 264, 268

Manual mode
Schedule definition

Marker

Classical Shock schedule 242
Define exact position 495
Define label 495
Hiding markers 498
Labeled markers 495
Moving markers 498
Random schedule 121
Reference graphics 75
Removing markers 498
Report 495
Setting markers 495

License

dongle-enabled 3
Independent from PC

3
License for desktop PC 3
Limits
Report

484

Line style selection 72, 510
Linear acoustic control 400

Marker label
Report

Linear scale
Reference graphics

69

Online graphics 95
Post-test analysis 517

515

Maximum input voltage

Line-by-line check start level
Mixed mode 292
Random test mode

Define a shaker 65
Shaker 114, 158, 233,

107

Load
Alarm tables

Measure

108

VibRunner

Reference graphics

Classical shock schedule 241
Random schedule 121
Report 481
RoadLoad schedule 418

69

Logo on printout 528
Loop definition
Classical shock

Measurement channel
combinations of filters

242

Low-pass filter
m+p VibRunner front-end

173, 366

Measurement unit change

125, 171, 317, 364

VibPosttest

483

Microphone calibration

402

Progressive Wave Tube testing
Random 131

M

Microsoft Windows operating systems

m+p VibControl software installation

4

13
453
m+p VibPilot hardware 12
Advanced VibUtil 453
m+p VibRunner hardware 12
Advanced VibUtil 453
m+p VibMobile hardware

m+p VibSlideRule
Multi-function vibration calculator

m+p VibUtil 453
test sequencing

Classical shock test mode

Main pulse peak
Classical shock test mode
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Minimum, maximum values (VibPostTest)
Mission Profiles

499
507

102, 120

Mixed mode

59

Broadband random 286
Random-on-random (RoR) 285
Schedule 314
Sine-on-random (SoR) 284

Mixed mode testing

55

Main pulse length

Minimum search

1

Minimum, maximum labels (VibPostTest)

Advanced VibUtil

552

34

Measurement

212

Logarithmic scale

312, 339, 413

513

Maximum search

Lines tolerated out of abort limit
Mixed mode 292
Random test mode

496

Mathematical functions

Linear transfer function
Post-test analysis

415

283

Mixed test mode

208
207

Control 323
Narrow band random 301
Sine tones 295
Sine-on-random-on-random (SoRoR)

MNotch channels

285

183
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Modal shaker 192

Number of lines

Mixed mode 286
Random test mode

Momentum notching
Graphics 185
Sine 182

Number of repetitions
Sine dwell schedule
Sine schedule 166

130, 322

Monitor channel

Moving coil mass

Define a shaker 64
Shaker 114, 158, 233,

Classical shock test mode
SRS test mode 261

312, 338, 413

Sine schedule

Online graphics 94
Transducer check 95
Report

166

O

486

OASPL 402

Multi-sine

OASPL = Overall sound pressure level 401

284
Multi-sine test run 326
Test definition

Octave
SRS test mode

Octave spacing
SRS test mode

N

267
262

Offset
Classical shock test mode

Narrow band random
Mixed test mode

301

Online chart
Classical shock control

Narrowband random

Online differentiation

Narrowband, selected 304

Classical shock control

NEXUS™

File creation 545
Parameter verification 544
Remote control via m+p VibControl 543
Remote controlled 126, 174, 246, 279,

367, 422, 543

318,

544
NEXUS™ conditioning amplifier 126, 174, 246,
279, 318, 367, 422, 543, 544
No random option for mixed mode 284
301

Non-linearity (drive)
Classical shock control

Notch filter
RoadLoad editor

Notch profile

253

443

182

Notch references

144, 203
Notch table import 123, 170, 182, 316, 363
Notching 131
Advanced notching 189
Momentum notching (Sine) 182
Summed Force notching (Sine) 187
Vector RSS notching (Sine) 186
Online graphics
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255
255

Online display

Transfer of m+p VibControl channel settings

Narrowbands

209

Online control 32

Controls 326
Graphics 309

No. of sweeps

208

Number of sweeps

59

Multi-monitor

Multiplot

345

Number of samples

Multi-function vibration calculator
VibSlideRule

100

Displacement 141, 202
Frequency data 145, 204
Time data 145, 204
Velocity 141, 202

Online graphics

Channel selection 88
Charts 92
Client window 87
Control signal 89
Cursor, tracking 200
Display of multiple y-values 90
Drive signal 90
Error signal 90
Freeze, online signal 95
Frequency domain view 92
Mathematical functions 95
Mixed mode control 329
Multi-monitor function 94
Notch references 144, 203
Random control 138
Reference 142, 256
Result data graph import 91
RMS value 90
Sine control 200
Sine dwell control 377
Sine tones 90
Time domain view 92
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Index

Online integration
Classical shock control

Postprocessing

255

Transient capture

Online SRS

Post-processing of throughput files

282
Online test log 37

399

SRS control

Storage

Classical shock control 253
Random control 137
Sine control 197
Sine dwell control 376
Sine tone controls 325

Optimization of SRS wavelets

526

Power Spectral Density = PSD
SRS test mode

263

Pre-pulse tolerance
Classical shock test mode
Logo on printout 82, 528
Reference graphics 82
Report 526
RoadLoad editor 447
Selfcheck results 52

Output file conditioning

434

Output file parameters

Probability Density Function (PDF)

428

Probability Function (PF)

SRS test mode

209

Printout

269

Optimize SRS shaker displacement 269

Output time

102, 287

Pre-pulse optimization

Operating systems 1

RoadLoad editor

383, 395,

Post-test charts format

Open loop

RoadLoad editor

391

262

Profile

Overall RMS values (VibPostTest) 507

Random schedule

101, 143

143

122

Overall sound pressure level = OASPL 401

Progressive wave tube chamber 401

Overload 43

PSD = Power Spectral Density
Mixed mode 287
Random test mode

Overload handling 130, 322

102
225

Pulse builder, external

P

Pulse definition (classical shock)
Rounded decay 217
Sawtooth 224
Sine decay 217
Sine rounded 217
Sine square 217
Sine wave 217
Symmetrical 213
Trapezoid 224
Triangle 224

Paste 24

In tables 25
RoadLoad editor

Paste insert
RoadLoad editor

446
446

PDF (Probability Density Function)
Peak marker
Post-test analysis

101, 143

513
260

Pulse editor (ASCII)
Classical shock, SRS shock

Peak RMS magnitude
Peak values
Post-test analysis

Pulse editor tool
Classical shock pulse definition

511

Pulse encoding

Peak-peak displacement
Classical shock test mode
SRS test mode 262

209

Sine dwell schedule

349

Phase chart in VibMultiplot
Phase display
VibPosttest

Sine dwell online graphics

377

126, 174, 246, 279, 318,
367, 422, 543
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Classical shock schedule

240

R

Piezoelectric accelerometers
Channel definition

254

Pulse table

485

57

227

Pulse polarity

488

Phase over time

554

External pulse builder

Classical shock control

Phase

58

Ramp time
Narrowbands

301

Rampdown rate
Random schedule

117
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Random control 136
Random online graphics

138
Random reduction 397
RMS over time

Window type selection

398

Random schedule 117

Resample

285

Rescale

Range
Channel parameters

370, 424

129, 177, 248, 281, 320,

Recalculate pulse and SRS
SRS test mode

Reference
Online graphics
Report 491

Reference charts
SRS test mode

270

142, 256

Colors 71
Copy to clipboard 81
Cursor 73
Marker 75
Mixed mode 307
Printout 82
Screenshots 81
Sine dwell mode 336
Zoom 70

Sine control 197
Sine dwell control

376

Files

Channels in VibPostTest

Classical shock schedule
Autoplot 529
Channel scaling 500
Colors 509
Comments 508
Cursor 493
Data labels 500
Filter channels 479
Label 495
Limits 484
Marker 495
Measurement 481
Multiplot 486
Printout 526

23

Result file 23
VibPostTest

471

Result file names
Sorting

473

Result file search

473

RMS abort

Mixed mode 293
Random test mode

109

RMS abort limit high

483

RoadLoad test mode

RMS abort limit low
RoadLoad test mode

345

Repetition rate

331

Result data graph import 541

376

Rename

376

Sine dwell test mode

Release sweep
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Reset counter

Restore

SRS control 282
SRS test mode 264
Transient capture 386

Report

Sine control 197
Sine test mode 153

Resonances

Reference SRS

Sine dwell schedule
Sine schedule 165

Rescale spectrum

Sine control 198
Sine dwell control

Reference graphics

Repetition parameters

Narrowbands 293
RoadLoad editor 441
Sine dwell test mode 335

Reset measurement

272

Sine control 198
Sine dwell control

440

RoadLoad editor

Random-on-random (RoR)
Mixed mode

Reference 491
Scaling 500
Singleplot 484
Test legend 504
VibPostTest 478
Zoom 503

RMS display
RMS legend

238

408
408

39
39

RMS over time
Random online graphics

138

RMS value

Classical shock test mode 207
Online graphics 90
RoadLoad test mode 408
SRS test mode 262

RoadLoad editor 427

ASCII data 450
Bandpass filter 443
Building composite sample files
Copy 445
Cursor readout 439
Edit input buffer 440

444
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555

Index

Edit point data 441
External sample file generation 436
FFT averaging 432
File types 449
Graph view 438
Graphics 428
Input buffer editing 429
Input file parameters 428
Notch filter 443
Output file conditioning 434
Output file parameters 428
Paste 446
Paste insert 446
Printout 447
Resample 440
Rescale 441
RPC data input 450
Saved data files review 444
Spectra display 430
Spectral resolution 448
Symmetric clip 449
Time replication file generation 436
Zoom 438

Random 117
RoadLoad 415
Sine 161
Sine dwell 341
SRS 277

Scope mode
Troubleshooting

Reference graphics

SDOF damping
SRS test mode

Search

473
Second cursor 74, 494
Result files

Select
Global selection

Pulse definition (classical shock)

RPC data input
RoadLoad editor

217

Selected tone definition (sine tones)

298

Selfcheck

Log storage 476
Protocol 52
VibRunner 33, 44

46, 119, 163, 239, 343,

Selfcheck level
Schedule

119, 162, 239, 342, 417

Selfcheck level limit

450

119, 163, 239, 342, 417
238
Selfcheck results 49
Printout 52
Saving 52
Storing 476
Schedule

Selfcheck modes

S
Sampling rate

Classical shock test mode 208
RoadLoad test mode 407

SensCal transducer calibration software

Save

Alarm tables 212
Online graphics layout format
Shaker file 65

Save counter
Classical shock control

Save timer
Random control

Shaker

96

RoadLoad editor

444

Scale x-axis to cursor 74,
Scaling
Report

Shaker control

52

Pulse definition (classical shock)

500

Schedule

Classical shock 237
Mixed mode 314
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338, 413
235, 311,

314, 338, 339, 412, 414
312, 339, 413
158, 233, 312,
339, 413
Moving coil mass 114, 158, 233, 312, 338,
413
Total weight 114, 158, 233, 312, 338, 413

254

Sawtooth

60

Input voltage 114, 158, 233,
Maximum input voltage 114,

137

Saving selfcheck results

113, 157, 232, 311, 337

Axial stiffness 114, 158, 233, 312,
Fixture 113, 115, 157, 159, 232,

Saved data files review

556

25

417

Rounded decay

259

262

Selfcheck attenuation

RoadLoad test mode 406

81

SDOF = Single Degree of Freedom

RoadLoad operation details 432
RoadLoad schedule 415

40

Screenshots

HCF

224

358

Shaker displacement

269
62, 113, 157, 232, 311, 337, 412
Shock reduction = Transient capture 379
SRS, optimize

Shaker file

Shock response spectrum (SRS)
Post-test analysis

521
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Shock, recorded

Shutdown time
Sine dwell schedule
Sine schedule 165

Sine-on-random-on-random (SoRoR)

390

Analysis in VibPostTest
Test run 389

Mixed test mode

Single autoscale
Reference graphics
Report 502

344

Signal tolerance
Post-test analysis

Singleplot
Report

100

Multiple VibRunner windows

516
201

273

Sine chirp

SRS test mode 273
Test definition 275

Classical shock test mode

Sine data reduction
Online display of selected filters

201

Sine data reduction filter modes

Pulse definition (classical shock)

217

Sine dwell

Definition

Phase/Frequency over time

RoadLoad editor

377

Spectral resolution
RoadLoad editor

VibPostTest

SRS control

Sine rounded
Pulse definition (classical shock)

Sine schedule 161
Sine square
Pulse definition (classical shock)

Sine test mode 147
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Post-test analysis
Transient capture

521
521
386

SRS parameters (transient capture) 535

SRS transformation

Definition 296
Graphics 308
Mixed test mode 295
Online graphics 90

284

SRS functions

277
SRS test mode 259

Sine tones

Pulse definition (classical shock)

282

SRS schedule

324

Sine wave

257

4

448

SRS parameters

217

224

430

Post-test analysis

217

224

473

SRS error

395

300

112, 156, 231, 310, 336, 411

Spectra display

Sine filter modes

Mixed mode

Sorting
Specimen

Sine dwell online graphics

Sine-on-random (SoR)

Software installation
Result file names

Control 373
Resonances 331
Schedule 341
Test mode 330

Sine tone controls

Classical shock test mode
Classical shock control

Sine decay

Filter mode selection

Slope time (initial)
Smoothing

480

480
Sine reduction 392

Mixed mode 288
Notch parameters 181
Random test mode 104
Selected tone definition (sine tones)
Sine dwell test mode 332
Sine test mode 148, 151
SRS test mode 265, 267

Slope time (final)

Sine control 193

VibPostTest

95

Slope

Online display of selected filters
SRS test mode

484

Slave Mode

Sine
Sine burst

68

Single Degree of Freedom = SDOF 259

Sigma clipping

Mixed mode 287
Random test mode

285

Post-test analysis 521
Transient capture 534

SRS wavelets optimization
SRS test mode

217

269

Standby
Classical shock schedule
Random schedule 121
VibRunner 33

242
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Index

Start drive
Sine dwell schedule
Sine schedule 165

Start level
Narrowbands

Start service

344

301

Sweeps

Narrowbands 303
Sine control 194
Sine dwell control 373

Symmetric clip

449

RoadLoad editor

8

Symmetrical pulse

Starting frequency
Sine schedule

Classical shock test mode

164

Startup ramp time
RoadLoad schedule

Startup time
Sine dwell schedule
Sine schedule 165

Startup tolerance
Sine dwell schedule
Sine schedule 165

Synthesis

415
344
344

Status report

464
Stepped Sine 357

SRS test mode

213

266

SysGain

128, 176, 248, 280, 320,
369, 424
System gain 119, 163, 239, 342, 417
Switch on/off, remove 44
System language 451
System operation without administrator rights 14
Channel parameters
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Stop at sweep end
Sine schedule

166

Post-test charts format
Selfcheck results 476
Time interval 415

Strain gauge

526

399

Strain measurements
Stress analysis

399

399

Subscreen 27

187

Summed force notching channel 187
Sweep
Sine tones

Abort 34
Analyze a test 469
Load a test 31
Run a test 33

344

Sweep direction

Sine control 194
Sine dwell control 374
Sine schedule 164
Sine tone controls 325

Sweep duration
Sine dwell schedule
Sine schedule 166

345

Sweep rate

Sine control 195
Sine dwell schedule
Sine schedule 165
Sine tone controls

Sweep table
Sine schedule

Test information

345

28

Test legend

504

Test log

Sine dwell schedule
Sine schedule 164

Sweep stop

Sine dwell schedule
Sine schedule 166

Report

297

Sweep conditions

558

Test

Test duration

Summed Force notching
Sine

124,
170, 244, 316, 363, 420
TEDS Support 124, 170, 244, 316, 363, 420
TEDS = Transducer Electronic Data Sheet

Storage

344, 349

325

167
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Classical shock control 255
Mixed mode control 329
Random control 138
Sine control 198
Sine dwell control 377

Test mode

Classical shock 206
Mixed mode 283
Random test mode 99
RoadLoad 406
Shock response spectrum (SRS)
Sine 147
Sine dwell 330

Test name

259

48

Test run
Beep at test end

Test run name

35

48
453

Test sequencing
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Transducer calibration software SensCal 60

test sequencing
m+p VibUtil

55

Transducer check

Test status window

95

Transducer database list

Random control 136
Sine control 193

362, 420

124, 169, 244, 316,

Transducer Electronic Data Sheet = TEDS

Text label

170, 244, 316, 363, 420

497
Throughput 44
Report

Transfer

Automatic start and stop

417

119, 240, 343, 382,

Online functions 43
Schedule 163
Show/hide recording controls

m+p VibControl channel setting to NEXUS™

Transfer function
Post-test analysis

44

128, 176, 247, 280, 320,
369, 424
Throughput data recording controls 43
Channel definition

throughput files
post-processing

383, 395, 399
110, 154, 228, 294, 335,

Throughput settings

382, 409

514

SRS parameters 386
SRS parameters definition
SRS transformation 534

381

Trapezoid
Pulse definition (classical shock)

Triangle
Pulse definition (classical shock)

Trigger delay
Transient capture

224
224

380

Trigger mode
Transient capture (VibEdit)

Time

544

Transient capture

Throughput data path 8
Throughput data recording 228, 293

124,

380

Trouble shooting

Mixed mode control 324
Narrowbands 303
Random control 136
Sine control 194
Sine dwell control 373
Sine tones 297

coherence

50

Troubleshooting

compare mode 489
Gain error in selfcheck log
Scope mode 40

50

Time data

145, 204
Time domain replication 427
Time domain view 145, 205
Online graphics 92
Online display

Time offset

U
UFF/unv = Universal File Format
Units

Classical shock test mode 228
Mixed mode 289
RoadLoad test mode 408
Sine dwell test mode 334
SRS test mode 265

Classical shock test mode 209
External pulse builder 227

Time replication file generation

436

RoadLoad editor

Tolerance, pre-pulse
Classical shock test mode

209

Tool bar customization 18
Tools

40

VibPostTest

Total test time
Random schedule

Classical shock test mode

Transducer

208

Coupling 127, 175, 247, 280, 319, 369, 384,

423
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Values

114, 158, 233, 312, 338, 413

Total window length

Update test pulse

477

V

122

Total weight
Shaker

Universal File Format = UFF/unv
SRS test mode

491

477

Minimum, maximum (VibPostTest)
Overall RMS (VibPostTest) 507

507

Variable sweep rate
Mixed mode

305

Vector add
classical shock

249, 426
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Index

Vector add function
classical shock

Wave form

249, 426

Classical shock test mode
Full sine wave 217
Half sine 213
Rounded decay 217
Sawtooth 224
Sine decay 217
Sine rounded 217
Sine square 217
Trapezoid 224
Triangle 224

Vector RSS notching
Sine

186

Vector RSS notching channels 186
Velocity

Define a shaker 62
Online display 141, 202
Selected tone definition (sine tones)
Sine dwell test mode 332
Sine test mode 150

299

VibCoPilot

Data analysis on remote PC 60
Test setup on remote PC 60

VibMultiplot

Wave tube chambers

Classical shock test mode

Window type
SRS test mode

268

Classical shock test mode

477
VibShakerDef 61
Export

Virtual channel definition 249, 426

External pulse builder

WANO = Warning, Abort limit, Notch limit, Overload 42
WANO channel mapping 42

178, 321, 371
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Z
Zero padding

W

560

268

Window usage

VibPostTest result files

Watchdog channel 130,

453

SRS test mode

Report 478
Tools 491

208

Window structure
Window time

VibPostTest 469

400

Window length (total)

VibUtil

Coherence chart 488
Phase chart 488

207

227

Zoom

Reference graphics 70
Report 503
RoadLoad editor 438

Zoom-in function

74, 494
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